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1.1

1.2

1.3

Introduction

About This Guide and Related Documentation

This document is intended for MOTOTRBO radio network administrators as well as
dispatchers responsible for the TRBOnet dispatch console operations. It provides
guidance on the installation, configuration, and maintenance of the TRBOnet Server
and Dispatch Console applications.

About TRBOnet

TRBOnet is a suite of professional applications for MOTOTRBO digital two-way radio
networks. TRBOnet manages voice and data communication paths across network
endpoints. It provides a unified graphical dispatcher workbench interface for the
entire range of workforce fleet management tasks.

Contacts
Region Phone Email & Support

EMEA +44 203 608 0598 .
info@trbonet.com — general and
commercial inquiries

Americas +1872 222 8726 support@trbonet.com — technical
support
http://trbonet.com/kb/ — online

APAC +61 28 607 8325 knowledge base
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2 Hardware and Software Requirements
TRBOnet Server/Agent with IP connection only ‘
Voice Channels | 4 8 16 24 24+
CPU Intel Core i3 Intel Core i5 Intel Core i7, 4 Cores Intel Core i7, 6
Cores
Contact
Memory 2 GB 4 GB 4GB 8 GB technical
HDD 300 MB for installation files, +1 MB per 1 minute of voice recording support
Sound Card No

Supported OS

Windows 7/8.x/10, Windows Server 2008/2012/2016

Note:

Windows Server 2008/2012/2016 requires Desktop Experience
Role/Feature installed.

Software

.NET Framework 4.6.x, MS SQL Server 2008 R2 or higher

TRBOnet Server /Agent with Control Stations

Control Stations 1 2+

CPU Intel Core i5

Memory 2 GB

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording
Multi-channel Sound Card required;
Recommended:

Sound Card Integrated sound card can be used. 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Additional Devices

Cable connector Motorola PMKN4016

Supported OS

Windows 7/8.x/10

Software

.NET Framework 4.6.x, MS SQL Server 2008 R2 or higher

Dispatch Console ‘

CPU Intel Core i3

Memory 4 GB

HDD 70 MB for installation files

Sound Card Yes

Display 1280x1024 minimum resolution, 1600x900 recommended resolution

Additional Devices

Speakers and microphone, or headset; Imtradex devices are recommended

Supported OS

Windows 7/8.x/10

Software

.NET Framework 4.6.x

TRBOnet Enterprise — User Manual
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System Architecture Overview
TRBOnet Server, Agent and Console

The TRBOnet software is designed as a client-server architecture,

where TRBOnet Server is PC-based and runs as a Windows service on a network
computer, stores data in an MS SQL database, and allows client connections from
Web Consoles, Dispatch Consoles, and Mobile Clients. The TRBOnet service can be
located on a dedicated remote PC, a local PC (along with the Dispatch Console), or
on a virtual machine.

In addition, remote software agents, such as TRBOnet Agent, and/or hardware
agents, such as TRBOnet Swift A200, can be connected to TRBOnet Server providing
additional voice and data communications paths to and from remote sites. Such
configurations can be used when radio equipment can't be connected directly to
TRBOnet Server due to IP network limitations (see section 3.3, IP Backend Network

Requirements).
TRBOnet Dispatch Console is a PC-based voice dispatch and data application for
MOTOTRBO professional digital two-way radio systems.

TRBOnet Server

TRBOnet Agent

FEE

Local

Radio Infrastructure
WAN/LAN

-

Remote ]

Radio Infrastructure L

TRBOnet
= Web Console

LS

TRBOnet
Dispatch Console
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3.2
3.2.1

3.2.2

MOTOTRBO Radio Systems

Single Site conventional system

A Single Site conventional system is a digital conventional two-way MOTOTRBO
system that includes one digital repeater and allows you to transmit voice and data
via two conventional channels. Radio groups and radio units are assigned to these
conventional radio channels.

IP Site Connect

An IP Site Connect (IPSC) system is a digital conventional two-way MOTOTRBO
system that provides two wide-area channels to increase your communications RF
coverage area. It is possible to connect up to 15 repeaters (each geographical
location of a repeater is called a "site") into one system using an IP connection,
which allows increasing the coverage area for voice and data transmissions. The
main objective of an IPSC system is to provide a stable connection between the
radio units and control centers regardless of the distance.

1% 2% 3%
L& o L & o ® o
L & ® ®

Master Repeater 1 Peer Repeater 2 Peer Repeater 3

TRBOnet
Server

.

LAN/WAN

LSRR\ LR\ LT\

Dispatcher 1 Dispatcher 2 Dispatcher 3
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3.2.3

Capacity Plus

Capacity Plus (also known as Capacity Plus Single Site) is a digital trunked two-way
MOTOTRBO system that is designed for high volume communications at a single
site location. The system is designed to provide communications among a large
number of users within a building, a set of buildings, or a single geographical region.
This system type allows you to effortlessly increase the number of channels for both
voice and data transmission between the radio units and control centers. As this
system type is trunked instead of standard conventional, radio units are always
automatically forwarded to a free channel rather than being programmed to remain
on a single slot, thereby utilizing/sharing the available unused/free RF resources
(channels) among different users. The main objective of Capacity Plus is to support
more simultaneous voice and data transmissions within one capacious system.

Paa=——uuN
Dispatcher 1

LFE\
Dispatcher 2

E Voice Repeater 3

LR
Dispatcher 3

e

,,"'/Talk Group 1
Master Voice Repeater 1 R

Voice Repeater 2

’ Talk Group 2
Data Repeater 4 N

Data Repeater 5

TRBOnet
Server
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3.2.4 Linked Capacity Plus (LCP)

Linked Capacity Plus (also known as Capacity Plus Multi Site) is a digital trunked
multisite two-way MOTOTRBO system that enables you to accommodate both high
volume and wide area communications. This system design allows you to connect
via IP up to 15 Linked Capacity Plus sites located in one geographical region (for
example, City of Charlotte) or in larger geographically separated territories (for
example, covering the Florida Keys from Miami to Key West). This system type allows
you to increase the RF coverage area and the number of channels for voice and data
transmission between the radio units and control centers. The main objective of
Linked Capacity Plus is to support more simultaneous voice and data transmissions
regardless of the distance.

L\

Dispatcher 1

E Router + Switch

P-EE0
Dispatcher 2

E TrEer LAN/WAN

] Router + Switch

L\

Dispatcher 3

E] Router + Switch

Server
Voice Repeater 5 Voice Repeater 6 Data Repeater 7 Data Repeater 8

Control Control Control
Station 1 Station 2 Station N

se2 /7 :Q;

It
i1
"
4

"
&
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3.2.5

Connect Plus

Connect Plus is a digital trunked multisite two-way MOTOTRBO system that enables
you to accommodate high volume, wide area communication that's required for
your business allowing you to connect via IP multiple sites located in one
geographical region or in larger geographically separated territories. This system
type allows you to increase the RF coverage area and the number of channels for
voice and data transmission between the radio units and control centers. Radio units
are always automatically forwarded to the control channel. The main objective of
Connect Plus is to support more simultaneous voice and data transmissions
regardless of the distance as well as to provide a more structural addressing of the
transmissions provided by XRC controller and XRT gateway.

XRC 9000 XRC 9000

Dispatcher 1

-
P
E Voice Repeater 1 Ta”;a;gap 1 Voice Repeater 3 Tallz.a;:c';ap 3
Dlspatcher 2 Data Repeater 2 % % { Data Repeater 4 l'" % % /
E m Talk Group 2 m TaIkGroup4
- — —
LR
Dispatcher 3 XRT 9000
BB m 9
E LAN/WAN
[ ]
LRSS
TRBOnet
Server* * TRBOnet Server requires connections to only one XRT 9000 Controller and one XRC 9000 Controller in the system
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3.2.6 Capacity Max

Capacity Max is MOTOTRBO's next-generation trunking solution. Built on the DMR
Tier 1l Mode of Operation, it delivers smooth scalability, low cost of ownership and
reliable operation.

Il Czpacity MAYX companents TREOnet companents

Application Server Capacity MAX System Server

Dispatch Position
Trunked Controller

TREON

RBOnet Dispatch

MNIS Data Gateway MNIS VRC Gateway

Application network CMSS network

. Router
Dispatch position

BOnet Dispatch

Console

~

[ 3™ party network

3.3 IP Backend Network Requirements

Before planning any IP connected MOTOTRBO system, read the MOTOTRBO System
Planner (Back-End Network Considerations).

If the

Delay/Latency

The amount of time it takes for voice to leave the source repeater and arrive at
the destination repeater. The delay should be less than 60 ms. It can be up to
90 ms, but requires changes in CPS for both radio units and repeaters.

Jitter
The variation of the packet inter-arrival time. It should be less than 60 ms.

Packet Loss

In the case of voice, the ongoing call ends if six consecutive packets do not
arrive within 60 ms of their expected arrival time. In the case of data, the
repeater waits for the expected number of packets (as per the data header)
before ending the call.

Bandwidth
Refer to the MOTOTRBO System Planner for bandwidth calculations, but

roughly, it requires 96 kbps for each repeater connection and should be
summed up for all repeaters.

IP backend network does not satisfy MOTOTRBO requirements, it will degrade

audio quality significantly, including dropped voice calls.

TRBOnet Enterprise — User Manual
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3.3.1

4.1

4.2

4.3

Linked Capacity Plus Specific Requirements

¢ Addresses and Ports
A static IP Address and UDP Port for the master repeater must be made
available to all peer devices on the Linked Capacity Plus system.

= When a peer device registers with the master repeater, the network supplies
the return IP address and UDP port of the peer device to the master
repeater. The IP address and UDP port must then be made available to all
other MOTOTRBO™ LCP devices on the system.

TRBOnet Enterprise and Dependencies Installation

TRBOnet runs on Microsoft Windows-based PCs. For the TRBOnet Enterprise
Compatibility Table, see

https://trbonet.com/kb/trbonet-enterprise-plus-compatibility-table/

Installing Microsoft SQL Server
Download and install Microsoft SQL Server 2008 R2 or higher.

You can download and install either a full-featured MS SQL Server or an Express
edition of MS SQL Server. The Express edition of MS SQL Server is free; however, it
has some technical restrictions (maximum database size of 10 GB, RAM usage, and
other restrictions).

For example, Microsoft SQL Server 2008 R2 SP2 - Express Edition (which is free) is
available at:
http://www.microsoft.com/en-us/download/details.aspx?id=30438

Note: We recommend that you download a version of SQL Server with
Tools.

Select the 32-bit or 64-bit version depending on the underlying OS. Accept the
defaults for the setup.

See also section 5.2.1.1, Windows Authentication on page 15.

Installing .NET Components

Windows 8 and later, as well as Windows Server 2012 and later, include the required
.NET 4.6 components as part of the operating system.

The .NET Framework redistributables are available from Microsoft at:
https://www.microsoft.com/en-us/download/search.aspx?g=.net%20framework

Installing TRBOnet Enterprise

e Contact Neocom Software to obtain the latest installation package of the
TRBOnet Enterprise software, unzip, and run the setup file as a local
administrator.

e When the TRBOnet Enterprise Setup wizard appears, click Next.

e On the End User License Agreement page, accept the terms of the license,
and then click Next.


https://trbonet.com/kb/trbonet-enterprise-plus-compatibility-table/
http://www.microsoft.com/en-us/download/details.aspx?id=30438
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework
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Choose Setup Type .
Choose the setup type that best suits your needs

TRBOnet Dispatch Console
This is @ dispatcher computer and only Dispatch Console must be installed

TRBOnet Server and Dispatch Console

This is a Server computer and you need to install Server software and
Dispatch Console

= Custom
E Allows users to choose which program features will be installed and where
2 they will be installed.

Neocom Software

< Back Next > Cancel

e On the Choose Setup Type page, click one of the following options:
* TRBOnet Dispatch Console

Choose this option to install only TRBOnet Dispatch Console on your
computer.

TRBOnet Server and Dispatch Console

Choose this option to install both TRBOnet Server and

TRBOnet Dispatch Console at once on your computer.

Custom

Choose this option to select from the list one or more components to be

installed.
Custom Setup '
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features will be installed.

(= ~ | Dispatch Console TREOnet Enterprise 5.2 Agent
e () 7 | Server Instance

Agent Instance |

This feature requires 199MB on
your hard drive.

Location:  C:'Program Files (x85)\Neocom Software|TRBOnet

Browse...
Enterprise\

Neocom Software

Reset Disk Usage < Back Cancel

For example, you may install only TRBOnet Server Instance:

Custom Setup r
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features wil be installed.

e X _~ | Dispatch Console TRBOnet Enterprise 5.2 Server
(=T
b X

~ | Agent Instance

This feature requires 209MB on
your hard drive.

Location: C:\Program Files (x86)Neocom Software\TREOnet

Browse...
Enterprise}

Neocom Software

Reset Disk Usage < Back Cancel

e Accept the defaults for the rest of the setup and complete the installation.

TRBOnet Enterprise — User Manual
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5 TRBOnet Server

To start TRBOnet Server, click the corresponding shortcut on the desktop,
or click Start > All Programs > Neocom Software > TRBOnet Server x.x

5.1 License Information

neocom
software

The TRBOnet software requires a valid license in order to operate. Depending on the
License Type (see next section), the license can be obtained via TRBOnet's website or
from a Neocom representative.

5.1.1 License Types

There are three license types available for TRBOnet Enterprise:

License

Commercial
Type

Validity 60 days By Request Permanent (non-expiring)

Quantity of Up to 2 control stations

Control or 1 IP repeater )

Stations and | connection By Request According to Customer order

Radio Units | 10 Radio Units

Features Limited functionality By Request According to Customer order
Assigned to server's Assigned to server's Hardware ID.
Hardware ID. Assigned to the serial numbers of
For more details on master repeaters and control

How to It can be downloaded Hardware ID, see stations. To retrieve serial

obtain from the web page. the article at numbers, use Control Station's
https://trbonet.com/kb | codeplug (do not rely on a serial
/how-to-get-the- number printed on the device's
hardware-id/. label).

For more information on the license and renewals, contact our technical support at info@trbonet.com

To see how the Hardware ID and control stations and/or repeaters are assigned in
your license, open the INFO file delivered with the license file (for example, in

Notepad):

License ID: aada3405-4e5f-4254-843f-alballeTc473
License generated by: John Smith
License generation date: 7/20/2016

TRBCnet Support is active up to:
TRECOnet Enterprise (4.0.0.138)

Product:

License for: Neocom Software Ltd
Licensed instance: [Defaulrt]

Server limitations

EIVer Rardware Keys:
42B1-BA64-D473-D6ES-DFAC

Remote Agent connections: 5
System types: Unlimited

Agent limitations
Agent hardware keys: Any

Number of master radios or master repeaters:

7/20/2017

|—!

"

/

Fa=ter radicos

master repeaters serial numbers:

4B4TNL2887; ¢84TNL2BEE; 484TNL2889; 4B84TNL2B90; 4B4TNL2BI]]

Total number of peers in IP Site Connect or Capacity Plus systems: 10
Serial numbers of peers used in IP 3ite Connect or Capacity Plus systems: Unlimited

Limitation for Client connections
Remote Dispatch connections: 10
Number of Remote Dispatch accounts: 10

Subscriber radios limitations
Humber of subscriber radios: 10

11
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5.1.2

5.1.3

5.14
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1. Your license is assigned to the Hardware ID.

2. Your license is assigned to the serial numbers of master repeaters and control
stations.

Moving TRBOnet Server to a Different Server PC

If there is a need to use TRBOnet Server on a different server PC, please contact your
Neocom sales representative for further instructions.

Using Spare Repeaters

If the plan is to use spare repeaters, for example, as replacement for damaged ones,
communicate the total number of repeaters when ordering a license.

For example, 3 repeaters will be actively used with TRBOnet Server and 1 spare
repeater. Communicate the following repeaters limitation: 3 active 1 spare and
provide the serial numbers of all 4 repeaters when placing an order (also include the
spare repeater’s serial number).

License Manager

¢ In the Configuration pane on the left, select License.
In the right pane, you can see the text of your current license.

e Heense Version: 5.4,0,2157
U’ Service
0 Metwork License is valid N

& Redundancy
Database

(@ Reports

L} Service Management

,’_ Advanced Settings

ION Geocoding Servers

B Radio Systems

B§ PTT over Cellular

il Remote Agents

i Friendly Servers

%@ Telephony

«} Data Sources

4 Email

[ SMS

Sl e

License ID: 3391297d-e6bc-46f9-bba5-fo48ads62712 (5.3)
Hardware ID: 4281-BA64-D473-D6ES-DFAC

License generated by: Mike Tikhomirov

License generation date: 24 June 2019

TREOnet Support is active up to: 20 June 2020

Product: TRECnet_Enterprise

License for: demo

Active instance: [Default]

Licensed instance: [Default]

Demo License
Expiration date: 20 June 2020

Server limitations

Server hardware keys:
4261-BA54D473-DGES-DFAC
Remote Agent connections: 3
System types: Unlimited

Agent limitations
Agent hardware keys: Any
Mumber of master radios or master repeaters: 5

Master radios [ master repeaters serial numbers: Unlimited
Total number of peers in IP Site Connect or Capadty Plus systems: Unlimited
Serial numbers of peers used in IP Site Connect or Capacity Plus systems: Unlimited

immitatinm e Chant rannackinne

License Manager Send Email Copy to Clipboard

Apply oK Cancel

To apply the new license:

1. Click the License Manager link in the right pane.
The License Manager wizard appears.
2. Click Next.

3. Click the ellipsis (...) button on the right-hand side of the License file box.
The Open dialog box appears.

4. Locate the license file you received from our technical support and click Open.
The full path of the license file appears in the License file box.

5. Click Next.
6. Click Finish to close the wizard.

7. Click Apply and then confirm to restart TRBOnet Server.
TRBOnet Enterprise — User Manual
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Note: To use a single license for multiple TRBOnet software
instances, you need TRBOnet License Server. For detailed
instructions on how to use TRBOnet License Server, refer to
TRBOnet License Server Configuration Guide.

5.2 TRBOnet Server Database

¢ In the Configuration pane, select Database.

Configuration Database Version: 5.4.0.2178
' service
) Network SQL Server: (local) SQLEXPRESS -

# Redundancy Database: TRECnet -
= Authentication: Windows A

@ Reports

[} Service Management
/ Advanced Settings
----- * Geocoding Servers

R Radio Systems i Specify the path for database archives
B PTT over Cellular

Bl Remote Agents Path: D:\Temp{TRECNnet
Bl Friendly Servers W] Use custom folder for audio files
1? gzlzzzzrces Path: D:\TemplAudio
_. 4 Email i Use custom folder to store file attachments
B0 SM5 Path: D:\TemplAttach
[ License
Test Connection
Upgrade Database
Create Database
Set Defaults Apply oK Cancel

¢ |n the Database pane, specify the following database-related settings:

SQL Server

Enter the location of the Microsoft SQL Server name and instance. For
example, in the screenshot above, the default instance name of Microsoft
SQL Server Express installed on the local computer is shown.

Database
Enter the name of the TRBOnet database.

Authentication

Select the authentication method for the TRBOnet database. The default
method is Windows Authentication. See also section 5.2.1, Database
Authentication Methods (page 15).

Login and Password
Enter a valid SQL Server login and password if the SQL Server
Authentication is selected for the database.

Specify the path for database archives

Select this option, and in the corresponding Path box enter the full path of
the custom folder for database backups. Or, click the ellipsis (...) button and
in the Browse For Folder dialog box locate the appropriate path.

Use custom folder for audio files

Select this option, and in the corresponding Path box enter the full path of
the custom folder for audio recordings of the voice calls/sessions. Or, click
the ellipsis (...) button.

13
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Path to Audio Files

Root Folder:
D:\audio

File Format:

“oYEAR %\ %MONTH %\ DAY %

Channel Name SystemID System Name Call Tvpe Source Source Type
Source ID Recipient Recipient Type Recipient ID

Example:
D:\Audio\2017Y05423 oo wav

oK Cancel

¢ In the Path to Audio Files dialog box, select the Root Folder, and in the
File Path Template box enter the information (by clicking the
appropriate links below: Year, Month, Day, etc.) that will be used to
generate the file/path name.

Note: If you don't specify folder paths for the database archives
and audio files, TRBOnet Server will use the following
default paths:
%ProgramData%\Neocom Software\TRBOnet Enterprise\Backups -
for database archives.
%ProgramData%\Neocom Software\TRBOnet Enterprise\Audio -
for audio.

Use custom folder to store file attachments
Select this option, and in the corresponding Path box enter the full path of
the custom folder where text message attachments will be stored. Or, click
the ellipsis (...) button and in the Browse For Folder dialog box locate the
appropriate path.
When you finish configuring the required database parameters, click
Create Database.

After you create or upgrade a database, click Apply and then confirm to
restart TRBOnet Server.
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5.2.1 Database Authentication Methods

5.2.1.1 Windows Authentication

e From the Authentication drop-down list, select Windows.

Configuration
ﬂ' Service
0 Metwork
@ Redundancy
Database
(@ Reports
LF Service Management
/ Advanced Settings
)\ Geocoding Servers
I8 Radio Systems
Bj PTT over Cellular
[l Remote Agents
=l Friendly Servers
’E Telephony
"} Data Sources
{ Email
B SM3

E License

Set Defaults

Database
SQL Server: {local)\SQLEXPRESS
Database: TREOnet
Authentication: Windows
Windows
SQL Server

Version: 5.4.0.2178

-
-

<>

K| Specify the path for database archives
Path: D:\Temp\TRBOnet
i Use custom folder for audio files
Path: D:{TemplAudio

i Use custom folder to store file attachments

Path: D:\TemplAttach
Test Connection
Upgrade Database -
Create Database >
Apply oK

Cancel

To provide access permissions for TRBOnet Server to connect to MS SQL Server,
create an account with sysadmin privileges.

During the installation process, MS SQL Server 2008 automatically grants sysadmin
privileges to the NT Authority\SYSTEM account.

In the case of MS SQL Server 2012 and higher versions, add the

NT Authority\SYSTEM account to the Administrators group during the installation
process. If the database owner privileges are required to work with TRBOnet
Database, you need to assign the sysadmin role to the Local System account. For
instructions on how to install and configure MS SQL Server 2012, see

Appendix B: Configuring SQL Server 2012 for Local System Account.

5.2.1.2 SQL Server Authentication

e From the Authentication drop-down list, select SQL Server.

Configuration
¢ service
o Metwork
@ Redundancy
Database
% Reparts
£} Service Management
%4 advanced Settings
A Geocoding Servers
IR Radio Systems
B§ PTT over Cellular
5l Remote Agents
F| Friendly Servers
@@ Telephony
' Data Sources
4 Email
[ SMS

E License

Set Defaults

Database
SQL Server: {local)\SQLEXPRESS
Database: TREONEt
Authentication: SQL Server
Login: Ll
Password: | FEEEEEEE

¥4 Spedify the path for database archives
Path: D:{TempiTRBOnet

W Use custom folder for audio files
Path: D:\TemplAudio

W] Use custom folder to store file attachments

Path: D:\Temp'\Attach

Test Connection
Upgrade Database -
Create Database -

Apply CK

Version: 5.4.0.2178

-
-

-

Cancel
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To connect to SQL Server using SQL Server Authentication, create an SQL login
with sysadmin privileges in the SQL Server in use. For detailed instructions on how
to create an SQL login, see
http://technet.microsoft.com/en-us/library/aa337562.aspx

5.3 TRBOnet Server Service

¢ In the Configuration pane, select Service.

Configuration Service

& B
G Network. The TRBOnet Server service is not installed!
& Redundancy
Itis recommended to run TRBOnet Server as a Windows service: it
— Database will start automatically after a reboot and run even when no user is
(@ Reports logged on. Click the Install Service button below to install the
L Service Management THEE TR SEE SRR
£ advanced Settings Service logon type:
L2A Geocoding Servers (@) Logon as Local System (Recommended)

IR Radio Systems
BEj PTT over Cellular
55 Remote Agents
5= Friendly Servers

() Logon as User

@ Telephony
[ Data Sources Install Service
24 Email
0 5M5
E License
EViev.' Log Entries Export Configuration Import Configuration
Set Defaults Apply oK Cancel

¢ In the Service pane, specify the following service-related parameters:
= Choose the required logon type:

Logon as Local System
Choose this option to use an account with local system administrator
privileges to run the service as a Windows service (Recommended);

Logon as User

Choose this option to use a different account to run the service as a
Windows service. This account must allow the user to run services in
Windows, have read and write access to the Neocom Software folder and
subfolders in the "%ProgramFiles%" (or, "%ProgramFiles(x86)%" for 64-
bit OS) and "%ProgramData%" folders. For example, using such an
account may be required in the following cases:

1. An Active Directory domain network is used, and the current Windows
user is not allowed to use a Local System account to launch services on
the local PC due to domain policy restrictions.

2. MS SQL Server is installed on a remote PC, and Windows
Authentication (see section 5.2.1.1, page 15) has been selected to
connect to the database.

= (Click Install Service.

= Click the Start Service link that appears in the right pane.
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Note: If the area, where TRBOnet Enterprise is installed, observes
daylight saving time, it is recommended that, when the
local time is set one hour back, you should stop the service
(Stop Service link) immediately before the time change (for
example, at 2:59) and start it again after an hour (for
example, at 2:59 according to the new time). This procedure

is required to prevent database corruption.

Network Parameters

¢ In the Configuration pane, select Network.

Configuration Metwork Version: 5.4.0.2173

o service
Gm Network interface: T
@ Redundancy Command port: 4021 :
Database =
'b‘ Reports First VoIP port: 4022 -
£} Service Management VolP protacol: TCP -
/.’v Advanced Settings Data protocol: TCP -

.2\, Geocoding Servers
I8 Radio Systems
5 PTT over cellular
33 Remote Agents
[ Friendly Servers
@& Telephony
'}’ Data Sources

Use broadcast mode for audio
Broadcast port:
W/ Use proxy server
Configure
Encrypt data over netwark
24 Email

[ sMs

E License

Set Defaults Apply OK Cancel

¢ In the Network pane, specify the following network-related parameters:

Network interface
From the drop-down list, select the network interface that will be used to

communicate between the Server and Dispatch Consoles. Click ® to
refresh the list of network interfaces available on your PC.

Note: If both TRBOnet Server and Dispatch Console are installed
on the same PC, then select 127 .0.0.1 (Loopback

Pseudo-Interface).

Command port
Enter the port number to be used by a Dispatch Console to connect to the
Server (4021, by default).

First VolP port

Enter the number of the first VolP port for audio communications between
the Server and Dispatch Consoles (4022, by default). Each additional
Dispatch Console will establish a connection on the next available port
number.

VolIP protocol
From the drop-down list, select the VolIP protocol type for communications
between the Server and Dispatch Consoles:
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e All - UDP will be used first; if unavailable, TCP will be used;
e TCP - slower but more reliable (set by default);

e UDP - faster but data packets can be lost; some routers may drop
UDP packets.

Data protocol
From the drop-down list, select the protocol to exchange data other than
voice between the Server and Dispatch Consoles (TCP, by default).

Note: If you enable the PTT over Cellular service for Mobile Client
applications, set this parameter to UDP to ensure a better
performance.

Use broadcast mode for audio

Selecting this option will help to optimize network load and minimize
transmission delays. The "load" on the network will be reduced as the
Server will utilize a single audio transmission to a group of Dispatch
Consoles instead of sending multiple audio streams to each individual
Dispatch Console. This method of transmission will also minimize the
transmission delays if there's a large number of Dispatch Consoles or the
Server is busy processing other features.

Note: When the broadcast mode is set, a Dispatch Console
cannot run on the same machine as TRBOnet Server, and a
warning message will appear when you select this option.

¢ Broadcast port
Enter the port number to be used to broadcast audio (5000, by default).

Use proxy server
Select this option to enable an alternative proxy server for TRBOnet
Dispatch Software to access Internet.

o Click the Configure link to specify the alternative server settings:

Configure the proxy server X

Use an alternative server

Settings

Address: (1777113470

Part: 30

Authertication
Use authentication

Lo

Password:

Cancel

e Use an alternative server
Select this option to enable an alternative proxy server.

v Address
Enter the proxy server IP address.
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v Port
Enter the proxy server port number.

¢ Use authentication
Select this option to use authentication to connect to the alternative
proxy server.
v" Login
Enter the login for the authentication, if needed.

v" Password
Enter the password for the authentication, if needed.

e After you configure the proxy server settings, click OK.

Encrypt data over network

Select this option to guarantee the security of data transfer between
TRBOnet Server and Dispatch Console, and/or TRBOnet Agent. It is
recommended that this option be used when a connection between system
components is established via the Internet or other public networks.

5.5 Reports

¢ In the Configuration pane, select Reports.

Configuration Reparts Version: 5.4.0.2178
§ Service
U@ Network W save scheduled reports
# Redundancy Path: D:'\Reparts
Database
s Format: PDF -
3

L} Service Management
)’, Advanced Settings
* Geocoding Servers
I8 Radio Systems
5 PTT over Cellular
F:l Remote Agents
il Friendly Servers
ﬁ Telephony
} Data Sources
4 Email
) SMS5

E License

Set Defaults Apply 0K Cancel

¢ In the Reports pane, select the Save scheduled reports check box and specify
the following parameters:

Path
Click the ellipsis (...) button and locate the folder on the PC where you wish
to save reports generated by the TRBOnet software.

Format
From the drop-down list, select the format for the reports (PDF or Excel).
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5.6 Backup Configuration

TRBOnet Server supports a redundant (secondary/backup) configuration which
allows automatic switching from the primary to the redundant (secondary/backup)
server in case of failure of the primary server. Dispatch Console operation will not be
interrupted.

¢ In the Configuration pane, select Redundancy.

Configuration Redundancy Version: 5.4.0.2178
q Service
O Network ] Redundant server mode

# Redundancy Mode: Passive -

Database

‘b‘ Reports Main servers:

L} Service Management IP Address Part
)’_ Advanced Settings 1 W 1010234162 4021

N Geocoding Servers
B Radio Systems
5 PTT over cellular
33l Remote Agents
[ Friendly Servers

& Telephony
} Data Sources
24 Email
[ M3
E License
Add Edit Delete Test
Set Defaults Apply 0K Cancel

¢ In the Redundancy pane, select the Redundant server mode option.

¢ Redundancy Mode
Select a mode for the redundant server from the drop-down list.

For details, see sections Passive Mode and Active Mode on page 368.

e To add a main server, click Add.

Server Properties X

IP Address: | 10.10.234.163|

Port: 4021 s

oK Cancel Test

e IP Address
Type the IP address of the main server.

e Port
Enter the same port number as specified for the Command port.

Note: For more details on Redundant Server configurations, see
Appendix G: Redundant Server (page 367).
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5.7  Service Management

The Service Management pane allows you to specify various parameters for the
Presence, Location, and Indoor services.

¢ In the Configuration pane, select Service Management.

Configuration Service Management Version: 5.4.0,2173
& Service
O Netwark Presence service
* Redundancy Auto request presence timeout: 5 : minutes
Datab:
= atabase ARS refresh interval: 1440 : minutes
% Reports

O Ignore unregistered Radios

X Advanced Settings

Locati i
----- A Geocoding Servers ocation senvice

l Radio Systems GPS restart by inactivity timeout: | 10 : minutes
B PTT over Cellular Dispatch Console update interval: |5 3+ seconds
E Remote Agents
E Friendly Servers ‘f Automatic error correction

Configure
%@ Telephony

| Data Sources Send the |atest GPS data to dispatchers on alert

24 Email For the last:
[ 5MS GPS points:

[ License

Indoor service
W] Remove offiine radio from beacon

Ignore beacon position on alarm if GPS is fixed {only K-TERM)
Set Defaults Apply oK Cancel

¢ In the Service Management pane, specify the following service-related
parameters:

5.7.1 Presence Service

The Presence service group includes the following registration-related parameters:

¢ Auto request presence timeout
Enter the time interval that will be used by the server to regularly check the
online subscriber radios if there has been no activity. The server considers a
radio to be inactive (or, offline) if the radio does not send any GPS, Text, ARS,
or Voice messages.

If you do not have a dedicated channel for data revert, use the following table:

Number of Presence timeout Number of Presence timeout
radio units (minutes) radio units (minutes)

up to 10 5 30 to 40 17

10 to 20 9 40 to 50 21

20 to 30 13 over 50 120

If there is a dedicated data revert channel in the system, you may set this
parameter to a somewhat lower value than indicated in the table.

Note: If the DDMS service is enabled, set the value of this
parameter to the value of the DeviceRefreshTime
parameter in MOTOTRBO DDMS.
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¢ ARS refresh interval
Enter the value of the parameter that determines how often a radio unit will
send ARS packets. It is recommended that a value of 30 minutes be used for
this interval. This value may be changed depending on the system load.

Notes: For all radio systems (except for Connect PLUS and Capacity
MAX), the ARS service must be enabled on the subscriber
radio channels (MOTOTRBO CPS, Channels>Channel>ARS).

If the DDMS service is enabled, set the value of this
parameter to the value of the PersistenceTO parameter in
MOTOTRBO DDMS.

See also Appendix F: NAI VOICE & DATA Support.

¢ Ignore unregistered Radios
Select this option so that unregistered radio units will be ignored and thus
won't appear in Dispatch Console.

5.7.2 Location Service

The Location Service group includes the following location-related parameters:

¢ Dispatch Console update interval
Enter the time interval that will be used to send GPS data packages from the
Server to Dispatch Consoles. The lower the value, the more data traffic will be
present on the network. Adjust this value based on the network bandwidth.
The lower the bandwidth, the higher the update interval.

e Automatic error correction
Select this option to enable automatic error correction to detect and correct
invalid GPS data.

Click the Configure link to specify the GPS parameters to be corrected:

Automatic error correction X

In some real world situations, speed and location values from the GPS
receiver may be erratic or unreliable. Use the settings below to apply
automatic error correction to the GPS data feeds.

km'h

meters

W GPS time error greater than: 30 minutes

Coordinates have duplicates

Consider speed zero if less than:

Defaults oK Cancel

Discard GPS data if

= Speed greater than
Select this option and enter the maximum possible speed of your vehicles.
As a result, the coordinates with speeds that exceed the maximum limit will
be discarded.
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Location accuracy worse than

Select this option and enter the largest distance for the accuracy of the GPS
receiver. As a result, the coordinates with distances that exceed the
maximum limit will be discarded.

GPS time error greater than

Select this option and enter the largest allowable time error, in minutes. As
a result, the coordinates with time errors that exceed the maximum limit will
be discarded.

Coordinates have duplicates
Select this option to remove duplicate coordinates from the GPS data.

Consider speed zero if less than
Select this option and enter the low-speed threshold. Speeds below this
threshold will be considered as zero by the server.

Send the latest GPS data to dispatchers on alert
Select this option so that dispatchers receive the latest GPS data when an alert
occurs. Then choose one of the following options:

For the last X minutes
Choose this option and enter the time, in minutes, to be used as the last
time period for the latest GPS data.

GPS points
Choose this option and enter the number of GPS points to be used for the
latest GPS data.

Indoor Service

The Indoor Service group includes the following indoor-related parameters:

Remove offline radio from beacon
Select this option so that an offline radio is not shown on its associated
beacon.

Ignore beacon position on alarm if GPS is fixed (only K-TERM)
Select this option so that beacon positioning is ignored in case of alarm when
a radio transmits valid GPS data.

Note: This feature relates only to K-TERM beacons.
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Advanced Settings

¢ In the Configuration pane, select Advanced Settings.

Configuration

£ Service

G Network

iﬁ Redundancy

Database

_-D‘ Reports

L} Service Management
A Geocoding Servers
& Radio Networks

|5l Remote Agents

[z Friendly Servers

Advanced Settings

Language:
Logging level:

Administrator Account:

Audio Recording format:
Audio Recording codec:

Voice of Text to Speech:

Measurement system:

Version: 5.4.0.2164

English
Mormal

Enabled

-

-

-

Reset password

TNA - TRBORet Audio File
G.711 AdLaw/8000

Default

Metric

ﬁ Telephony
| Data Sources Latitude/Longitudeformat: Degrees, Minutes, Seconds -
4 Email
s TX Passive timeout: Unlimited < hours
B0
3 License Voice Mail timeout: Unlimited < | hours
Text Message Passive timeout: Unlimited : hours
Set Defaults Apply OK Cancel

¢ In the Advanced Settings pane, specify the following advanced parameters:

Language

From the drop-down list, select the interface language for TRBOnet Server.
Logging level

From the drop-down list, select the logging level that determines the
granularity of log messages in the System Log. The choices are: None, Low,
Normal, and High.

Note: This information is used by technical support for
troubleshooting purposes, so it is recommended that this
value be kept unchanged (Normal).

Administrator Account
From the drop-down list, select either Enabled or Disabled. If you select
Disabled, the administrator won't be able to log in to the Dispatch Console.

¢ Reset password
Click this link to reset the administrator password to the default value.

Audio Recording format
From the drop-down list, select the format to be used to store audio
recordings. The available formats are WAV and TNA.

Note: The TNA format is a proprietary audio format that contains
additional information about radio calls, such as radio ID,
start time, end time, and other parameters. This format
provides more details about call participants and allows
easy navigation within recorded audio files.

Audio Recording codec
From the drop-down list, select the audio codec to be used to compress the
audio files.
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Voice of Text to Speech

From the drop-down list, select the voice that will be used for Text-to-
Speech messages.

Measurement system
From the drop-down list, select either Metric or US units.

Latitude/Longitude format
From the drop-down list, select the format of Latitude/Longitude pairs.

TX Passive timeout

Enter the time that text and voice messages will be stored and later sent
when the channel becomes available (no longer busy). "Unlimited" is
recommended.

Voice Mail timeout
Enter the time duration where TRBOnet Server will continue to try to send
Voice Mail messages to a recipient. "Unlimited" is recommended.

Text Message Passive timeout
Enter the time duration where the TRBOnet Server will continue to try to
send Text messages to a recipient. "Unlimited" is recommended.

5.8.1 Geocoding Servers

Geocoding servers resolve GPS coordinates to street addresses for reporting
purposes and other needs, for example, 'GPS activity for period' reports. Online
geocoding services, such as Google or Nominatim, can be used and are the standard
default services in TRBOnet. However, their use may be limited by the number of
requests. Furthermore, you can add custom geocoding servers to the system.

You can configure geocoding servers in three ways depending on whether the
Server and/or Dispatch Console have Internet access and on your local geocoding
server settings:

1. The Dispatch Console has Internet access and the Server has no Internet
access. The Server can connect to preconfigured (Google and Nominatim)
and/or local corporate geocoding servers via the Dispatch Console.

2. The Server has Internet access and Dispatch Console has no Internet access.
The Dispatch Console can connect to preconfigured (Google and Nominatim)
and/or local corporate geocoding servers via the Server (follow the
instructions below).

3. You have your own Geocoding server in the local network. In this case, you can
configure data resolving in both the Server and the Dispatch Console.

5.8.1.1 Configuring Geocoding Servers

¢ In the Configuration pane, select Geocoding Servers.
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Configuration Geocoding Servers Version: 5.4.0.2178
& Service
O Network Server Name
@ Redundancy ] Google
= Database i Nominatim
(2 Reports

L} Service Management

4 Advanced Settings
A

I8 Radio Systems

5§ PTT over Cellular

F:l Remote Agents

il Friendly Servers

ﬁ Telephany
I Data Sources
4 Email
[ EC
5 License
Add Delete A v
D Request aplace name upon receiving GPS coardinates
Set Defaults Apply OK Cancel

¢ In the Geocoding Servers pane, specify the following geocoding-related
parameters:

= Google and Nominatim
These are pre-configured geocoding servers, which allow resolving GPS
coordinates to street addresses and street addresses to GPS coordinates.

Note: These geocoding servers can't be deleted from the system.

= Click Add to add a geocoding server to the system.

Map Server for Geocoding X

Server Name: |M)GeocodingServer |

Get address by coordinates

‘Hl‘lp -//127.0.0.1/reverse Format =xml&lat ={at }&lon={on }ézoom=184adressdetails=1 |

Test

Get coordinates by address
‘I‘Mp:;"/‘IZ?.D.D 1/search Pq={address }&fomat =xml

Test

Carcel

e Server Name
Enter the name of your geocoding server.

¢ Get address by coordinates
Select this option to resolve GPS coordinates to street addresses.
In the box below, enter the server address with the appropriate
parameters.

Note: Keep in mind that the {lat} and {lon} variables are
mandatory to allow TRBOnet Dispatch Console to retrieve
GPS coordinates from the radio unit.

Click Test to check the connection to the geocoding server. Enter a pair
of GPS coordinates and see if the resolved street address appears.
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¢ Get coordinates by address

Select this option to resolve street addresses to GPS coordinates (for
example, for the Search by Address feature).

In the box below, enter the server address with the appropriate
parameters.

Note: Keep in mind that the {address} variable is mandatory to
allow TRBOnet Dispatch Console to search map objects by
address.

Click Test to check the connection to the geocoding server. Enter an
address and see if you get the list of map objects corresponding to the
address entered.

Use the Up ( * ) and Down ( ¥ ) buttons to move the selected geocoding
server up and down in the priority list of geocoding servers. When
requesting GPS data via the geocoding servers configured in TRBOnet
Server, GPS data is requested from the geocoding servers according to the
priority level. The geocoding server at the top of the list has the highest
priority level. In case the first geocoding server is unavailable, data will be
requested from the second geocoding server in the list, and so forth down
the list of geocoding servers.

The administrator must ensure that the geocoding servers in the list are
able to resolve GPS data.

Request a place name upon receiving GPS coordinates

Select this option to resolve GPS coordinates to street addresses
immediately by a GPS event. Note that street addresses and GPS
coordinates are automatically (without user intervention) stored in the
TRBOnet database to optimize the response time for street address
requests (for example, GPS reports) and to reduce geocoding server load.
These street addresses and GPS coordinates will be stored without user
intervention whenever GPS are resolved to street addresses via a request to
a Geocoding Server.
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Radio Systems

By enabling the Radio Systems feature, the TRBOnet Server is able to be connected
to a radio system. Otherwise, you should use Remote agents (see section 5.11,
Remote Agents).

¢ In the Configuration pane, select Radio Systems.

¢ In the Radio Systems pane, select or make sure that the Enable Radio
Systems option is selected.

Configuration Radio Systems Version: 5.4.0.2177
U Service -~
& Network W/ Enable Radio Systems
& Redundancy
Database CAI Network: 12 :
Lf‘ Reports CAI Group Network: 225 :
L} Service Management
£ advanced Settings Registered Radio Systems
-2\ Geocoding Servers ... Name Address Radio ID
B Capadty MAX 2003
~LF Services IPsC1 10.10,101,137 54250
-l Capacity MAX Pl 10,10, 138,35 84250
ol PSCL W/ TRBORet Swift Agent #1 192.168.0.100 64250
e i1 Analog Station #1 coM1 0
- TRBOnet Swift Agent #1
}', Advanced Settings
- @ Redundancy
L Analog Station #1
B PTT over Celular
5=l Remote Agents
[ Friendly Servers
@ Telephony
'} Data Sources Add Delete
: Cmmmil 1
Set Defaults Apply oK Cancel

¢ In the Radio Systems pane, specify the following parameters:

CAIl Network

The CAl (Common Air Interface) Network is a value that is combined with
the Radio ID to produce the individual radio's air interface network IP
address. All radios must use the same CAI Network ID to be able to
exchange data. It is recommended that the default value of 12 is used.

CAI Group Network

The CAIl Group Network is a value that is combined with the Group ID to
produce the group's air interface network IP address. The CAl Group
Network ID forms the first or most significant byte of each group's network
IP address. All radios must use the same CAI Group Network ID to be able
to exchange data (225, by default).

Note: The values of these two parameters must match those
configured for the radio units via the MOTOTRBO CPS.
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Configuration Radio Systems Version: 5.4.0.2177
o Service ”~
0 Metwork W1 Enable Radio Systems
‘@ Redundancy
Database CAI Network: 12 p
l>‘ Reports CAI Group Network: 225 z
LF Service Management
M Advanced Settings Registered Radio Systems
(RN Geocoding Servers o | Name Address Radio ID
! Radio Systems Capadity MAX 2003
~LF Services W IPsc1 10.10.101.137 64250
-l Copadity MAX cp1 10.10. 188.35 64250
‘B PsCt TREOnet Swift Agent #1 192.168.0.100 54250

)’: Advanced Settings
-\ Privacy

Slot #1

Slot #2

Local Slots

R Analog Station #1 COM1 0

- cP1

-- I TREOnet Swift Agent #1

--thy Analog Station #1

E§ PTT over Cellular

& Remote Agents i Add | Delete Test

(= - S

Set Defaults

Add MOTOTRBO System
Add Capacity MAX
Add DIMETRA Express

oK Cancel

Add Control Station

Add TREOnet Swift Agent \
Add Friendly FS-1000 Statien

Add XRC-9000 Controller

Add XRT-8000 Controller 2
Add SELEX Repeater
Add KAIROS Repeater
Add WAVE Controller
Add Analog Station
Add ED137 Station

L R R R ORI Y

Add ZENITEL Station

All radio systems based on MOTOTRBO services are represented in the
Registered Radio Systems table, including their Name, IP Address, and Radio ID (1):

e To add a radio system, click Add and select the appropriate system type from
the drop-down menu (2).

5.9.1 Services

¢ In the Configuration pane, under Radio Systems, select Services:

¢ In the Services pane, specify the following Radio System Services-related
parameters:

= Automatic Registration Service (ARS)
Select this option to enable the ARS service for the radios. When the radio
powers up, it automatically registers with the server. This feature is used
with data applications, that is, any data traffic on this channel is associated
with an application server such as MOTOTRBO Text Messaging or
MOTOTRBO Location Services.

e Port
Enter the local port number for the ARS service (4005, by default).

= Telemetry service (TLM)
Select this option to enable the Telemetry service, which is the wireless
transmission and reception of measured quantities for remotely monitoring
environmental conditions or equipment parameters.

e Port
Enter the local port number for the Telemetry service (4008, by default).
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Text Messaging service (TMS)
Select this option to enable the Text Messaging service which is used to
exchange text messages between the radios and the dispatchers.

e Port
Enter the local port number for the Text Messaging service (4007, by
default).
Location service (GPS / Indoor)
Select this option to enable the Location service. The radio can send its
coordinates when it is in Global Positioning or iBeacon coverage area.
e Port

This is the local port number for the Location service (4001), which
cannot be modified.

Job Ticketing service (JTS)

Select this option to enable the Job Ticketing service.

e Port
This is the local port number for the Job Ticketing service (4013, by
default).

Text Messaging service DMR

Select this option to enable the DMR-based Text Messaging service.

e Port
Enter the local port number for the DMR-based Text Messaging service
(5016, by default).

Indoor service (K-TERM)
Select this option to enable the Indoor Location service.
e Port
Enter the local port number for the Indoor service (3022, by default).
Indoor LAN Service (K-TERM)
Select this option to enable the Indoor LAN service.
e Port
Enter the local port number for the Indoor LAN service (3001, by default).
Tallysman Sprite service
Select this option to enable the service for autonomous event and
aggregated event reporting to provide significant reduction in GPS data
overhead.
e Port
Enter the local port number for the Tallysman Sprite service (4004, by
default).
FS 5000 location service (GPS)
Select this option to enable the FS 5000 location service, which is a service
for transmitting GPS data packages. This service uses FS 5000 Option Board.
e Port

Enter the local port number for the FS 5000 location service (4004, by
default).
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Swift.Tracker v.1 service

Select this option to enable the service to transmit coordinates and data
packages via a radio channel using the Swift.Tracker TRO01 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service (4004, by
default).

Swift.Tracker v.1 service (IP channel)

Select this option to enable the service to transmit coordinates and data
packages via a radio channel and a reserved IP channel using the
Swift.Tracker TROO1 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service with an IP
channel (4080, by default).

Swift.Tracker v.2 service

Select this option to enable the service to transmit coordinates and data
packages via a radio channel using the Swift.Tracker TRO01 device (version
2).

e Port

Enter the local port number for the Swift.Tracker v.2 service (4104, by
default).

Swift.Tracker v.2 service (IP channel)

Select this option to enable the service to transmit coordinates and data
packages via a radio channel and a reserved IP channel using the
Swift.Tracker TRO01 device (version 2).

e Port
Enter the local port number for the Swift.Tracker v.2 service with an IP
channel (4180, by default).

Extended Text Messaging service

Select this option to enable the Extended Text Messaging service to include
sending detailed preconfigured templates with the help of TRBOnet
Dispatch Software.

e Port
Enter the local port number for the Extended Text Messaging service
(4010, by default).
Extended Data service
Select this option to enable the Extended Data service that will be used for
communication with TRBOnet Communicator.
e Port
Enter the local port number for the Extended Data service (4106, by
default).

Telemetry service Novox
Select this option to enable the Telemetry service based on NOVOX devices.

e Requests port
Enter the local port number to listen for requests (8090, by default).
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e Events port
Enter the local port number to listen for events (8091, by default).

G4S RS232 service
Select this option to enable the custom developed G4S RS232 service.

e Port
Enter the local port number for the G4S RS232 service (4004, by default).

Zebra printer service

Select this option to enable the service for printing Job Tickets. A Zebra
printer is connected to a radio via Bluetooth. The radios should be
Bluetooth-enabled.

e Port
Enter the local port number for Zebra printer service (4072, by default).

Forward Data service
Select this option to enable the Forward Data service. This feature is used to
forward "raw data" via the COM port from one device to another.

e Port
Enter the local port number for Forward Data service (4011, by default).

5.9.2 Adding a MOTOTRBO Repeater

¢ In the Radio Systems pane, click Add.

Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add MOTOTRBO System.
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Configuration Radio Systems Version: 5.4.0.2177
o service
0 MNetwork i/ Enable Radio Systems

@ Redundancy

Database CAI Network: 12 s

b‘ Reports CAI Group Network: 225 b

L} Service Management
/ Advanced Settings Registered Radio Systems

- Geocoding Servers ... Name Address Radio ID
Yoo 5 stene

L} Services | gp  Add MOTOTREOQ Systermn
& PTT over Cel i Add Capacity MAX
5| Remote Ager|
B Friendly Serv o Add DIMETRA Express
E Telephony | g Add Control Station
b DataSowrees gy 44 TREOnet Swift Agent
4 Email
e Add Friendly F5-1000 Station
RO
E License Add XRC-9000 Controller
Add XRT-9000 Controller
Add SELEX Repeater
Add KAIROS Repeater E

Add WAVE Controller
SetDe Apply OK Cancel

Add Analog Station
Add ED137 Station

& odr dpodp 4 g g oAb o

Add ZEMITEL Station

Set Defaults
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¢ In the Repeater pane, specify the connection parameters.
To ensure your connection parameters match the actual configuration of your
radio network, you may need to use Motorola CPS or Config Advisor tools to
determine the values. Contact your radio network administrator, if you do not
have this information.

Configuration Repeater #1 Version: 5.4.0.2177
o Service A
G Network System Name: Repeater #1
& Redundancy TREONEt Peer ID: 100 :
Database § =
2 Reports TRBOnet Radio ID: 64250 -
L'} Service Management TREONet Local Port: 50000 I

)’_ Advanced Settings

Master Repeater Connection Info:
)\ Geocoding Servers

Master IP Address: 10.10.101.137
! Radio Systems -
:..IF Services Master UDP Port: 50000 s Test
Repeaber #1 Authentication Key: 99999
v Advanced Settings System Type: TP Site Cornect -
Privacy
Slot £1 System Identifier: Department 1

Slot #2
...C17 Local Slots
Bj PTT over Cellular
[3:l Remote Agents
il Friendly Servers
@8 Telephony
|’ Data Sources

Ernsil

€ >

Use MAT Voice
Use NAI Data (MNIS and DDMS)

Set Defaults Apply oK Cancel

= System Name
Enter a name for the repeater. This name will be displayed in the Dispatch
Console.

* TRBOnet Peer ID
Enter a Peer ID for TRBOnet Server. The Peer ID must be unique among the
repeaters in the radio system.

Note: Motorola recommends that this value be less than 200.

= TRBOnet Radio ID
Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system (for Capacity Plus and Linked Capacity
Plus systems, the maximum value is 65535).

= TRBOnet Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the repeater. Use unique port numbers for each
repeater connection if there are several repeaters connected.

= Master IP Address
Enter the Ethernet IP address of the master repeater.

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Master IP.

= Master UDP Port
Enter the UDP port number of the master repeater.

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Master UDP Port.
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Authentication Key
Enter the repeater's authentication key (if any).

Note: This value is programmed for a repeater via MOTOTRBO
CPS, in Link Establishment>Authentication Key.

System Type

From the drop-down list, select the type of the radio system
('IP Site Connect', 'Capacity Plus', 'Linked Capacity Plus', or
‘Extended Range Direct Mode').

Test

Click this button to check the connection to your master repeater. If the test
is successful, you'll see the information on the repeater you are connected
to, such as the serial number, firmware version, and other relevant
information.

System ldentifier

Enter the system identifier if a Capacity Plus or Linked Capacity Plus system
is used with one or more control stations. Use the same system identifier as
you have specified for the corresponding control stations.

Use NAI Voice

Select this option to connect to the repeater via NAI (Network Application
Interface) for Voice transfer. For more details about NAI, see Appendix F:
NAI VOICE & DATA Support (page 357).

Use NAI Data (MNIS and DDMS)

Select this option to connect to the repeater via NAI (Network Application
Interface) for Data transfer. For more details about NAI, see Appendix F: NAI
VOICE & DATA Support (page 357).

o MNIS
MOTOTRBO Network Interface Service is a Windows application which
acts as a data gateway between the data applications and the radio
system. Data messages are routed through the MNIS.

e DDMS
Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting the
data to the server.

5.9.2.1 Advanced Settings

¢ In the Configuration pane, under the corresponding Repeater, select
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Configuration Advanced Settings Version: 5.4.0.2177
U Service ~
O Netwark Voice Call Hang Time (ms):
# Redundancy Group Call: 3000
Database .
—b‘ Reports Private Call: 4000

)’, Advanced Settings
[N Geocoding Servers
I8 Radio 5ystems T¥ Timeout: 60
(LT Services
eater #1 Phone System: Motorola Phone System -
Privacy
LI Slot #1
.. Slot #2
\.£17 Local Slots
B PTT over Celular
35 Remote Agents
[ Friendly Servers
E Telephony
I Data Sources

Erm=il

=
-

=

-

L} Service Management Emergency Call: 4000 s
{ : -

TX Preamble: 120 :

=

-

seconds

€ >

Set Defaults Apply O Cancel

¢ In the Advanced Settings pane, specify the following repeater-related
advanced settings:

Voice Call Hang Time (ms):

Group Call

This value sets the duration the repeater reserves the channel after the end
of a group call transmission. During this time, only members of the group
that the channel is reserved for can transmit.

Private Call

This value sets the duration a radio keeps the private call setup after a user
releases the PTT button. This is to avoid setting up the call again each time
a user presses the PTT button to transmit. During this time, other radios can
still transmit since the channel is essentially idle. After the hang timer
expires, the radio transmits using the TX Contact Name parameter specified
for this channel in MOTOTRBO CPS.

Emergency Call

This value sets the duration the repeater reserves the channel after the end
of an emergency call transmission. During this time, only members of the
Group that the channel is reserved for can transmit.

Note: The values of the above three parameters must be taken
from the corresponding parameter values programmed for
the repeater via MOTOTRBO CPS in General Settings.

TX Preamble

Enter the value of the TX Preamble. The TX Preamble is a string of bits
added in front of a data or control message (Text Messaging, Location
Messaging, Registration, Radio Check, Private Call, and other message
types) before transmission. The acceptable range is 0 - 8640 ms. The
recommended value is 120 ms.
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= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When the
dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

* Phone system
From the drop-down list, select the system for phone calls:

¢ Motorola Phone System
This system uses a special call type with the parameters specified for a
radio unit in MOTOTRBO CPS. The Motorola Phone System is
recommended for IP Site Connect mode to minimize Radio response
time. For more details on programming Motorola Radios, see Appendix
E: SIP Setup for Motorola Phone System (page 355).

¢ TRBOnet Phone System (TX Interrupt)
This is a phone call system based on the private call type using TX
Interrupt feature. This phone system is available for radio systems with
control stations.
= Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

Note: This feature is available only when the MNIS Data Service is
enabled for the repeater.

5.9.2.2 Privacy

¢ In the Configuration pane, under the corresponding Repeater, select Privacy.

Configuration Privacy Version: 5.4.0.2177
£ Service -~
& Network Privacy Type: Erhanced -

@ Redundancy

Database .
Enhanced Privacy Keys:

_b‘ Reports
L} Service Management Alghoritm D Name Value
2 Advanced Settings FARC4(40bit) [ vi1
‘A Geocoding Servers ARC‘(‘ ({l:\?
i AES (256 bit]
Radio Syste
! \ji o ystEme AES (256 bit) Legacy
-4} Services
:3 Repeater #1

,’_ Advanced Settings
L Privacy

Slot #1

Slot #2

Local Slots

B PTT aver celular

F:l Remote Agents

el Friendly Servers

ﬁ Telephany
I Data Sources
Ersil

Add Remove @ File
< >

Set Defaults Apply oK Cancel

¢ In the Privacy pane, specify the following privacy-related settings:
= Privacy Type
From the drop-down list, select one of the privacy types: None, Basic, or
Enhanced.

= Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic privacy type.
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server.

Enhanced Privacy Keys
Here you add enhanced privacy keys when the Enhanced privacy type is
selected.

e Click Add and specify the required Algorithm, ID, Name, and Value for
the privacy key being added.

v" Algorithm

From the drop-down list, select one of the enhanced algorithms if you
are going to use additional encryption.

5.9.2.3 DDMS Service

The DDMS, or Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting the data to the

¢ In the Configuration pane, under the corresponding Repeater, select
DDMS service.

Configuration
o Service ~
0 Network.

& Redundancy

Database

_b‘ Reports

L} Service Management
,’_ Advanced Settings

(N Geocoding Servers
I8 Radio Systems

L} Services

:3 Repeater #1
: . Advanced Settings

rivacy

)f: Advanced Sett|

i MNIS data service
.. Audio Paths

B PTT over Cellular

55 Remote Agents

[ Friendly Servers

E Telephony

[i Pots Cruwrae

< >

Set Defaults

DDMS service

& Use DOMS service
Local port: a
Service IP Address:
Service port: 3000
Authentication Port: | 5055

Redundant services:
Service IP Address

1 W 10.10.101.207

Add Delete

127.0.0.1

Service port
3000

Apply

Ab 4K 4 4

Version: 5.4.0.2177

Test

Local port
1]

Test

CK Cancel

¢ |n the DDMS service pane, specify the following DDMS service-related

settings:

Use DDMS service
Select this option to enable the DDMS service for the server.

Local Port
Enter the number of the local port to be used on a PC with TRBOnet
Dispatch Software for DDMS service.

Service IP Address
Enter the IP Address of the PC with the DDMS service installed and running.

Service port
Enter the service port number.

Note: This value is programmed for a DDMS service via

MOTOTRBO DDMS Administrative Client, in
Interfaces >Watcher Settings>PortWatcher.
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Authentication Port

Enter the authentication server port number.

Note: This value is programmed for a DDMS service via
MOTOTRBO DDMS Administrative Client, in
Interfaces>Authentication Server Settings >
AuthenticationServerPort.

Redundant services

Here you see the list of redundant DDMS services for failover purposes.

Click Add and specify the required parameters for the DDMS service

being added.

Click Test to test if the selected DDMS service is available.

Use the Up (\* ) and Down (Y ) buttons to move a selected DDMS
service up and down in the priority list of DDMS services.

Advanced Settings

¢ In the Configuration pane, under DDMS service, select Advanced Settings.

Configuration
U‘ Service
& Network

@ Redundancy

Database

_LQ Reports

L} Service Management
)’_ Advanced Settings

(N Geocoding Servers
IR Radio Systems

,' Services

:3 Repeater #1
/ Advanced Settings
I Privacy

X DDMS service

1§ MNIS data service
-3 Audio Paths
B PTT over Cellular
5l Remote Agents
5l Friendly Servers
E Telephony

I Mzt Crnrrae

€ >

Set Defaults

Advanced Settings

Version: 5.4.0.2177

Radio ID list: 1-200 ?
Events: All -

Specify external sites:

Site ID Presence Voice Data
M 251 M M i
Add Delete
Apply oK Cancel

¢ In the Advanced settings pane, you can specify settings that relate to the

connected DDMS service:

Radio ID list
Enter a list of the radios to receive data from according to the following
rules:

To receive data from all radios in the system, leave this box blank.

To receive data from multiple radios, separate each Radio ID by a
comma, for example, 105,106,111, and so on.

To receive data from a range of radios, enter the range using the
following example: 105-111.

Note: In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".
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= Events

In the drop-down list, select the events to be monitored.

= Specify external sites

This is the list of sites that is used when the corresponding system has a
MOTOROLA System Bridge to the current Capacity MAX system.

e Click the Add button and add a site by specifying its Site ID and
selecting the appropriate data types (Presence, Voice, and/or Data).

5.9.2.4 MNIS Data Service

The MNIS, or Motorola Network Interface Service, is a Windows application which
acts as a data gateway between the data applications and the radio system. Data
messages are routed through the MNIS.

¢ In the Configuration pane, under the corresponding Repeater, select

MNIS data service.

Configuration
o service
0 Network
@ Redundancy
Database
_D\ Reports
L} Service Management
\/’: Advanced Settings
)\ Geocoding Servers
IR Radio Systems
L.LF Services
epeater #1
){ Advanced Settings
Privacy

DMS service
M Advanced Sett

INIS data service

I Audio Paths
5§ PTT over Cellular
32 Remote Agents

5=l Friendly Servers
R Talanhan
<

Set Defaults

MNIS data service Version: 5.4.0.2177

W/ Use Data Gateway
i/ Service is on a local host
TP Address: 176.16.10.2 A

i/ Contral port: 55000 : Test

MNIS Service: &2

Redundant services:

IP Address Control port Local port

Add

Apply OK Cancel

¢ In the MNIS data service pane, specify the following MNIS data service-

related settings:

= Use Data Gateway

Select this option to enable the MNIS data service for the server.

= Service is on a local host
Select this option if the MNIS data service will be used on the local PC.

= |P Address

Enter the IP Address used by the MNIS to communicate with the PC.

Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, and can be
retrieved from General>Tunnel Network>Tunnel IP Address.

= Control port

Enter the number for the MNIS control port.
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Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, in
Advanced>Network>MNIS Control Interface TCP Port.

= MNIS Service

Select this option, and from the drop-down list select the available MNIS
service.

= Redundant services
Here you see the list of redundant MNIS data services for failover purposes.

e Click Add and specify the required parameters for the MNIS data service
being added.

e Click Test to test if the selected MNIS data service is available.

e UsetheUp (2 )and Down (Y ) buttons to move a selected MNIS data
service up and down in the priority list of MNIS data services.

Advanced Settings

¢ In the Configuration pane, under MNIS data service, select
Advanced Settings.

Configuration Advanced Settings Version: 5.4.0.2177
ﬂ’ Service -~
G Network Add network routes to the Windows routing table

@ Redundancy

Database

@ Reports i/ send data to group over control port

L} Service Managesment
/’_ Advanced Settings

N Geocoding Servers
BB Radio Systems

LF Services

Radio Range: 1 - - 18777215

epeater #1

dvanced Settings

rivacy

DMS service

/’: Advanced Sett

NIS data service

o et
L. Audio Paths

B PTT aver Celular

F3- Remote Agents

3l Friendly Servers
T Talarham:
< >

Set Defaults Apply oK Cancel

¢ In the Advanced settings pane, you can specify settings that relate to the
remote MNIS data service:

= Add network routes to the local Windows routing table
Select this option to allow TRBOnet Server to add network routes to the
local Windows routing table so that data can be sent to the remote MNIS
data service.

= Add port forwarding rules to the remote MNIS service
Select this option to allow TRBOnet Server to add forwarding rules to the
remote MNIS data service.

= Send data to group over control port
Select this option so that data will be sent via the specified control port.

40 TRBOnet Enterprise — User Manual



TRBOnet Server

neocom
SOoftware

= Radio Range

Specify the range of radios to be monitored by the MNIS service.

5.9.2.5 Slots

Note: The slots are available only when IP Site Connect is selected in the

Repeater pane.

¢ In the Configuration pane, under the corresponding Repeater, select Slot #1

or Slot #2.

Configuration
q Service
G MNetwork
@ Redundancy
Database
L‘ Reports
£} Service Management
)f_ Advanced Settings
A Geocoding Servers
IR Radio Systems
£F Services
:s Repeater #1
}’ Advanced Settings
! Privacy

>

Slot #1 Version: 5.4.0.2177

W] Slot #1

Name:; Slot 1

Messaging Delay: Mormal -

Use the slot for RX Data only (GPS Revert or Data Revert)

Allow interruption

Always transmit when the FTT is pressed ("Impolite™ channel access)
w1 Data Call Confirmed

Private Call Confirmed
/1 Emergency Alarm Ack
¥4l Emergency Call/Alarm Indication

{11 Slot #2
Local Slots
B PTT over Cellular
3=l Remote Agents
il Friendly Servers

ﬁ Telephany
J Data Sources

Ernail

< >

Set Defaults Apply oK. Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

= Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

= Messaging Delay
From the drop-down list, select the inter-repeater messaging delay based
on the IP network configuration.
e Normal
The inter-repeater messaging delay is 60 ms.
e High
The inter-repeater messaging delay is 90 ms.
= Use the slot for RX data only (GPS Revert or Data Revert)
Select this option to configure the slot so that it will only receive data, thus
having no transmission capability.

= Use Privacy
Select this option to use Privacy for the slot.

Note: This option is available only if the Basic or Enhanced
Privacy Type have been selected in Repeater's Privacy
settings.
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= Privacy Key
From the drop-down list, select the privacy key.

Note: This option is available only if the Enhanced Privacy Type
has been selected in Repeater's Privacy settings).

= Allow interruption
Select this option to allow interrupting dispatcher transmissions by radios
that are Transmit Interrupt capable.

= Always transmit when the PTT is pressed ("Impolite" channel access)
Select this option so that when the PTT button is pressed, the dispatcher
will start transmitting regardless of whether the channel is free or not (that
is any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

= Data Call confirmed
Select this option to enable data packets in data calls (ARS, GPS, and Text
Message) on the current slot to be confirmed.

Note: This feature is available only when both the Use NAI Voice
and Use NAI Data (MNIS and DDMS) options are not
selected in the Repeater pane.

= Private Call Confirmed
Select this option to set Private calls on the current slot as confirmed. By
default, Private calls are unconfirmed.

= Emergency Alarm Ack
Select this option so that the Dispatch Console is allowed to acknowledge
an emergency alarm received via this slot.

= Emergency Call/Alarm Indication
Select this option so that audio and visual indication is given for an
emergency call/emergency alarm received via this slot.

5.9.2.6 Local Slots

While on a local slot, voice or data are not transmitted between sites in IPSC
systems. Due to MOTOTRBO limitations TRBOnet Server can only receive
information from local slots, but cannot transmit by IP connection to such slots.

Note: Local slots are available only when IP Site Connect is selected, and
the Use NAI Voice option is selected in the Repeater pane.
If the Use NAI Voice option is not selected, local slots will be
available only through dedicated control stations.

¢ In the Configuration pane, under the corresponding Repeater, select
Local Slots.
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Configuration Local Slots
o service
Load P Map
0 Network o3l eers vMa

Name
W Local Brine's

& Redundancy
Database

(@ Reports

[} Service Management

‘,,: Advanced Settings
(N Geocoding Servers

BB Radio Systems
Services

Repeater #1

f Advanced Settings
11 Privacy
DDMS service
}' Advanced Sett
MMIS data service
}' Advanced Sett

Slot #1
-.[I7 Slot #2

Local Slots

! PTT over Cellular

El pamata Anante Add
< >

Remove

Set Defaults

Apply

Version: 5.4.0.2177

Peer ID
1002

Peer Slot
Slot #1 =

Configure

oK Cancel

¢ In the Local Slots pane, specify the following Local Slot-related settings:

To add a Local Slot to the system, click Add.

Select the option in the first column to enable the selected local slot.

Enter a Name for the local slot. This name will be displayed in the Dispatch

Console.

Enter the Peer ID of the repeater.

Note: This value can be taken from the repeater's configuration in
MOTOTRBO CPS, in General Settings>Radio ID.

From the drop-down list, select the Peer Slot.

To configure the selected local slot, click Configure:

TX Configuration

Name: _ocal Brine's

Messaging Delay: Mormal

Use Privacy

Private Call Confirmed
/] Emergency Alarm Adk
¥ Emergency CallfAlarm Indication

-

Use the slot for RX Data only(GPS Revert or Data Revert)

OK

Always transmit when the PTT is pressed ("Impolite™ channel access)

Cancel

X

= Specify the desired local slot settings similar to those for a common

repeater slot.

5.9.2.7 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Capacity Plus system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.
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Note:

Audio paths are available only when Capacity Plus or Linked
Capacity Plus are selected.

¢ In the Configuration pane, under the corresponding Repeater, select
Audio Paths.

Configuration Audio Paths Version: 5.4.0.2177
& Service 'S
Load Groups Map

5 Network oad Groups Ma
@ Redundancy Call Type Group ID Site ID

Database i Group Call 10 Wide
_b‘ Reports ¥4 Group Call 20 Wide
L} Service Management ] Private call
4 advanced Settings K| all call

N Geocoding Servers
B Radio Systems
L ¥ Services
:3 Repeater #1
)f Advanced Settings
UL Privacy
~-LF DDMS service

~-4F MNIS data service

e

B§ PTT over Cellular

F:l Remote Agents

il Friendly Servers

? Talanhan Add Delete Configure

Set Defaults Apply OK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:

To add an audio path to the system, click Add.

Make sure the check box in the first column is selected to make and receive
voice calls from the selected subscriber.

From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All Calls.

Enter the Site ID of the site the audio path will belong to in a Linked
Capacity Plus system. Or, leave zero value in this column. In this case, the
Site ID will be displayed as Wide, meaning that the audio path will belong
to all sites in the system.

To configure the selected audio path, click Configure.

Specify the desired audio path settings similar to those for a common
repeater slot.

Adding a Capacity MAX System

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add Capacity MAX.

Note that a Capacity Max system can only be integrated with TRBOnet PLUS
software. For more information on how to configure and deploy a Capacity MAX
system, see TRBOnet PLUS MOTOTRBO Capacity MAX Deployment Guide.
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5.9.5

Adding a DIMETRA Express system

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add DIMETRA Express.

For more information on how to configure and deploy a DIMETRA Express system,
see TRBOnet DIMETRA Express Deployment Guide.

Adding a Control Station

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add Control Station.

Configuration Control Station #1 Version: 5.4.0.2177
u Service
(& Network Name: Control Station #1
& Redundancy Radio ID: 54250 :
Database
'bg Reports 1P Address: 192,168,10.2 - Test
Service Management Mode: Single Control Station -
Ad d Setti
”T vanced setings System Identifier: Department 1
)\ Geocoding Servers
! Radio Systems Use the radio for R¥ Data only (GPS Revert or Data Revert)
;& Services Playback device: | Speakers (Logitech USB Headset) -
ontrol Station #1
)’ Advanced Settings Recorder device: Line In {2- High Definition Audio Device) @
B PTT over Cellular
5=l Remote Agents
il Friendly Servers
ﬁ Telephony
I Data Sources
4 Email
1) 5Ms
[ License
Set Defaults Apply Ok Cancel

¢ In the Control Station pane, specify the following control station-related
parameters:

Name

Enter a name for the control station. This name will be displayed in the
Dispatch Console in the Voice Dispatch Radio Interface pane. It will be the
name at the top of the PTT box.

Radio ID

This is the Radio ID of the radio unit connected as a control station.

(for Capacity Plus and Linked Capacity Plus systems, the maximum value is
65535).

Note: This box is populated automatically once you have
successfully tested the control station by clicking the Test
button.

IP Address
Enter, or select from the list, the IP Address of the control station network
interface.
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Note: This value is can be taken from the radio's configuration in
MOTOTRBO CPS, in Network>Accessory IP.

= Test
Click this button to check the connection to the control station. If the test is
successful, you'll see the information on the control station you are
connected to, such as radio ID, serial number, firmware version, and other
relevant information.

* Mode
From the drop-down list, select the connection mode for the control station

being configured. For more details, see section 5.9.5.1, Control Station
Connection Modes (page 46).

= System ldentifier
Enter the system identifier with which the control station is used within a
Capacity Plus or Linked Capacity Plus system. Note that the system
identifier should be the same for all control stations used in a (Linked)
Capacity Plus system.

= Use the radio for RX data only (GPS Revert or Data Revert)
Select this option to configure the radio channel so that it will only receive
data, thus having no transmission capability.

= Playback device
From the drop-down list, select the playback device on the PC that will be
used to transfer audio data to the connected control station.

= Recorder device
From the drop-down list, select the recording device on the PC that will be
used to receive audio data from the control station connected via a line-in
jack.

5.9.5.1 Control Station Connection Modes

Single Control Station

The Single Station mode is the simplest connection mode for receiving and
transmitting voice and data through a conventional channel using one control
station at this particular frequency.

P
L .
/ Subscriber #2 \
/ \
Control Station 1 \
!
\ N N !
\\\ Subscriber #1 Subscriber #N/r

AN \ ’
N \ /
AN
N\

D <« LAN/WAN—» j

LSS D

TRBOnet Dispatch Console
Server
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IP Site Connect

The IPSC is a digital conventional two-way MOTOTRBO system that allows you to
extend the area of your communications by providing 2 wide area channels per
repeater. It is possible to connect up to 15 repeaters in one system using IP
connection.

The Server Connection Modes are as follows:

1. TRBOnet Server is connected to a repeater with two time slots in the "IP
Site Connect" mode. The Server can transmit and receive over IP.

2. TRBOnet Server has no IP connection to a repeater. Two control stations
are required to transmit and receive voice and data, that is, one control
station per time slot.

Site 1 Site 2 Site 3

- ». »
O T

y B B b
’ Control Station %?\/ E @‘/ E ‘@\/ E
- P P P
= ® ® ®

Common Channel

The Common Channel is a mode where it is possible to use multiple simplex base
stations operating at the same frequency with overlapping communication zones.

This mode allows the customer to provide radio coverage to large areas when there
is only one frequency and additional frequencies are unavailable. While in this mode,
the coverage area is being extended only for the dispatcher, and specifically when
operating at one and the same frequency. When a radio unit initiates a call, the
signal that can potentially be received by several base stations will be filtered on the
server side so that repeated audio playback and recording is prohibited.

The signal filtering is performed based on the "first packet", that is, only the signal
coming first to the server is played back and recorded, while the remaining signals
are discarded.

When a dispatcher initiates a call to a specific base station, the signals received by
the neighboring base stations will be discarded to prevent dispatchers from listening
to their own call at the time of transmission. The dispatcher is not recommended to
place a simultaneous call to all base stations to avoid interference to the subscribers.

The recommended way to use this mode is as follows: each base station is
configured with its own color code, and radio units are equipped with option boards
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having a Geo-roaming feature, and each geographic area is assigned its own radio

channel with the corresponding color code.
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\
\

/
/
N\
s, Control Station #1* ,*
NG e All control stations in the system

S~ operating the same frequency.

D\spatch Console

Capacity Plus/Linked Capacity Plus

Capacity Plus is a digital trunked two-way MOTOTRBO system that allows you to
accommodate high volume communication. It is designed to organize stable
connection in a few groups within one building or a set of buildings. This system
type allows you to increase the number of channels for voice and data transmission
between the subscribers and control centers. The subscribers are always
automatically forwarded to a free channel. The main objective of Capacity Plus is to
support more simultaneous voice and data transmissions within one capacious
system.

In the Capacity Plus mode you can configure voice and data control stations to
transmit and receive data over the air as it is described in the MOTOTRBO System
Planner. Keep in mind that two data control stations are required per each data
repeater — one per time slot. TRBOnet Dispatch Software provides you an option to
utilize an IP connection to receive voice and data.
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5.9.5.2 Advanced Settings

¢ In the Configuration pane, under the corresponding Control Station, select
Advanced Settings.

Configuration Advanced Settings Version: 5.4.0.2177
d': Service
G MNetwork n! Automatically reset alarm mode

@ Redundancy \/ Automatically handle call alert

— Database /! Emergency Callfalarm indication

& Reports

Use front microphone
LF Service Management

f Advanced Settings
.\ Geocoding Servers
& Radio Systems
L} Services TX Timeout: &0 5 seconds
-y Control Station #1

Always transmit when the PTT is pressed ("Impolite”™ channel access)
Use gerial part for FTT key up

/ Adhanced Salbngs Signaling System: MNone ¥ | Configure
B PTT over Cellular Allow CSBK Data

F:| Remote Agents
5 Friendly Servers
'E Telephony

V' Data Sources
24 Email
[ sMs

E License

Set Defaults Apply O Cancel

¢ In the Advanced Settings pane, specify the following control station-related
advanced settings:

Automatically reset alarm mode
Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.

Automatically handle call alert
Select this option to automatically redirect call alerts from the control
station radio to the Dispatch Console.

Emergency Call/Alarm indication
Select this option so that audio and visual indication is given by the control
station radio when an emergency Call/Emergency Alarm is received.

Use front microphone (for PTT key up)
Select this option to use a remote control of the PTT button via a remote
speaker microphone on the radio.

Always transmit when the PTT is pressed (“Impolite” channel access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Use serial port for PTT key up
Select this option to use a remote control of the PTT button via the serial
port of the PC, and select the serial port from the drop-down list.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, the ongoing
transmission will be interrupted after this TX Timeout expires.

49



neocom
sofFtware

= Signaling system
From the drop-down list, select the signaling system.
¢ MDC-1200 signaling is a Motorola data system using audio frequency
shift keying (ASFK) using a 1,200 baud data rate. A general option setting
for the system is to enable or disable an acknowledgement (ACK) data
packet.

e SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling Systems,
each radio has a unique numeric identity (for example, 12345). To signal
the number 12345, a sequence of 5 tones is sent. Sequences of audible
tones of a very short duration are sent between radios. Most 5 tone
sequences take less than half a second to send. Available for Voice Calls,
Check Radio, Call Alert, and Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

Configure Select 5 X

Voice Calls

Private Cal: Encoder:

[i!
Group Call: Encoder:
[

Al Call Encoder:

Call Type Telegram ID Source ID
[
[
\
\
[
[

Check Radio
call Alert
Enable Radio

Disable Radio

¢ Quick Call I. Using this signaling system, the radio sends a pair of tones
followed by 50 to 1,000 milliseconds of silence and then a second pair of
tones.
Click the Configure link and specify desired Quick Call | settings.

Quick Call | x
Preamble: 500} S ms
Tone 1: 1000 Sims
Tone 2: 1000 < ms
Long Tone: 4000 s oms
Pause: 200 S oms
Defaults oK Cancel

e Quick Call Il. Using this signaling system, the radio sends a single tone
followed by 50 to 1,000 milliseconds of silence and then a second tone.
Click the Configure link and specify desired Quick Call Il settings.

¢ Quick Call Il MOTOTRBO
When this system is selected, the parameters are configured on the radio
unit via the MOTOTRBO CPS.

= Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

5.9.5.3 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a radio
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system be registered in its configuration. If an audio path is not registered, the
TRBOnet operator will not be able to receive and transmit to the corresponding talk
group.

Note: Audio paths are available only when one of the following modes is
selected: Capacity Plus, Linked Capacity Plus, Connect Plus, or
Capacity MAX.

¢ In the Configuration pane, under the corresponding Control Station, select
Audio Paths.

Configuration Audio Paths Version: 5.4.0.2177
df: Service
5 Network Site ID: 1 s
# Redundancy Call Type Group ID Site
S Eatﬁb:e | Group cal 10 Wide
= epn.r V! Group cal 20 Wide
L4 Service Management 5
3 W Private Call
)f_ Advanced Settings
A Geocoding Servers W ancal
1B Radio Systems
L} Services
s Control Station #1
/ Advanced Settings
Lo
EJ PTT aver Cellular
i Remote Agents
| Friendly Servers
ﬁ Telephony
‘} Data Sources
{ Email
i sMs
E License
Add Delete
Set Defaults Apply O Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
= To add an audio path to the system, click Add.

= Make sure the check box in the first column is selected to make and receive
voice calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All Calls.

= In the Site column, select either Local or Wide. The value Wide means that
the audio path will be to all sites in the system and not just to the local site.

5.9.6 Adding a TRBOnet Swift Agent

The TRBOnet Swift Agent functions as a gateway to receive and transmit voice and
data.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add TRBOnet Swift Agent.
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Configuration TREORet Swift Agent #1 Version: 5.4.0,2164
d’: Service A
& Network MName: TRECnet Swift Agent #1

@ Redundancy Radio ID: 64250 :

Database 10.10.110.191

- : .10.110. -

2 Reports IP Address:

L} Service Management Port: 8002 - Test
P advanced Settings TREOnet Local Port: 50001 =

----- A Geocoding Servers
B Radio Systems

¥ Services System Identifier: Department 2
Capacity MAX
IPSC1
CP1 VolP port: 4000 s

Mode: Single Control Station -

Use the radio for RX Data only {GPS Revert or Data Revert)

TRBORet Swift Agent 1 Audio Format: PCM 8 kHz 16 bit M
)’, Advanced Settings
" @ Redundancy
Bj PTT over Cellular
=l Remote Agents
il Friendly Servers

E Telephany
«}’ Data Sources

24 Email
chac

Set Defaults Apply oK Cancel

¢ In the TRBOnet Swift Agent pane, specify the following Swift Agent-related
parameters:

= Name
Enter a name for the Swift Agent. This name will be displayed in the
Dispatch Console.

= Radio ID
This is the Radio ID of the control station connected to the Swift Agent.
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is
65535).

Note: This box is populated automatically once you have
successfully tested the Swift Agent by clicking the Test
button.

= IP Address
Enter the IP Address of the Swift Agent network interface.

* Port
Enter the port number of the Swift Agent connection (8002, by default).

= TRBOnet Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the Swift Agent. The value 0 (default) means that
a random port will be used.

= Test
Click this button to check the connection to the Swift Agent. If the test is
successful, you'll see the information on the Swift Agent you are connected
to, such as Serial number, Firmware version, and other relevant information.

= Mode
From the drop-down list, select the connection mode for the Swift Agent
being configured. For more details, see section 5.9.5.1, Control Station
Connection Modes (page 46).
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System Identifier

Enter the system identifier if the control station is used with a Capacity Plus
or Linked Capacity Plus system. Note that the system identifier should be
the same for all control stations used in the radio system.

Use the radio for RX data only (GPS Revert or Data Revert)

Select this option to configure the radio channel so that it will only receive
data, thus having no transmission capability.

VolP port

Enter the port number for audio communications (4000, by default).

Note: This setting is used for older firmware versions of TRBOnet
Swift Agent.

Audio Format
From the drop-down list, select the format to transmit audio data.

5.9.6.1 Advanced Settings

¢ In the Configuration pane, under the corresponding TRBOnet Swift Agent,
select Advanced Settings.

Configuration Advanced Settings Version: 5.4.0,2177
o Service R
0 Network

& Redundancy

Database

_-b‘ Reports

£} Service Management
)f Advanced Settings

..... )\ Geocoding Servers
IR Radio Systems

[} Services

- Capacity MAX

g PsC1

tﬁ cP1

‘.3 TREOnet Swift Agent #1

ﬁ! Redundancy

B FTT over Cellular
55| Remote Agents
[ Friendly Servers
'ﬂ Telephony

..... }' Advanced Settings

..... .. Internal PBX Server
L Y

vl Automatically reset alarm mode
il Emergency Callf/Alarm Indication
Always transmit when the PTT is pressed ("Impalite™ channel access)

TX Timeout: 60 % | seconds

PTT Mode: Keylp f DeKey -

Signaling System: Mone ~ | Configure

i Ctdinnn

Set Defaults Apply Ok Cancel

¢ In the Advanced Settings pane, specify the following Swift Agent-related
advanced settings:

Automatically reset alarm mode
Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.

Emergency Call/Alarm indication
Select this option so that audio and visual indication is given by the Control
Station radio when an Emergency Call/Emergency Alarm is received.

= Always transmit when the PTT is pressed ("Impolite" channel access)

Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).
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Note: This feature is not available in Capacity Plus and Linked

Capacity Plus systems.

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

*= PTT Mode
From the drop-down list, select the mode of pressing the PTT on the radio.

= Signaling system
From the drop-down list, select the signaling system.

MDC-1200 signaling is a Motorola data system using audio frequency
shift keying (ASFK) using a 1,200 baud data rate. A general option is to
enable or disable an acknowledgement (ACK) data packet.

SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling Systems,
each radio has a unique numeric identity (for example, 12345). To signal
the number 12345, a sequence of 5 tones is sent. Sequences of audible
tones of a very short duration are sent between radios. Most 5 tone
sequences take less than half a second to send. Available for Voice Calls,
Check Radio, Call Alert, and Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

Quick Call I. Using this signaling system, the radio sends a pair of tones
followed by 50 to 1,000 milliseconds of silence and then a second pair of
tones.

Click the Configure link and specify desired Quick Call | settings.

Quick Call II. Using this signaling system, the radio sends a single tone
followed by 50 to 1,000 milliseconds of silence and then a second tone.
Click the Configure link and specify desired Quick Call Il settings.

Quick Call Il MOTOTRBO
When this system is selected, the parameters are configured for the
radio units via the MOTOTRBO CPS.

5.9.6.2 Redundancy

A Redundant TRBOnet Swift Agent will be used when a connection to the Main
TRBOnet Swift Agent is lost.

¢ In the Configuration pane, under the corresponding TRBOnet Swift Agent,
select Redundancy.
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Configuration Redundancy Version: 5.4.0,2177

2 service

A
0 Network Redundant agents:
. 1P Address Port Local Port
& Redundancy

Database 1 W 10100210 8002 0
_D‘ Reports
£F Service Management
/ Advanced Settings
----- A Geocoding Servers
l Radio Systems
L} Services
g Capacity MAX
g PsC1
l.ﬂ cP1
i TREONet Swift Agent #1
}' Advanced Settings
v
B PTT over Cellular
5= Remote Agents
B2l Friendly Servers
ﬂ Telephony

" Data Sources
24 Emal Add Delete Test

chac

Set Defaults Apply Ok Cancel

¢ In the Redundancy pane, specify the following Redundant Agent-related
settings:
= Click Add and specify the desired parameters for the Redundant Agent
being added.

o [P Address
Enter the IP Address of the Swift Agent that will be used as a Redundant
Swift Agent.

e Port
Enter the port number that will be used for connections between the
server and the Redundant Swift Agent (8002, by default).

e Click Test to check the connection to the Redundant Swift Agent.
If the test is successful, you'll see the information on the Swift Agent you
are connected to, such as Serial number, Firmware version, and other
relevant information.

¢ Local Port
Enter the port number that will be used for connections from the
Redundant Swift Agent. The value 0 (default) means that a random port
will be used.

5.9.7 Adding an XRC Controller

The XRC Controller is a site controller that provides a channel for transferring data
between sites and managing data flow.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add XRC-9000 Controller.
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Configuration Controller #1 Version: 5.4.0.2177
o service
& Network Name: Controller #1
# Redundancy IP Address: 10.10.100. 100 - Test
Database
(2 Reports System Identifier: Connect Plus 1

[} Service Management
,’_ Advanced Settings

(N Geocoding Servers
I Radio Systems
Services

Controller #1

Services

Advanced Settings
‘@ Redundancy
B FTT over Celuiar
5| Remote Agents
[ Friendly Servers
%@ Telephony
l Data Sources

4 Email

i sMs

E License

Set Defaults Apply oK Cancel

¢ In the Controller pane, specify the following XRC controller-related
parameters:

= Name
Enter a name for the XRC controller. This name will be displayed in the
Dispatch Console.

= |P Address
Enter the IP Address of the XRC controller network interface.

= (lick Test to check the connection to the controller.

= System ldentifier
Enter the system identifier. Note that the system identifier should be the
same through all the controllers in a Connect Plus system.

5.9.7.1 Services
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¢ In the Configuration pane, under the corresponding XRC Controller, select
Services.

Configuration Services Version: 5.4.0,2177
& Service
0 Metwork |
@ Redundancy —
Database Controller port: 4005 -y
(2 Reports Local port: 0 z
‘ Service Management W Location service (GPS { Indoor)
,’_ Advanced Settings -
i\ Geocoding Servers Sl oot =
R Radio Systems Local port: 4001 -
Services Use adaptive location trigger
85 Controller #1
: W Text Messaging service (TMS)
i Advanced Settings Controller port: 4007 :
‘@ Redundancy =
B P77 over Celuiar o= ez 4007 -
& Remote Agents Dispatcher ID: 64250 s

[ Friendly Servers
E Telephony
l Data Sources
4 Email
i sMs

E License

Set Defaults

Multi Gate Connection

Apply
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Automatic Registration service (ARS) provides an automated data
application registration for the radio. When the radio powers up, it
automatically registers with the server. This feature is used with data
applications, that is any data traffic on this channel is associated with an
application server, such as MOTOTRBO Text Messaging or MOTOTRBO
Location Service. This option is selected by default and cannot be cleared.

¢ Controller port
Enter the controller's port number for ARS service (4005, by default).

¢ Local port
Enter the local port of the PC with TRBOnet Dispatch Software. The value
0 (default) means that a random port will be used.

Location service (GPS)

Select this option to enable Location service on the controller. The radio can
send its coordinates when it is in Global Positioning coverage area. GPS
settings can be configured in the Service Management pane (see section
5.7.2, Location Service).

e Controller port
Enter the controller's port number for Location service (4001, by default).

¢ Local port
Enter the local port of the PC with TRBOnet Dispatch Software (4001, by
default).

e Use adaptive GPS trigger
Select this option to use the adaptive GPS polling interval.

Text Messaging service (TMS)
Select this option to enable text message transmission on the controller.

e Port
Enter the controller's port number for Text Messaging service (4007, by
default).

¢ Local port
Enter the local port of the PC with TRBOnet Dispatch Software (4007, by
default).

¢ Dispatcher ID
Enter the Dispatcher ID. The Dispatcher ID should belong to TRBOnet
Server account in a Connect Plus system.

Multi Gate Connection
Select this option to use a multi-gate connection and enter the
corresponding Subscribe ID.

5.9.7.2 Advanced Settings

¢ In the Configuration pane, under the corresponding XRC Controller, select
Advanced Settings.
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Configuration Advanced Settings Version: 5.4.0,2177
o service
& Network Radio ID list: 100-200 ?
@ Redundancy Spedfy external sites:

_D! E:::‘:E Site ID Presence Voice Data

" ) ¥ 251 i v v

L+ Service Management
,’_ Advanced Settings ¥l 232 i v

(N Geocoding Servers
I Radio Systems

L} Services

: 85 Controller #1

: ervices
‘@ Redundancy

B FTT over Celuiar
5| Remote Agents
[ Friendly Servers
%@ Telephony

I Data Sources

4 Email
[ sMs
5] License Add Delete
Set Defaults Apply oK Cancel

In the Advanced Settings pane, specify the following XRC controller-related
services:

= Radio ID list
Enter a list of the radios to receive data from according to the following
rules:

e To receive data from all radios in the system, leave this box blank.

e To receive data from multiple radios, separate each Radio ID by a
comma, for example, 105,106,111, and so on.

e To receive data from a range of radios, enter the range using the
following example: 105-111.

Note: In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".

= Specify external sites
This is the list of Connect Plus sites that is used when the corresponding
Connect Plus system has a MOTOROLA System Bridge to the current
Capacity MAX system.

e Click the Add button and add a site by specifying its Site ID and
selecting the appropriate data types (Presence, Voice, and/or Data).

5.9.7.3 Redundancy

A redundant XRC controller will be used when a connection to the main XRC
controller is lost.
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In the Configuration pane, under the corresponding XRC Controller, select
Redundancy.
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Configuration Redundancy Version: 5.4.0.2177
q Service
G Network
& Redundancy
Database
1} Reparts
LF service Management
/ Advanced Settings
)\ Geocoding Servers
l Radio Systems
F Services
% Controller #1

i} Services

Redundant controllers:
1P Address

1 M 10.10.101.100

Contraller port
4005 0

Laocal port

4

. Advanced Settings
s
EJ PTT aver Cellular
i Remote Agents
| Friendly Servers
ﬁ Telephony
‘} Data Sources
{ Email
| sMs
[ License Add

Delete Test

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, specify the following redundant XRC controller-
related settings:

= Click Add and specify the desired parameters for the redundant XRC
controller being added.

IP Address
Enter the IP Address of the XRC controller that will be used as a
redundant XRC controller.

Controller Port
Enter the port number of the redundant XRC controller for incoming
connections (4005, by default).

Click Test to check the connection to the redundant XRC Controller.

If the test is successful, you'll see the information on the XRC controller
you are connected to, such as serial number, firmware version, and other
relevant information.

Local Port

Enter the port number that will be used for incoming connections from
the redundant XRC controller. The value 0 (default) means that a random
port will be used.

5.9.8 Adding an XRT Controller

The XRT controller functions as a voice gateway connected to each XRC controller in
a Connect Plus system.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add XRT-9000 Controller.
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Configuration Controller #1
ﬂ’ Service -~
& network
@ Redundancy

Database

_-b\ Reports

Version: 5.4.0.2177

System Name: Controller #1

Radio ID: 54250

4K 4r

Start Local Port: 1]

£} Service Management XRT-9000 Controller Info:

)’_ Advanced Settings
N Geocoding Servers
I8 Radio Systems
L3 Services

: % Controller #1

4

Controller IP Address: 10,10,111.102

Controller TCP Port: 10001 Test

4

User Name: Admin

Password: T

System Identifier: Connect Plus 1

... }'_ Advanced Settings
g Redundancy

(R Controller 71

Monitor Voice sessions (without audio)

Audio Paths

----- @ Redundancy
B PTT over Cellular
5l Remote Agents

EA mricndle Carvars

< >

Set Defaults Apply OK Cancel

In the Controller pane, specify the following XRT Controller-related
parameters:

System Name
Enter a name for the XRT Controller. This name will be displayed in the
Dispatch Console.

Radio ID
Enter the individual virtual radio ID. The virtual Radio ID is required to do
the following:

e Make all types of voice calls from XRT Controller to radios, dispatchers
and groups.

e Send commands (for example, Remote Monitor).

Start Local Port
Enter the local port of the PC with TRBOnet Server. The value 0 (default)
means that a random port will be used.

XRT Controller Info:

Controller IP Address
Enter the IP Address of the XRT controller network interface.

Controller TCP Port
Enter the port number of the XRT controller to be used for connections via
TCP (10001, by default).

Click Test to check the connection to the XRT controller.

User Name
Enter the user name. For the user name, refer to the XRT controller
configuration.

Password
Enter the password for the user. For the password, refer to the XRT
controller configuration.
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5.9.8.1 Privacy

Note: The user name and password should belong to the same
TRBOnet Connect Plus account and be appropriately
configured.

System Identifier
Enter the system identifier. Note that the system identifier should be the
same through all the controllers in a Connect Plus system.

Monitor Voice sessions (without audio)

This is the Billing feature. Select this option to monitor only PTT press
events.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Privacy.

Configuration Privacy Version: 5.4.0.2177

o Service ~

0 Network

& Redundancy

Privacy Type: Enhanced M

Database .
— Enhanced Privacy Keys:
@ Reports
L3 Service Management Aot
/ Advanced Settings ARC4 (d0bit) i1
-\ Geocoding Servers ARC? (40;'?
" AES (256 bit]
R d Systes
l adio systems AES (256 bit) Legacy

F Services

Name Value

% Controller #1

/ Advanced Settings
. @ Redundancy
% Contro\ler #1
Privacy
Data Path
i~ Audio Paths
@& Redundancy
5§ PTT aver Cellular

Ei Remote Agents
EA rricndh: caruare
< >

Add @ File

Remove

Set Defaults Apply oK Cancel

¢ In the Privacy pane, specify the following Privacy-related settings:

Privacy Type

From the drop-down list, select one of the privacy types: None, Basic, or
Enhanced.

Basic Privacy Key ID

Enter the Privacy Key ID available for the Basic privacy type.

Enhanced Privacy Keys

Here you add enhanced privacy keys when the Enhanced privacy type is
selected.

e Click Add and specify the required Algorithm, ID, Name, and Value for
the privacy key being added.
v Algorithm
From the drop-down list, select one of the enhanced algorithms if you
are going to use additional encryption.

5.9.8.2 Data Path

The Data Paths are used to transmit data in a Connect Plus system.
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¢ In the Configuration pane, under the corresponding XRT Controller, select
Data Path.

Configuration Data Path Version: 5.4.0.2177
CF Service ~
G Network Data Service: Extended Data service hd
& Redundancy
Database
_b‘ Reparts
£¥ Service Management
/ Advanced Settings
)\ Geocoding Servers
B Radio Systems
Services

Y
-

Radio ID: 54251

ontroller #1

-\ Privacy

o

-0 Audio Paths

& Redundancy
B PTT aver Cellular
F:| Remote Agents

E4 Ericndh: 2arvare

£ >

Set Defaults Apply 0K Cancel

¢ In the Data Path pane, specify the following data path-related settings:

= Data Service
From the drop-down list, select the data service to be used to transfer data.

= Radio ID
Enter the Radio ID of the data service.

5.9.8.3 Audio Paths

The Audio Paths are talk paths of the system to make and receive voice calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Connect Plus system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.

¢ In the Configuration pane, under the corresponding XRT Controller, select
Audio Paths.

Configuration Audio Paths Version: 5.4.0,2177
£ service "
G Network Call Type Source ID Target ID
& Redundancy | Group Call 10
Database W | Group Call 20
"2 Reports W Private call 64250
£F Service Management W1 | Al call

/ Advanced Settings

N Geocoding Servers
l Radio Systems

LF Services

g5 Controller #1

J Services
,f‘_ Advanced Settings
@ Redundancy

- iy Controller #1

- Privacy

F Data Path
i! Redundancy

5 PTT over Cellular

[l Remote Agents

EA Eriandl: Carvare Add Delete Configure
< b g

Set Defaults Apply OK Cancel

¢ In the Audio Paths pane, specify the following Audio Path-related settings:
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To add an Audio Path to the system, click Add.

Make sure the check box in the first column is selected to make and receive
Voice Calls from the selected subscriber.

From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

Enter the Source ID for Private Calls. In general, this is TRBOnet's Radio ID.
If more than one Radio ID is specified in a Connect Plus system (for
example, for different dispatchers), the corresponding talk paths should be
added for all of them.

Enter the Target ID for Group Calls. This is the Radio ID of the talk group to
make a call to. The Target ID is not applicable for Private Calls and All Calls.

5.9.8.4 Redundancy

A Redundant XRT Controller will be used when a connection to the Main XRT
Controller is lost.

¢ In the Configuration pane, under the corresponding XRT Controller, select

Configuration Redundancy Version: 5.4.0.2177
q'f: Service -
Redundant controllers:
G Network
p Controller IP Address  Controller TCP Port | Start Local Port
# Redundancy
Database 1 W 10011298 10001 0

_-D‘ Reports

£} Service Management
4 Advanced Settings

N Geocoding Servers
B Radio Systems

-L} Services

% Controller #1
Services

/ Advanced Settings

Lo i Redundancy

ﬁ Cuntru\ler #1

e Privacy

Data Path
11 Audio Paths

Ly
! PTT aver Cellular
g Remote Agems
= rueths Carvare M Add Delete Test
< >
Set Defaults Apply oK Cancel

¢ In the Redundancy pane, specify the following Redundant XRT Controller-
related settings:

Click Add and specify the desired parameters for the Redundant XRT
Controller being added.

Controller IP Address
Enter the IP Address of the XRT Controller that will be used as a Redundant
XRT Controller.

Controller TCP Port
Enter the port number of the Redundant XRT Controller to be used for
connections via TCP (10001, by default).

Start Local Port
Enter the local port of the PC with TRBOnet Dispatch Software. The value 0
(default) means that a random port will be used.
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= (Click Test to check the connection to the Redundant XRT Controller.
If the test is successful, you'll see the information on the XRT Controller you
are connected to, such as Serial number, Firmware version, and other
relevant information.

5.9.9 Adding a Selex Repeater

The Selex repeater is configured as a stand-alone repeater which supports
connections to MOTOTRBO™ radios to transmit voice and data in digital, analog,
and mixed modes.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add SELEX Repeater.

Configuration Selex #1 Version: 5.4.0.2177
u Service
& Network Name: Selex #1
@ Redundancy Radio ID: 54250 :
Database I
@ Reperts Repeater Mode: Digital -

£F Service Management
,f Advanced Settings
N Geocoding Servers
BB Radio Systems
L} Services

il EE
)’ Advanced Settings
L Slot #1
L0 Slot #2
Bj PTT aver Celular
5 Remote Agents
[ Friendly Servers

ﬁ Telephony
} Data Sources
4 Email

[ sMs

E License

Set Defaults Apply oK Cancel

¢ In the Selex pane, specify the following Selex Repeater-related parameters:

* Name
Enter a name for the Selex Repeater. This name will be displayed in the
Dispatch Console.

= Radio ID
Enter the Radio ID for the Selex Repeater (for Capacity Plus systems, the
maximum value is 65535).
The Radio ID is an individual ID that uniquely identifies the radio. This ID is
used by other calling radios when addressing the radio, for instance, when
making a private call or sending a text message.

= Repeater Mode
From the drop-down list, select the mode. The available modes are Digital,
Analog, Mixed, and Tier IlI.

5.9.9.1 Advanced Settings

¢ In the Configuration pane, under the corresponding Selex, select Advanced
Settings.
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Configuration Advanced Settings Version: 5.4.0.2177
q Service
G Netwark Keep Alive Interval: 10 : seconds
@ Redundancy T Timeout: &0 3| seconds
Database
;‘ Reparts

£¥ Service Management
4 Advanced Settings
)\ Geocoding Servers
BB Radio Systems
L} Services

j Selex #1
ocedsetnge
Slot #1
.0 Slot #2

EJ PTT aver Cellular
i Remote Agents
| Friendly Servers
ﬁ Telephony
I Data Sources

{ Email
80 SMs

E License

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following Selex Repeater-related
advanced settings:

5.9.9.2 Slots

Keep Alive Interval
Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Selex repeater (10, by default).

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires (60, by default).

The Selex repeater has two available slots (in Digital or Mixed mode) to transmit
voice and data.

¢ In the Configuration pane, under the corresponding Selex, select Slot #1 or

Slot #2.
Configuration Slot #1 Version: 5.4.0.2177
¢ service
G Network W slot #1
& Redundancy Name: Slot 1
— Database TREOnet P Address:  10.10.100.89 = ¢ Port: 6080 &
(@ Reports ) =
-~ ) SELEX IP Address: 10.10.9.30 - Port: 6080
£+ Service Management A
/ Advanced Settings Test
L. Geocoding Servers
BB Radio Systems Use the gateway for RX Data only (GPS Revert or Data Revert)
L} Services Use Encryption
é Selex #1 Always transmit when the PTT is pressed ("Impolite™ channel access)
M Advanced Settings W/ Data Call Confirmed

H Tibed W Private Call Confirmed
.00 Slot #2

B PTT over Cellular
5 Remote Agents

[ Friendly Servers
‘E Telephony
} Data Sources
4 Email
[ 5MS

E License

Set Defaults Apply QK Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:
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Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the
Port number (6080, by default).

SELEX IP Address
Enter the IP Address of the Selex Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

Click Test to check the connection to the repeater.

Use the gateway for RX data only (GPS Revert or Data Revert)
Select this option to configure the channel so that it will only receive data,
thus having no transmission capability.

Use Encryption
Select this option to encrypt voice and data traffic over IP.

Always transmit when the PTT is pressed (“Impolite” channel access)
Select this option so that that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

Data Call Confirmed
Select this option to enable individual packets in data calls (ARS, GPS, and
Text Message) on the current slot to be confirmed.

Private Call Confirmed
Select this option to set Private calls on the current slot as confirmed.

5.9.9.3 Tier lll and Audio Paths

The Selex repeater can be used in a Tier Il mode. To configure this mode, do the
following:

e While in the Selex pane, select Tier Ill from the Repeater Mode drop-down

list.

¢ In the Configuration pane, under the corresponding Selex, select Tier Ill.
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Configuration Tier [T
q Service R
& Network Y
& Redundancy Name:
= Database TRBOnet IP Address:
(@ Reports
LF service Management
/ Advanced Settings Test
..\ Geocoding Servers
BB Radio Systems
L} Services Use Encryption

10.10.100.5% + ¢ Pork:
SELEX IP Address: 10.10.9.30 ~ Port:

}' Advanced Settings v,
i Private Call Confirmed
-0 Audio Paths
EJ PTT aver Cellular
i Remote Agents
| Friendly Servers
ﬁ Telephony
‘} Data Sources
{ Email
80 SMs

E License

Set Defaults Apply oK

6080
6080

Version: 5.4.0.2177

AF 4K

j Selex #1 Always transmit when the PTT is pressed ("Impolite™ channel access)

Cancel

¢ In the Tier Il pane, specify the following Tier Ill-related parameters:

Use Encryption

Select this option to encrypt voice and data traffic over IP.

Always transmit when the PTT is pressed (“Impolite” channel access)

Select this option so that that when the PTT button is pressed, the radio will

start transmitting regardless of whether the channel is free or not (that is

any transmission in progress will be interrupted).

Capacity Plus systems.

= To configure Audio Paths:

Note: This feature is not available in Capacity Plus and Linked

¢ In the Configuration pane, under the corresponding Selex, select
Audio Paths.

Repeater Mode for the Selex repeater.

Note: Make sure the Tier lll mode has been selected as a

Configuration
q Service
0 Network
& Redundancy
Database
1} Reparts
£¥ Service Management
/ Advanced Settings
)\ Geocoding Servers
BB Radio Systems
L} Services

j Selex #1
}' Advanced Settings
Tier III
o
EJ PTT aver Cellular
35 Remote Agents
| Friendly Servers
ﬁ Telephony
‘} Data Sources

{ Email
[ 5MS

E License

Set Defaults

Audio Paths

Call Type Group ID
il Group Call 10
W Group Call 20
i Private Call
W ancal

Add Delete

Apply oK Cancel

Version: 5.4.0.2177
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¢ In the Audio Paths pane, specify the following Audio Path-related settings:

To add an Audio Path to the system, click Add.

Make sure the check box in the first column is selected to make and receive
Voice Calls from the selected subscriber.

From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

Enter the Group ID, which is a radio ID of the talk group to make a call to.
The Group ID is not applicable for Private Calls and All Calls.

5.9.9.4 Analog channel

The Selex repeater can also use the Analog channel.

¢ In the Configuration pane, under the corresponding Selex, select Analog.
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Note: Make sure the Analog or Mixed mode have been selected
as a Repeater Mode for the Selex repeater.

Configuration Analog Version: 5.4.0.2177

¢ service

G Network

& Redundancy
Database

2 Reports

£F Service Management

£ advanced Settings
L. Geocoding Servers

! Radio Systems

Name: Analog

rs
-

TREOnet IP Address: 10.10.100.99 ~ ¢ Port: G080

ry
-

SELEX IP Address: 10.10.9.30 - |Port: | 5080

Test

[} Services
‘é Selex #1

)f Advanced Settings
[eel Analog

Bj PTT aver Celular

35 Remote Agents

[ Friendly Servers

ﬁ Telephony

} Data Sources

Always transmit when the PTT is pressed ("Impolite™ channel access)

4 Email
[ sMs

E License

Set Defaults Apply QK Cancel

In the Analog pane, specify the following Analog channel-related settings:

Name
Enter a name for the Selex repeater in the analog mode. This name will be
displayed in the Dispatch Console.

TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the
Port number (6080, by default).

SELEX IP Address
Enter the IP Address of the Selex Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

Click Test to check the connection to the repeater.
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Always transmit when the PTT is pressed ("Impolite” channel access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

5.9.10 Adding a Kairos Repeater

The Radio Activity Kairos repeater is configured as a stand-alone repeater which
supports connections to MOTOTRBO™ radios to transmit voice and data in digital,
analog, and mixed modes.

Note:

When the Kairos repeater is connected, the following
TRBOnet Dispatch features are not supported: Remote Monitor,
Disable Radio, Enable Radio, Kill Radio, and Telemetry.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add KAIROS Repeater.

Configuration Kairos #1 Version; 5.4.0.2177

o service ~
O Network MName: Kairos %1
@ Redundancy IP Address: 10.10.155.130 -
Database
User Name: kairos

_-D\ Reports

L} Service Management
‘/’: Advanced Settings
L Geocoding Servers
I8 Radio Systems

.. LF Services

Password:  ssssss

Radio 1D: 54250

Repeater Mode: Mixed {Analog and Digital) -

..IT7 Slot #1
10T Slot #2
1 Analog
B PTT over Cellular
F5-l Remote Agents
F33 Friendly Servers
& Telephony
'} Data Sources
24 Email
L cnac
< >

Set Defaults Apply oK Cancel

¢ In the Kairos pane, specify the following repeater-related parameters:

Name
Enter a name for the Kairos repeater. This name will be displayed in the
Dispatch Console.

IP Address
Enter the IP Address of the Kairos repeater network interface.

User Name
Enter the user name. For the user name, refer to the Kairos repeater
configuration.
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= Password

Enter the password for the user. For the password, refer to the Kairos

repeater configuration.
= Radio ID

Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system.

= Repeater Mode

From the drop-down list, select the mode. The available modes are Digital,

Analog, and Mixed.

5.9.10.1 Advanced Settings

¢ |n the Configuration pane, under the corresponding Kairos, select Advanced

Settings.

Configuration
d’: Service -~
0 Netwaork
& Redundancy
Database
_b‘ Reports
L} Service Management
\)’: Advanced Settings
(N Geocoding Servers
B Radio Systems
i L} Services

5 Kairos #1

Slot #1

LI Slot #2
Tl Analog

B PTT over Cellular

F:l Remote Agents

5l Friendly Servers
ﬁ Telephany

J Data Sources
4 Email

L s

< >

Set Defaults

Advanced Settings

Keep Alive Interval: 10

TX Timeout: 60

Voice Call Hang Time (ms):
Group Call: 3000
Private Call: 4000

Emergency Call: 4000

Version: 5.4.0.2177

seconds

Ar 4k

seconds

RRARERARE N 3

Apply oK Cancel

¢ In the Advanced Settings pane, specify the following Kairos Repeater-related
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advanced settings:

= Keep Alive Interval

Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Kairos repeater (10, be default).

= TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires (60, be default).

Voice Call Hang Time (m

= Group Call

S):

This value sets the duration the repeater reserves the channel after the end
of a group call transmission. During this time, only members of the group
that the channel is reserved for can transmit.
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= Private Call
This value sets the duration a radio keeps the private call setup after a user
releases the PTT button. This is to avoid setting up the call again each time
a user presses the PTT button to transmit. During this time, other radios can
still transmit since the channel is essentially idle. After the hang timer
expires, the radio transmits using the TX Contact Name parameter specified
for this channel in MOTOTRBO CPS.

= Emergency Call
This value sets the duration the repeater reserves the channel after the end
of an emergency call transmission. During this time, only members of the
Group that the channel is reserved for can transmit.

5.9.10.2 Slots

The Kairos repeater has two digital slots (in Digital mode) and one analog slot (in
Mixed or Analog mode) to transmit voice and data.

¢ In the Configuration pane, under the corresponding Kairos, select Slot #1 or
Slot #2 (or Analog, if you have selected Mixed or Analog mode).

Configuration Slot #1 Version: 5.4.0.2177
u Service ~
0 Network VI slot #1
@ Redundancy Name: slot 1
= Datzbase Audio Codec: G711 p-Law/3000
i Reports
I'} Service Management #udio port KATROS: 40000 -
/ Advanced Settings Audio port TREOnet: 40000 -
L.,k Geocoding Servers
B Radio Systems Data port KAIROS: 40001 -
ervices Data port TRECnet: 40001 -
Kairos #1
)!: Advanced Setting
] Slot #1
I Slot #2
..... 4 Anzlog
B PTT over Cellular
F:l Remote Agents
5l Friendly Servers
E Telephony
I Data Sources
4 Email
S~ Y &
< >
Set Defaults Apply Ok Cancel

¢ In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters:

= Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

= Audio Codec
From the drop-down list, select the audio codec to be used to compress the
audio files.

= Audio port KAIROS/ Audio port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet audio ports.

= Data port KAIROS/ Data port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet data ports.
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Note: Use the matching port numbers for KAIROS and TRBOnet.
The default audio and data port numbers are 40000 and
40001 for Digital slot 1, 40002 and 40003 for Digital slot 2,
and 40004 and 40005 for the Analog slot.

5.9.11 Adding a Wave Controller

Before creating a connection to the Wave controller, make sure the Wave server is
configured to allow 3rd party applications to connect with a Neocom Software-
specified license key.
¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add WAVE Controller.

Configuration Wawve Server #1 Version: 5.4.0.2177
d’: Service
0 Metwork MName: Wave Server #1

# Redundancy Connection:

- Database W] Use proxy for connection

i Reports

'} Service Management Controller IP Address: 10.10.150.110 -
\)’: Advanced Settings

LA Geocoding S

A Geocoding Servers TREOnet Local Port: 0 -

IR Radio Systems

i LF Services User Name: testd

[ wave Server #1) Password: | weeeeweess
!: PTT over Cellular Profile: all-channels -
il Remote Agents
3 Friendly Servers Test
8 Telephony

«} Data Sources

74 Email

0 sM5
E License

Set Defaults Apply 0K Cancel

¢ In the Wave pane, specify the following Wave controller-related parameters:
= Name
Enter a name for the Wave controller. This name will be displayed in the
Dispatch Console.

= Use proxy for connection
Select this option to use a proxy server to connect to the Wave controller.

= Controller IP Address
Enter, or select from the list, the IP Address of the Wave controller.

= Controller Port
Enter the port number of the Wave controller.

= TRBOnet Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the Wave controller.

= User Name
Enter the user name. For the user name, refer to the Wave server
configuration.
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Password

Enter the password for the user. For the password, refer to the Wave server
configuration.

Profile
From the drop-down list, select the profile to be used on the Wave server.

Test
Click this button to check the connection to the Wave controller.

5.9.12 Adding an Analog Control Station

TRBOnet Dispatch Software allows using analog radios as control stations.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ In the drop-down menu, click Add Analog Station.

Configuration Analog Control Station Version: 5.4.0.2177

& Service
0 Network Name: Analog Control Station
@ Redundancy
Database Playback device: Primary Sound Driver v
_D‘ Reports Recorder device: Primary Sound Capture Driver - &
£F Service Management
): Advanced Settings Serial port: COM1 -
RN Geocoding Servers
l Radio Systems Always transmit when the PTT is pressed (Impalite™ channel access)
(e TX Timeout: &0 2 seconds
ﬁ fPsc1 Mic delay time: 1] 2 | milliseconds
8 1 he
I TREOnet Swift Agent #1
!: PTT over Celliar Extended protocol: Maone -
3| Remote Agents -
Signaling System: Quick Call I -

3 Friendly Servers

E Telephony Configure
} Data Sources
24 Email
B 5M5
E License
Set Defaults Apply Ok Cancel

¢ In the Control Station pane, specify the following Analog Control Station-
related settings:

Name
Enter a name for the analog control station. This name will be displayed in
the Dispatch Console.

Playback device
From the drop-down list, select the playback device on the PC that the
control station is connected to.

Recorder device
From the drop-down list, select the recording device on the PC that the
control station is connected to.

Serial port
From the drop-down list, select the serial port the control station is
connected to on the PC.
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= Always transmit when the PTT is pressed ("Impolite" channel access) -
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that is
any transmission in progress will be interrupted).

Note: This feature is not available in Capacity Plus and Linked
Capacity Plus systems.

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any voice session in the Dispatch Console, transmission
will be interrupted after this TX Timeout expires.

= Mic delay time
Enter the time, in milliseconds, to be used as a delay time interval between
pushing the PTT and starting voice communication.

= Extended protocol
From the drop-down-list, select either None, if your radio does not support
the extended protocol, or IC-F1721D v1.01 if the radio supports the
extended protocol.

= Signaling System
From the drop-down-list, select the signaling system (Quick Call I or
Quick Call I1). Click the Configure link and specify desired Quick Call
settings. Selecting the signaling system is available only if None is selected
in the Extended Protocol list.

5.9.12.1 Serial Port

Note: The serial port settings are available only when the
extended protocol IC-F1721D v1.01 is selected for the
analog control station.

¢ In the Configuration pane, under the corresponding Control Station, select
Serial Port.

Configuration Serial Port Version: 5.4.0.2177
d’: Service
G Network Baud Rate: 19200
@ Redundancy Data Bits: 8
Database
@ Reports Parity: MNane

£} Service Management
)’, Advanced Settings

N Geocoding Servers Handshake: Mone
IR Radio Systems

L} Services

g TPsc L

!

iy Analog Control Station

|

B PTT over Cellular
32l Remote Agents

Stop Bits: 1

2 Friendly Servers
’E Telephony

I Data Sources
24 Email
B8 sMs

E License

Set Defaults Apply Ok Cancel
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¢ In the Serial Port pane, specify the same serial port settings as those on the
radio device connected to the serial port.

5.10 PTT over Cellular

To enable connections of Mobile Client applications to TRBOnet Server, you must
configure at least one dedicated gateway.

¢ In the Configuration pane, select PTT over Cellular.

¢ In the PTT over Cellular pane, select Enable PoC service.

Configuration PTT over Cellular ersion: 5.4.0.2177
IR Radio Systems A
AF Services i/ Enable PoC service

ol IPSC 1 .

)'_ Advancad Settings Registered PoC Gateways
Privacy oo Name Port

I Slot #1 /| TRBOnet.Mabile gateway #1 5070
[ Slot #2
...LI1 Local Slots

ol CP1

)f_ Advanced Settings
" Privacy

DMS service
){ Advanced Settings

£F MNIS data service

/ Advanced Settings

[ Audio Paths
-

)’ Advanced Settings

l TRBOnet.Mobile gateway #1
5 Remote Agents

[ Friendly Servers
R Telarham
<

Add Delete

Set Defaults Apply oK Cancel

5.10.1 Advanced Settings

¢ In the Configuration pane, select PTT over Cellular > Advanced Settings.
¢ In the Advanced Settings pane, specify the following parameters:

= Max Call Time
Specify the maximum call time, in minutes.

= Registration Interval
Enter the time interval, in seconds, to check the registration status of mobile
subscribers.

5.10.2 Adding a Mobile Gateway
¢ Inthe PTT over Cellular pane, click Add.

¢ In the Mobile Gateway pane, specify the following parameters:
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Configuration TREOnet.Mobile gateway #1 Version: 5.4.0.2177
BB Radio Systems A
AL} Services MName: TREOnet.Mobile gateway #1
ol [PSC 1 System Identifier: Mabile 1
)’_ Advanced Settings
3} Privacy Local Interface: 127.0.0.1 -3
-0 Slot #1 Local Port: 5070 s
-1 St £2 Public Add 84.52.107.217
Local Slote ublic ress/Domain: .52.107.
I:B CP1 First VoIP port: Default s
)’, Advanced Settings

Privacy
¥ DDMS service
}"_ Advanced Settings
F MNIS data service
j’ Advanced Settings
[ Audio Paths
Ej PTT over Cellular
/ Advanced Settings

N

5 Remote Agents

2l Friendly Servers
B Telamham
< >

Set Defaults Apply oK Cancel

Name
Enter a name for the mobile gateway.

System Identifier
Enter the name of the mobile system to which the gateway will belong.

Local Interface
Enter the IP address of the PC with TRBOnet Server.

Local Port
Enter the local UDP port number for the Mobile service (5070, by default).

Public Address/Domain
This is the public IP address of your PC. To detect the public address, click
the ellipsis (...) button.

Public |P Address x

Detect public IP Address over STUN server

STUN Server: stun.ekiga.net -
Port: 3478 :
IP Address detected:  84.52.107.217

oK Cancel

e STUN Server
From the drop-down list, select the STUN Server.

e Detect
Click this button to detect your public IP address.

First VolP port
Enter the number of the first VolP port for audio communications. The
default value is specified in Network Parameters.

Note: In addition, for a better performance, make sure that the
Data protocol parameter is set to UDP in Network
Parameters.
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Remote Agents

¢ In the Configuration pane, select Remote Agents.

Conﬁguratlan Remote Agents
H - Slot #1 L)

I Slot #2

Local Slots
Lol CP1
}’ Advanced Settings
" Privacy
F DDMS service
,f_ Advanced Settings
L ¥ MNIS data service
,f_ Advanced Settings
- Audio Paths
! PTT over Cellular
i Advanced Settings
l TREONet.Mobile gateway #1
B
9 Agent: 1
----- 55 Redundancy
F2 Friendly Servers
ﬁ Telephony
I Data Sources
{ Email

L eme Add
< >

Agent Name
W Agent: 1

Registered remote Agents:

Delete

¢ In the Remote Agents pane, click Add.

2 Privacy
¥ DDMS service
)f Advanced Settings
LF MNIS data service
)’_ Advanced Settings
I Audio Paths
! P"I'I' over Cellular
i M, Advanced Settings
i... [l TREONEet.Mobile gateway #1
32l Remote Agents

(@) Use all services

9 Agent: 1
----- & Redundancy
2 Friendly Servers
‘ETEIephnny
<} Data Sources
4 Email

L ema

< > Load services fro

D

Conﬁgurahon Agent: 1
H - Slot #1 A
H I St £2 Agent Name: Agent: 1
i L.CI3 Local Slots
I:B Pl IP Address:

j’ Advanced Settings Port: 4020

Use only specified services

m agent

IP Address
10.10.110.190

Apply

10.10.110.190

Apply

The Remote Agent is TRBOnet Agent installed on a remote PC.

Version: 5.4.0.2177

Paort Redundancy
4020 Mo

Test

oK Cancel

Version: 5.4.0.2177

Test

oK. Cancel

= In the Agent pane, specify the following parameters:

e Agent Name

Enter a name for the remote agent. This name will be displayed in the

Dispatch Console.
e |IP Address

Enter the IP address of the remote agent.

e Port

Enter the local port number that will be used by TRBOnet Server to

accept connections from the remote agent.

e Click Test to check the connection to the remote agent.
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e Use all services
Choose this option so that all available services will be used on the
remote agent.

¢ Use only specified services
Choose this option and click the Load services from agent link to load
services available on the remote agent.

5.11.1 Redundancy

A Redundant remote agent will be used when a connection to the Main remote
agent fails.

¢ In the Configuration pane, under the corresponding Agent, select
Redundancy.

Configuration Redundancy Version: 5.4.0.2177

i L.L17 Local Slots A N "
:I:ﬂcpl edundant agents:

3¢ Advanced Settings Name IP Address Port
' Privacy 1 | M Backup Agnet 1 10.10.110.192 4020
DMS service 2 \/ Backup Agnet 2 10,10.110,101 4020 -
. Advanced Settings
NIS data service
)’, Advanced Settings
L Audio Paths

B PTT over Cellular

,’_ Advanced Settings

! TRECNet.Mobile gateway #1
5l Remote Agents

9 Agent: 1
L
2 Friendly Servers
‘E Telephony
I Data Sources
24 Email
B8 sMs

E License
v Add Edit Delete Test i
< >

Set Defaults Apply oK Cancel

¢ In the Redundancy pane, click Add.

Remote Agent X
Agent Name: Backup Agent 2
IP Address: 10.10,110.101
Port: 4022

(@) Use all services

() Use only specified services

Load services from agent

oK Cancel

¢ In the Remote Agent dialog box, specify the following parameters:

e Agent Name
Enter a name for the redundant remote agent.
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o [P Address
Enter the IP address of the redundant remote agent.

e Port
Enter the local port number that will be used by TRBOnet Server to
accept connections from the redundant remote agent.

e Click Test to check the connection to the redundant remote agent.

¢ Use all services
Choose this option so that all available services will be used on the
redundant remote agent.

¢ Use only specified services
Choose this option and click the Load services from agent link to load
services available on redundant the remote agent.

e Click OK to add a redundant remote agent to the system.
5.12 Friendly Servers

The Friendly Servers are used to transmit voice over IP between dispatchers
connected to different servers.

¢ In the Configuration pane, select Friendly Servers.

Configuration Friendly Servers Version: 5.4.0.2177
,’_ Advanced Settings ~
L.\ Geocoding Servers Registered Friendly Servers:

Radio Systems Mame IP Address Part
F Services 4 Region Server 1 10.10.101.167 4021

:3 PsC1 W1 Region Server 2 10.10.101.198 4022
. Advanced Settings

1 Privacy
Slot #1
Slot #2
Local Slots

BE§ PTT aver Cellular

j’_ Advanced Settings

B TREORet.Mobile gateway #1
35 Remote Agents
| 78| Friendly Servers

T8 Telephony
I Data Sources
24 Email
[ sMs
E License
v Add Ecit Delete Test
< >
Apply oK Cancel

¢ In the Friendly Servers pane, click Add.

Server X

Mame: Region Server 1
IP Address: 10.10.101.167

-

Port: 4021 -

oK Cancel

= In the Server dialog box, specify the following parameters:

e Name
Enter a name for the friendly server. This name will be displayed in the
Dispatch Console.
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IP Address
Enter the IP Address of the server.

Port
Enter the local port number on the PC to connect to the friendly server.

Click Test button to check the connection to the friendly server.
Click OK to add the friendly server to the system.

5.13 Telephony

TRBOnet Server has its own built-in SIP server to support VolP communications
between the radios as well as other SIP-compliant clients. In addition, you can add
multiple external PBX servers to the TRBOnet Server configuration.

¢ In the Configuration pane, select Telephony

¢ In the Telephony pane, select Use Telephony.

Configuration T Version: 5.4.0.2177
)’_ Advanced Settings ~

[N Geocoding Servers W] Use Telephony

IR Radio Systems
L L} services
o 1PsC 1 1 & Internal PEX Server

SIP Server

Advanced Settings
" Privacy
Slot #1
Slot #2
Local Slots

L et
5 PTT over Cellular
}t Advanced Settings

i [ TREOnet.Mobile gateway #1
5l Remote Agents

3 Friendly Servers
P eson]
3 . Advanced Settings
L. /T Internal PBX Server
}' Advanced Settings

[ Data Sources
Ermil & Add
< >

Apply oK Cancel

5.13.1 Advanced Settings

¢ In the Configuration pane, under Telephony, select Advanced Settings.
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Configuration Advanced Settings Version: 5.4.0,2177
/’ Advanced Settings -

(N Geocoding Servers Max Ring Time: 30 : seconds
! I?ad\o Systems Max Call Time: 10 : minutes

L ¥ Services
IPSC 1 Public Address: 84.52.107.217

« Advanced Settings Phone owner address: Take from database -
Privacy Configure
Slot #1

Slot #2

Local Slots

28 cr1

B PTT over Cellular
/ Advanced Settings
TREOnet.Mobile gateway #1
53 Remote Agents
5= Friendly Servers
IR Telephony
L./ ZR Internal PBX Server
)’_ Advanced Settings
V" Data Sources

Ern=il

£ >

Set Defaults Apply oK Cancel
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¢ In the Advanced Settings pane, specify the following parameters:
= Max Ring Time
Specify the maximum ringing time, in seconds.
= Max Call Time
Specify the maximum call time, in minutes.
= Public Address

This is the public IP address of your PC. To detect the public address, click
the ellipsis (...) button.

Public [P Address X

Detect public IP Address over STUN server

STUN Server: stun.ekiga.net -
-

Port: 3478 -

IP Address detected:  84.52.107.217

oK Cancel

e STUN Server
From the drop-down list, select the STUN Server.

e Detect
Click this button to detect your public IP address.

= Phone owner address
From the drop-down list, select 'Take from database'. This will enable
determining the street address of a caller.
Click the Configure link.

Address format X

Address format:

, %HOUSE_NUMBER. %, %STREET_NAME%]| -
Availablefields:

%HOUSE NUMBER% S%FLAT MUMBER%: %STREET NAME%: %COMMUNITY NAME%%
%%STATE NAMEY: %%POSTCODEY %%COUNTRY NAME%Y 3EXTRA INFO%

oK Cancel

e Add the required fields to the address information.
5.13.2 Internal PBX Server

¢ Make sure the Internal PBX Server option is selected in the Telephony pane.

¢ In the Configuration pane, select Internal PBX Server.
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Configuration
l Radio Systems ~

L} Services
o Psc 1
[, . Advanced Settings
| Privacy
Slot #1
Slat %2
-L11 Local Slots
L et
5 PTT over Cellular
}t Advanced Settings
.- ]l TRBOnet.Mabile gateway #1
ﬂi Remote Agents
3 Friendly Servers
B Telephony
L4 Advanced Settings
&
}' Advanced Settings
I Data Sources
4 Email

|5 sMs
[ r— 4
<

Set Defaults

Internal PBX Server

Version: 5.4.0.2177

i Use Internal PBX Server

Local IP: 127.0.0.1 v § Port: 5080
Digpatch Center
SIP ID: 1234
SIP user: 1234
Apply oK Cancel

¢ In the Internal PBX Server pane, specify the following parameters:
Local IP
Enter the IP address of the PC with TRBOnet Server.

Port

Enter the local UDP port number for the SIP service (5060, by default).

Dispatch Center
= SIPID

Enter the SIP ID that will be used by the Dispatch Center.

= SIP user

Enter the SIP user name that will be used by the Dispatch Center.

5.13.2.1 Advanced Settings

¢ In the Configuration pane, under Internal PBX Server, select
Advanced Settings.
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Configuration

IR Radio Systems "

L} Services

IPsC 1

; . Advanced Settings
Privacy

Slot #1

Slot #2

Local Slots

28 cr1

IEJ PTT over Cellular

B
B

/ Advanced Settings

l TREOnet.Mobile gateway #1
:| Remote Agents
-| Friendly Servers

L& Telephony

/ Advanced Settings

/T Internal PBX Server

",{, Advanced Settings

J Data Sources
24 Email

[ 5Ms
=l ticanca he
<

Set Defaults

Advanced Settings

Packet time (ms):

Codecs:

Registration Interval (sec):
DTMF Send Mode:

First VoIP port:

Use VoIP ports:

Version: 5.4.0.2177

60 -

-

SPEEX-WE,G711p,G711a,0PUS,OPUS-WE... =

3600 s
RFC 2833 -
Default s
Al -
Apply oK Cancel
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¢ In the Advanced Settings pane, specify the following Internal PBX Server-
related advanced settings:

Packet time
Enter the packet length, in milliseconds.

Codecs
In the drop-down list, select/unselect the codec(s) to be used for audio
compression.

Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status of
subscribers.

DTMF Send Mode
Enter mode for sending DTMF tones. The available modes are RFC 2833,
SIP INFO (DTMF relay), and SIP INFO (DTMF).

First VolP port
Enter the number of the first VolP port for audio communications. The
default value is specified in Network Parameters.

Use VolP ports
From the drop-down list, select which VolP ports will be used (all, even, or
odd).

5.13.3 External PBX Server

You can enable multiple external PBX servers to use the SIP Interconnect feature.
This feature enables calls from the radio to the phone and vice versa. The dispatcher
can make a call from the Dispatch Console to a phone as well as redirect a phone
call to a subscriber radio.

¢ In the Telephony pane, click Add.
Or, in the Configuration pane, right-click Telephony and choose
Add PBX Server.

Configuration External PBY, Server Version: 5.4.0.2177
l Radio Systems ~

L) Services W Use External PBX Server

! ‘3 IPSC 1

Advanced Settings Provider options

Privacy Address: yourprovider.com UpF -
Slot #1 pre— —
Slot #2 Port: - e
-C17 Local Slots .
L et Local IP: 127.0.0.1 - ®| port: 5061 =

5§ PTT over Celular
3zl Remote Agents
FE| Friendly Servers SIPID: 57068
ﬂ Telephany SIP user: User 123
.34 pdvanced Settings
ﬂ Internal PEX Server FES
£ advanced Settings
g External PBX Server
)f Advanced Settings
ﬁﬁ Redundancy
i} Data Sources
4 Email
[ 5Ms
e v

Set Defaults Apply oK Cancel

Dispatch Center

¢ In the External PBX Server pane, specify the following parameters:
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= Use External PBX Server
Select this option to enable an external PBX server.

Provider options

= Address
Enter your SIP provider address, and select the protocol from the drop-
down list on the right of the address (for more details, contact your SIP
provider).

= Port
Enter the port number of the SIP provider (5060, by default).

= Click Test to check the connection to the provider.

e Local IP
Enter the IP address of the PC with TRBOnet Server.

e Port
Enter the local port number to make connections from.

Dispatch Center

Note: This information is provided by the SIP provider.

= SIPID
Enter the SIP ID that will be associated with TRBOnet Server to make and
receive calls.

= SIP user

Enter the SIP user name for the login.

= Password
Enter the password for the login.

= Test Call
Click this button to make a test call.

Note: To make a test call, make sure that the TRBOnet Server
service is not running.

5.13.3.1 Advanced Settings

¢ In the Configuration pane, under the corresponding External PBX Server,
select Advanced Settings.
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/®

Configuration Advanced Settings Wersion: 5.4.0.2177

l Radio Systems ~
LT Services Packet time {ms): &0 s
fPsc 1 Codecs: SPEEX-WE,G711y.,G7112,0PUS OPUSWE... ~
/ Advanced Settings <
o1 Privacy Registration Interval (sec): 3600 -
Slot #1 DTMF Send Mode: RFC 2333 -

Slat %2
Local Slots

Do not register users on & PBX server (SIP trunk)

cP1 Do not register internal users on a PBX server

B PTT over Cellular
35l Remote Agents

Configure user's authorization

Default

4k

- First YoIP port:
F2 Friendly Servers

B Telephony

/ Advanced Settings

B Internal PBX Server

f Advanced Settings

a External PBX Server
;5 Redundancy

} Data Sources

24 Email

G SMS

Use VoIP ports: All

Available SIP numbers: 5555-6666 -

Set Defaults Apply oK Cancel

¢ In the Advanced Settings pane, specify the following External PBX Server-
related advanced settings:

Packet time
Enter the same value as specified in the phone system;

Codecs
In the drop-down list, select/unselect the codecs specified in the phone
system.

Note: For more details on Phone System configuration, see
Appendix E: SIP Setup for Motorola Phone System
(page 355).

Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status of
subscribers.

Do not register users on a PBX server (SIP trunk)
Select this option so that radios will use the SIP trunk system to get
extensions.

Configure user’s authorization

Click this link to set up user authorization for the systems with enhanced
authorization parameters. It is recommended to be used when Radio ID is
equal to SIP ID. In case when Voice is transmitted via Radio Channel, Radio
ID is used. When voice is transmitted via a GSM channel, the SIP ID is used.
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SIP Authorization users X
SIFID User Mame

I 010101 iUser # 1
Add Delete

apidd X oK Cancel

e Click Add to add a new user authorization.

e SIPID
Enter the SIP ID for the new user.

e User Name
Enter the User Name for the new user;

e C(lick OK to save the new user authorization.

= First VolP port
Enter the number of the first VolP port for audio communications. The
default value is specified in Network Parameters.

= Use VolIP ports

From the drop-down list, select which VolP ports will be used (all, even, or
odd).

= Auvailable SIP numbers
Enter the range of SIP phone numbers that will be available for outgoing
calls.

5.13.3.2 Redundancy

A Redundant PBX Server be used when a connection to the main PBX Server fails.
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¢ In the Configuration pane, under the corresponding External PBX Server,
select Redundancy.

Configuration Redundancy Version: 5.4.0,2177
IR Radio Systems
: Redundant PBX Servers:
Services
‘s — PBX Server Address | PBX Server Port TRBOCnet Local Port
% Advanced Settings 1 123.321.102.201 5060 5061

Privacy
Slot #1
Slot #2
-LCI3 Local Slots

CP1
B PTT over Celluiar
52| Remote Agents
5| Friendly Servers
ﬂ Telephony
/ Advanced Settings
& Internal PBX Server
)’_ Advanced Settings
H g External PBX Server

; )’_ Advanced Settings

.F\ Eri:l sources W] Reregister users when changing PSX server
_.‘_, 5MS Add Delete Test
=7 w
Set Defaults Apply oK Cancel
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¢ In the Redundancy pane, click Add.

= PBX Server Address
Enter the IP address of the redundant server.

= Check the corresponding port numbers (PBX Server Port and TRBOnet
Local Port).

= Select the check box beside the server address.

= Register users when changing PBX server
Select this check box so that phone users will be registered when the PBX
server is switched to the redundant server.

5.14 Data Sources

The Data Sources feature allows receiving data from third-party applications and
devices.

TRBOnet Dispatch Software can work with the following two data source types:
1. Physical or virtual devices connected via a COM port
2. PCs running third-party applications connected via TCP/IP

To allow TRBOnet Dispatch Software to receive data from a third-party application
or device:

¢ In the Configuration pane, select Data Sources.

Configuration Data Sources Version: 5.4.0.2177
IR Radio Systems A
L} Services W/ Enable Data Sources

SC1
. Advanced Settings
| Privacy
Slat #1
Slot #2
Local Slots
LR cP1
5§ PTT over Cellular
3=l Remote Agents
F52 Friendly Servers
ﬂ' Telephony
}t Advanced Settings
L./ZR Internal PBX Server
)f Advanced Settings
¥
COM ports
B 1o
24 Email
) SMS

E License

Apply oK Cancel

¢ In the Data Sources pane, select the Enable Data Sources option.
5.14.1 COM Ports

To manage physical or virtual devices connected to the TRBOnet Server PC via COM
port:

¢ In the Configuration pane, under Data Sources, select COM ports.
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Configuration COM ports Version: 5.4.0.2177
BB Radio Systems A

£} Services MName Baud | Parity Data Bits | Handshake | Stop Bits

ol Psct ¥ coMi 9500 None 8 Mone 1

- )4 Advanced Settings ¥ coM2 9500 None 8 None 1

% Privacy
Slot #1
Slot #2
Local Slots

Lo Pl

5§ PTT over Cellular
[l Remote Agents
[zl Friendly Servers
ﬂ Telephony
/ Advanced Settings
LR Internal PBX Server
; / Advanced Settings
}' Data Sources
L
L= e
4 Email
5 sMs
S License Add Delete Edit

Apply oK Cancel

¢ In the COM ports pane, click Add to add a new device.

COM Port X
Sarial port name: o TR
Baud rate: 9600 -
Parity-checking protocal: Mone -
Stop bits per byte: 1 -
[Diata bits per byte: 8 -
Handshaking protocal : Mone -
Protocol: Text -
Text Encoding ASCIT -
Message delimiter: LINE FEED Ox0A(N) -

Cancel

¢ In the COM Port dialog box, specify the following parameters:

Serial port name
From the drop-down list, select the COM port on the PC with TRBOnet
Server to which the device is connected to.

Baud rate
From the drop-down list, select the baud rate at which the data is
transmitted.

Parity-checking protocol

From the drop-down list, select one of the values that represent the parity-
checking protocol.

Stop bits per byte

From the drop-down list, select the standard number of stop bits per byte.

Data bits per byte
From the drop-down list, select the standard length of data bits per byte.

Handshaking protocol
From the drop-down list, select the handshaking protocol for serial port
transmission of data.
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= Text Encoding

From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

= Message delimiter

From the drop-down list, select the type of delimiters in the data.

Note: The Message delimiter types selected in the TRBOnet
Server and in the connected application must be the same
to avoid incorrect text display and incorrect data parsing.

= Click OK to save settings and close the dialog box.

5.14.2 TCP/IP

To manage PCs running third-party applications:

¢ In the Configuration pane, under Data Sources, select TCP/IP.

Configuration TCR/IP
IR Radio Systems -
L' Services MName
-l IPSC 1 R Terminal 1
,’ Advanced Settings W Terminal 2
o) Privacy
I Slot #1
1 Slot #2

Local Slots

LB opt
B§ PTT over Cellular
[ Remote Agents
[i Friendly Servers
ﬂ Telephony

/ Advanced Settings
: ﬂ Internal PBX Server
)’: Advanced Settings

7 Data Sources

[ sMs
[ License Add

Remote IP

10.10.102.216

Delete

Port

Version: 5.4.0.2177

Mode Encoding

11002 Client UTF3
11002 Server UTFa

Apply

Edit

oK Cancel

e Inthe TCP/IP pane, click Add to add a TCP/IP connection.

Text Enceding: | UTFE
[ Ignore the following data
During:

Do not consider the followin

min

g substring:

External Connection X
Name: Terminal 2
Mode: Server (TRECnet connects to App) -
Remote IP: 10,10, 102, 216
Port: 11002 5
Protocol: Text -

Cancel

89



neocom
sofFtware

¢ In the External Connection dialog box, specify the following parameters:

= Name
Enter a name for the TCP/IP connection.

= Mode
From the drop-down list, select the connection mode. The connection
mode depends on the type of the application installed on the connected
PC:

e Client
In this case, the application connects to TRBOnet Server which sends the
data to the application.

e Server
In this case, TRBOnet Server accepts connections from the application
and receives the data.

= Remote IP
Enter the IP address of the application server.

Note: Available only when the Server connection mode is
selected.

* Port
In the case of the Client connection mode, select the local port of the PC
with TRBOnet Server PC.
In the case of the Server connection mode, select the port of the PC where
the third-party application is installed.

= Text Encoding
From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

= Ignore the following data
Select this option so that the following messages arriving during the
specified time period will be ignored.

e During
Specify the time period, in minutes, so that similar messages that arrive
during this time period will be ignored.

¢ Do not consider the following substring
Enter a regular expression that will be used to filter messages upon
arriving and before being processed. For example, the following regular
expression \d{2}:\d{2}:\d{2} means that if a message contains a
substring like 11:01:54, then this substring will be dropped before
processing the message.
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5.15 Email Settings

TRBOnet Dispatch Console allows processing emails as follows:

1. Receive emails from email servers and forward them to a particular radio or
talk group (via a POP3 or IMAP server);

2. Send emails from radios to a particular email address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and POP3/IMAP
servers.

¢ In the Configuration pane, select Email.

¢ In the Email pane, select Enable Email Server.

Configuration Email Version; 5.4.0,2177
[ ~

: /’ Advanced Settings &1 Enable Email Server

Privacy

Slot #1

I Slot #2

17 Local Slots
tﬁ cP1
I PTT over Cellular
5l Remote Agents
[5:l Friendly Servers
‘T Telephony
/ Advanced Settings
‘R Internal PEX Server
/ Advanced Settings
[ Data Sources
Y COM ports
A% rcppp

Incoming Mail Server
f..aM® Outgoing Mail Server
B8 sMs

E License

Apply oK Cancel

5.15.1 Incoming Mail Server

The Incoming Mail Server is used to synchronize the Incoming Emails folder located
on a mail server with your local PC. If you are using a POP3 server, all incoming
emails can be downloaded from the mail server to the local PC to be then forwarded
as text messages to radios or talk groups.

¢ In the Configuration pane, under Email, select Incoming Mail Server.

Conﬁguratmn Incoming Mail Server Wersion: 5.4.0.2177

¥ Advanced Settings Enable
Privacy Server: |\map‘gmall.com |
Slot #1
Slot =2 This server requires a secure connection (S5L)
: Local Slots Port: 993 =
) tﬁ AL Protacol: IMAP -
B PTT over cellular
55 Remote Agents Check for new messages
[5:l Friendly Servers every: |60 5| seconds
ﬂ Te\ephony Connect using

. Advanced Settings

B Internal PBX Server (0) Anonymous access

i3 Advanced Settings () Windows authentication
i}’ Dats Sources (® Uselogin and password
;o COMports Login: [testedzas |
E.. TCPIP
Email Password: | “““““ |

H m’ Check New Emails Now

..wr Qutgoing Mail Server
|0 5Ms

E License

Set Defaults Apply OK Cancel
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¢ In the Incoming Mail Server pane, specify the following incoming mail-
related parameters:

= Enable
Select this option to enable Incoming Mail Server.

= Server
Enter the server hostname or IP address.

= This server requires a secure connection (SSL)
Select this option to enable a secure connection. Note that a dedicated port
will be used to connect to the mail server via SSL.

Note: The port number will automatically change when you select
this option. For example, from 110 to 995 for POP3, and
from 143 to 993 for IMAP.

= Port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected protocol and whether a secure connection is
required.

= Protocol
From the drop-down list, select either IMAP or POP3. Note that if you
select POP3, all email messages will be deleted from the server once you
have downloaded them. In the case of IMAP, all new messages will be
marked as read once you have downloaded them.

Note: The port number will automatically change when you
change the protocol.

= Check for new messages every X seconds
Enter the time interval to check for new email messages (60, by default).

= Connect using
Choose one of the following options:

e Anonymous access
Choose this option to use an anonymous access to the incoming mail
server.

¢ Windows authentication
Choose this option to connect via TRBOnet Service Windows Account, if
it is running under a specific account;

¢ Use login and password
Choose this option and specify the credentials for the mailbox:

v Login
Enter the incoming mail server login.

v Password
Enter the incoming mail server password.

92 TRBOnet Enterprise — User Manual



TRBOnet Server

neocom
SOF ware
Check New Emails Now

Click this button to synchronize the Incoming Emails folder and check for
new emails.

5.15.2 Outgoing Mail Server

The SMTP Server is used to send emails from users to mail servers as well as
between mail servers to deliver emails to the final destination.

For example, the Administrator can enable email notifications from TRBOnet
Dispatch Console to particular email users when alarms occur on selected radios. In
this case, the radio sends an alarm to TRBOnet Server which in turn converts this
alarm to text and then forwards it as an email message to particular email addresses
(for example, to admin@yourcompany.com).

¢ In the Configuration pane, under Email, select Outgoing Mail Server.

Configuration Qutgoing Mail Server Version: 5.4.0.2177
ol PSC 1 ~
/ Advanced Settings Enable
gy Privacy Sender Email: | |
- Slot #1
.[I Slot #2 SMTP Server: |smtp.gmai|.com |
[ Local Slots Encryption: Implicit (55L) -
L.pff CP1
B 7T over celular SMTP Server Port: 485 &
5l Remote Agents Connect using
[ Friendly Servers O anonymous access
‘& Telephony

(O) Windows authentication

/ Advanced Settings
: (®) Use SMTP user name and password

/T Internal PBX Server
- / Advanced Settings

User name: |besbed383 |
|’ Data Sources
COM perts Password: | ““““““ |
- Type: Auto -
4 Email
rers Incoming Mail Server
;.....NIF
R
E License
v
Set Defaults Apply 0K Cancel

¢ |n the Outgoing Mail Server pane, specify the following outgoing mail-
related parameters:

Enable
Select this option to enable Outgoing Mail Server.

Sender Email
Enter the email address (optional) of the sender.

SMTP server
Enter the server hostname or IP address of the SMTP server.

Encryption

From the drop-down list, select the encryption protocol (SSL, TLS) if a
secure connection is required, or select None if not. Note that three
different dedicated ports will be used to connect to the mail server: via SSL,
TLS, or with no encryption.

Note: The port number will automatically change when you select
the encryption protocol. For example, from 25 (no
encryption) to 465 for SSL, and to 587 for TLS.
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= SMTP server port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected encryption protocol.

= Connect using
Choose one of the following options:

e Anonymous access
Choose this option to use an anonymous access to the SMTP server.

¢ Windows authentication
Choose this option to connect via TRBOnet Service Windows Account, if
it is running under a specific account;

e Use SMTP user name and password
Choose this option and specify the credentials for the mailbox:

v" User name
Enter the SMTP server user name.

v Password
Enter the SMTP server password.

v Type
From the drop-down list, select the SMPT login type.

= Send Test Message
Click this button to send a test message from the Sender Email address.

5.16 SMS Settings

TRBOnet Dispatch Console allows sending SMS notifications to a cell phone when
alarms and other events occur on selected radios (for example, DTMF commands
from radios, Telemetry, Radio State, and other events).

¢ In the Configuration pane, select SMS.
¢ In the SMS pane, select Enable SMS Server.
¢ |n the Configuration pane, under SMS, select SMS.

Configuration 5M3 Version: 5.4.0.2164
. Advanced Settings A

Sender: ‘ |
Privacy

Slot #1 Connection to GSM via: | Vianett service (www.vianett.com) ~
Slot #2
Local Slots Loginz ‘Iogin@:yourcompany.com |

Tl E— |

Ef Mobile Systems

|5 Remote Agents Send Test MM3 Send Test SMS
5| Friendly Servers
‘B Telephony

,f_ Advanced Settings
R Internal PBX Server
/ Advanced Settings
I’ Data Sources
: COM ports
LM eppp
24 Email
rw Incoming Mail Server
¥ Outgoing Mail Server
B0 5M3
E License

Set Defaults Apply QK Cancel
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¢ In the SMS pane, specify the following SMS-related parameters:

Sender
Leave this box blank.

Connection to GSM via
From the drop-down list, select the type of connection.

¢ COM port GSM modem
Select this item if you are using a GSM Modem connected via COM port.
In addition, select the COM port the modem is connected to, and enter
the SIM Card Pin Code.

¢ Gemalto Cinterion EHS6T LAN
Select this item if you are using a Cinterion EHS6T GSM modem
connected via LAN. In addition, enter the IP address of the modem, and
enter the SIM Card Pin Code.

¢ Vianett service
Select this item to use an account on Vianett service.
For more details on Vianett service, see www.vianett.com

e SMS Broadcast
Select this item to use an account on SMS Broadcast service.
For more details on SMS Broadcast service, see
www.smsbroadcast.com.au

e Clickatell
Select this item to use an account on Clickatell service.
In addition to the Login and Password, you'll have to specify the API ID.
For more details on Clickatell service, see www.clickatell.com

Login
Enter the login for the selected service account.

Password
Enter the password for the selected service account.

Send Test MMS
Click this button to send a test MMS from the selected service account to a
recipient's phone number.

Note: This button is available when connected via Vianett service
only.

Send Test SMS
Click to send a test SMS from Vianett account to recipient phone number.

Note: This button is available when connected via Vianett, SMS
Broadcast, or Clickatell services.
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6 TRBOnet Dispatch Console

The key features of TRBOnet can be configured by the Administrator in TRBOnet
Dispatch Console after initial installation and configuration.

6.1 Connecting to Server

Launch TRBOnet Dispatch Console using the desktop or Start menu shortcut.

The default Administrator credentials are admin for the login and admin for the
password.

Connect to TRBOnet Server >

Connect to:

Address: 127.0.0.1 ~

Port: 4021 = Configure
Authentication:

Method: TRBCnet Authentication ~

User Name: |admin ‘

Password: — ‘

|:| Connect on startup

Cancel

Connect to:

= Address
Enter the IP address of the TRBOnet Server to connect to.

Note: This is the Network interface parameter of TRBOnet Server
configured in section 5.4, Network Parameters (page 17).

* Port
Enter the local port of the TRBOnet Server PC to accept connections from
the Dispatch Console.

Note: This is the Command port parameter of TRBOnet Server
configured in section 5.4, Network Parameters (page 17).

Authentication:

= Method
From the drop-down list, select the Authentication method:
e TRBOnet Authentication
Select this method to log on as a User registered in the TRBOnet
Dispatch Console Users list.
¢ Windows Authentication

Select this method to log on using the PC name. The system
automatically shows the PC name as a User Name.

Note: The Windows user must be registered in the TRBOnet
Dispatch Console Users list.

= User Name
Enter the User Name registered in the TRBOnet Dispatch Console Users list.
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= Password
Enter the user password.

= Connect on startup
Select this option to launch the Dispatch Console without having to type
the User Name and Password every time. Use this option if you regularly
connect to the same TRBOnet Server and your workstation is in a secure
location.

6.2 Main Window Elements

When the TRBOnet Dispatch Console application is initially launched, the default
Dispatch Console window will be displayed with the Voice Dispatch tab being
active.

Radio Interface |

F
Wednesday, April 25, 2018
11:17 am

) 1m =]
®) 125pets) B
)] Cd
® 2 (=]
=}
=}

M Tntercom H=@ 7 Telephony = [ Repeater #1: Siot #1 pEE
P e

(%) Radio 200
(%) Radio201

—
ey

“““““

Sender:

Sender:
@ \

Radio Bridge
Unknown
ny Group g

Recent Calls/Events

ES Playback | Save~ () Print | 11 Pause ¥ Clear ~ & Reload | ‘[ Filter By Radio | = Grouping /' Auto Filter (€ Default Settings || &7 Details \shuwwom [Z] Add Note

Date | Radio System | Sender | Recipient | Message | Details | bote |
14Mov-2016 12:21:24  Repeater #L:Slot #1125 Al Al Call from *125" (00:02) Members: 125 i‘
1440v-2016 12:21:15  Repeater #1: Siot 1 235 Al Al call from '235' (00:02) Members: 235
S 11Nov-2016 17:52:44 235 Al Reset Geofending Alarm
S 11Nov-2016 17:52:38 235 Al eanm Ieft alowed region Route 1
F 11N0v-2016 17:52:38 235 Al Geofencing Alarm [GPS Date: 11-Nov-20..,

S5 11Hov-2016 17:52:38 235 Al Radio left allowed region 'Route 1' -
|« | <] Record tofeas v [w|m| 4| ) »
Recent Cals/Events | RecentCalls | Requestto Tak | Rado state | Active Tasks | Active Routes | User Actvty | Map | Cameras

(3127001 &3 By B | B Dispatcher1 | [ Licensed to: demo Demo License | @ active~

The main user interface elements are as follows:
1. Main menu

Radio list pane

Modules tab pane

Radio Interface pane

Activity Monitor panel

S e

Quick Panels pane

Note: The look of the Dispatch Console windows may have been
customized for your specific operation.

97



&

neocom
sofFtware

6.3 Main Menu

The TRBOnet Dispatch Console main menu allows the user to manage the main
Dispatch Console options. The main menu is located in the upper left corner of the
main window.

6.3.1 File

The File menu contains the following items:

6.3.2 View

File > Connect to TRBOnet Server
Choose this menu item to connect to a different TRBOnet Server, or to use
different credentials for the current connection.

For more details, see section 6.1, Connecting to Server (page 96).

File > Exit
Choose this menu item to exit TRBOnet Dispatch Console.

The View menu contains the following items:

98

View > Show Navigation Pane

Choose this menu item to toggle the display of the Navigation pane on the
left of the main window. The Navigation pane includes two panes: the Radio
list pane and the Modules tab pane (see section 6.2, Main Window Elements).

View > Show Touch Keyboard Button

Select this menu item to display a Touch Keyboard button on the bottom of
the Modules pane. Clicking this button will bring up a virtual keyboard on the
screen.

View > Show Modules
Choose this menu item, and in the drop-down menu select/unselect the
modules to display in the Modules tab pane.

View > Additional Tabs
Choose this menu item, and in the drop-down menu select/unselect the tabs
to display in the Activity Monitor panel.

View > Configure PTT Boxes
Choose this menu item to configure the view of PTT boxes.

Configure PTT Boxes x

Radio Interface

Type MName View Mode Available Calls

Channel Intercom Normal a
Channel Control Station #1 Normal Al

Group Group 1 MNormal Firemen

Group Group 2 Mormal Police -

Create | ShEdit Delete
R B G Conce
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In the Configure PTT Boxes dialog box, specify the following PTT box
parameters:
= Type
In this column, the box type (for example, Channel, Group, Radio or All Call)
is displayed.

Note: The 'Channel' type means that the PTT box has been
automatically created by the radio systems connected to
TRBOnet Server and it can only be partially edited. The Edit
link is grayed out when a PTT box of this type is selected.

* Name
Enter a name for the selected box. This name will be displayed in the title of
the PTT box.

= View Mode
From the drop-down list, select the view mode:

¢ Invisible
Select this mode so that the PTT box will not be displayed.

¢ Normal
Select this mode so that the PTT box will be displayed in Normal view
mode:

f/_ Control Station #1 E
Channel 1
All call -]

Session:

Free channel

Sender:

RX[TX

¢ Minimized
Select this mode so that the PTT box will be displayed in Minimized view
mode:

( Control Station #1 [+)][«] _J

Note: Hover the mouse pointer over the Minimized PTT box to
view the PTT box in the Normal view mode.

= Auvailable Calls
From the drop-down list, select target radios or radio groups for the PTT
box.

Create virtual channel boxes

= To create a virtual PTT box, click the Create link in the lower-left corner of
the Configure Voice Boxes dialog box.
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Virtual Channel X
Name: Group Call
Call Type: Call Target:
O alcal (® Select by Dispatcher
(®) Group Call () Selected from list
() Private Call | j

Execute call on channels:
(") Execute call on all available channels
(®) Execute call only on selected channels

W Control Station #1

I Intercom

I¥ Local Brine's
Repeater #1: Slot #1
™ Repeater #1: Slot #2

Cancel

In the Virtual Channel dialog box, specify the following virtual channel
parameters:

Name
Select this option and enter a name for the virtual channel.

Choose a Call Type for the channel.

Call Target

(available only when Group Call or Private Call is selected as the Call Type)
Choose Select by Dispatcher to allow the dispatcher to select a Call Target.
Or, choose Selected from list and from the list below select the desired
group (if the Group Call type is chosen) or individual radio (if the Private
Call type is chosen).

Execute call on channels

(available only when All Call or Group Call is selected as the Call Type)
Choose Execute call on all available channels,

or Execute call only on selected channels and in the list below select the
available channels.

View > Configure Active Calls panel

Choose this menu item to configure call types and advanced settings for the
Active Calls panel. This menu item is available if View > Show Active Calls
Panel is selected.

= Call Types

On this tab, you can select which call types to display in the Active Calls
panel:
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Active Calls
£al 358 | advanced
[~ Show All Call
[ Show Group Calls
[+ Show Emergency Calls
[ Show Private Calls
[+ Show Remote Monitor
[ Show Intercom All Calls

[ Show Intercom Private Calls

Cancel

Advanced

On this tab, you can set following options:

e Show Visible Channels

neocom
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Select this option to display Visible channels in the Active Calls panel.

¢ Show Hidden Channels

Select this option to display Hidden channels in the Active Calls panel.

Note: For the visibility of channels, see Configure PTT boxes,

View Mode.

¢ Show Requests To Talk

Select this option to display Requests To Talk in the Active Calls panel.

¢ Show Missed Calls for

Select this option to display Missed calls in the Active Calls panel, and
specify the duration of displaying Missed Calls, in seconds.

Active Calls

Call Types A

¥ Show Visible Channels
¥ Show Hidden Channels
v Show Requests To Talk
I Show Missed Calls for:

2 seconds

x

Cancel
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The Active Calls panel is displayed in the upper part of the Dispatch Console:

Tools Help

Radio Interface

]
1 KXV

& B, oniine Dispatchers (1)
B administrator

= b )

[ e
L) Palice |

[]mtercom = Control Station #1 To: Selected Channels

[orr I —

11, Voice Dispatch

B

Session:

Free channel

Recent Calls/Events

[ Playback [l Save~ () Print | 11 Pause < Clear + & Reload | [ Filter By Radio | = Grouping /' Auto Filter @ Defautt Settings .
Date |Radio System | sender |Recpient | Message | petais | note |

29-5ep-2016 17:03:17 Control Station... Administrator Police Dispatcher "Adh strator’ ... Members: ﬂ
29-5ep-2016 17:02:37 Control Station... Administrator Police Dispatcher " ... Members: Administrator
29-5ep-2016 17:02:23 Control Station... Administrator Police Dispatcher Members: Administrator

= Event Viewer
29-5ep-2016 17:02:00 Control Station... Administrator Firemen Dispatcher ator' ... Members: Administrator
29-5ep-2016 17:01:47 Control Station... Administrator Police Dispatcher ‘Administrator' ... Members: Administrator

(2] Radio Alocation 25-5ep-2016 17:01:35  Intercom Administrator Al Intercom Cal: Dispatcher ... Members: Administrator -
1] @] ¢| Record1of31z x| m|w <] »

[ Recent Cals/Events | RecentCals | Radio State | Active Tasks | | User Activity | Map | Cameras
(127001 By B Bb B | @ Administiotor | [ Licensed to: demo Demo License | @ active~

e View > Customize Hot Keys

Choose this menu item to configure hot keys for the actions on the selected
channels.

Configure HotKeys X

¥ Show actions panel

HotKey Action Caption
shift Terminate All Transmitions  Terminate all -
Enter Default PTT channels Transmit
] FTT Intercom
[shift] +[H] PTT Repeater #1: Slot #1
[Shift] +[0] PTT Repeater #1: Slot #2
FTT Local Brine's
FTT Control Station #1
PTT Group 2 -
4| 4| RecordSof 10 ¥ | e [m] € LH

o Create %m ¥ Delete Show all PTT boxes

o 0 cne |

= To configure hotkey PTT actions to the PTT boxes, click the
Show all PTT boxes link, double-click the desired PTT box(es) to apply the
changes, then assign a hotkey or a combination of hotkeys.

= To configure specific non-PTT actions to PTT boxes (for example, mute
channels or set default PTT channels), click the Create link to make the
changes:
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Action X
Caption: ‘Mube Mode
Hotiey: Ctrl )
Action: ‘Mube channels j
Channels:
[v Telephony -
[¥ Intercom
[~ Group 10
[~ Group 20
¥ Slat 1

In the Action dialog box that appears, specify the following parameters:

e Caption

Enter the caption that will be displayed in the Dispatch Console.

HotKey

Click the Configure button, and on the keyboard, press the key or key
combination you want to assign as a hot key for the selected action.
Action

From the drop-down list, select the desired action:

v' Default PTT channel
Selected PTT box functions as a default PTT channel.

v' Mute channels
This action mutes selected PTT boxes.

v Unmute channels
This action unmutes selected PTT boxes.

v' Voice from channels
This action mutes voice from all PTT boxes except for selected one(s).

v Terminate All Transmissions
This action terminates all transmissions for selected PTT boxes.

Channels
In the list below, select PTT boxes to assign the actions specified above.

= To enable displaying the configured hot keys in the Dispatch Console,
select the Show actions panel option.

All the hot keys you have configured are displayed in the upper part of the Dispatch

Console:
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Radio Interface

Radio Interface | Recent Cals /Events

= /B, oniine Dispatcners (1)
& agministrator

= & )

L) Palice |

All Call -

Drag and Drop PTT Box here to
create new grou

ession: ession:
Free channel

Sender:

Recent Calls/Events

[ Playback (el Save~ () Print | 11 Pause ¥ Clear ~ 5 Reload | " Filter By Radio | = Grouping '\ Auto Filter (0 Default Settings >
Date |Rado system | sender |Recpient | Message | Detais | mote [

295ep-2016 18:15:42  Intercom Administrator Al Intercom Call: Dispatcher ... Members: Administrator ﬂ

$ 29-5ep-2016 17:53:22 RadioServer All Connection to ‘Contral Sta...

29-5ep-2016 17:27:01  Intercom Administrator  All Intercom Call: Dispatcher ... Members: Administrator

29-5ep-2016 17:27:00 Control Station... Administrator  Police Dispatcher ‘Administrator' ... Members: Administrator

29-5ep-2016 17:26:48 Intercom Administrator  All Intercom Call: Dispatcher '... Members: Administrator -

| 4| ¢| Recordtof31s b [w|mi| «] 3

Recent CalefEvents  RecentCals | Radio Siate | Acive Tasks | Actve Routes | user Actvity | Map | Cameras |

127001 G5 By B B | @ Admini

@ ‘ Fesrestimdams Boalieres ‘ @ Active -

e View > Add Radio Interface Tab
Choose this menu item to add a new Radio Interface tab to the Radio Interface
pane.

Configure Voice Boxes X
Mame: |Rad\o Interface #1 |
Type | Mame View Mode Available Calls
Channel Intercom Normal EI
Channel Control Station #1 Normal Al
Group Group 1 Mormal Firemen
Group Group 2 Mormal Police
Channel Repeater #1: Slot #1  Mormal Al
Channel Repeater #1: Slot #2  Mormal Al
Channel Local Brine's Normal Al
Al Call Al Call Normal

Create Edit Delete
s L o ]

= In the Configure Voice Boxes dialog box, specify the following PTT box
parameters for the new radio interface:

¢ Name
Enter a name for the radio interface.

Other parameters can be configured in the same way as when Configuring
PTT Boxes.

The user can switch between Radio Interfaces by clicking on the tab bar in the upper
part of the Radio Interface pane.
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Radio Interface

| Rado nterfoce ” Radio Interface #1] RecntCobsfvents [Rodos|| |

[} & Online Dispatchers (1) Confiqure

B administrator
To: Selected Channels

[y Firemen

[ Police

44

Control Station #1 [
P

Session:

Free channel

Sender:

Recent Calls[Events

5 Playback (el Saver () Print | 11 Pause ¥ Clear + & Reload | [ Filter By Radio | =
Date | Radio System | Sender |Recpient | Message Note |
30-5ep-2016 10:48:54  Intercom Administrator Al Intercom Call: Dispatche. .. Members: Administrator ﬂ
29-5ep-2016 18:15:42 Intercom Administrator Al Intercom Call: Dispatche... Members: Administrator
P 29-Sep-2016 17:53:22 RadioServer Al Connection to ‘Contrel S...
29-5ep-2016 17:27:01 Intercom Administrator Al Intercom Call: Dispatche. Members: Administrator
29-5ep-2016 17:27:00 Control Statio... Administrator  Police Dispatcher ‘Administrato... Members: Administrator
29-5ep-2016 17:26:48 Intercom Administrator Al Intercom Call: Dispatche. Members: Administrator -
| «| 4] Record1of303 v |w|mi| 4] 3
Recent CalsfEvents | RecentCals | RadoState | ActiveTasks | ActiveRoutes | User Acthity | Map | Camerss
127001 @ | 8 Administrator | (28 Licensed to: demo Demo License | @ Active-

e View > Delete Radio Interface Tab
Choose this menu item to delete the Radio Interface tab currently selected in
the Radio Interface pane.

Note: The default Radio Interface tabs can't be deleted.

¢ View > Show Channel Selector Box
Select this menu item to display a separate PTT box that allows selecting a
channel.

(i 0\

1P Site Connect: Slot #1
1P Site Connect: Slot #2

Session:

L 1

O Sender:

Channel not selected

b S

Click the arrow of the drop-down list and select the channel for this PTT box.

e View > Show Call Type Buttons
Select this menu item to display the Call Type Buttons panel in PTT boxes.

f|]]1 Site Connect: Slot #1 | -P

Session:

Free channel

Q C—

RX T
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¢ View > Show Keypad Panel
Select this menu item to display the Keypad panel in PTT boxes.

(_ IP Site Connect: Slot #1 [= @

0 — T

Qﬂadluhst
—
A A
el o o
e b Ao o
oAb o b <4

RXfTX o

=]

. J

Note: The Keypad panel will be displayed only when the Num
button is pressed in the Call Type Buttons panel.

e View > Audio Message Library

Choose this menu item to add configured Voice Messages to the Queued
Messages panel. For how to configure Voice Message settings, see Tasks,
Voice Message.

Saved Audio Files X

A Add % Remove | [ Filter | Hot Key
Filename Description Severity Hot Key Visibility

Alarm Tone Alarm Hidden

» Bobby.mp3 Information Button

Daisy.mp3 Information Link

send Cancel

* In the Saved Audio Files dialog box, specify the following parameters:

¢ Filename
The name of the message displayed in the Queued Messages panel.

e Description
Enter a description for the Voice Message.

e Severity
From the drop-down list, select the severity level (Information, Alarm, or
Warning).

¢ Hot Key
Click the Hot Key button and press the key or key combination you want
to assign as a hot key for the selected Voice Message box.
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o Visibility
From the drop-down list, select how to display the selected Voice
Message box:

v Hidden

Hide the Voice Message box.
v' Button

Display the Voice Message as a button (1).
v Link

Display the Voice Message as a link (2).

Radio Interface

Radio Interface | Recent Calls/Events.

[Jintercom

. -
ree channel

e View > Extended PTT boxes
Select this menu item to display PTT boxes as shown:

v Control Station #1
‘Control Station #1 ‘ @@
‘Channel 1 4
Free channel
e =
caii: Al Call o [ cneek |
T | G | . | [_m
e —
[ | i |
& & oy oy - w\ --
\_ Sk Mc

e View > Large PTT boxes
Select this menu item to display PTT boxes as shown:

/" Control Station #1 [E8)

¢ View > Medium PTT boxes
Select this menu item to display PTT boxes as shown:
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Control Station #1

g 5l

e View > Small PTT boxes
Select this menu item to display PTT boxes as shown:

[ Control Station #1 @w

Free channel
alcal Channel 1

e View > Custom PTT boxes >

Select Custom PTT Boxes 1 to display PTT boxes as shown:

Control Station #1

Mo

Channel 1

Free channel

Select Custom PTT Boxes 2 to display PTT boxes as shown:

Select Custom PTT Boxes 3 to display PTT boxes as shown:

Slot 1

Al Call @
Free channel ‘£
LINC]

R fTX

e View > PTT Box Themes
Click this menu item and select the theme to be edited, or create a new theme.

To create a new theme:

e C(Click View > PTT Box Themes > Create Theme.

e In the PTT Box Theme dialog box, enter a theme name and specify
desired colors for PTT box elements in various states and for various call
types.

e From the Preview list box, select the box size/type and see how it will
look like.

e To set the theme as default, select the Set as default theme option
located at the bottom of the dialog box.

e Click OK.
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PTT Box Theme X
Name: [polce
Voice Box States: Defaults  Preview: Large PTT Boxes -
¢ MasterRadio dscornected " @)
I — | (Ccortoistoton | chomel 7] @)
| Ererey chamd m
(=) Transmit state
HE Y- e ] Recipients
i Group Call
i Emergency Cal
i i Private Cal =L
i L. Remote Monitor Free channel
=) Receive state
- AIcal Sender:
- Group Cal . O
Configure Colors: Defaults
Title Fort Color: W 33; 75; 160 - RXfX —
Back Color: [ MistyRose -
Border Calor: I 69; 116; 159 -
Font Color: I 16; 48; 139 -
Fields Border Color: [ 200; 209; 230 -
Indicator Back Color: ] white -
Indicator Fore Color: [ 255; 153; 51 -
PTT Color: = hd
[ [0 Setasdefauttheme

e View > Show Active Calls Panel
Select this menu item to display the Active Calls panel in the Dispatch Console.
See also Configuring Active Calls panel.

e View > Show Clock Panel
Select this menu item to display the Clock panel (1) in the Dispatch Console.
e View > Show Quick Commands Panel

Select this menu item to display the Quick Commands panel (2) in the
Dispatch Console. For more details, see section 6.5.6, Quick Commands.

e View > Show Queued Messages Panel
Select this menu item to display the Queued Messages panel (3) in the
Dispatch Console. For more details, see section 6.5.7, Queued Messages.

e View > Show Patch Panel
Select this menu item to display the Patch panel (4) in the Dispatch Console.
For more details, see section 6.5.5, Patches.

e View > Telephony Tab

Select this menu item to display the Telephony tab (5) in the Radio Interface
pane.

e View > Show Extended Messages Tab
Select this menu item to display the Extended Messages tab (6) in the Radio
Interface pane.

e View > Show Radios Tab
Select this menu item to display the Radios tab (7) in the Radio Interface pane.

Radio Interface

Radio Interface | Telephony | Recent Calls/Events | Extended Messages

P Telephony 3 Intercom

m Al call

[ renu |

m, Line 2 |y Line 3 4
b Lne4 o Line5 o Lines Free channel

2wy O sender:

RX [ TX

.
.
0w
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6.3.3 Map

e Select Location Tracking (1) in the Navigation pane to enable Map Options:
e Click the Map menu (2).

File View | Map | Tools Help

| ¢ || @] oviecs

= H 3 [1(] I 2 ercom o) (B2 Ll 2
o i print [][<][@] I rove 20 [2][+][@] BN crece 11 [D[EE[E))  Erip—
K Geocoding. 9 WA Frivate Cal [][<][@] Beoe
[ v — -
e :
&

4 Open New Mapin Tab -

& [} Poli [E][E] 7. || Show Beacons: Al ~ [ Draving Panel
& Google Earth I3, 0, 01 oot

A v Gl Delete Route on Google Earth b EeRs el

o
Show Radios on Google Earth » J@

Open New Map in Window..

@ Location Tracking - !E) =7/ Region 1
—— 1 e & (7 Map Routes
&2 sob Ticketing @
- Bcutctimmaoemest 235
| 5] RemD Tracker (legTa @
5
[ Text if Lattude: 58°56:27.63" N: Longitude: 30'1649.88" E [
ﬁ _ Recent Calls/Events ")
[ Playback [l Save~ () Print | 01 Pause ¥ Clear - & Reload | [ Filter By Radio | = Grouping i/ Auto Filter (> Default Settings =
y y ping @ g B
@ Reports Date. Radio System Sender Redipient Message Details
SE 09.06.2017 14:43:57 Server Al Connection to ‘Capacity Plus 1 h. il
Event Viewer 09.06.2017 12:43:30  CapacityPlus 1 Administrator 1 Dispatcher ‘Administrator’ calls ... Members: Administrator, 125
5 09.06.2017 12:40:06  Capacity Plus 1 125 11 Radio '125' calls group '11' (00:08)  Members: 125
EEI _ 09.06.2017 12:39:55 Capadity Plus 1 Administrator 11 Dispatcher 'Administrator’ calls gr... Members: Administrator
09.06.2017 12:38:34 Capadity Plus 1 Administrator Police Dispatcher 'Administrator’ calls ar... Members: Administrator A
0 40| «| Record 10f 305 ¥ | m[ [ « »
E Administration Recent Calls/Events | RecentCalls | RequestToTak | Radio State | Active Tasks | Active Routes | User Activity | Beacons | Beacon Events | TagList

127001 &3 B | § Administrstor | [ Licensed to: demo | @ Active~

The Map menu contains the following items:

e Map > Select Active Map
Click this menu item to select the map to display in the Dispatch Console.

Select Map. X

Caption:

Available Maps

Name Path State
MARNIK oK
CYCLE oK
LANDSCAPE oK
BING_ROAD oK
BING_AREA oK
BING_HYBRID oK

Add Ed Remove Cancel

= Enter the Caption of the map that will be displayed in the Dispatch
Console.

= In the list of Available Maps, choose the map to be displayed.
Adding custom maps

You can also add an online map using its specific URL.
= Click the Add button.
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Add Map X

Name: [ap 1 |

Map Type: \WMS (Web Map Service) -
URL: |t /vmaps.dgs udel edu 80/ geoserver/DGS _Surficial_and_Cortact_Geology/wms |

~ v Get Capabities

Map Tite Identifier Description style

T ococ - Usoe t . emephon e s ey cfD.

US-DEDGS ... |US-DE_DGS_... | This map shows the surfical geology cont.... | DGS Geologic Statewide Map

ip: //maps.dgs.udel edu:80/geoserver/DGS_Suficial_and_Cortact_Geology/wms ZREQUEST-GETMAPSSER] (5

o o

e Enter a Name for the new map.

e Map Type
From the drop-down list, select the map type: Custom Map, WMS (Web
Map Service), or WMTS (Web Map Tile Service)

e Enter the URL of the map service and click Get Capabilities.

As a result, the table in the lower part of the dialog box will get
populated with the available map layers.

e Select the check box in the left column of the table to enable the
appropriate map layer.

e Click OK.
As a result, the new map will appear in the list of available online maps.

¢ Map > Save Online Map Data
Click this menu item to save your current map region.

Tiles bulk downloader - [m] X
Region from: N59°57°07.92" E030°14'33.51" to N59°56'48.68" E030°19'02.27"

Expire ties days: |30

Redownload alltiss

Zoom level: 14 Tiles to download: 40

‘Show fes preview [7] Show fles progress

Loaded: 40 of 40 (100 %)

In the dialog box, specify the following parameters:

= Expire tiles days
Enter the expiration time, in days, for the map tiles. When you download
the map, the already downloaded tiles are checked and if they are older
than this number of days, these map tiles will be re-downloaded from the
Internet.

= Redownload all tiles
Select this option to re-download the map tiles before saving to your PC.

= Zoom level
Move the slider from left to right to increase the detail level of the map.
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= Show tiles preview
Select this option to show how the map is divided into tiles.

= Show tiles progress
Select this option to show the progress bar while the online map is being
saved.

= Click Start and wait for the system to save the files. This may take several
minutes.

e Map > Map Content
Click this menu item to specify the folder and settings to store the map data.

Online Map - o X
Map cache

Cache folder.
D:\Temp\Maps

Update: Never v

Map Type: BING_ROAD -

Bing key: \

hitp://msdn microsoft Mibrary 423642 250

=

In the Online Map dialog box, specify the following settings:

= Cache folder
Click Change and locate the folder on the PC where you wish to store the
map data.

= Update
Select the update interval ('Never', 'Immediately’, or 'By period’) for the map
data stored in the specified Cache folder.

= Map Type
From the drop-down list, select the map type. For more details on the maps
used in TRBOnet Dispatch Console, see section 6.3.3.1, Map Types
(page 112).

= <Map Provider> key
Enter the key for the selected map.

Note: To obtain the key, click the hyperlink below and follow the
instructions.

6.3.3.1 Map Types
Online maps:

= MAPNIK - free online map. For more details on OpenStreetMaps, visit the
official the website: http://www.openstreetmap.org

* Thunderforest — commercial online maps. Visit
http://www.thunderforest.com/docs/apikeys/ to get a key.

= Microsoft BING — commercial maps from Microsoft. Includes BING_ROAD,
BING_AREA, and BING_HYBRID subtypes. A user may use BING maps for 90
days and then they must get a Basic Key. Visit
http://msdn.microsoft.com/en-us/library/ff428642.aspx to get a Basic Key.
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= Google Maps — online mapping service from Google. Visit

https://developers.google.com/maps/documentation/javascript/get-api-
key#key to get a key.

Custom Maps - online mapping services such as TRBOnet Map Server,
WMS and WMTS services. For more details, see TRBOnet Map Server User
Guide. For more details on the WMS/WMTS services, visit
http://www.opengeospatial.org/standards/wms/introduction.

Offline Maps:

= TMap - internal map-making resource. The user can create an offline copy

of online maps for selected regions according to their needs and
requirements. The user can create a map from any picture via the TRBOnet
Map Edit application.

Click Start > All Programs > Neocom Software > TRBOnet Enterprise>
Console> TRBOnet.MapEditor.exe

For more details on map calibration, read the following article at:
https://trbonet.com/kb/how-do-i-create-a-custom-map-for-trbonet/

Beacon 2D - two-dimension offline map for Indoor positioning. The user
can create indoor maps using the Indoor 2D Map Converter. See section
6.4.16.2, Indoor 2D Map Converter.

Beacon 3D - three-dimension map for Indoor positioning. The user can use
any DirectX file as a map.

Map > Print
Click this menu item to print the map region currently displayed in the Map
pane.

Map > Geocoding
Click this menu item to configure geocoding servers in the Dispatch Console.

Geacading X

Load data from TRBOnet Serverif Geocoding services are inaccessble from local PC

Add Delete Al v
Defat Cancel

Load data from TRBOnet Server if Geocoding services are inaccessible
from local PC

Select this option to receive location data from the TRBOnet Server PC if the
Dispatch Console is unable to resolve location data.

For other settings, see section 5.8.1.1, Configuring Geocoding Servers
(page 25).

Map > Open New Map in Tab
Click this menu item to add a new map tab to the Map pane.
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Select Map.. X
Map Type: Orline maps v
Caption: [y maapl

Available Maps

Name Path State

MAPNIK oK

crae oK
TRANSPORT oK
LANDSCAPE ok
BING_ROAD oK
BING_AREA oK
BING_HYERID oK

add Remove Cancel

Map Type
From the drop-down list, select
= Caption

the map type.

Enter a caption for the new map tab.

For other settings, see Selecting Active Map.

Once you have clicked OK, the new tab will appear in the Map pane:

BING ROAD X/ My Map X[

°

O, O 12 e e [@]®]O]@] 7 [@] showBeacons: xi
% 3
= B
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>
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o o
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00m 5 )
fome

e Map > Open New Map in Window

For required settings, see Selecting

= | & Ruler | FindonMap~ 4. 4 Drawing Panel .l Router <& Geofencing
2 -~

% c)
C)

o

(o

o
ol

2
)

Ey
%
%
%,
2,

%

Click this menu item to create a new map window with the specified map

Active Map

Once you have clicked OK, the new Map window will appear:

o x
o & Ruler C4 FindonMap~ il  # Drawing Panel (7l Route~ & Geofencing
=3 A
é; =l
EAl
2 le & Online Dispatchers (1) Vaslyevskly |sland
H i
B agministrator
& [ ) Firemen (=]
B® 125 Pew
®ekS V151N
[} Palice |
< \
‘O Lattude: 59°5628.50N: Longtude: 30°1645.62°E ||
235

e Map > Google Earth

Click this menu item to open the Google

Earth application.
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Note: Google Earth must be previously installed on the PC. To
download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and click
Download.

¢ Map > Delete Routes on Google Earth
Click this menu item delete all routes from Google Earth.

e Map > Show Radios on Google Earth
Click this menu item and in the drop-down menu select which radios to
display on Google Earth.

6.3.4 Tools

The Tools menu contains the following items:

e Tools > Event Viewer in Window
Click this menu item to open the Event Viewer in a new window.

vent Viewer - o x
ter events Talk Sessions

All Messages [ Playback [ Save~ | 1l Pause -# Clear £ Reload Grouping "/ Auto Filter g
(5 Text Messages Date V| Radio System Sender Reciient .
=% trbox (i) 05-Oct-2016 15:38:45  Control Station #1 Dispatcher Al -
o sent (i) 05-0ct-2016 15:38:43  Control Statio Dispatcher Al
oy Teemetry () 05Cct-2016 15:38:41  Control Staor Dispatcher Al
g :m‘:‘"m s‘g”:‘s 040ct-2016 17:38:38  Repeater 51 1 1s Al
=Nt commencs 040Ct-2016 17:38:32  Repeater 1 23 Al
Talk Sessions
040ct-2016 17:3242  Repeater 2 Administrator Al
(& Registration in a radio network
" 040ct-2016 17:3L:55  Repeater 2 Administator Al
$* System Messages
040ct-2016 17:30:50  Repeater £ 115 Al
iy User messages
040ct-2016 17:30:45  Repeater 235 Al
040ct-2016 17:30:40  Repeater Administrator Al
040Ct-2016 17:28:48  Repeater # 125 Al
040ct-2016 17:28:45  Repeater £1: St #1235 Al
040ct-2016 17:18:05  Repeater #L:Slot #1235 Al
0402016 17:16:01  Repeater #1 Administrator Al
040ct-2016 17:15:58  Repeater £1: St 22 Administrator Al
040ct-2016 16:56:17  Repeater £1: Sot #2  Administrator Al
03-0ct-2016 10:51:39  Control Station #1 235 Al =
6] 9| 4] Record 120f 200 ¥ w[mi| ¢ r
u Sender: 235 Date: 04-Oct-2016 17:28:45
Redpient: Al [Blplavbads [ Save [ AddNote
All call from '235' (00:07)

¢ Tools > Recent Calls/Events in Window
Click this menu item to open Recent Calls/Events in a new window.

Recent Calls - [m] X

Grouping 7 Auto Filter @ Default Settings *|

%] Playback [ Save~ (h Print | 11 Pause <# Clear + £ Reload | \[F Filter By Radio

Date Radio System | Sender Redpient. Message Details Nate
38 05-0ct-2016 1514232 Radioserver | All Connection to ‘Control St... -
[] 05-0ct-2016 15:38:95  Conwrol Stati... Dispatcher  All Al Call from dispatcher 'Di...
[ 050ct-2016 15:35:43  Control Stati... Dispatcher  All Al Call from dispatcher Di.
[] 050ct-2016 15:38:41  Control Stati... Dispatcher  All Al Call from dispatcher Di...
R 05-0ct-2016 09:99:04 Radioserver | Al Connection to ‘Repeater ...
3% 040ct-2016 17:45:38 Administrator 125 Dispatcher ‘Admiristrator' ...
3% 040ct-2016 17:43:26 Administrator 125 Dispatcher ‘Admiistrator' ...
[ 040ct-2016 17:38:38  Repeater #1.., 125 al Al Call from 125 (00:01)  Members: 125

. 235 Al Al Call from '235' (00:00)  Members: 235
Admiristrator Al Al Call from dispatcher 'A... Members: Administrator
.. Administrator Al Al Cal from dispatcher ‘A... Members: Admiristrator
125 Al All Call from '125' (00:00)  Members: 125
235 Al Al Call from '235' (00:01)  Members: 235
Admiristrator Al Al Call from dispatcher A... Members: Administrator

[J 04-0ct-2016 17:38:32
[ 04-0ct-2016 17:32:42
[ 04-0ct-2016 17:31:55
[J 04-0ct-2016 17:30:50
[ 04-0ct-2016 17:30:45
[ 040ct-2016 17:30:40

[ 04-0ct-2016 17:28:48 . 125 Al AllCall from 125 (00:01)  Members: 125
[ 04-0ct-2016 17:28:45 . 235 Al All Call from '235' (00:01)  Members: 235
3B 04-0ct-2016 17:28:40 Admiistrator 125 Dispatcher ‘Administrator' ..
() 040ct-2016 17:18:05  Repeater £1... 235 Al AllCall from '235' (00:02)  Members: 235 =
4] 1] RecordBorzar v |mlmi| (| = . : »
u Sender: 125 Date: 04-0ct-2016 17:38:38
Redpient: Al [Blplavbads [ Save [ AddNote

Al Call from'125' (00:01)

= Click Playback to play back the selected call.

= (Click Save to save the selected call as an audio file.
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In the Save As dialog box, locate the folder where you want to save the
audio file, specify the file name, and from the drop-down 'Save as type' list,
select the format (*.wav or *.tna) for the audio file.

= (Click Add Note to add a note to the selected call.

MNote =
well done ~l
Add Extension. .. oK | Cancel

e Enter the text of the note in the text box.

¢ You can extend the form of a note by clicking the Add Extension link
and adding new fields and their possible values to the form.

¢ Tools > Job Ticketing Monitoring
Click this menu item to open the window that visually represents the job
tickets created by dispatchers and assigned to radios.

------

In this window, you can perform the following actions:

= Select a time period for which to display Job Ticketing data.
= Monitor tickets created by dispatchers.

= Monitor tickets assigned to radios.

All data are shown in the form of status diagrams.

¢ Tools > Radios in Window
Click this menu item to open a new window that displays the radios present in
the system.
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Radios [m] X
Filter: l:l Radio Groups: | All -

A 2.2
Statuses: | (Online, Indoar), (Onine, ... v '7 Palice

F’ Cleaners
W 11
M 22
¥/| Mobile Client d
oK Cancel | |
. @ || & | @ |

In this window, you can make radio calls, send text messages. In addition, you
can select to display radios by groups and states.

b
o
3
]
s

¢ Tools > Telephony in Window

Click this menu item to open a new window that displays the Telephony
system present in the system.

Hold

In this window, you can make and receive telephone calls.

¢ Tools > Telemetry Monitoring

Click this menu item to open the window that displays configured telemetry
profiles for the radios.

Telemetry 21 - [u] X

Radio « | status VIOL vI02

= From the Show drop-down list, select the Telemetry profile to display.
See also section 6.4.11, Telemetry (page 204).

¢ Tools > Text Messages in Window
Click this menu item to open a new window to manage text messages.
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Text Messages - o x

BlEs & Y S@ |  Clear S Reload ||} Inbox [ Sent

[05-0ct-2016 17:51:13 Received from 235 to 125
His be on

& B online Dispatcners (1
& o n l05-0ct-2015 18:01:43 Received from 235 to 125
piq 2aministrator only6m
© [ Firemen B ||p5-Oct-2015 18:06:04 Received from 125 to 235
_ nog
H® s |V
= 05-0ct-2016 18:10:53 Sent from Administrator to Police
[CICE: |v king me fool
| Police 2

Recipient: *% | Poiice | Ed send | ] AttachFile

125

In this window, you can perform the following tasks:
= View sent messages in the upper-right pane.

= Select online dispatchers and radio groups in the left pane, or by clicking
the ellipsis (...) button in the lower-right pane.

= Type messages in the text box in the lower-right pane.
= Send messages by clicking the Send button in the lower-right pane.

¢ Tools > Routes in Window
Click this menu item to open a new window to manage routes.

For more details on Route Management configuration,
see section 6.8, Guard Tour / Route Management (page 302).

¢ Tools > Camera in Window
Click this menu item to open a new window with a camera view.

® Camerat — [m| *

In this window, the camera view is displayed.

= Camera
From the drop-down list, select a camera that is connected to TRBOnet
Dispatch Console.

See also section 6.4.9, IP Cameras (page 200).

e Tools > Reset All Location Triggers
Choose this menu item to stop/start location triggers on all radios.
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¢ Tools > Dynamic Regrouping
Click this menu item to dynamically regroup radios depending on current
needs. For more details, see section 6.4.26.2, Dynamic Regrouping.

Note: The Dynamic Regrouping feature is available only for
Capacity MAX systems. In addition, the radio's firmware
version must be 2.10 or later, and the DGNA feature must
be enabled on the radios.

e Tools > Terminate All Transmissions
Click this menu item to terminate all voice sessions.

This action is a "hard" request to stop all "hung" transmissions in the TRBOnet
software. If a radio communication session is not allowed to be interrupted on
a repeater or base station, it will only be stopped for the TRBOnet software.

e Tools > Phone Book
Click this menu item to open the phone book for reference and editing

purposes.
L)) Phone Book x
w Add S+ Edit | A Remove \ Filter . Configure “0 Import-
Marker SIF ID SIP User Display Mame
: 2409 2409 Walt
Yellows 2235 2235 235
Yellow 2125 2125 125
M| 4| 4 |Record 1af3 b M M| 4 3
call oK Cancel

= Click the Add button to add a new record to the phone book.
= Click the first column, and from the drop-down list select a marker color.

= Double-click the second column.

Phone Number *
SIP ID: |2125
SIP User: |2125
Display Mame: |J0hn

e SIPID
Enter the SIP ID that is used by the user.
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e SIP Name
Enter the SIP user name that is used by the user.

¢ Display Name
Enter the name that will be displayed for the user in the Dispatch
Console.

e Click OK to save the phone book.
6.3.4.1 Options

e On the Tools menu, click Options.

Options x

Sound Map  CoverageMap Hardware Advanced Audio  Alarm  Telephony
@), oo the Saundiotfiaten
2

Use Sound Netifications

To configure the individual sounds notfications on every system event, choose
eventfrom the list and specify a demanded sound fi or use a fil by default

©. Takbegin

@), Tak end

©), Line busy

@, Alarm or Emergency Cal
), Text message received
@), nformation received

@), alarm Tone
@ Private cal from 2 radio Network to dispatcher
@), Request To Talk from Radio Network to dispatcher

Sound:
(Sound by defaut) ~| [ Select..

Alarm r Emergency Call duration: 5 | seconds

Cane

Sound
¢ In the Options dialog box, click the Sound tab.

¢ Use Sound Notifications
Select this option to enable sound notifications in the Dispatch Console.

e Select the event in the list and specify the sound.

e From the Sound drop-down list, select ether 'Sound by default' to play
default sound, or 'Disabled' to disable sound notification for the event.

e Click E] to listen to the sound notification for the selected event.
e Click Select and browse for the audio file on your PC.

= Alarm of Emergency Call duration
Enter the time value, in seconds, for the duration of the alarm tone when
an emergency call is received.

Map
¢ In the Options dialog box, click the Map tab.
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Options x

sound Mop  CoverageMap Hardware Advanced Audio Alarm  Telephony

= Configure the image parameters that are shown on the map

30 3| seconds

Show PTT n map: [ rados [ Map Objects
Default Map Filter . . @ -
ow eoodinates on may

s, Minutes, Seconds

32 x 32 pixels -
(@) Mobile radios ==

Path to Google Earth exe fie

[c:\Proaram Files\Goodle\Goodle Earth Pro\dient\aocaleearth.exe |

o

¢ Map refresh interval

Enter the time period, in seconds, to update map data.

¢ Show the directions of motion

/®
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Select this option to display a direction of motion for map objects.

¢ Show names of objects

Select this option to display object names on the map.

¢ Hide overlapping names of objects
Select this option to hide overlapping object names.

¢ Show PTT on map

Select this option to allow the dispatcher to make private calls by

clicking a corresponding radio icon on the map.
o Default Map Filter

Select/unselect the icons for the default map filter (for a description of

the icons, see section 6.6.2.4, Filters).

¢ Show coordinates on map

In the drop-down list, select the coordinate systems/units that will be
used to display coordinates in the lower-right corner of the Map pane.

¢ Select the image size

From the drop-down list, select the size of a radio icon.

¢ Select the default image type

From the drop-down list, select the default image type of a radio icon.

¢ Path to Google Earth exe file

Click the ellipsis (...) button and specify the location of the Google Earth
exe file on your PC. For example, the path may look like: C:\Program

Files\Google\Google Earth Pro\client\googleearth.exe

Coverage Map

TRBOnet Dispatch Console allows displaying RSSI levels on a map. The RSSl is a
received signal strength indicator. It measures the power level of the signal at a
radio's receiver. The RSSI maps can be used by radio system engineers to plan

further extension of their radio networks.
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¢ In the Options dialog box, click the Coverage Map tab.

Options X
Sound Map  CoverageMap Hardware Advanced Audio Alarm  Telephony

O Draw in Dots
(@ Draw Coverage Zone

100 5] RSSI Zone size (m)

Value (d5) | Description Color
» -65 | Excellent B 0, 125, 0
81 Normal [ 255, 165, 0
-97 | satisfactory [ 184, 134, 11
-113 | Poor . 139, 0, 139
0| Bad I 255, 0, 0

= Draw in Dots
For a more detailed data view, choose this option to display on the map,
dots of RSSI levels representing coordinate points.
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= Draw Coverage Zone
For a less detailed view, choose this option to configure and display on the
map, RSSI zones of average RSSI levels using GPS coordinates.
¢ RSSI Zone Size
Enter the size of the RSSI zone within which RSSI levels will be averaged.
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= (Click Add to add a new RSSI level.

¢ Value

Enter the minimum level for the signal range (for example, -65 means -
65 and higher).

e Description
Enter the name of the RSSI level to display in the system.

e Color
Pick a color for the RSSI indicator on the map.

To view RSSI Levels on the map, click the Location Tracking tab in the
Navigation pane, and on the Map pane toolbar, click Coverage Map. Then
set the Start Date and End Date to display RSSI data.

Hardware

¢ |n the Options dialog box, click the Hardware tab.

Options X
Sound Msp  CoverageMap Hardware Advanced Audo Alarm Telephon

3@ External hardwar n attach ar ddn al equipment to
(3 w\rrrhtm [fﬂts cm h dmn:mnh ete)

[ Use signaling device
Serial port: comi ~
Configure
External Devices
[ Name [Desaription
| Footswitch com3
{8 Microphone 1 TREOnet Mic Adapter
U5 keyboard Wired Keyboard 600

o add ELEdit X Delete

L] TRBORet Microphone Adapter

FistV @& TRBOnet Media Dock 2000
FrstT . TREOnet Footswitch
us & HID
ce X Directx
7 TiPRO

. COM

= Use signaling device
Select this option to use an external signaling device.
e Serial port

From the drop-down list, select the COM port the signaling device is
connected to.

= Click Configure and specify the duration of a signal and which call types to
include in signaling.

Signaling COM port X
Duration 0 EI: seconds
Private Cal
Call Alert
Alam

oK Cancel

The External Devices table displays the connected devices
(Type/Name/Description).
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Click the Add link, and from the pull-down menu select the type of
TRBOnet device with a PTT button connected to the PC (Microphone
Adapter, Media Dock, or Footswitch), or the device type (HID, DirectX,
TIPRO, or COM).

In the dialog box that opens, specify the desired device parameters and
click OK.

First VolP port

Enter the number of the first VolP port for audio communications (4022,
by default). Each additional Dispatch Console will create a connection on
the next port number.

First IP Camera port

Enter the number of the first IP Camera port for video communications
(13152, by default). Each additional Dispatch Console will create a
connection on the next port number.

Use proxy server
Select this option to enable a Proxy Server service in TRBOnet Dispatch
Console to access the Internet.

A proxy server can be used when a user's computer cannot be
connected directly to the Internet, but there is another computer with
Internet access in the network.

v" Click the Configure link to specify the alternative server settings.

Configure the proxy server X

Use an alternative server

Settings

Address: (1777113470

Part: 80

Authertication
Use authentication

L
Conce
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Advanced
¢ In the Options dialog box, click the Advanced tab.

Options. x
Sound Map  CoverageMap Hardware Advanced  Audio  Alarm  Telephony
Q% Advanced application options
e
Configuration Scope ~
() Per machine: all dispatchers share the same workspace
separate workspace for each Windows user account

e
[ suggest Queued Mes: when channel is busy or subscriber radio is offiine
[ Enable sticky PTT

Use 'Space’ key to press PTT Configure...

[ Enable Single PTT Select mode

Voice Options

[ Mute other dispatchers

[ Mute radio-to-radic private calls

[] Automatically unmute chanr hen transmitting audio

View Options

[ customize the automatic subscriber name pattern Canfigure...
[ show extended notes

E nitinformation detals
Show confirmation dizlogs
[ Show incoming text messages in a pop-up window v

Configuration Scope

= Per machine
Choose this option to store settings in a common place for all dispatchers
of the Dispatch Console.

= Per user
Choose this option to store settings for each dispatcher separately if they
are using different Windows user accounts.

PTT Options

= Tone and PTT when using external PTT device
Select this option to enable Alert Tone for all subscribers on a channel when
the dispatcher presses the PTT button on an PTT external device.

= Use Record Mode with external PTT device
Select this option to record all voice transmissions from external PTT
devices (Palm mics, Footswitches, and other devices).

= Suggest Queued Message when channel is busy or subscriber radio is
offline
Select this option to record a Queued Voice Message when a radio channel
is busy or subscriber is offline.

= Enable sticky PTT
Select this option to start and finish voice calls by a short press of the PTT
rather than holding the PTT down until the end of a voice call.

= Use 'Space’ key to press PTT
Select this option to use a hot key for the PTT. Click the Configure link, and
on the keyboard, press the key you want to assign as a hot key for the PTT
button.

= Enable Single PTT Select mode
Select this option so that only one PTT box can be selected at a time, that is
you can't have multiple selected PTT boxes.
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Voice Options

Mute other dispatchers
Select this option to mute all other dispatchers voice transmissions.

Mute radio-to-radio private calls
Select this option to mute all private calls on the channel.

Mute all channels when transmitting audio or recording a voice
message

Select this option to mute other channels when the dispatcher transmits
audio or records a voice message.

Mute the tone when receiving a Tone and PTT call
Select this option to mute the tone when you receive a Tone and PTT call.

Play a sound when starting a Tone and PTT call
Select this option to play the tone when you start a Tone and PTT call.

Automatically set channel to Solo when transmitting audio
Select this option to mute other channels when transmitting audio.

Automatically unmute channel when transmitting audio
Select this option to automatically unmute a channel when transmitting
through this channel.

View Options

Customize the automatic subscriber name pattern
Select this option and click the Configure link to set a custom alias for a
radio in the list of subscribers. Once the changes are made, selecting this

check box will cause a change to the radios in the Radio list pane (upper left

pane of the Main Interface screen).

Display Formats *

Radio display name:

=
Example: My Radic

Allocated radio display name:

| MNAME % (%0WINER %) -
Example: My Redic (John Smith

Allocated radio display name

(the owner has more than one radio):

| eNAME: (%OWNER %) =
Example: My Radio (John Smith)

Defaults Cancel

¢ Radio display name
Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for a radio.
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Format X

SEMAME %% (3CHAMMEL %)

BExample: My Radic (Master Station [ Channel)
Add Field:

Radio Callsign

Radio Owner name

Radio ID

Active Channel

Plate Mumber

Make

Phone Number

Email

cance

¢ Allocated radio display name
Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for an allocated (taken) radio.

¢ Allocated radio display name
(the owner has more than one radio)
Click the ellipsis (...) button and in the Format dialog box pick the fields
to display for an allocated (taken) radio in case when a user has more
than one radio.

o Click Defaults to set default settings for radio display.

= Show extended notes
Select this option to enable Extended Notes in the Dispatch Console.

The Extended Notes feature is intended to add predefined Extended Notes
templates, the same as for Extended Messages, for the selected calls and
events.

For example, a Taxi Dispatcher needs to check clients' calls response period
for the company internal monitoring of the employees. They can add a
predefined template and check the time period. All Extended Notes are
displayed in the Ext. Note column in the Recent Calls/Events tab:

Recent Calls/Events
8 Playback (=l Save || 1l Pause ¥ Clean ‘%3 Reload | [ Filter By Radio | = Grouping "/ Auto Filter » Default Settings | 7 Details ||[7] Show Notes "2 Add Note [ Extended Nots

Date V| Radio System Sender Recpient Message Ext, Note Note
5B 7/7/2014 3:48:5 AM Radio 11 Al Geofencing Alarm [Da
S8 7/7/2014 3:49:56 AM Radio 11 Al Radio leftallowed region

% 7/7/20143:47:524M  Repeater #1Slot 1 Radio 105 Dispatcher Administrator Accept 1
38 7/7/20143:41:244M  Repeater #15bot 1 Radioserver Radio 105 Telemetry status cann. ..
=% 77712014 3:40: 16 A Admiristrator Al test

7/7/20143:39:08 M Repeater #1Slot 1 Radio 105 Unknown group: 010 Radie Radio 105" calls .., View

S 7/7/2014 3:32:55 AM Administrator Radio 105 Dispatcher ‘Administra...

S /72014 3:18:43 AM 105 Al On Duty 2
n

[ 7/7/2014 12:56:40 AM  Intercom Dispatcher 1 Al
[ 7/4/2014401:354M  Intercom Dispatcher 1 Al

4| 4| 4| Record 54083 » | wv [ < »
Recent Calls/Events  RecentCals | Radio State  Active Tasks | Active Routes | User Actiity | Map

Click the Extended Notes button (1) to fill the template;
Click the View button (2) to see the Extended Note.

= Show latest note in Unit information details
Select this option to include the latest note about the radio state change in
the Radio information window (see section 6.5.1.3, Radio Pop-up Window).

= Show confirmation dialogs
Select this option to enable confirmation dialogs for dispatcher actions. For
example, when sending a configured Voice Message from the Dispatch
Console, the following confirmation dialog box will appear:
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TREOnet Enterprise 5.1 / Dispatch Console

0 Start 'Voice Message'?

= Show incoming text messages in a pop-up window
Select this option so that incoming Text Messages will pop up over the
application window.

File View Map Took Help
Volce Dispatch

FEEE IR ] "Recent Cos/venis -
Quick Commands. -
@ [ Clesnars g G —
" o - m— .
2 n &
el | e
.i.L"“* o 18 o018 13253 = B e H
2 tocation Tracking
4 rob Ticketing
| 5) Ao Tracker
[ ] Text Messages.
@ Ve Recording
{5 Evenviewer
(73] Radio mtocation
), Administration
122001 @ o | | Administ

= Show RTT notifications in a pop-up window
Select this option so that incoming Request to Talk messages will pop up
over the application window.

Request to Talk

: 125
’ The Request to Talk has been received.
_J You must accept or reject it.
Accept Reject Queue

= Close button minimizes application
Select this option so that clicking the Close button will minimize the
Dispatch Console rather than close it.

= Minimize button minimizes to Voice Bar
Select this option so that when you click the Minimize button you will see
only the Voice Bar displayed at the top of the PC's screen.

= Show this number of Recent Calls/Events
Enter the number of items to display in the Recent calls/Events pane.

= Measurement system
From the drop-down list, select either the Metric or the US unit system.

= Coordinate system
From the drop-down list, select the coordinate system to be used.

Audio
¢ In the Options dialog box, click the Audio tab.
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Options X
Sound Map  Coverage Map Hardware Advanced Audio Alarm  Telephony
Default audio devices: Confiwe
Recorder: Primary Sound Capture Driver
Player: Primary Sound Driver
Selected channel Defauits A
Recorder: [pefautt =]
Player: [pefautc ~|
Speaker: [Defautt ~]
External PTT: [ ~|
Indicator: [ ~]
Unselected channek Defauits
Recorder: [pefautt =]
Player: [pefautc ~|
Speaker: [Defautt ~]
Indicator: F ]
System sounds: Defeults
Player: [pefautc ~|
Speaker: [Defautt ~]
[ =],
Reset All audio devices to default Manage Custom Modes
Cance

Default audio devices

= Recorder
From the drop-down list, select the recording device the microphone is
connected to.

= Player
From the drop-down list, select the audio device to play incoming voice
messages and playback voice recordings in the Dispatch Console.

Note: If TRBOnet Dispatch Console is running on the same PC
with TRBOnet Server connected to control stations via a
programming cable and sound card, the playback and
recorder devices cannot be the same for TRBOnet Dispatch
Console and TRBOnet Server.

= Selected channel
Select the recorder, player, speaker, and external PTT device for radio
channel boxes which are selected in Dispatch Console.

= Unselected channel
Select the recorder, player, and speaker for the radio channel boxes which
are not selected in Dispatch Console.

= System sounds
Select the player and speaker for the system sounds.
For the list of system sounds, see section Sound (page 120).

= Alarm
Select the player and speaker for the alarm sounds.

= Telephony/Intercom/Private Calls
Select the recorder, player, speaker, and external PTT device for the
appropriate voice boxes.

= All Call/Groups/Slots
Select the recorder, player, speaker, external PTT device and volume level
for the appropriate voice boxes.
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Alarm

¢ In the Options dialog box, click the Alarm tab.

Options X

Configure display options for radios in alarm mode:

Alarm Panel: [Main Window

Call Button: [none

[KA[EN

Always show radio on map
[ Display camera in new window

[ Display racio in new window

Select map

Canc

= Alarm Panel

From the drop-down list, select where to show the alarm panel (in the main
window or in a new window), or select ‘None' to hide it.
= Call Button

From the drop-down list, select the call destination when the PTT button is
pressed in the alarm panel (private call, group call, or all call).

# Radios in Alarm -

6235 x

Request Location
PTT Copy Coordinates
Find on GPS map

Find on Beacon map

GPS: 18 Jul 2018 17:01

Region: Region 1

Coffee 18 Jul 2018 17:01
125 x
Emergency Call

Request Location
P I I Copy Coordinates
Find on GPS map
Find on Beacon map
Beer

GPs:
Region:

18 Jul 2018 16:58
18 Jul 2018 16:57
Region 1

Reset Al Minimize

= Always show radio on map

Select this option so that radios in alarm mode will always be displayed on

the map regardless of the filters applied to the radio (see section 6.6.2.4,
Filters).

Note: When this option is selected, you cannot disable the display
of radios in alarm mode.
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= Display camera in new window
Select this option so that when a radio is in alarm mode, a window will
open with the camera associated with the radio.

= Display radio in new window
Select this option to display a radio in alarm mode on the selected map in a
new, separate window.

e Map
This field displays the map name. Click the Select map link and specify
the map on which to display a radio in alarm mode.

125 - o0 x

& il Fiker (B @] Q@68 57 Show Beacons: Al ~ | & O, FindonMap~ L | # Drawing Panel | 7 Route -

Bloom 2

e au U0 spala0

Lattude: 53°5626.78" N; Longtude: 301646 14"E

Telephony
¢ In the Options dialog box, click the Telephony tab.

Options X
Sound Map  CoverageMap Hardnare Advanced Audio Alarm  Telephony
Queue allincoming telephane calls
Show this number of Recent Phone Calls: 10 =
Ringtone configuration
Incoming €all | Call Waiting | Held Cal
Call Priority Ringtone Action
Normal: Default b play
Emergency: Default b Play
High: Default b Play
Low: Default b Play
Cance

* Queue all incoming telephone calls
Select this option so that when the telephone line is busy, incoming calls
will be queued rather than rejected.
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= Show this number of Recent Phone Calls

Enter the number of items to display in the list of recent calls. The list of

recent phone calls appears when you click the arrow on the right of the dial

string in the Telephony box (see section 6.5.9.1, Phone Calls from/to

Dispatch Console).

Ringtone configuration

On the Incoming Call (Call Waiting) tab:

e Click a corresponding link in the Ringtone column, and from the pull-
down menu, select either Set Default, Set Custom, or Disable.
If you select Custom, in the dialog box that opens, browse for the audio
file on the local PC and click Open.

e Click a Play link in the Action column to play back the corresponding
ringtone.

On the Held Call tab:

¢ Remind after
Enter the timeout, in seconds, that will be used for playing the reminder
tone when a call is on Hold.

¢ Ringtone
Specify the reminder tone to be played when a call is on Hold.

6.3.4.2 Exporting/Importing Options

6.3.4.3

132

A dispatcher can export custom Dispatch Console settings (Volume level, Ul view,
hotkeys configuration, and other settings) as a .config file and save it to the local PC
or to a selected external device.

e Click Tools > Export Options and save the file to the specified location.
If you want to apply settings from a different TRBOnet Dispatch Console:

e Click Tools > Import Options and browse for the .config file with the desired
settings.

Exporting/Importing Objects

A dispatcher can export/import various types of objects, such as beacons, map
objects, map routes, maps regions, radio users, and radios.

To export objects:

e C(lick Tools > Export Objects.

In the dialog box that opens, enter the following information:
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/®

= Object Export - m} X
Objects: Radios F
Beacons
Radio ID Radio Mar Map Objects Block outgoing calls | CAR_MAKE DESCRIPTION | EMAIL
Map Regions -
K 125 Radio 125 Map Routes False tester@gmai
W 235 Radio 23¢ Radio Users False
W 4494 PYEPRR Radios False
W 240 Radio 240 False False
W 230 Radio 230 False False
Wl 235 Radio 235 False False
W 27 Radio 27 False False
/] 155 Radio 155 False False
/] 16500000 Radio 16500000  False False .
= . . . -
Select All Deselect Al Export
.
= Objects

neocom
SOoftware

From the drop-down list, select the type of objects you want to export.

= |n the table below, select/deselect the desired records.

= Click Export, and in the Save As dialog box, locate the folder where you
want to save the file, type a filename, and click Save.

To import objects:

e Click Tools > Import Objects.

In the dialog box that opens, enter the following information:

/v Object Import
Objects

Object Properties

Login

Name

Password

AlDevices

AllowArsLogin
AllowDtmfLogin
AllowTmsLogin

ArsLogin
BlockIncomingPhoneCalls
BlockOutgoingPhoneCalls
CAR_MAKE
DESCRIPTION

[] Passwords encrypted

Radio Users

y Beacons

| Map Objects
Lg Map Regions
¢ Map Routes
P Radio Users.
) Radios

AllowArsLogin
AllowDtmfLogin
AllowTmsLogin

ArsLogin
BlockIncomingPhaneCalls
BlockOutgoingPhoneCalls
CAR_MAKE
DESCRIPTION

Impaort

= Objects

From the drop-down list, select the type of objects you want to import.

= In the table below, in the right column, enter/change the column names
that would correspond to the database field names.

= Passwords encrypted

Select this option if the passwords are encrypted in the data being

imported.

= Click Import, and in the Open dialog box, locate the desired file and click

Open.
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6.3.4.4 Setting Language

e On the Tools menu, click Set Language

Select Language x

Language: E

= From the drop-down list, select the desired language and click OK.
The changes will apply after you restart the Dispatch Console.

6.3.4.5 Changing Password
e On the Tools menu, click Change Password

Change Password x

»?\5) Change Password

Old password: | ooooo |

MNew password: |uuu |

Repeat password: |uooo. |

Cancel

= In the Old password box, enter your current password.
= In the New password box, enter the new password.
= In the Repeat password box, enter the new password again.
= Click OK.
6.3.5 Help

e Help > Send Feedback
Click this menu item to send your feedback to Neocom Software, either
through E-mail, or online via the site.

e Help > Save System Logs
Click this menu item to save the logs as a .zip file. This .zip file can then be sent
to Neocom support.

e Help > About
Click this menu item to see the About dialog displaying information about
TRBOnet Enterprise (applied license, version, build date, and other relevant
information).
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6.4 Administration

This section describes how to configure the most important settings of
TRBOnet Enterprise.

e Click the Administration tab (1), and see the full system information in the
Server (2) pane:

File View Map Tools Help

Administration & ]S

0 EE- e oEE LR el
[ Database rou ¢ rou [-1][][@] 88 ¥ Group 30 [2][«][@]
L.l Radio Systems
+-.sBg System Eridging
-G Telephony I~
L Tacks = ( L - '\
@ Administration
{14 voice Dispatch Select an item in left menu to administer.
Licensed to:
) demo
@ Location Tracking Bema License
Server is available
ﬁ Job Ticketing
CapacityPLUS
Plus (Departmentl)
g Route Management Data {Data)
mumber: $83TMGS110
Version: 2607
|5]| RFID Tracker CapacityPLUS: Private Cal
mumber: $94TMG110
Version: 2607
CapacityPLUS: All Call
[ e Serisl mumbers 4S5TMGS110
Version: 2607
" CapadtyPLUS: Group #10
G voiceRecondn ol e
Version: 2607
CapacityPLUS: Group #20
() Reports S momter, 503110
Version: 2607
i CapadtyPLUS: Group #30
{5 EventViewer Serial numbers 494TMGILID
Version: 2607
*3] Radio Allocation Telephony
\ Service & avaisble /
e
(127001 £ @, |  Administiator | (8 Licensed to: dema Dem License | @ Active -

6.4.1 Database

¢ Go to Administration (1), Database (2) to see the full overview of the
database:

File View Map Tools Help

Administration Database

g e * | W5 & e free < e s Alcal
[ 0atabase Mcow 10 P Group 20 [][«][@] |8 ¥ Group 30
ih Radio Systems
B System Briding 2 [JPrivate call [0][<]
?; Ie‘ip*‘“”" o || & Backup | O schedute
E\E‘J Voice Dispatch u Database Information
Server name: {local)\SQLEXPRESS
sk Location Trackang Datebase name: TREONet
Backup date: 25-0ct-2016 16:28:26
ﬁ Job Ticketing Database version: Mirosoft SO Server 2014 (5P2) (B3171021) - 12.0.5000.0 064)
Jun 17 2016 19:1
Copyright (<) Mmsn& Corporation
R-llel‘l-l-r:_il Express Edition (64-bit) on Windows NT 5.3 <X64> (Buid 10586: )
@ RFID Tracker Data size: 17.23M8
Audio size 2.77v8
[] Text Messages
ﬁ Voice Recording
@ Reports
Event Viewer
EEI Radio Allocation 1
i
H 127.00.1 Administrator | (4 Licensed to: demo Demo License Active >
] £ = (]

In the Database pane, the administrator can restore and back up the database
and audio recordings.

For more details on backups, see Appendix D: Backing up and Restoring Database
and Audio Recordings (page 344).

6.4.2 Radio Systems

All radio systems registered in the Server are represented on the Radio Systems
pane.
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Go to Administration (1), Radio Systems (2) to see the system parameters:

File View Map Tools Help

Administration Radio e € |0)
g e * | % 1 e ree [<][2] I B mtercom maE e Plislel
(1l Database ¥ rown 10 [2][«][@] | ¥ Group 20 [2][«][@] S ¥ roup 30 [2][«][@]
e Radio Systems|
3 System Bridging | S []l«]
@:E‘Th""’ 2 || 2 Properties
System type System ID Caption
E‘E‘E‘ Voice Dispatch +// Intercom Intercom
o/ Phone Telephony
E Location Tracking /" Capadity Plus Department1 CapacityPLUS
@ Job Ticketing
Ej Route Management
@ RFID Tracker
[] Text Messages
ﬂ' Voice Recording
C‘e Reports.
Event Viewer
EE] Radio Allocation / 1
., Administration e
16| ¢ | Record 10F3 ¢ [ [mm] < »
127001 &3 B | § Administrator | (28 Licensed to: demo Demo License | @ Active-

The administrator is able to see the following radio system parameters in the table:

System Type — the type of the system.

System ID - a unique System Identifier configured in TRBOnet Server
configuration for repeater or control stations in the system.

Caption — the caption of the system.

6.4.2.1 Radio System Properties

To see the radio system properties, do the following:

136

Select a radio system in the list and click the Properties button (1);

or,

double-click the radio system in the list;

or,

click the corresponding element at the bottom of the Dispatch Console
window, and choose Properties (2).

file View Map Tools Help

Rado Sy FEE
g el * | W% e free PG ntercom F3uical
3 Databare Facroun 10 pEE (VB pEE (vErD Pl
’% [Jrrivate cal
@ Telephony

LF Tacke

«l@]

<

T Properties

System System 1D Caption
(i) voice Dispatch -/ Intercom Intercom
' Phone Telephony

Location Tracking «ff Capacity Plus Department1 CapadityPLUS

ﬁ Job Ticketing
Route Management
@nmnmdu

[] Text Messages

E\ﬁ'ﬂﬂnﬂnﬁg
(2 Reports
Euu!t\lizwzl

2

T
«| < |Record 10F3 » [ |m] <] »

127001 &3] & Administrator

Licensed to: demo Demo License | © Active~
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The administrator is able to see Active and Inactive registered systems. In case you
have more than 10 registered systems, systems are grouped and can be seen in the

drop-down list.

Common information for all system elements is listed below:

Description tab

On the Description tab, you can see the general info:

e System Type

Repeater #1: Slot #1

Description  Channels  Transmits

System Type: |IP Site Connect

System ID: |Department1

Caption: |Repeater #1: 5l

ot #1

The system type for a repeater/control station (in Digital or Analogue mode).

For more details on the systems, see section 3.2, MOTOTRBO Radio Systems

(page 4).
e System ID

The Unique System Identifier configured in TRBOnet Server for a repeater or
control stations in the system.

e Caption

Enter the system name.

Channels tab

On the Channels tab, you see the list of channels:

Repeater #1: Slot #1

Description  Channels  Transmits

7' Properties Control | =5 Reset

‘ Name Voice Data
.. Repeater #1: Slot #1 RX, TX RX, T
Channel for private and phone calls:

e Click the Properties button to see the channel additional data:

137



&

neocom
sofFtware

138

Repeater #1: Slot #1 *

Description  Talk groups ~ Volume

D: |8:cc8f18-a3e64b4f—b8&7—56 1le19debceb

Mame: |Repeater #1: Slot #1

Type: [MoToTREG Repeater

Mode: |IP Site Connect

Connected

Serial Number: [as4TMG4110

Firmware version; ‘2.6.0.7

= ID
Default registration number (manufacturer’s number);

= Name
System element’s name in the system;

= Type
System type for a repeater/control station (in Digital or Analogue mode).

= Mode
System type for a repeater/connection mode for a control station.

For details on the control station modes, see section 5.9.5.1, Control Station
Connection Modes (page 46).

= Connected

¢ Serial number
Default system element'’s serial number (manufacturer's number).

¢ Firmware Version
Current system element’s firmware version.

Click the Reset button to test the connection to the system element.

Note: For a repeater, clicking the Reset button reconnects the
repeater.
For a control station, clicking the Reset button reloads the
radio.
Talk groups tab (for repeaters only)

= On the Talk groups tab, you can see selected Talk group info:
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Repeater #1: Slot #1

Description  Talk groups  valume

Specify available talk groups

[v | All Call
[v |Firemen
[ |Police

neocom
sofFtware

= Specify available Talk groups for the system element in the list of created

Talk groups.

Selected Talk groups are available on the Radio tab in the system element
box in the drop-down list:

RX JTX

-

(_D Repeater #1: Slot #2 [%:]
All call E
Firemen
Police

Note: Close TRBOnet Server before applying the system element

settings.

Volume tab (for repeaters only)

= On the Volume tab, you can see Volume settings for the repeater:

Repeater #1: Slot #1
Description  Talk groups  Volume

& &

RX ™
Reset Reset

[ Configure system volume

e Specify the RX and TX volume levels for the Repeater using a volume

control slider.
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e Click the Reset link to set default volume level for RX or TX.

¢ Configure system volume
Select this option to save default volume settings for Voice transmissions
from the selected Repeater.

Transmits tab

e On the Transmits tab, you can see the information about audio and data
transmissions:

Repeater #1: Slot #1 b4
Description  Channels  Transmits
Record Audio
[] Manage Audio by DTMF
Cance

= Record audio
Select this option to enable audio recordings for the selected repeater.

= Manage Audio by DTMF
Select this option to manage audio on the selected channel by specified
DTMF tones.

¢ Mute channel
Enter the DTMF sequence to be used to mute the selected channel.

¢ Unmute channel
Enter the DTMF sequence to be used to unmute the selected channel.
6.4.2.2 Intercom Properties

e Select Intercom in the list and click the Properties button;
or,
double-click Intercom in the list of radio systems.

Channels tab

On the Channels tab, you see the list of Intercom channels.
These are the dispatcher groups you added in TRBOnet Dispatch Console (see
section 6.4.19, Dispatcher Groups).
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Transmits tab

Intercom X
Description  Channels  Transmits

Record Audio
Voice Call Hang Time (ms):

Group Call: 3000 3:
Private Call: 4000 L
TX Timeout: &0 El: seconds

= Record Audio
Select this option to record all audio transmissions over the Intercom
channel.

Voice Call Hang Time (ms):

= Group Call
This value sets the duration of reserving the channel after the end of a
group call transmission. During this time, only members of the dispatcher
group that the channel is reserved for can transmit.

= Private Call
This value sets the duration during which the private dispatcher call setup is
kept after a dispatcher releases the PTT button. This is to avoid setting up
the call again each time a dispatcher presses the PTT button to transmit.
During this time, other dispatchers can still transmit since the channel is
essentially idle.

= TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When the
dispatcher starts a voice session over the Intercom channel, transmission
will be interrupted after this TX Timeout expires.
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6.4.3 System Bridge

TRBOnet Dispatch Console provides the System Bridge function that allows
configuring the network for redirecting radio calls.

The administrator can create the following two types of system bridges:

1. System Bridge for Radio Channels - allows connecting all types of Radios
(analogue and digital radios, supports IP Site Connect, Capacity Plus, Linked
Capacity Plus and Connect Plus modes). See section 6.4.3.1, Radio Bridge.

2. System Bridge for Repeaters (Binary Patch) - allows connecting only the
repeater slots between IP Site Connect systems without encoding/decoding
voice and data. See section 6.4.3.2, Binary Patch.

To add a system bridge:
e Go to Administration (1), System Bridge (2).

5§ TRBOnet Enterprise 5.3 / Dispatch Console

- o x
File View Masp Tools Help
Administration B ||
B‘S;Wi EEEEE 2 | 1: tne free " @ W ntercom [« B W [vaintenace D) (mETE [@]«]=]
(1 Database [JGroup 10 [@sEe) (WEE [20] () B N [ Jevercency crowp  [o0] (4] B [ JRecular cerowe [3)] (] [E)
) Rad
L Red Syatens [ Jsiot 1 D) EErE D) s D<) BT B2
-G Telephony 2 [ Jeroup 11 B3(@] BN [ J6roun 22 [«<[E) (WEEE [2)] B[] [ ]Private cal [« |=)}
G Tasks v
< 5 Mdrreren B<]E]
A, voice pin 5 Add|- =) Edit | [k Delete
A
[l Locotion Trcka Binary Patch (for IPSC Systems only)
Iy Radio Bridge Private calls
0 sob ke 4l Radio Bridge Rado Bridge
[] Text Messages
Q Voice Recording
ey
Event Viewer
EEI Radio Allocation / 1
F—
| «| 4| Record 20F 3 | m|m 4] »
[ Connected &3 B B B B | ¥ Administrator | (28 Licensed to: demo (Wa) Demo License |2 @ Active-

e Click the Add button, and from the drop-down menu, select the System
Bridge type (3).

6.4.3.1 Radio Bridge

Radio Bridge X

Name: [Fremen-poice
Work Mode [channets redirect the cals to each other ~|
PTT Button: IAMays Enabled ~|

Channels | Parameters

Channels to redrect calls

Radio System Group Mode

Control Station #1 Any Groups Always

Repeater #1: Slot #1 \;} Any Groups \ Nway]

P Add X Delete

o

* Name
Specify a name for the Radio Bridge to display in the Radio Interface pane.
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= Work mode
Select the work mode from the drop-down list. For more details on System
Bridge types, see Radio Bridge Types (page 144).

* PTT Button

From the drop-down list, select how to display the PTT button in the
System Bridge box. There are 3 options available:

e Enable when Bridge enabled
e Always Enabled
e Invisible
= On the Channels tab, click the Add button (1) to add a channel to the list.

= In the Radio System column, select a radio channel from the drop-down
list (2).

= In the Group column, select available group for the radio channel (3).

= |n the Mode column, select a mode for the radio channel (4).

e Always
Enables the System Bridge always, regardless of the radio state
(online/offline).

¢ By Radio
Enables the System Bridge on a selected channel when there are online
radios capable to receive voice calls from the selected group.

= On the Parameters tab, specify call types for the System Bridge:

Radio Bridge X

Name: [Fremen-poiice

Work Mode [channeis redirect the calls to each other =l

PTT Button: [tenisible =l
Channels | Parameters

‘Specify call types for System Bridge:

¥ veice call ¥ Text Message
I chedk Radio [ Telemetry

I EnableDisable Radio ¥ Location (GPs)
I call Alert I user Data

¥ Emergency Alert

o

= Select call types to use in System Bridge mode.
= Click OK to add a System Bridge for the radio channels.

The System Bridge boxes are displayed on the Patch panel of the Radio
Interface pane:
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File View Map Tools Help

R 151
Radio Interface  Recent Calls/Events
Start Voice Message ~
i Joice M
Voice Message
[, | Freechamel ~
—
Drag and Drop PTT Box here to
create new group
Group 10 [9] [«
S| Police System Bridge
(S| Administrator capaci
pacity... [
B Foice alcal P
CapacityP...
¥ Group 20 ] el Cleaners
Firemen Firemen - Police |
PTT S @ Copaca
u e (]
@ capadityP...
[ Group 30 [ [« [@] v Firemen v
Recent Calls/Events
5 Playback [ Save~ () Print | 11 Pause ¥ Clear ~ &3 Reload | [ Filter By Radio
Date |Radio System | sender  |Recplent | Message Detais | mote |
18-Nov-2016 17:18:52  CapacityPLUS Administrator Firemen Dispatcher ‘Ad . Members: Administrator B
18-Nov-2016 17:18:52  CapacityPLUS Administrator Police Dispatcher ‘Administra... Members: Administrator
18-Nov-2016 17:18:49 CapacityPLUS Administrator Al All Call from dispatche... Members: Administrator
18-Mov-2016 17:16:31  CapadtyPLUS 125 Al All Call from '125" (00:01) Members: 125 A
|| 4] Record1ofe72 WM 4| 3
Recent CalefEvents  Recent Cals | Requestto Tak | Rato State | Acive Tasks | Actve Routes | ser Acvity | Map || Cameras |
127001 &3 B | § Administrotor | [ Licensed to: demo Demo License | @ active~

Radio Bridge Types
1. Channels redirect the calls to each other
This is the most common type of System Bridge when data exchanges

between the channels set in the System Bridge settings. Thus, there is a
common channel for all the subscribers of the specified control stations:

To create this type of System Bridge, add a System Bridge and set the Work
Mode as Channels redirect the calls to each other.

S [

Y
)
(//// e Call via System Bridging: \\//_/,//
A\ \
VvV \
Analogue MOTOTRBO
Radio Capacity Plus
network

Analogue / Capacity Plus
Control Station L Control Station

TRBOnet
System
Bridging

k Y

9
Digital 1P Site Connect \.////
Control Station Control Station \\/

e Call via System Bridgi MOTOTRBO IP
Site Connect

Digital Radio
network

2. A channel redirects calls to many channels

To create this type of System Bridge, add a System Bridge and set the Work
Mode as A Channel redirects calls to many Channels.

3. Many channels redirect calls to one channel
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O

22N

Radio network

To create this type of System Bridge, add a System Bridge and set the Work
Mode as Many Channels redirect the calls to one Channel.

Redirect private calls
Select this mode so that private calls can be redirected between radio systems.
Redirect private calls to group calls

Select this mode so that private calls will be redirected to group calls within
one radio system or between radio systems.

6.4.3.2 Binary Patch

Binary Cross Patch (IPSC Systems only) X

Name: Binary Patch
Rules
Rule Lof2

siot: slot 1 ] voice o Data

Al Calls Private Cals W Group Calls
Groups: (Al Groups)

Repeaters: (Al Repeaters)
Rule 20f 2

Slot: Slot2 Voice Data

¥ Al calls W private calls Growp Cals
Groups: (All Groups)

Repeaters: (Al Repeaters)

ik Add X Delete

Cone

Name
Specify a name for the Binary Patch to display in the Radio Interface pane.
Rules
Specify the rules for redirecting calls between IPSC systems. Click the Add link
below to add a rule.
= Slot
From the drop-down list, select the slot (Slot 1 or Slot 2) of the IPSC
systems being connected.
= Select the type of data: Voice and/or Data.
= Select the call types: All Calls, Private Calls, and/or Group Calls.
= Groups
In the drop-down list, select the group(s).
= Repeaters

In the drop-down list, select the IPSC systems to be connected via the
selected slot.

The Binary Patch boxes are displayed on the Patch panel of the Radio Interface pane:
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Radio Interface

Radio Interface| Telephony | Recent Calls/Events

a ‘R Online Dispatehe.
B administrator

O Online, Indaor (0)
Q Online, GPS Fixe

() Online, No GPS (0) ntrol Station #1 [erou1
& () Offine (2)

r”_'j Free channel r”_'1 Free channel

- i cal Charnel 4 — Eiremen

Drag and Drop PTT Box here to
eate new group

[Jeroup2 [JRepeater #1: slot #1

r—q Free channel h Free channel

PTT e chame PTT ree channe Patch on Repeaters
Police — allcal Einary Patch

Radio Bridge

Cancan
Repeater ...
Firemen

r—j Free channel
PTT Control St...

— e Any Groups

[[] repeater #1: Slot #2

[y Freechamme
PTT
—

Recent Calls/Events
%) Playback |l Save~ ) Print | 11 Pause <¥ Clear - &i Reload | ‘[ Filter By Radio | = Grouping "7 Auto Filter € Defauh Settings || 4 Details |
Date | Radio System | sender |Recpient | Message | Detais [ Wote [Ext.rvore |
17-Oct-2016 14:21:07 Repeater #1: Slot #1 125 Al All Call from '125' (00:01)  Members: 125 -

17-0ct-2016 14:21:06 Control Station #1 Dispatcher Al All Call from dispatcher *...

17-0ct-2016 14:21:02 Control Station #1 Dispatcher Al All Call from dispatcher *...

17-Oct-2016 14:20:57 Control Station #1 Dispatcher Al All Call from dispatcher .

17-Oct-2016 14:20:51 Repeater #1: Slot #1 125 Al All Call from '125' (00:01)  Members: 125

AT-0re-2N1A 1420051 Crntral Statinn 21 Nisnatrhar an Al Al fram Aisnateher A
w4 4] Record 10F 333 v mm[ 4] »
‘Recent CallEvents | RecentCals | Redo State | Active Tasks | Active Routes. | User Ackity | Map | Cameras
127001 &3 B B B | & Administrator | [ Licensed to: demo Demo License | @ Active~

Note: System Bridges can also be created by drag and drop of the
PTT boxes in the Radio Interface pane. It is a temporary
System Bridge, which will be deleted after reconnecting to
TRBOnet Server or exiting TRBOnet Dispatch Console.

6.4.4 Telephony

This section describes how to configure the telephony system.

e Click Administration (1), and then Telephony (2) to configure incoming and
outgoing SIP calls:

File View Mep Tools Help

Administration Telephony
[ server ~

28 License O 1: Lne free [+][2] P tntercom Mo 10 pl[][e]

(1 Database 3 2 call P Group 20 M Grop 11 [2][«][@]
iz Radio Systems

i dosrens Gows LLO

] Configure Calls | Extensions | Redrrect Calls | Aliases | Profies
@ Tasks 2
2] Virtual Modbus Devices N N
5 1P Cameras Radio calls configuration
(55} Event/alarm Management Allow subscribers to make outgoing cals: Yes
(8] swift Event Profiles Allow to use DTMF: Yes
[ Telemetry Allow to use Text Messages: Yes, Prefix: 'sip:’
(G Radio Groups Telemetry Play the incoming call tone on the radio After the called party answers the call
L Telemenry #1 Initislize cal to radio Start transmission
£y Rado stauses Initislize cal tmeout: Unlimited
(B Group Radio Statuses
5, S profe Exeaute Check Radio before cal No
() s Profie #1 v Send Text Message if cannot establish call Yes
Piay tone when PTT changed: ves
DTMF Access code: 0
DTMF Deaccess code: *

_cotare o3

TIncoming calls configuration
Call to Dispatch Center: Redirect to dispatchers
Cal to external number: Dedine calls

Extension numbers (voice menu)

Start cal automaticaly Yes

Maximum number length: Uniimited, Accept code: #

Number Call Desaription

0 Calldispatcher (any available)
<Number> Callradio with Radio ID = <Humber>

Configure |4———‘ 4

[ 127001 &3 € | @ Administrtor | (8 Licensed to: demo | @ Active-

6.4.4.1 Radio Calls Configuration

e Click the Configure button (3) to set radio call configuration parameters:
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TRBOnet Dispatch Console / @

Radic calls configuration *

¥ allow subscribers to make outgoing calls
v Allow to use DTMF
v allow to use Text Messages

Prefix: sip:

Play the incoming call tone on the radio: |Af‘ter the called party answ... j

Initialize call to radio: |Start transmission j
Initialize call imeout: Unlimited 3: seconds

[ Execute Check Radio before call
¥ Send Text Message if cannot establish call

¥ Play tone when PTT changed

DTMF Access code: o

T

DTMF Deaccess code:

Cancel

Allow subscribers to make outgoing calls
Select this option to enable outgoing phone calls from the radio subscribers.

Allow to use DTMF
Select this option to allow radio subscribers to dial the phone number as a
sequence of DTMF tones.

Allow to use Text Messages
Select this option to allow radio subscribers to initialize phone calls via sending
TMS messages with a specified prefix to the dispatcher.

= Prefix
Enter the standard prefix for a text message.

Play the incoming call tone on the radio
Select the mode for playing the incoming call tone on the radio that initiates a
call.

= After the called party answers the call
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS
message, the incoming call tone will be played on the radio after the called
party answers the call.

= Immediately
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS
message, the incoming call tone will be played on the radio immediately
that is without waiting for the called party to answer the call.

Initialize call to radio
Select the option how to start a call on a radio.

= Start transmission
Select to start a call to a radio automatically.

= Send ringtone
Select to play a ringtone until the radio user presses the PTT.

Initialize call timeout
Specify a timeout that defines how long to attempt to connect to the called

party.
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¢ Execute Check Radio before call
Select this option to execute a Check Radio command before placing a call.

¢ Send text message if cannot establish call
Select this option to send a text message to the radio when the channel is
busy and a phone call cannot be established.

¢ Play tone when PTT changed
Select this option so that the phone will sound a tone when the remote radio’s
PTT is pressed or released.

e DTMF Access Code
Set the value to that configured for the radios as Access Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

e DTMF Deaccess Code
Set the value to that configured for the radios as Deaccess Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

6.4.4.2 Incoming Calls Configuration

Click the Configure button (4) to set incoming call configuration parameters:

Incoming calls configuration x
Call to Dispatch Center:  [Open voice menu ﬂ
Call to external number: |Use number as Internal ﬂ
Extention numbers (voice menu)

[V Start call automaticaly

Man. number length: Unlimited 3: Accept code: £ -
Number Call Description

1] Call dispatcher (any available)
<Number > Call radio with Radio ID = <Mumber =

= add 5 Edit [Sk Delete

e Call to Dispatch Center
Select the mode for handling incoming calls made to the dispatcher.

Decline calls
All incoming phone calls will be declined.

Open voice menu
When an incoming call arrives, the subscriber will hear Voice menu
commands.

Redirect to dispatchers
All incoming voice calls will be redirected to all dispatchers of the Dispatch
center and any free dispatcher will answer the phone call.

¢ Call to external number
Select the mode for handling incoming calls made from unregistered

subscribers.
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= Decline Calls
Select this option to decline all phone calls from unregistered subscribers.

* Use number as Radio ID
Select this option so that the system will use unregistered numbers as a
Radio ID and start a Private Call.

= Use number as Internal
Select this option to allow the system to read unregistered numbers
according to Voice Menu rules.

Extension numbers (Voice menu)

o Start call automatically
Select this option to search for the number in the Extensions table
automatically. When this option is disabled, the subscriber must dial the
number according to the following example: 0(phone number)#. The
character # is used to search for the phone number in the table.

e Max. number length
Specify the maximum number of characters allowed in a phone number.

e Accept Code
Specify the character that will be used to finish dialing the number.

All available numbers are listed in the table below.
e Click the Add link to add a number to the table.

To add a static number

= Choose Static number.

Extension number >

{* Static number

" Dynamic number

Number: 123456

Call Type: |Ca|| Group j

Channel: |C0mm\ Station #1 j

Group: |AI\ Call j
Cancel

= Number
Enter a phone number to add to the table (contact list).

= Call Type
Select the call type from the drop-down list.

¢ Call Dispatcher
Select this type to make a phone call to the dispatcher.

e Call Radio
Select this type to make a phone call to the selected radio.

e Call Group
Select this type to make a phone call to the selected group.
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= Channel

Select the channel to make a group phone call through (available for Group
Calls only).

= Dispatcher/Radio/Group
Select the dispatcher, radio, or group depending on what you have selected
in the Call Type box.

To add a dynamic number

= Choose Dynamic number.

Extension number x

" Static number

% Dynamic number

Prefix: | 127

Call Type: |Ca|| Radio

|Autc- Detect

|Detacted by Radio ID

tbbb

= Prefix
Specify a prefix to type in on the keyboard.
= Call Type
Select the call type from the drop-down list.
¢ Call Radio
Select this type to make a phone call to a radio.
e Call Group
Select this type to make a phone call to a group.
e Call Phone
Select this type to make a phone call to a telephone.
= Channel

Select the channel to make a group phone call through (available for Group
Calls only).
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6.4.4.3 Adding SIP Extensions
e Click Administration (1), Telephony (2), Extensions (3), Add > SIP Phone (4)

File View Map Tools Help

Administration Telephony
5 server ~
[ Licen

i [l Dat tab
{5l Radio Systems

'v%'s tem Brid @Add » Edit Delete —Groupg \/ Auto Filter 'ADaf ult Settings

b ystem Bridging

G retony 4= 2 oo

L Tasks & TRBOnet bile Client Internal PEX Server

ﬁ Radio 125 125

,9_55 Voice Dispatch B Rado 2 .

Location Tracking

Route Management

[] Text Messages

o &

1

4| 4| 4 | Record 10f3 b | m M| 4 3

[ 127.00.1 &5 | § Administrator | [ Licensed to: demo Demo License @ Active -

In the Phone User dialog box, specify the following parameters:

Phone User >
SIP ID: 2403
SIP Name: |walt
Caption: |Walt
Password: | -----
Password {repeat): | ----- |
= SIPID
Enter the SIP ID that will be used by the phone user.
= SIP Name

Enter the SIP user name that will be used by the phone user.
= Caption
Enter the caption to be displayed for the phone user.

= Password
Enter the password for the phone user to be authenticated by the
telephone system.

= Password (repeat)
Enter the password again.
6.4.4.4 Redirect Calls

If a dispatcher doesn't take a phone call within the set period or they have changed
their status to unavailable, the call is automatically forwarded to a specified
dispatcher, radio, radio group, or phone account. This can be useful during night
shifts when no dispatcher is available.

e Click Administration (1), Telephony (2), Redirect Calls (3), Add (4).
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File VWiew Map Tools Help

Administration Telephony & |0
i Radio Systems ~ - _ -
| & System Bridging £ L Line fres [«][@] B [ ] mtercom [=a]
— Fldisp 15 @Ee) [~EE B « =)
ections X B
N > Configure Calls_| Extension: rect Calls | Aliases [ Profies
B pdd B Edit Delete g ‘\/ AutoFilter @» Default Settings
(1), voice Dispatch
Drage @ ol g et Call N3 X
Location Tracking callo | |
Call to:
ﬁ Job Ticketing 4 Target: & Dispatcher 1 -
: 30 =
Timeout: + | seconds
Redirect to:
L tea Type: @iFadoGrow T,
ﬁ Voice Recording Radio System: Slot 1 -
- Target: [} Firemen -
Event Viewer
Priority: Normal -
7] Radio Allocation 1
/ OK Cancel
I
p— 4
16| | 4 |Record0ofo v [ w|w] «] 3
Br2roo B B € Administrator | £ 21 days before your Support expires | [ Licensed to: demo. @ Active~

In the Redirect Call dialog box, specify the following parameters:
Call to

= Target
From the drop-down list, select the dispatcher or dispatcher group.

* Timeout
Specify the time period, in seconds, defining how long to wait until the
dispatcher answers a call.

Redirect to

= Type
From the drop-down list, select one of the following:
e Decline
The calls will be declined.

e Dispatcher
The calls will be redirected to a specified dispatcher or dispatcher group.

¢ Radio unit
The calls will be redirected to a specified radio.

¢ Radio Group
The calls will be redirected to a specified radio group.

¢ Phone account
The calls will be redirected to a phone account from the phone book.

= Radio System
If a radio group is selected as the redirection destination, select the radio
system over which to make a call to the specified radio group.

= Target
From the drop-down list, select a particular dispatcher/dispatcher group,
radio, radio group, or phone account, depending on what you have
selected in the Type field.
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= Priority
If a radio or radio group is selected as the redirection destination, select the
priority with which the call will be made over the radio system.
6.4.4.5 Aliases

In addition to SIP extensions, the SIP aliases can also be used in your Telephony
system.

e Click Administration (1), Telephony (2), Aliases (3), Add (4)

File View Map Tools Help

Administration Telephony a
B e :

(Jl Database
5h Radio Systems
~#3 System Bridge

- Telephor

@ Tasks (\ 2

B nam b m i b
(i Vawe D

=y Cont
o4 3 <1
% Location Tracking
SIP ID: [2412

ﬁ Job Ticketing 4

B TRl
[ private call (2]l [@]
e

w

SIP Name: [2412

Route Management Caption: [Eugene

[ Texttessages Cencel
C% Reports
Event Viewer

1
p———
4[4 4| Record 10F 1 v [ve[mm] 4] i
(127001 &3 B B | § Administrator | [ Licensed to: demo Demo License | @ active-

In the Phone Alias dialog box, specify the following parameters:

= SIPID
Enter the SIP ID that will be used by the phone user.

= SIP Name
Enter the SIP user name that will be used by the phone user.

= Caption
Enter the caption to be displayed for the phone user.
6.4.4.6 Profiles

In order to restrict incoming and outgoing calls as well as set priority for calls, SIP
profiles can be used in your Telephony system.

¢ Click Administration (1), Telephony (2), Profiles (3), Add (4).
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File View Mop Tools Help

Administration Telephony

g EWLH * | B 1 tine fre= P int=rcom
& Lcense
[ Database P scles P disp 15

il Radio Systems

g System Bridge

&3 Telephon)

@ Tasks \2

38 Modbus TCP Connections
+f2 virtual Modbus Devices

i
Profile
. edora General | Patterns | Inheritance
Name: Droite
@ Location Tracking

4 Description: Restirct dising to JeFF

Group 20 [2] Al cal

[Jprivate cal

™ Apply to Incoming Calls

C@ Reports ™ Apply to Outgoing Calls

‘2] Radio Allocation
L~ 1
< Admosirten 0 et .72 [ = .
127001 &g & B | § Administator | (8 Licensed to: demo Demo License | @ active-

In the Profile dialog box, specify the following parameters:

* Name
Enter a name for the profile.

= Description
Enter a description for the profile.

= Apply to Incoming Calls

Select this check box to apply the profile to incoming calls.
= Apply to Outgoing Calls

Select this check box to apply the profile to outgoing calls.

e Click the Patterns tab.

Profile X

‘ General | Patterns | Inheritance

You can use wildcard chars in pattern:

* - any number of characters

? - one character

XXX-yyy -range of numbers from xxx to yyy

*411777 X

Call Priority: Mormal -

o

= Specify the pattern that will be used to match the numbers in the dial string
or the incoming call numbers.

= Call Priority
From the drop-down list, specify the priority for the calls corresponding to
the specified patterns.

Click the Inheritance tab.
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Profile s

Call Priority Profile Mame
/! Emergency ~ Fedora
[ | Inherit Mals
Emergency
High
Normal
Low

On this tab, you can select the profiles to include in the profile you are
adding/editing.

= Call Priority
From the drop-down list, select the priority for the inherited profile.

6.4.5 Tasks

This section describes how to configure the tasks that can be performed in
TRBOnet Dispatch Console.

e Go to Administration (1), Tasks (2), and see the list of the tasks in the right

File View Map Tools Help
Administration a &)
g g'ﬁ;nse |5 1:Lne free ) Mintercom e 2] Slot 1

[l Database Psiot 2 [ R N Esrow 11 (9] %) (@] O ¥ Group 22

4 Radio Syster

L e s B R T " @2 W8 renen

&P Telephony P roic= [« [@] Group 10 Group 20

W Tads — D

18] Crstom Fields v |/ B Add|+] 3 it | [k Delete

5 - Task Name o

il veice Dispatch vl @ Dispatcher Presence Conrol 3

4% Export to SWD - Location of radio
@ Location Tracking

@ Idle Time
Job Ticketing
L] %) Radio Allocation {Sprite Forms)
M and Email notifications
Route Management

[] Text Messages

ﬁ Voice Recording

Ge Reports
Event Viewer
1
o e
Administration o
| 4| ¢ Record30F7 b | me|mi| 4] »
) Connectes 3 € B B B B | 8§ Administrator | [ Licensed to: demo Demo License | @ active~

e To create a task, click Add (3), and from the drop-down list, select the
appropriate task.

Note: After you have created a task you need to enable it. Just select the
check box (4) beside the task you want to enable.
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6.4.5.1 Dispatcher Presence Control

When enabled, this feature checks the presence of dispatchers and sends
notifications to interested parties if the specified dispatchers are not present in the

system.

¢ In the Tasks pane, double-click Dispatcher Presence Control.

¢ In the Dispatcher Presence Control dialog box, specify the following options:

Dispatcher Presence Control X

Presence timeout 10 | minstes

Reminder time 30 % seconds

(®) Al Dispatchers
() Selected Dispatchers

Motifications

OK Cancel

Presence timeout
Enter the time period, in minutes, that will be used as a timeout to check for
the presence of dispatchers.

Reminder time

Enter the time period, in seconds, that will be used to show a reminder
pop-up dialog before the planned time of performing the check. When the
reminder appears on top of the screen, the dispatcher must click the round
button in the center to confirm their presence in the system.

All Dispatchers
Choose this option button so that all dispatchers will be checked for
presence.

Selected Dispatchers
Choose this option button so that only selected dispatchers will be checked
for presence.

e Dispatchers
In the drop-down list, select the dispatchers.

Notifications

Click this link to select who will receive the appropriate notifications. The
recipients may include dispatchers, Email groups, SMS groups, radios, and
radio groups.

6.4.5.2 Geofencing

The Geofencing feature allows controlling the location and speed of radios relative
to manually defined regions on the map.
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The Geofencing monitoring consists of the manually defined regions and the tasks.
The regions specify where to apply the rules, while the tasks specify how to apply
the rules for the regions and radios.

¢ In the Tasks pane, double-click Geofencing.
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The administrator can add/disable/delete the rules for Geofencing as well as edit
the currently selected rules:

‘ Geofencing and Speed Control X

General | Location| Speed| Regions| Radios| Lone Worker |

W Monitor Area 1

¥l Moritor Area 3 Specify the general parameters of the rule and the time window when itis active
\ Mame: [monitor area s J
4 Description: | Watch out for the workers
Activate the rule on a schedule
Days of week: [Monday, Tuesday, Wednesday, Thursday, ... =]
Start time: 2:00 E|:
Stop time: 18:00 El:

After the rule is triggered:
Reset Alarm mode when the rule conditions are no longer met

1

CIRerun the m\eyﬁer each rule edt, server res}ﬁ and at the start nfea/ sehechied tme window {not recommendec) (1)
7 7 7
[ addrue  [-][ osabierde * || peketeric ¥ | Cancel

e Click the Add Rule button (1) and select the appropriate rule from the drop-
down list (Map Region, Beacons, Radios, Lone Worker) to add a rule to the
current Geofencing configuration. A new rule will be displayed in the list of
rules (4).

e C(lick the Disable rule button (2) to disable the selected rule.
e Click the Delete rule button (3) to delete the selected rule.

General tab

e Name
Specify the rule name.

e Description
Add a description of the rule.
¢ Run the rule on a schedule

Select this option and in the boxes below specify the schedule for the rule to
run.

= Days of week
In the drop-down list, select the days of the week on which to run the
Geofencing rule.

= Start time
Specify the start time to run the rule.

= Stop time
Set the time to stop running the rule.

¢ Reset Alarm mode when the rule conditions are no longer met
Select this option to reset Alarm mode after the rule is triggered.
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Location tab

Geofencing and Speed Control be

I | General[ tocaton | spesd| Regions| Radios| Lone worter|

| Moritor Area 1

¥l Monitor Area 3 itioning conditions which wil trigger the rule and
le is executed

lected regions
ves the selected regions

For multiple nested/overlapping regions:
(@ Crosses outer border only
() Crosses any border

Perform the folloning actions:
Activate Alarm mode
[ Activate Lone Worker mode.
[[] Send Text Message to the so
[] send netification
Recpients
Send Request To Tak to the s

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (not recommended) (1)

[ addRuie DisableRue | [ DeleteRule ok [ caneel ]

Trigger this rule when a subscriber:

Enters the selected regions

Select this option so that the rule will be triggered as soon as a subscriber
enters the selected region.

Leaves the selected regions
Select this option so that the rule will be triggered as soon as a subscriber
leaves the selected region.

For multiple nested/overlapping regions

Choose one of the options specifying for multiple regions whether to consider
only an outer border of the group of regions, or any border of a region within
the group.

Perform the following actions:
Here you specify which actions to execute when the rule is triggered.
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Activate Alarm mode
Select this option to activate an Alarm mode in the Dispatch Console.

Activate Lone Worker mode
Select this option to automatically activate a Lone Worker mode for the radio
in case of entering or leaving the selected region.

Send Text Message to the source radio
Select this option to automatically send a text message to the radio when it
enters or leaves the selected region.

Send notification

Select this option to send a notification when the radio enters or leaves the
selected region. Click the Recipients link and specify the recipients to send the
notification to.

Send Request to Talk to the source radio
Select this option to automatically send a Request-to-Talk to the radio when it
enters or leaves the selected region.
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Speed tab

Geofencing and Speed Control X
Generall Location| Speed | Regions| Radios | Lone Worker|

| Moritor Area 1

| Moritor Area 3.

fon atirbutes which wil trigger the rule and choose specific actions
ecuted

Trigger this rule when a subscriber’

Moves faster than: 50 % kmh

[ Moves slower than: 10 HE
30 d:
[Everywhere -

Perform the following actions:
Activate Alarm mode
[[] Send Text Message to the source radio
[ Send Call Alert to the source radio

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

[ addRue  [v][  DscbleRue |  DeleteRue

Trigger the rule when a subscriber:

¢ Moves faster than
Select this option and specify the maximum allowed speed for the vehicles.
The rule will be triggered when the vehicle with the radio exceeds this speed
limit.
¢ Moves slower than
Select this option and specify the minimum allowed speed for the vehicles. The
rule will be triggered when the vehicle with the radio drops below the
specified speed.
¢ Stands still for longer than
Select this option and specify the time period, in seconds, during which the
vehicle is allowed to stand still. The rule will be triggered when the vehicle with
the radio stands still for longer than this specified time period.
e Track speed in relation to regions
From the drop-down list, select where to track the speed of the vehicles: inside
or outside the selected regions, or independently of the regions.
Regions tab
Geofencing and Speed Centrol x
r—— Generai| Location| speed| Regions | Radios| Lone Worker|
- :Z:::: :::: 32 SOE\E;; :;:gsmns where this rule can be triggered
@ Only selected regions
O My zone
O Route 1
O Route 2
[¥] Zone 2
[JRerun the rules after each rule edt, server restart and at the start of each scheduled time windaw (notrecommended) (1)
[ addrue  [-][ oiblerue || eleterue
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e All regions
Choose this option to apply this rule for all regions.

e Only selected regions
Choose this option to apply the rule for one or several regions.

e Select all
Click this button to select all regions in the list.

e Clearall
Click this button to unselect all regions in the list.

Radios tab

Geofencing and Speed Cantrol X

[ [ Genersi] Location| spezd| Regions| Radios | Lone Warker]
¥l Maritor Area 1

¥ Monitor Area 3 Select radios the rule is appled for:
O Alradios
@® Only selected radios
|
1= B3 Firemen
FA@ 125 (Pete) 125
@) 235 (Basi) 235
[ Police

-
[N]
w
~

5

e
e
i
i

\

]
B

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (notrecommended) (1)

[ _addrue  [-][  oisblerue  |[  Deleterue Cancel

e All radios
Choose this option to apply this rule for all radios.

e Only selected radios
Choose this option to apply the rule for one or several radios.

e Selectall (1)
Click this button to select all radios in the list.

e Clearall (2)
Click this button to unselect all radios in the list.

e Collapse all (3)

Click this button to collapse the view of radios in the list.
e Expand all (4)

Click this button to expand the view of radios in the list.

° E * (5)
Click this button, and from the drop-down menu, select which list to display:
Radio List, Radio Groups, or Logical Groups.
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Geofencing and Speed Control X
General| Location| Speed| Regions| Radios| Lone Worker
¥l Monitor Area 1
| Monitor Area 3 Select the tasks to be executed when the rule s triggered
Q) Altasks
@) Only selected tasks
Lone Workers ’
] Lone Warker
select Al Deselect Al
[JRerun the rules after each rUle edt, server restart and at the start of each scheduled time window (notrecommended) (1)
I [ o e ]

Choose this option to execute all Lone Worker tasks configured by the
administrator when the rule has been triggered.

e Only selected tasks
Choose this option, and in the list below, select the Lone Worker tasks to be
executed when the rule has been triggered.

Variable settings for Geofencing rules of event types (Map Region, Beacons, Radios
and Lone Worker) are represented in the table below:

Event type

Tab Name

Parameters Description

Common Settings

General Name - specify the rule name;
Description — add the rule description;
Scheduler Run the rule on a schedule - select to start a scheduler
for Geofencing rules;
Days of week - select the days of the week on which to
activate the Geofencing rule;
Start time - set the time at which to start the rule;
Stop time - set the time at which to stop the rule.
Radios All radios — choose to apply this rule for all radios;

Only selected radios — choose to apply the rule for one
or several radios;

Select all - click to select all radios in the list;

Clear all - click to unselect all radios in the list.
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Event type

Map Region.
Allows configuring
rules when a
radio(s) enters or
leaves the defined
map region(s).

‘ Tab Name

General

Parameters Description

Regions Control — select to enable regions control;

Control mode - select the control mode for regions in
the dropdown list;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Regions Control rule has been triggered;

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Regions
Control rule has been triggered;

Activate Lone Worker if the rule has been triggered -

allows automatically activating a Lone Worker policy for a
radio in case of entering or leaving exact region on map.

Select to enable this option.

Speed and Idle Control - select to enable speed and
idle control;

Control mode - select the control mode for speed and
idle control in the dropdown list;

Maximum Speed - set the maximum speed for radio;

Maximum Idle Time - set the maximum idle time for
radio;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Speed and Idle Control rule has been triggered

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Speed
and Idle Control rule has been triggered;

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Reset Alarm mode if the rule is not triggered - select
to inform radio subscriber if the rule has not been
triggered.

Scheduler

See above.

Regions.

Select regions
to apply the rule

All regions — choose to apply this rule for all regions;

Only selected regions — choose to apply the rule for one
or several regions;

Select all — click to select all regions in the list;

Clear all - click to unselect all regions in the list.

Radios

See above.

Lone Worker.

Enables Lone
Worker when
the rule has
been triggered

All Tasks — choose to apply all tasks configured by the
administrator when the rule has been triggered;

Only selected tasks — choose this option, and in the list
below, select the Lone Worker tasks to be executed when
the rule has been triggered.
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Event type Parameters Description
Beacons. General Control mode:
Allows configuring Control entering beacon coverage zone - select to
rules when a radio enable the rule when a radio enters beacon coverage
(s) enters or leaves Zone;
the beacon

Control leaving beacon coverage zone - select to
enable the rule when a radio leaves beacon coverage
zone;

coverage zone

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Beacons rule has been triggered;

Reset Alarm mode if the rule is not triggered — select
to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered (for
example, when Control entering beacon coverage zone
is selected and the radio enters the monitored coverage
zone and then instantly leaves the zone, the alarm mode
in the Dispatch Console will be reset automatically)

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Beacons
rule has been triggered;

Activate Lone Worker if the rule has been triggered -
allows automatically activating a Lone Worker policy for a
radio in case of entering or leaving beacon coverage
zone. Select to enable this option.

Scheduler See above.

Radios See above.

Beacons. All Beacons — choose to apply this rule for all beacons;
Enables the rule | Only selected beacons — choose to apply the rule for
for selected one or several beacons.

beacons

Lone Worker See above.
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Event type

Radios.

Allows using
radio(s)1 as a map
region and monitor
when another
radio(s) enters or
leaves radio’s
coverage zone

‘ Tab Name

General

Parameters Description

Control mode:

Control Entering Region — select to enable the rule
when a radio enters the coverage zone associated with
another radio;

Control Leaving Region - select to enable the rule when
a radio leaves the coverage zone associated with another
radio;

Activate Alarm mode if the rule has been triggered -
select to activate Alarm mode in the Dispatch Console if
Radios rule has been triggered;

Reset Alarm mode if the rule is not triggered — select
to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered (for
example, when Control Entering Region is selected and
radio enters to the monitored coverage zone and then
instantly leaves the zone, alarm mode in the Dispatch
Console will be reset automatically)

Send Text Message to a radio if the rule has been
triggered — select to inform radio subscriber if Radios
rule has been triggered;

Send Call Alert to a radio if the rule has been
triggered — select to inform radio subscriber if the rule
has been triggered;

Minimum distance between radios - specify the
distance, in meters. When a distance is less than the
selected value, the rule will be triggered according to the
settings above.

Color of region — select the radio coverage zone color.

Scheduler

See above.

Regions

Select radio coverage zones the rule is applied for.

Radios

See above.

Lone Worker.

Allows configuring
scheduled Lone
Worker tasks

General

Days of week - select the days to activate the Lone
Worker rule;

Start time - set the time to start the rule;

Stop time - set the time to stop the rule.

Radios

See above.

Lone Worker

Select all configured by Administrator Lone Worker tasks
or several configured tasks.

When a Lone Worker task is mentioned as Disabled, the
administrator should enable the task.

Idle Time

The Idle Time feature allows monitoring vehicles idle time assigning Telemetry
Commands on selected VIOs.

¢ In the Tasks pane, double-click Idle Time.

Specify the telemetry command to set the Idle Time:
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Idle Time X

= Command: |High -
Stop VIO: 1 3: Command: |High -

Start VIO:

Start

e Specify the telemetry VIO and Command to start the Idle Time task.
Stop

e Specify the telemetry VIO and Command to stop the Idle Time task.
The administrator can see Idle Time reports and statistics.

Click Reports (1), and under GPS reports, click Idle Time Summary or Idle Time
detailed (2) to see a common Idle Time report:

File View Map Tools Help

) GPs reports A
{17 Location for Period EIREEE el
) Location on Date [ Jsdks (][]
[ ) staysin Region 2
1.1 Drive Actvity Detais [ Jeveraencr Groe[1)]
+..[F5) Drive Activity Summa [Jaical ]
i) speed for period
1. 1de Time summdfy [Jeow 1 [2][<][@]
.75 Idie Time Detais v
" Report Settings
{14 voice Dispatch Idle Time Summary
savedprofes:  [“Notdefred-  v|
Location Tracking
Select data by period:
@ Job Ticketing

Start Date: 4/26/2017 12:00 AM ~| |-

End Date <Maximum date> v

E:j Route Management
Filter:

[ ] Text Messages Radio: Mot defined- >

Logical Group: [iotdefined- ]
ﬁ' Voice Recording
Radio ID (e.g. 22,33,40-55,88 ):
(D Reperts |
L
I~ Speed: 1= kmp
EE] Radio Allocation \ 1 3
E R —— Generate Repart Save Report Profile Delete Repart Profile
[ Connected &3 B B | § Administrator | [28 Licensed to: demo Demo License @ Active~

Note: Specify the speed accuracy value in the Speed box (3).

6.4.5.4 Radio Allocation (Sprite Forms)

This function is used for direct communication between the dispatcher and the
subscriber via special Tallysman Option board installed into the radio. The
dispatcher and subscriber have special form templates. The dispatcher receives Duty
ID of the subscriber with his template output form whereas the subscriber sends it
using his template input form. The radio name changes to its Duty ID.

Note: Any activity may be decoded with its Duty ID so this is a
way to communicate for the dispatcher and subscribers
only.

¢ In the Tasks pane, double-click Radio Allocation (Sprite Forms).

e Load the Sprite Form (output template) and select the Field Name:
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Radic Allocation (Sprite Forms) x

Form Description:

APP_VERSION1=0.14 -
IAPP_VERSION2-1

DATE_MODIFIED=12/12/2012 8:21:05a.m.

FORMATTED=
0203000FBIECOAFS02FBO04ESA20427573018000000106180500028768CEQF1
0FBOOF5025368696674206E756D62657235AD781E

AS_ARRAY=0:02, (03, (00, 0<0F, BxBI, (x8C, (<A, 0¢F5, (02, 0xFB, (<00,
Oxc4E, Ox5A, 020, (xd2, (<75, Bc73, B, <80, (00, (0O, (01, (06, (x18,
0x05, 200, (02, (x87, (x68, BeCE. (xOF, Bc10, BcFB, (00, OxF5, (02, (53,

m

0x68. (x63, (66, (74, (20, (BE, (75, (6D, (x62, (65, (72, (35, (xAD,
0x78. O 1E
METADATA=-0002000000000000

FORM_TITLE=NZ Bus
FORM_ID=2
FORM_REVISION=3

[Field Data #0]
[romgt-*Shf unber” -
Load
Field Name Shift number ﬂ
Cancel

e Click OK to add a Sprite Form.
6.4.5.5 SMS and Email Notifications
TRBOnet Dispatch Console allows managing text messages:

1. Send Text Messages from LAN to a particular radio or talk group (POP3
Server);

2. Forward all Text Messages from radios to base radio to particular email
address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and POP3
servers. For more details on SMTP or POP3 servers, ask your
System Administrator.

¢ In the Tasks pane, double-click SMS and Email notifications:

SMS settings tab

SMS settings  Qutgoing Email settings (SMTP)  Incoming Email settings

Send SMS to recipients if ALARM has been activated
L1 5end MMs to recipients if ALARM has been activated ‘

Forward Text Messages to cell phone recpients
put messages (from radionetwork to dispatchers)

Output messages (from dispatchers to radionetwork)

SMS Groups

= Send SMS to recipients if ALARM has been activated
Select this option to send an SMS in case of an alarm on the radio.
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= Send MMS to recipients if ALARM has been activated
Select this option to send an MMS in case of an alarm on the radio.

Forward Text Messages to cell phone recipients

= Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to cell phones.

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to cell phones.

For more details on SMS settings, see section 5.15.2, Outgoing Mail Server (page 93).

A radio sends text messages to the base station. TRBOnet Server forwards all text
messages to a particular email address (for example, admin@yourcompany.com).
The administrator receives text messages from radios as regular emails.

Outgoing Email settings (SMTP) tab

SMS and Email notifications X
SMs settings  Outgoing Email settings (SMTP)  Incoming Email settings
Send Email to recipients if ALARM has been activated

Forward Text Messages to email recpients
Input messages (from radionetwork to dispatchers)

Output messages (from dispatchers to radionetwork)

Emai Groups

= Send Email to recipients if ALARM has been activated
Select this option to send an Email in case of alarm.

Forward Text Messages to email recipients

* Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to Email address(es).

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to Email address(es).
Incoming Email settings tab

TRBOnet Server connects to POP3 server, reads emails and sends text messages to
radios or talk groups.
1. Create an email account on your email server.
2. Send an email to radioserver@yourcompany.com. In the Subject field, enter
either 'RadiolD:XXX' to send an email to a selected radio, or 'GroupID:XXX' to
send an email to a selected radio group.
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Note: If you don't properly specify the email Subject, or specified
a non-existing RadiolD (or GrouplID), a corresponding
notification will appear in the Event Viewer of the Dispatch

Console.

¢ Forward incoming emails to radio network (from email box to radios)
Select this option to forward incoming emails to radio network.

6.4.5.6 User Activity
The User Activity function allows the dispatcher to create lists of radios, to which
radios can be assigned due to their activity.

For example, if a subscriber sends an On duty message or presses an exact preset
telemetry button, this subscriber gets assigned to the On duty list in the Dispatch
Console. The dispatcher can also manually assign subscribers to lists.
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¢ In the Tasks pane, double-click User Activity:

Lists of radios tab

User Activity

Lists of radios  Advanced

Name
@ offbuty
@ onDuty
@ User Activity = 1

Add

Description

Edit

Delete

Cacel

e Click Add to add a list of radio activities:

User Activity List Settings

General | Logical Groups

Mame: |User Activity # 1

Description:

Move a radio to this list if:
Manually by dispatcher

VIO 1

0

Background: @ Violet

[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

+ Command: High level -

[] automatically by receiving DTMF command from a radio

e

[ automatically by receiving Status from a radio

Cancel
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Name
Specify a name for the user activity list.

Description
Add a description for the user activity list.

Background
Select the background color to display the radios assigned to the list.

Move a radio to this list if:

Manually by dispatcher
Select this option to assign radios to the list manually.

Automatically by receiving Text Message from a radio

Select this option to assign a radio to the list after receiving a text message
from the radio. If you select this option, specify a brief text message in the
Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to assign a radio to the list after receiving a telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to assign a radio to the list after receiving a predefined
DTMF command, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Automatically by receiving Status from a radio
Select this option to assign a radio to the list after receiving a specified
Status, for instance, 1. If you select this option, specify the Status.

To assign offline radios to the default User Activity list, click the Advanced tab:

User Activity x
Lists of radios  Advanced
Automatically set the default status for offine radios
Timeout: 10 = minutes
e

e Automatically set the default status for offline radios
Select this option to enable assigning the default status for offline radios.
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Timeout

Specify the time period, in minutes, after which the default status is set to a
radio.

6.4.5.7 Lone Worker

The Lone Worker policy lets the dispatcher set a time interval the communication
with a subscriber is expected. For example, if a lone worker has not called the
dispatcher for 15 minutes, the radio receives a message and the Dispatcher receives
an alarm signal.
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e To add a Lone Worker task, in the Tasks pane, click Add > Lone Worker.

In the Lone Worker dialog box that appears, specify the following parameters:

Lone Worker X

Task name: Lone Worker 1

Task Start  Conditions Task Stop

[ Manually by dispatcher
Automatically by receiving Text Message from a radio

Message: Start |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| command: Any event -
[ Automatically by receiving DTMF command from a radio

] Automatically by receiving Status from a radio

Send the following text message to the radio

Message: ||

Cancel

Task Start tab

Manually by dispatcher
Select this option to start the Lone Worker task manually by the dispatcher.

Automatically by receiving Text Message from a radio

Select this option so that the Lone Worker task will start after receiving a
message from a radio. If you select this option, specify a text message in the
Message box.

Automatically by receiving Telemetry Command from a radio

Select this option so that the Lone Worker task will start after receiving a
telemetry command from a radio. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option so that the Lone Worker task will start after receiving a
predefined DTMF command, for instance, #11#. If you select this option,
specify a DTMF combination without the # characters in the Command box.
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¢ Automatically by receiving Status from a radio

Select this option so that the Lone Worker task will start after receiving a
specified status from a radio. If you select this option, specify Status.

¢ Send the following text message to the radio
Select this option and in the Message box enter the text message that will be
sent to the radio when a Lone Worker task is started for that radio.

Conditions tab

e Response time

Lone Worker

Task name: Lone Worker

TaskStart  Conditions  Task Stop

Response time 30 2| minutes

Send notification to radio

Reminder time B0 < seconds

(® send Request To Talk
() Send Text Message

D ResetLone Warker when receiving Text Message

[7] Reset Lone Worker when receiving Telemetry command

1 e Any event -

[] Reset Lone Worker when the distance has been traveled

[[] Do not trigger alarm if radio is offiine for less than

Cancel

Specify the time period, in minutes, that determines how long TRBOnet Server
waits since the last radio transmission.

¢ Send notification to radio
Select this option so that TRBOnet Server will send a notification to the radio
before raising the alarm if the radio has not transmitted for the specified time

period.

= Reminder time
Specify the time period before it comes to raise the alarm, to send a
notification asking the radio to respond.

= Send Request to Talk
Choose this option to send a Request-to-Talk to the radio.

= Send Text Message
Choose this option to send a text message to the radio. Specify the
message text in the Message box.

¢ Reset Lone Worker when receiving Text Message
Select this option to reset the Lone Worker task after receiving the message
specified in the Message box.
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¢ Reset Lone Worker when receiving Telemetry command
Select this option to reset the Lone Worker task after receiving the telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

e Reset Lone Worker when the distance has been traveled
Select this option to reset the Lone Worker task after the distance specified in
the Distance box has been traveled.

¢ Do not trigger alarm if radio is offline for less than
Select this option so that the alarm is not triggered if the radio is offline for a
time less than the time specified in the Interval box.

Task Stop tab

Lone Worker

Task name: |L0ne Worker 1

Task Start Conditions Task Stop

Manually (on demand of dispatcher)
[ Automatically by receiving Text Message from a radio

[ Automatically by receiving Telemetry Command from a radio

L o Any event -

Automatically by receiving DTMF command from subscriber
Command: 123 #123#
] Automatically by receive Status from subscriber

[] send Text Message to a radio

Cancel

In the Task Stop tab, you can specify how to stop the Lone Worker task. The
available options are similar to those you specified on the Task Start tab.

Enabling Lone Worker

e To enable the Lone Worker task for a selected radio, go to Voice Dispatch (1),
right-click the selected radio (2), and choose Start Lone Worker (3):
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Radio Interface

T |

Private Call
Send Call

Advanced

Monitoring

Set On Duty

) Presencein Network

Request Location
Send Message..

Find on Google Earth
‘Show Route on Google Earth

Specify Custom Icons.
Set Radio Channel

Daisy.mp3

[eroup2

: Slot #1 1l < 1] ["Reveater #1: Slot #2 [l

‘Start Lone Worker 1

Start Timer

To: Selected Channels

ected Channels

Drag and Drop PTT Box here to

aeate new group

Patch on Repeaters

= (& Print | 11 Pause < Clear - '&i Reload | "[] Filter By Radio

rouping '/ Auto Filter > Default Settings >

Date |RadioSystem  [sender  |Recpent | Message | petals [ Hote [Ext.vote |
210t 2016 17:56:27  Repeater #1:So... Administra... Poice Dispatcher ‘Adminitr... Members: Adminisr.. R

1-0ct-2016 17:56:27  Repeater #1: So.... Adminstra... Poice Dispatcher ‘Administr... Members: Adminisr

1-0ct-2016 17:56:23  Repeater #1: Slo... Administra... Al Al Call from dispatch,.. Members: Adrinisr...

10ct 2015 17 Repeater #1: So... 125 A Al cal from 125" 00... Members: 125
210ct 2016 17:56:14  Repeater #1: Sio... 235 A Al Callfrom 235' (00... Members: 235

HAKINIE 78R 1T  Benonfer 218 778 a Bl from 38 101 Memhierer 738 =]
i« [« Record 1of 453 »Tif:u < LH

RecentCallfevents  RecentCals | RadoState | AciveTaks | ActveRoutes | UserActviy | Map | Cameras

127001 25 By B | § Administrator

| (8 Licensed to: demo Demo License

e To monitor the Lone Worker task, click the Active Tasks tab:

Voice Dispatch

Radio Interface

Confiqure

To: Selected Channels

&P Telephony Daisy mp3

Psinary Patch

1M Stop | = Grouping 7 AutoFilter ©» Defautt Settings

Patch on Repeaters

| © Active-

Task. | Radio

Lene Worker 1 125 (Pete) 125

127001 58 G G| & Administator | (8 Licensed to: demo Demo

0 44| 4| Record 10f 1 v [ v mi[ ¢
e e e )

Enabling Lone Worker from Geofencing

| @ nctive~
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e Click Location Tracking (1), and click the Geofencing button (2) in the Map

pane:
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File View Map Tools Help

Location Tracking

7 1 Line free Group 10
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o !

5 Playback |l Sove - () Print | 11 Pause < Clear ~ (& Reload | [} Filter By Radio | = Grouping 1/ Auto Filter (> Default Settings || Details | [ Show Notes [ Add Note | [3t Add Message ‘
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W@ Tea
¥ [ Map Objects.

1] camera 1
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- [ Map Regions

o/ T

-7 [/ Map Routes

Wige 111
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@ Reports Date Radio System Sender Redpient Message
09,06 2017 14:43:57 Server [ Connection to Capity Plus 1 has been lost
I [ lus 1 hs been|
{5 event viewer 09.06.2017 1214330 Capacity Plus 1 Admiristrator i Dispatcher Administrator’calls group 11 (00:07)
- 09.06.2017 12:40:06  Capacty Plus 1 125 1 Radio '125'calls group '11' 00:08)
EEI . 09.06.201712:39:55  Capacity Plus 1 Admiristrator 1 Dispatcher ‘Administrator calls group '11' (00:05)
Admiristrator Police Dispatcher Administrator’cals aroup Poice’ (01:00)

09.06,2017 12:38:34  Capadty Plus 1
W] 4[ <] Record1of305 b ||| <

Recent Cals/Events | Recent Calls | RequestToTak | Radio State | ActiveTasks | ActiveRoutes | User Activity | Beacons | Beacon Events | Taglist

@Mnﬁishnﬁnn

Details

Members: Adninistrator, 125
Members: 125

Members: Admiristrator
Members: Adniristrator

5
of

127001 53 €| @ seministotor | (4 ticensed to: demo | © active-
¢ In the Geofencing and Speed Control dialog box, click
Add Rule > Lone Worker (1):
B TR s D - o X
File View Map Tools Help
GPS Positioning Geofencing and Speed Control X o
b ‘General | Radios | Lone Worker|
Iv! Monitor Area 1
& () onine, ops ’i vl Moritor Area 3 Name: [Lone worker 2 | - [ Beacons
®e RIBI]] Y Lo Werker2 Description: Department 1 g % :’;;EE
BH®256. 93 W L@ T
ncing| % ([ Mep Objects
L [ Abidng place
e % [ Fre dep
Days of week: [Monday, Wednesday - e v | R st o2
@ GPS Positioning Start tme: o0 =] i -7 [ police depar...
“ Job Ticketing S 0:00 3: ¢ MM
*a@‘ &+ [ Map Routes
8

1

/

SR
Palsce

hiratteyskiy

[IRerun the rules after afm rule edit, server restart and at the start of each scheduled tme window (not recommended) (1)

porTs e [ Lo Il ew |
| 77 MapRegion 1240 14'E

Recent Calls | Radio State | Active Tacks | Active Routes | User Actvity | Beacons | Beacon Events | TagList

7] g@ Route 1

inistratk () Beacons |
e @) Rad
B R $ Admmtng‘mem Demo License

| @ Active-

= Specify a Name for the Lone Worker rule and add a Description.

= Days of week
In the drop-down list, select the days of the week on which to activate the
Lone Worker rule.

= Start time
Specify the time at which to start the rule.

Stop time
Specify the time at which to stop the rule.

Click the Radios tab and add radios to which to apply the Lone Worker rule:
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Geofencing and Speed Control X
| General Radios | Lone Worker |
¥l Monitor Area 1
¥ Monitor Area 3 Select radios the rule s applied for
v <rue name > O Al radios
@ Only selected radios

[A@ 125 (pete) 125
1@ 235 @asi) 235

2la

[IRerun the rules after each rule edit, server restart and at the start of each scheduled time window (ot recommended) (1)

[ addRue  [v][  DscbleRue |  DeleteRue Cancel

= All radios
Choose to apply this rule to all radios.

= Only selected radios
Choose to apply the rule to one or several radios.

= Select all
Click to select all radios in the list.

= Clear all
Click to unselect all radios in the list.

e Click the Lone Worker tab and select the configured Lone Worker tasks:

Geofencing and Speed Control X

General| Location| Speed| Regions| Radios | Lone Worker

vl Monitor Area 1
| Monitor Area 3 Select the tasks to be exeauted when the rule s triggered
O Altasks

(® Only selected tasks

Lone Workers
] Lene Worker

Select Al Deselect Al

[JRerun the rules after each rule edit, server restart and at the start of each scheduled time window (notrecommended) (1)

[ addrue  [-][ oiblerue || eleterue

= Choose either all configured Lone Worker tasks or several configured tasks.

Note: When a Lone Worker task is mentioned as Disabled, enable
it on the Tasks pane.
6.4.5.8 Export Data

TRBOnet Dispatch Console provides the Export Data function, which allows
exporting data to an external database table.

e To add an Export Data task, in the Tasks pane, click Add > Export Data.

¢ In the Export Data dialog box, specify the following parameters:
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Export Data x
Task name: |Export to database table - Location of radio |
Type: |Expurt to database table j
Data: |Lucatic|r| of radio j

Connection Data  Scheduler Advanced

Server name [oca\soLEXPRESS

Database name |TRBOnet j

¥ windows authentication

User name |

User password |

Cancel

Connection tab

e Task name
Specify a name for the task.

» Type
Select the type of data export from the drop-down list. TRBOnet Dispatch
Console allows exporting data for third-party systems using data export tasks.

= Export to database table
Allows exporting data to MS SQL Server tables. Specify MS SQL Server
connection parameters, database, and table to export data.

= Export to Versatrans
Allows exporting data to the Versatrans data collection system via IP. For
more details, visit the official website of Versatrans.

= Export to Google
Allows exporting data to file (file format is KML). For more details, visit the
following website.

= Export to NMEA
Allows exporting data to a file (text file format, export format is NMEA
0183). For more details, visit the following website.

= Export to file
Allows exporting data to a text file.

e Data
Select which data to export from the drop-down list.

e Default connection
Choose this option for default connection to SQL Server.

e Specified connection
Choose this option and specify the SQL Server and database name.

e Server name
Specify the SQL server name.
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e Database name

Select the database from the drop-down list.

¢ Windows authentication
Select this option to use Windows authentication, or unselect it to use SQL
Server authentication (SQL Server user name and password will be required).

Data tab

Export Data X
Task name: |Export to database table - Location of radio |
Type: |Export to database table j
Data: |Location of radio j

Connection Data  Scheduler Advanced

Table: |[Expurt_Lucah‘uns]

Create table  Load columns list

Column mapping:

Table column Data

Date Location date
Latitude Latitude
Longitude Longitude
Speed Speed
Direction Direction
Predsion Accuracy
RadinTh Radin TN

Ok

Cancel

e Table

neocom
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the name of the table to be exported into external database (by default, the
name of the table is created after you have specified it in Create table dialog

box).

e C(lick the Load columns list link to update the columns list in case you have
made any changes to the table.

e Click the Create table link to add a new table for data export:

X

Create table
Create new table to export data
Active database connection
Table name: Export_Locations
Column list:
Table column Data
v| Date Location date
| Latitude Latitude
v| Longitude Longitude
v| Speed Speed
| Direction Direction
| Predsion Accuracy
w| RadiolD Radio ID
v ID Unique radio ID
w| Name Radio name
v| ExportDate Export date

Cancel

-

= Select the data fields to add to the table.
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heduler tab
Export Data x
Task name: |Export to database table - Location of radio |
Type: |Expurt to database table j
Data: |L0cah‘0n of radio j
Connection Data  Scheduler  Advanced
Days of week: | (Al days) j

 Bxecute recurrently with inferval

" Execute at particular time

Start time: 13:00 E|:
Stop time: 15:00 E|:
Repeat every: 01:00:00 El:

Cancel

e Days of week

In the drop-down list, select the days of the week on which to export the data.

e Execute recurrently with interval

Choose this option to perform data export on a periodic basis.

= Start time

Specify the time at which to start data export.

= Stop time

Specify the time at which to stop data export.

= Repeat every

Specify a time period for periodic data exports.

¢ Execute at particular time

Choose this option and specify the times in the columns of the table below.

vanced tab
Export Data X
Task name: |Export to database table - Location of radio |
Type: |Export to database table j
Data: |Location of radio j

Connection Datz  Scheduler Advanced

Export only changed data

Export mode
(® Always add new records
(0) Update existing and add new records
() Update existing records

Cancel
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e Export only changed data
Select this option to export only changed location of the radio data.

e Export mode
Choose the mode for exporting data.

6.4.5.9 Scheduled Task
This task allows sending scheduled messages to radios.
e To add a scheduled task, in the Tasks pane, click Add > Scheduled Task.

¢ In the Scheduled Task dialog box, specify the following parameters:

Scheduled Task X
Task name: |Schedu|ed Task
Command ' Scheduler
Command: [Send Text Message ﬂ
Message: |.-'-\Iarm

¥ Send to radio group
" Send to subscribed radio
Recipient

[ Firemen

Canel

= Task name
Specify a name for the task.

= Command
From the drop-down list, select what to send to selected radios.

Send Text Message

e Message
Enter the message text in this box.

Send Telemetry
Select this command to send scheduled telemetry commands to selected
radios/groups, or request telemetry states from selected radios/groups.

e VIO
Specify the VIO contact.

e Command
From the drop-down list, select the signal level at which to send the
telemetry command to selected radios/groups, or select 'Request state'
to receive telemetry states from selected radios/groups.
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Request Location
Select this command to receive location data from selected radios/groups.

Send to radio group

Choose this option to send the specified command to selected radio
groups.

Send to subscribed radio

Choose this option to send the specified command to selected radios.
Recipient

In this list, select the radio groups/radios to send the specified command to,
or receive telemetry/location data from.

Send Voice Message
Select this command to send a voice message to selected radios/groups:

Scheduled Task X

Task name: |5|:heduled Task 1

Command  Scheduler

Command: |Send Voice Message j

|4 Load from file
,j’ Becord message
) Playback messace

Call Type Channel Call Target

Private Call Auto Detect 125
Group Call [i5h Repeater #1: Slot... Firemen
Intercom call Intercom All hd

ok Add 3 BRemove

[ Impolite channel access

Cancel

Load from file
Click this link to load an existing file from your PC.

Record Message
Click this link to record a new voice message.

Play back message
Click this link to play back the voice message.

Specify Call type, Channel, and Call Target for a voice message.
Note: To send a Voice Message to a subscriber from the phone

book, click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

Impolite channel access
Select this option so that the voice message will be sent regardless of
whether the channel is busy or not.
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Scheduler tab

Scheduled Task X

Task name: |S|:heduled Task 1

Command Scheduler

Start date: |01 October 2016 ~|

Stop date: |13 October 2016 ~|

Days of week: |Munday, Tuesday, Wednesday, Thursday, Friday j

¥ Execute recurrently with interval

Start time: 15:00 3:
Stop time: 18:00 3:
Repeat every: 01:00:00 3:

" Execute at particular time

Cancel

e Start date
Select a date to start the task.

e Stop date
Select a date to stop the task.

o Days of week
In the drop-down list, select the days of the week on which to perform the
task.

e Execute recurrently with interval
Choose this option to perform the task on a periodic basis.

e Start time
Specify the time at which to start the task.

e Stop time
Specify the time at which to stop the task.

e Repeat every
Specify a time period for periodic task executions.

e Execute at particular time
Choose this option and specify the times in the columns of the table below.

6.4.5.10 Voice Message

The Voice Message allows automatically broadcasting a predefined Voice Message
after receiving a telemetry command, a text message or a DTMF command.

e To add a Voice Message task, in the Tasks pane, click Add > Voice Message.

The user can have several Voice Message policies for different purposes. Specify a
name for the policy in the Task name box and set the policy's parameters.
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Task Start tab

182

Woice Message x

Task name: Voice Message

TaskStart Task Process TaskStop Message Telemetry

Manually by dispatcher
[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: High level -

[ Automatically by receiving DTMF command from a radio
,7
Automatically by receiving Emergency from a radio
Emg. Type: |AII j
() Activated by any radio
(@ Activated by specific radios only
Radio: [125 (Pete), walt |

Send the following text message to the radio

Message: | |

Cancel

Manually by dispatcher
Select this option to allow the dispatcher to manually start the Voice Message
task.

Automatically by receiving Text Message from a radio

Select this option to start the Voice Message task after receiving a specified
text message from a radio. If you select this option, specify a brief text
message in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to start the Voice Message task after receiving a telemetry
command. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's radio
should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to start the Voice Message task after receiving a DTMF
command from a radio, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Automatically by receiving Emergency from a radio
Select this option to start the Voice Message task after receiving an emergency
command from a radio.
= Emg. Type
From the drop-down list, select the type of emergency to be sent from a
radio.

Activated by any radio
Choose this option to expect receiving data from any radio in the system.

Activate by specific radios only
Choose this option to expect receiving data from selected radios.

= Radio
In the drop-down list, select the radio(s).
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¢ Send Text Message to a radio
Select this option so that a text message will be sent to the radio that activated
the Voice Message task. If you select this option, specify a brief text message
in the Message box.

Task Process tab

Voice Message x
Task name: Voice Message 1
Task Start TaskProcess TaskStop Message Telemetry
" Send voice message once
¥ Send voice message repeatzble
Repeat Interval: &0 El: second(s)
I¥ Repeat Count: 10 =

[ Impolite channel access

[™ Delay on start: 1 =

Cancel

¢ Send Voice Message once
Choose this option to send the voice message to a selected radio (s) only
once.

¢ Send Voice Message repeatedly
Choose this option to send the voice message repeatedly.

* Repeat Interval
Specify the repeat interval, in seconds.

= Repeat Count
Select this check box and specify the number of times to repeat the voice
message.

¢ Impolite channel access
Select this option so that the voice message will be sent regardless of whether
the channel is busy or not.

e Start delay
Select this check box and specify the delay time, in seconds, for the Voice
Message task.

Task Stop tab

Note: These options are available only if you have selected the Send
Voice Message repeatedly option in the Task Process tab.
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Woice Message x

Task name: Voice Message

Task Start Task Process TaskStop Message Telemetry

] Manually by dispatcher
[ Automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio
VIO: 1 < Command:

] Automatically by receiving DTMF command

e

[] send the following text message to the radio

Cancel

Manually by dispatcher
Select this option to allow the dispatcher to manually stop the Voice Message
task.

Automatically by receiving Text Message from a radio

Select this option to stop the Voice Message task after receiving a message
from a radio. If you select this option, specify a text message in the Message
box.

Automatically by receiving Telemetry Command from a radio

Select this option to stop the Voice Message task after receiving a telemetry
command from a radio: If you select this option, specify the VIO contact, and
from the Command drop-down list, select the signal level at which the user's
radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to stop the Voice Message task after receiving a DTMF
command from a radio, for instance, #11#. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Send Text Message to a radio

Select this option so that a text message will be sent to the radio that stopped
the Voice Message task. If you select this option, specify a brief text message
in the Message box.
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Message tab

¢ Load from file
Click this link to load an existing file from your PC.

e Record Message
Click this link to record a new voice message.

¢ Play back message
Click this link to play back the voice message.

Task Start  Task Process Task Stop

@ play back message

e add 5 Remove

Cancel

e Specify Call type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the phone
book click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

e Priority

From the drop-down list, select the priority with which the voice message will
be sent/queued. If this priority is higher than that of the current transmission,
which is, in turn, allowed to be interrupted, the current transmission will be
interrupted and the voice message will be sent instead.
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Telemetry tab

Task name: Voice Message 1

Task Start Task Process TaskStop Message Telemetry

Send Telemetry before starting task

VIO: 1 % Command:  |High level -

Delay after send: 0 + second(s)
Send Telemetry after stopping task

VIO: 1 3| Command: |Toagle level h

Delay befare send: a 3 second(s)
Redipient: Selected Radios: 1; Selected Radio Groups: 2 j
[] send Telemetry on every Voice Message

Cancel

Send telemetry before starting task
Select this option to send a telemetry command before the voice message is
transmitted.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay after sending
Specify the time period, in seconds, to wait before sending the voice
message after the telemetry command has been sent.

Send telemetry after stopping task
Select this option to send a telemetry command after the Voice Message task
is stopped.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay before sending
Specify the time period, in seconds, to wait before sending the telemetry
command after the voice message has been sent.

Recipient
In the drop-down list, select the radios/groups to send the telemetry
command to.

Send Telemetry on every Voice Message

Select this option to send the telemetry command to the selected
radios/groups every time the voice message is sent, provided the voice
message is repeatedly sent.

6.4.5.11 Recorder

The Recorder feature allows connecting to an audio recorder via IP.

186

To enable the task, in the Tasks pane, click Add > Recorder:
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The feature allows replicating audio recordings to the recorder:

Audio Recorder

X

Task name:

|Audim Recorder

Settings

IP: [10.10.163.121

Port: 9094

Test of Channels

Cancel

e Task name
Specify a name for the task.

e IP

Enter the recorder's IP address.

e Port

Specify the recorder's port number.

e C(lick Test of channels to view all available channels on the recorder.

e Click OK to add the task.

6.4.5.12 Agenda

neocom
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The Agenda is used to automatically send predefined messages to the radios. It may
be used when you have any software receiving any messages but it is not able to
send them to the subscribers. In this case, TRBOnet Dispatch Console acts as an
intermediary for receiving the messages from the folder and sending them to radios.

e To add an agenda, in the Tasks pane, click Add > Agenda.

¢ Inthe Agenda dialog box, specify the following parameters.

Agenda

x

Task name:

|Agenda

Settings

Qutgoing folder (on server):

|C:"-.0utgoing

Incoming folder {on server):

|C “Incoming

Wait for response(sec):

Text to corfim:

120

Cancel

= Task name

Specify a name for the task.
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Outgoing folder (on server)
Specify the outgoing folder for the text messages to be displayed in the
Dispatch Console (for example, C:\Outgoing).

Incoming folder (on server)
Specify the incoming folder for the reports (for example,
C:\Incoming files);

Wait for response
Specify the time interval, in seconds, for the response.

Text to confirm

Specify the text to be sent by the subscribers after they receive the
message.

6.4.5.13 Import Phone Addresses

The Import Phone Addresses option allows importing phone/address data from a
NENA database to TRBOnet database.

To perform this task:

e In the Tasks pane, click Add > Import Phone Addresses (NENA)
¢ In the Import Phone Addresses (NENA) dialog box, browse for the

corresponding *.CSV file, and click OK.

6.4.5.14 Scheduled Report

The Scheduled Report task allows reporting on selected parameters and sending
these reports to selected Email subscribers groups. The user can have several
Scheduled Report policies for different purposes.

Note: Before configuring the task, you need to create a number

of the Email groups to send reports to. For more details on
Email groups, see section 6.4.21, Email Groups (page 230).

e To add a Scheduled Report task, in the Tasks pane, click

Add > Scheduled Report:

e Specify a name for the policy in the Task name box and set the policy
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parameters.

Scheduled Report X

Task name:  |Registered Radios 1

Report  Scheduler

[F) General Information A Filter:
) Registered Radios

ﬁ Curren t Reports Radio Group: ~ot defined-- -
) Last known Systems and Radios Columns
TE) Presence and GPS Status
ﬁ Unregistered Radios Radio Name Radio ID Radio Groups
B System Reports
51 User Login History Select
B System Bridges

B Channel Changes

5] usage Statistics Reports
F) Messages

) Radio Activity

] Radio Status

) Radio Status Summary
] User Messages and Notes
T Radio Allocation

T5) Disabled Radios

T Telemetry

TE) Lone Worker Activities
B 3o Ticketing v

Check oK Cancel
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e On the Report tab, select the type of a report for the Scheduled Report task.
The report details and filter might be different.
For more details on reporting, see section 6.11, Reports (page 317).

e Click the Scheduler tab to configure a schedule for the report.

Task name: |Mesages 1 ‘

Repot  Scheduler

Start date: [26 Gctober 2016 -
Stop date: [27 October 2016 -
|
| Days of week: [Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday -
Start time: 5:00 =
| Statistic period: 1] [Fours - |
| Email groups: Police dep
Check OK Cancel

e Start date and Stop date
Select the time period over which to generate reports and send them to email

group.
Note: The start date may be any date you choose to start the task

on. The stop date must be later or the same as the current
date.

e Days of week
In the drop-down list, select the days of the week you want to generate
reports on.

e Start time
Specify the time to start generating the report at.

e Statistic period
Select the time interval (in minutes, hours, days, weeks, or months) to collect
the data.

¢ Email groups
In the list, select Email groups to send the report to.

The created scheduled report will be displayed in the Tasks pane:
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7 1: Line free [+] [Jarcal
P Group 20 [=2][«][@] ¥ 2 Group 30

() Database

i Radio Systems
i System Bridging [_]private Call [«]
G Teleshany b Add 5 Edit | Sk Delete
@ Tasks
3% Virtual Modbus Devices v LeckHame, 2
& Agenda
1=} Voice Dispatch G Dispatcher Presence Control
55 Export to SWD - Location of radio
@ Location Tracking wl [ i Geofencing
Wl {3 Idle Time
@ Job Ticketing vl G Lone Worker 1
Wl (2] Mesages 1_Messages for Period
Route Management wl 72, Missed GPS data loading
. vl 5% Radio Allocation {Sprite Forms)
QI RFID Tracker wl (%] Scheduled Report 1_Messages for Period_26-Nov-2016 00:00:00

i SMS and Email notifigations
[] Text Messages Wl {3 Timer
Wl {5 User Activity
'& Voice Recording W @ Voice Message
- wl @ Voice Message
Event Viewer

Eﬂ Radio Allocation

Fpr—
Wi | 4 Record 100f 15 ¥ W Wi 5

[ 127001 & B | § Administrator | [ Licensed to: demo Demo License @ Active~

To enable the task, select the check box in front of the Scheduled Report task you
have already created.

There are three types of the Scheduled Report status icons:
e Green indicates an active task, meaning the task is enabled (checked).
e Grey indicates an inactive task, meaning the task is disabled (unchecked).

e Red indicates a disabled task, meaning the task period is up in the past.

6.4.5.15 Import Beacon Data from Firebird DB

The Import beacon data from Firebird DB option allows importing beacon data
from Firebird database to TRBOnet Dispatch Software database.

e To add the task, in the Tasks pane, click Add > Import beacon data from DB
"Firebird".

¢ In the dialog box that opens, specify the following parameters:

Import beacon data from DB "Firebird" >
MName: Import beacon data from DB " Firebird"|
Settings | Import

Server: User:

|\ocalhcsl | |5YSDBA |

Database path: Password:

| | BEERARER |
Part: Update {sec):
3050 3 10 :
Test
G

¢ Name
Specify a name for the task.

e Server
Specify a remote server or a server on the local PC.
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e User
Enter the name of the Firebird DB user.

e Database path
Specify the Firebird DB path.

e Password
Specify a password to connect to Firebird DB (provided at logon).

e Port
Specify the port number to connect to Firebird DB.

¢ Update (sec.)
Specify the update period for Firebird DB.

e Click Test to test the connection to Firebird DB.
e Click the Import tab to specify Import settings:

Import beacon data from DB "Firebird” x

Name: Import beacon data from DB "Firebird"

Settings  Import

Import data from:
| <The Oldest Date Possible > ﬂ Import

Delete old data

Report:

Carcel

¢ Import data from
Specify the Firebird DB name.

e Click Import to import data.

¢ Delete old data
Select this option to delete all previously imported data from Firebird DB.

e Report
In this box, an import report will be displayed.

e Click OK to add the task.
6.4.5.16 HotSOS (Email)

The HotSOS (Email) task is used to automatically create and assign job tickets upon
receiving email messages at the address specified for the radio (Radio > Additional
> Email). In addition, you specify the email address at which to receive email
messages about changes to the created ticket status.

¢ In the Tasks pane, click Add > HotSOS (Email).
¢ In the HotSOS Configuration dialog box, specify the following parameters:
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HotS0S Configuration X
Name: [Hots05 |
Email: |lest @gmail .com| |
Source: |Subject j

Status | Hots0s status |
MNew N

Cancelled Ca

Assigned Ass

Accepted Acc

Rejected R

Completed C

In Progress InP

Cancel

Name
Enter a name for the task.

Email

Enter the email address at which you want to receive notifications
concerning the status of the created tickets.

Source

From the drop-down list, select which part of the email message, Subject or
Body, will be included in the job ticket text.

HotSOS Status

Enter the text of the emails that will be sent as notifications upon changes

to the job ticket status.

6.4.5.17 HotSOS (Web Service)

The HotSOS (Web Service) task is used to create and assign job tickets by using the
HotSOS Web Service.

¢ In the Tasks pane, click Add > HotSOS (Web Service).
¢ In the HotSOS Configuration dialog box, specify the following parameters:
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HotSOS Configuration >
Name: |Het505 |
URL: ‘Hl'tps:f"frfc.\nt.hotﬁos.netfap\/service.svc/soap |
Login: ‘Tester 123 |
Password ‘“‘“‘ |
Provider [MOTOTREO |
Polling Interval 1512 seconds
Text Messages: O
Message STEXT%%PRIORITY% % ORDER_ID%

Format:
Text Prioty Room Mame Room Number Remark
Order D Message ID
Status HotS0S Status
New N 1=
Cancelled Ca
Assigned Ass
Accepted Acc |
Rejected R
Completed C j
G
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= Name
Enter a name for the task.

= URL
Enter the URL of the service.

= Login and Password
Enter the login and password of the service account.

= Provider
Enter the service provider name.

= Polling Interval
Enter the interval, in seconds, to check the service for orders (job tickets).

= Text Messages
If you select this option, additional text messages will arrive at the
designated radios from the HotSOS server.

= Message Format
Select the fields of a message to include in the job ticket text.

* HotSOS Status
Enter the text of the messages that will be sent as notifications to the
HotSOS server upon changes to the job ticket status.

6.4.5.18 Automatic Data Retrieval

The Automatic Data Retrieval task is used to automatically retrieve missing
location data from the radio's option board.

¢ In the Tasks pane, click Add > Automatic Data Retrieval (Swift GPS).

¢ In the dialog box, specify the following parameters:

Automatic Data Retrieval (Swift GPS) =

Task name: ‘Momaﬁc Data Retrieval {Switt GPS]| |

General Radios
Maximum number of simultaneous requests:

Data upload

3 3
Retrieve missing locations if the data gap exceeds: 30 3: seconds

Do not retrieve missing locations older than: 30 3: minutes -
OK Cancel

* Maximum number of simultaneous requests
Specify the maximum number of radios being requested at the same time.

= Retrieve missing locations if the data gap exceeds
TRBOnet Server automatically checks whether the location data is
continuous. If it detects data gaps between any consecutive location data
that exceed this value, it will attempt to retrieve missing information.
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= Don't retrieve missing locations older than
TRBOnet Server doesn't check location updates for consistency if they are
older than this value in seconds, minutes, or hours.

= On the Radios tab, specify the radio(s) to retrieve location data from.
In the Tasks pane, activate the Automatic Data Retrieval (Swift GPS) task by
selecting the check box next to the task name.
6.4.5.19 Automatic Voice Download

The Automatic Voice Download task is used to automatically retrieve voice data
from the radio's option board when the radio is in WiFi zone.

¢ Inthe Tasks pane, click Add > Automatic Voice Download (Swift).

Automatic Yoice Download (Swift) X

Name: |Voice Download)| |

General  Radios

Maximum number of simultaneous requests: 33:

Saveto: |eh

%RADIO_ID%\EYEAR_EMONTH%_%DAY%_%HOURNEMINUTES_%SECOND%

Year Morth Day Hour Minute Second Call Type Source Source Type
Source ID Recipient Recipient Type Recipient 1D

ci\Radio_112018_06_06_17\32_57_xxx.tna

Cacsl

¢ In the dialog box, specify the following parameters:

* Maximum number of simultaneous requests
Specify the maximum number of simultaneously requested radios.

= Save to
Specify the path where to save voice data on your PC.

= On the Radios tab, specify the radio(s) to retrieve voice data from.
In the Tasks pane, activate the Automatic Voice Download (Swift) task by
selecting the check box next to the task name.
6.4.5.20 Sign-in Reminder
The Sign-in Reminder task is used to remind users to sign in into radios.

e To add a Sign-in Reminder task, in the Tasks pane,
click Add > Sign-in Reminder.

¢ In the dialog box that opens, specify the following:
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Mame: Sit J

Gereral  Radios

Timeout: 01:00 3:
... | Description
. Sign in please Text to speech:

Hurmy up with signing in| ‘

st o Core
[] Disable the radio(s) if not signed in during the timeout after being notified
Timeout: |3 minutes -
e

= Name
Enter a name for the task.

= Click the Add link and from the drop-down list, select either Text Message
or Text to Speech.

In the dialog box that opens, specify the following:

e Timeout
Specify the time, in minutes, to wait before sending the message (voice
message) to the selected radio(s).

¢ Text Message / Text to Speech
Enter the text of the message (voice message) to be sent to the selected
radio(s).

= Disable the radio(s) if not signed in ...
Select this option to disable the radio(s) if the user didn't sign in after being
notified.

e Timeout
Specify the corresponding timeout, in minutes.

= C(Click the Radios tab, and select the radio(s) to send reminder(s) to.

6.4.5.21 Screensaver

The Screensaver task is used to launch a screensaver when the dispatcher is idle for
a period longer than the specified timeout. Once started, the screensaver will be
stopped when you click the mouse button or press any keyboard key, or there is an
emergency call or a request to talk.

e To add a Screensaver task, in the Tasks pane, click Add > Screensaver

¢ In the dialog box that opens, specify the following parameters:
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= Name

Screensaver X
Name: |Screen Saver |
Show screensaver if no activity more than 30 minutes EI:
Background I RoyalBlue hd
Foreground [ whiteSmoke -
Text
TRBOnet
(® All Dispatchers
() Selected Dispatchers

4

Test
Cancel

Enter a name for the task.

= Show screensaver if no activity more than
Set the time of inactivity, in minutes, after which the screensaver will
automatically run.

= Background / Foreground
Select the background/foreground colors for the screensaver.

= Text

Enter the text that will be displayed in the screensaver.

= All Dispatcher / Selected Dispatchers
Select the dispatcher(s) to assign the screensaver task to.

= Test

Click this button to see how the screensaver will look.

6.4.5.22 Import Objects

The Import Objects task is used to import new objects to the Users database and
Radios database based on the .CSV data files.

e To add an Import Objects task, in the Tasks pane, click Add > Import Objects

Object Import frem File

MName: |Import Objects

General  Update Column Mapping

Object Type:

File Path

|D: \CSViusers.csv
Passwords encrypted
Delete objects not existing in file

X

|
Radio User ﬂ
Cance!

In the dialog box that opens, enter the following information:
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= Name
Enter a name for the task.

General tab

= Object Type
From the drop-down list, select into which database to import data (Radios,
Radio Users, Map Routes, Map Objects, Map Regions, or Beacons).

= File Path
Click the ellipsis (...) button and locate the .CSV file on the same PC with
TRBOnet Server.

= Passwords encrypted
Select this option if the passwords are encrypted in the data being
imported.

= Delete objects not existing in file
Select this option so that objects not found in the .CSV file will be deleted
from the database.

Update tab

= File changed
Choose this option so that the specified database will be updated as soon
as the source CSV file is changed. Note that the source .CSV file must reside
on the same PC with TRBOnet Server.

= Scheduler
Choose this option and on the list below select the scheduler to use to

perform the task. Or, click the plus sign button and specify a new scheduler
(see section 6.4.17, Schedulers).

Column Mapping tab

In the table below, in the right column, enter/change the column names that
would correspond to the database field names.

6.4.5.23 Export Objects

The Export Objects task is used to export objects from the Users database and
Radios database to external .CSV data files.

e To add an Export Objects task, in the Tasks pane, click Add > Export Objects

Export Objects to File X

MName: |Export Radios |

Object Type: Radio H

Columns: Al -

Scheduler: -Mot defined-- e

File Path
D:\CSViradios.csv

Cancel
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In the dialog box that opens, enter the following information:

= Name
Enter a name for the task.

= Object Type
From the drop-down list, select which database to export (Radios, Radio
Users, Map Routes, Map Objects, Map Regions, or Beacons).

= Columns
In the drop-down list, select the columns to be exported into a .CSV file.

= Scheduler
Choose this option and on the list below select the scheduler to use to
perform the task. Or, click the plus sign button and specify a new scheduler
(see section 6.4.17, Schedulers).

= File Path
Click the ellipsis (...) button and locate the CSV file on your computer (or
elsewhere).

6.4.6 Custom Fields

In this section, you can add custom fields that can later be used when registering
radios (see section 6.4.27, Radios, Additional tab) and users (see section 6.4.23,
Users, Custom Fields tab).

¢ Go to Administration (1), Custom Fields (2)

File View Map Tools Help

Administration Custom Fields €|
g et * |G 1: e free [ rtercom Ofe) (OB EEE]
©.[A License
[ Database Pl cleaners (][« [@] N P Firemen =@
{-ila Radio Systems
i.fi System Bridge B orovp 20 B[S
-Gp Telephony 2 Custom Fields
[ ek ., Add 5 Edit | = Delet
: Custom Fields = 5 Edit | B Delete
i Modbus TCP Connections Name & Key Type Description
1,33 virtual Modbus Devices v ||Car make CAR_MAKE Text

Description DESCRIFTION  Text Custom Field X

(=) Voice Dispatch Email 3 Een Emai

Name NAME Text o Car make
@ Location Tracking Phone PHONE Phone Key: CAR. MAKE
Plate number PLATE_NUMBER Text Type: Text -
Route Management
Description
[] Text Messages
(D Reports P 1 Cance
&
@ Administration |
M| 4| 4 | Record 1of6 b | |mi| 4 »
[H Connected &3 B ES € Administrator | [ Licensed to: demo Demo License @ Active ~

e Click the Add button (3).

¢ In the Custom Field dialog box, specify the parameters of the field, such as its
Name, Key, Type (Text, Phone, or Email), and Description.

6.4.7 Modbus TCP Connections

TRBOnet Server can receive and send data from/to Modbus hardware and interact
with Modbus data according to desired scenarios. There are two connection modes
between TRBOnet Server and Modbus hardware: Master and Slave.

To connect TRBOnet Server to Modbus hardware:
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e Go to Administration (1), Modbus TCP Connections (2):

File View Map Tools Help

Administration

s Radio Systems
5 System Bridging
& Telephony

& Tasks
- JModbus TCP Connections|

2

v
>

£ Mode IP Address Port Slave ID | Behavior
Master 192.168.77.10 502
il Voice Dispatch ¥ ModBus2 \Slave 502 1 Custom

% Location Tracking

& 30b Ticketing 3
T
/5] Radio Allocation 1

K
EP——
4|4 Record 10f2 » | W |M| 4 4

[ 127000 &5 B B, B 8 Administrater | [ Licensed to: deme Demo License @ Active-

¢ In the Modbus pane, click Add (3).

Modbus Configuration X

Name: ModBus_Siave
Mode: Save -
Port 502

Slave ID: 1

Behavior: Custom =

B

= From the Mode drop-down list, select the mode of connection.

¢ |If the 'Slave' mode is selected, specify the Port of TRBOnet PC and the
Slave ID to assign to this PC.

Leave Behavior as Custom if this connection will be used for
Event/Alarm management.

¢ |f the 'Master' mode is selected, specify the Remote Address, Port, and
ID of the Modbus device, which in turn will be running in the Slave
mode.

Modbus Cenfiguration be

Name ModBus_Master
Mode: Master -

Remote Address: [10.10.168.20

Port 502
D: 1
[ Parallel Requests

Cancal

v" Parallel Requests
Select this check box so that TRBOnet Server can send multiple
requests without waiting for responses from the Modbus device.

6.4.8 Virtual Modbus Devices

Once you have created the appropriate TCP connection, you can add a Modbus
device:

e Go to Administration, Virtual Modbus Devices, and click Add.
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Virtual Modbus Device X

Name. [Pect |

Description:

Corfiguration: ModBus2

Table: Disretelnputs

v Edit Filter
o

In the Virtual Modbus Device dialog box, specify the following parameters:

= Name
Enter the name of the device.

= Description
Enter the description of the device.

= Configuration
From the drop-down list, select the slave connection you previously created
for the device (that is, TRBOnet Server running in the Slave mode).

= Table
From the drop-down list, select the appropriate MODBUS data type
('Discrete Inputs', 'Coils’, 'Input Registers’, or 'Holding Registers’).
In the 'Address/Value' table, enter the appropriate register values.

6.4.9 IP Cameras

This section describes how to connect IP cameras to TRBOnet Dispatch Console.
¢ Go to Administration, IP Cameras to manage IP cameras in the system.
¢ In the IP Cameras pane, click the Add button.

¢ In the IP Camera Configuration dialog box, specify the following parameters:

IP Camera Configuration X

Name.
Camera 1

Description:

Disposal dump

URI
[rsp/710.10.102.243:554/

Protocal

UDP hd
Authorization
e 7

= Name
Enter a name for the camera.

= Description
Enter a description for the camera.
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= URI
Enter the URI for the camera. Note the use of the RTSP:// prefix and port
number 554 (also note that some cameras may have been configured to
use a different port number other than 554).

* Protocol
From the drop-down list, select UDP.

=  Authorization

e User
Enter the user name for the authentication, if needed.

e Password
Enter the password for the authentication, if needed.

6.4.10 Event/Alarm Management

The Event/Alarm Management feature allows you to create rules for Alarms, Emails,
Notifications, Text Messages to radios, and other events. When a configured rule is
executed, the appropriate action(s) will start.

For example, an external application sends some text data, which contains the text
"alarm", to TRBOnet software. The text "Alarm" is configured as the rule to start
sending a predefined voice message (for example, "Alarm in Sector N") to selected
radios (for example, the group "firemen"). As a result, the group "firemen" are
notified about an emergency condition.

e Go to Administration (1), Event/Alarm Management (2) to configure
Event/Alarm Management:

File View Map Tools Help

Administration Event/Alarm Management
] serv | B ntercom D[« Il 1: tine free OE W
[21][«][@] I Fd Group 20 [2)][«][@] I P Group 30
54 Radio Systems
3 System Bridging

& Telephony 2

@ Tasks
23¢ Virtual Modbus Devices

{58} Event/Alarm Management

(1)) voice Dispatch

@ Location Tracking

&L 3ob Ticketing

[j Route Management

@ RFID Tracker

[] Text Messages

ﬁ Voice Recording

Event Viewer
@ Radio Allocation 1
P 7
|« | | Record 20F2 b [o» ] < >
[ 127001 g3 B | @ Administrator | [ Licensed to: demo Demo License @ Active~

e Click Add (3) to add a new Event/Alarm Management rule.

Note: The administrator can also create a copy of the existing
Event/Alarm Management rule. Select a rule in the list and
click the Create a Copy button. The system will create a
copy of the rule with the same configuration parameters.
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Enter a name for the rule.

¢ On the Source tab (1), click Add (2) to add a new event source for the rule.

Event Source

Event.

[alarm Reset
Aarm

ame | ® Activated by arAlarm Reset
o
¥ o O Activated by s

M Port

Deivery Confimation
Dispatcher Presence Alarm
DTvF

Email

External Network Connection
Geofencing Rules

Job Ticket Status

Modbus {master)

Modbus (slave)

PTT Event

Radio Alocation

Radio locatin data s outdated
Rado state

Rado Status

RFID Signal

Route Events

ScadaEvent

ScadaThreshold

S Call

SMS

Swift Commands

System Events

Telemetry

Text Message

Timer State

From the drop-down list (3), select the event type to set for the rule.

For a description of the event types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: Select the event you want to enable. In case no event is

selected, all configured events are disabled by default.

Event/Alarm Management

Name: [Wew Event

Source | wiorking Hours | Location | Action

Name:
M TextMessage
W comport

Desaiption
Active Radios: All; Text: ;
Port: COML; Text: alarm;

gar | | odem

oK

ncel

e Click the Working Hours tab to set the time at which the rule will be valid.

All Time
Choose this option so that the rule will be valid all the time.

Selected Time
Choose this option so that the rule will be valid on the selected days of the
week at the specified time.

e Select the days of the week and specify the working hours.

e Click the Location tab to set the regions inside or outside of which the rule will

be valid.
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When a region(s) is (are) selected, the events specified in the Source tab must
take place inside/outside the selected region to start the action(s).

Note: When COM Port and/or External Network Connection
are selected as the event source, the Location rule should
not be used.

Event/Alarm Management X

Nam [Mew Event

ﬁmt ation | acton |
2 Enable

Radio Location: Inside Regions -
O Al Regions

@ selected Regions

Region

Region 2

[AliRegion_1

(P

Select Al Clear All
=

= Enable
Select this option to apply All Regions/Selected Regions to the rule.

= Radio Location
From the drop-down list, select whether the rule will be valid
Inside Regions or Outside Regions.

= All Regions
Choose this option to apply the rule inside/outside all map regions.

= Selected Regions
Choose this option to apply the rule only inside/outside selected regions.

e Region
In the list, select the region(s).

e Click the Action tab (1) to set actions for the rule.

In the Actions list, the administrator can add and configure the action types to
be started when the events configured and selected in the Source page are
triggered.

e C(lick Add (2) to add an action:
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Name: New Event

[Souree | Action Type Beacon: Edit Properties =
- ®,
_HOLN Action
Souree | warcrg vours | bocstn Beacon: Edit Properties
/ " Camera n New Window
Name Description
& Emal Recpienty N gﬁzﬁmen Notification
Geofencing Rules 3
1 Job Ticket

Map Object: Create New
Map Object: Delete Existing
Map Object: Edit Properties
Modbus
Description: Phone Call Establishment
Radio: Lock
Radio: Private Call
Radio: Remate Monitor
Radio: Request Location
Radio: Set Alarm
Radio: SetLocation Profie
Radio: Set Logical Groups
RFID Signal: Emergency Contact
2 RFID Signal: Supervisor
Route

Scada

Send to External IP Data Source

SMS

Start Lone Worker
= =l Swift Command

B System Bridging

Telemetry
Text Message
Text to Speech

Voice Message

= Action Type
From the drop-down list (3), select the action type.

For a description of the action types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: After you configure the rule, enable it by selecting the
check box beside it. In case when no rule is selected, the
action will not be started.

File View Map Tools Help

Administration ent/Ala anageme &l

R ;f!&nse N (= [][«][@] 5 1: Line free <] ] [ Jarcar el
Prisi B o DEE) (/s ooE (VErE D]
) Radio Systems
g System Bridging []Private call DEE]
@;Fli,:hw =k Add (5} Edit =] Create a Copy | =k Delete
@ Tes
5% Virtual Modbus Devices Name n
[} Event/alarm Management v || C] New Event
Send DTMF
(1Y Voice Dispatch
% Location Tracking
& 30b Ticketing
Route Management
@ RFID Tracker
[ ] Text Messages
Q Voice Recording
Event Viewer
SR
|« | <[ Record 202 » [w|m] <] .
9127001 63 € Administrator | [ Licensed to: demo Demo License Active~
o) g E] 2

6.4.11 Telemetry
On the Telemetry configuration page, you can configure settings for Telemetry.

6.4.11.1 Radio Groups Telemetry

This is a default telemetry profile that is used to send telemetry commands to radio
groups.

¢ Click Radio Groups Telemetry in the Administration pane.

¢ In the Telemetry configuration pane, click Edit.
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File View Map Tools Help

Administr onfiguratio €[
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-y Telemetry
L Edit
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L Telemetry #1 h
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Ay voice Dispateh Radio Groups Telemetry
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(@ VIO2: VIO2: High level (High level)
“ Job Ticketing
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@ i (Higt 0
RFID Tracker
[ Text Messages
Q Voice Recording
Event Viewer
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P —
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Radio Groups Telemetry x
Telemetry Type: MOTOTREO
Profile Name: Radio Groups Telemetry
Digital Qutputs
D [ Name | Command
VIOl WVIO1: High level High level
VIO2 VIO2: High level High level
VIO V103: High level High level
viot VIO Highlevel High level
VoS VIOS: Hioh leved High level
Description
D VIO1 -
Name: |
Command: High level =l

= Click Add and specify ID (VIO), Name, and Command (signal level).

Note: For Radio Groups Telemetry only the Digital Outputs tab

is available.

6.4.11.2 Adding Telemetry Profile for Radios

e Go to Administration (1), Telemetry (2), and click Add (3):
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Telemetry Profile X

Telemetry type: poToREC i

Profile name:

Telemetry #2

= Specify Telemetry Type for Radio groups:
¢ MOTOTRBO - telemetry from Motorola radios.

e Socintech Novox — telemetry from Novox devices connected to the
radio via COM port.

e Swift Option Board - telemetry from the option board connected to
the radio.

e Sprite — telemetry from Sprite devices.
Note: Sprite telemetry profile can be read but not written.

= Profile name
Enter the name of the profile to display in the Dispatch Console.

= Click OK.

Telemetry 21 X

Telemetry Type:  MOTOTREO

Profile Name: Telemetry #1

Common  Digital Inputs _ Digital Outputs

Auto request input states

Requestinterval: 500 =] second
inpu

Common tab

= Auto request input states
Select this option and in the Request interval box specify the time interval,
in seconds, to request input data.

= Trace digital inputs
Select this option to monitor digital input damages.

= Trace analog inputs
Select this option to monitor analog input damages.

= Replace state event to VIO events
Select this option to generate VIO ON/OFF event when the system
compares between the last and the current states of the VIO.

Note: Most of the policies are set to replace events, so it is
recommended to enable this option.
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Digital Inputs tab

Telemetry #1 X

Telemetry Type: ~ MOTOTREO

Profile Name: Telemetry =1

Common  Digital Inputs _ pigital Outputs

D Name Event
VIO1 @ vio1 High level
Vo2 @ vio2 High level

: vioz -

Heme: [ |
Reset Name [ ]
Event: igh level -

Severity: & (Warning ir

Display as subscriber state

[] Auto reset state.
[ Request location of subscriber Apply

= Add Sk Remove

=

e Click Add to add a VIO (Virtual Input/Output) to the profile.
= ID
Select the VIO to set the parameters for.

= Name
Specify a name for the VIO to be displayed in the Dispatch Console.

= Event
Select the signal level of VIO events from the drop-down list. When an
event with the selected signal level occurs on the selected VIO, the
telemetry will be activated. The signal level must be the same in the radio’s
codeplug and in Telemetry configuration in TRBOnet. It is a programmable
option that sets the pin's voltage level to High or Low in order to trigger a
selected functionality.

= Severity
Specify a severity level for the VIO event from the drop-down list.
= Display as subscriber state

Select this option so that the radio will change its status after it sends the
telemetry command.

= Auto reset state
Select this option to automatically reset the telemetry VIO after the radio
sends the telemetry command.

* Request location of subscriber
Select this option to request a GPS position of the radio after it sends the
telemetry command.

= Click Apply to apply settings to selected inputs.
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Digital Outputs tab

Telemetry 21

Telemetry Type: ~ MOTOTREO

Profile Name: Telemetry =1

Common  Digital Inputs.  Digital Outputs
D Name

ol VIOL: High level High level
vio2 VI02: Low level Low level
vio3 VIO3: High level
Vo4 VI04: Toggle

High level

Toggle level

D: vIo3 -

Command Figh level -
Apply

=

e Click Add to add a VIO (Virtual Configured PIN) to the profile:
= ID
Select the VIO in the dropdown list to set its parameters;
= Name
Specify a name for the VIO to be displayed in the Dispatch Console.
= Command
Specify a signal level for the command to send to the selected VIO.
= Click Apply to apply settings to selected outputs.
6.4.12 Text Messages

On the Text Messages configuration page, you can configure settings for Text
Messages.

6.4.12.1 Group Text Messages

This is a default text message profile that is used to send text messages to radio
groups.

e Click Group Text Messages in the Administration pane.
¢ In the Text Messages configuration pane, click Edit.

¢ In the dialog box that opens, change the desired parameters.

For a description of the profile parameters, see section 6.4.12.2, Adding Text
Message Profile.

6.4.12.2 Adding Text Message Profile
e Go to Administration (1), Text Messages (2), and click Add (3):
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File View Map Tools Help
Administration e g guratio €|
o ek Devess ~ (W5 1 e e W inercom @] I M st : el
(58} Event/Alarm Management Fsiot2 [9] (<) (@] I ¥ Group 11 (][ (@] I ¥ Growp 22 [« @
- ) Telemetry
| {8 Radio Groups Telemetry [ cal [71] (<) @] J O Private cal [DIEEE]
- () Text Messages.
Add [ dit | [Ek Del
biE7) GmuDTExt;;;E.QE'—- 2 [ 444 B et | Bk peese
- (1 Radio Statuses v
Profile Type: MOTOTRBO
Iﬁ‘éﬁ Voice Dispatch 3 Data protocol MS| Proprietary
Text Message fommat Senderand Text
% Location Tracking Max. message length: 140
Soit long message inte mutiple messages: Mo
& 3o Tickets Text Messages Profile X
Profile type: MoToTRED -
Profil name:
: Mobile Messenger (BT Accessor v)
[] Text Messages Text Messages #1
ﬁ Voice Recording Cancel
[ reemeten e
R
[ Connectes 3 B B B | & Administrotor | (8 Licensed to; demo Demo License | © Active-

¢ In the Text Messages Profile dialog box, specify the following parameters:

Select if the Bluetooth Communicator is used together with the radio to

Profile type
From the drop-down list, select one the two items:
¢ MOTOTRBO
Select if the radio itself is used to send/receive messages.
¢ Mobile Messenger (BT Accessory)
send/receive messages.
Profile name
Enter a name for the text profile.
Click OK.

Text Messages 1

Profile Type:

Profile Name:

Data protocol:

Route type:

Text Message format:
Custom format:

Max. message length:

MOTOTREO

|Text Messages #1

|MSI Proprietary

IReguIar

ISender and Text

Ll L <]

I{Sender} {Text}

I:HO 3: chars

I split long message into multiple messages

Cancel

¢ In the Text Messages Profile dialog box, specify the following parameters:

Profile Name
Enter a name for the profile.
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= Data protocol
From the drop-down list, select one of the two items:

e MSI Proprietary
Select if the radio is equipped with a display and supports the new Text
Messaging service.

e DMR Standard
Select if the radio is equipped with a display and supports DMR
Compatible text messages.

= Route type
From the drop-down list, select one of the three items:

e Regular
Select this type to receive messages on the radio.

e Option Board
Select this type to receive messages on the radio's option board.

¢ Non-IP Peripheral
Select if the radio is connected to a PC via a USB port.

= Text Message format
From the drop-down list, select one of the pre-defined formats for text
messages, or select the Custom format.

= Custom Format
Enter your own format for text messages in this box if you have selected
'‘Custom' from the list above. The Custom Format will default to
{Sender} | {Text}. There are four choices: {Sender}, {Text}, {Date}, and {Time}.
Another example would be: {Date} | {Time} | {Text}.

= Max. message length
Enter the maximum number of characters that TRBOnet will send per text
message. The recipient of the text message may not be able to receive the
maximum number of characters due to its design limitations. Therefore, it
may only display a partial text message.

= Split long message into multiple messages
Select this option to allow single messages to be split into multiple
messages based on the Max. message length setting.

6.4.13 Radio Statuses
In TRBOnet Dispatch Console, you can configure different profiles for the radio
statuses that are received from or sent to the radios.

¢ Go to Administration, Radio Statuses. You can see the default Radio Status
profile settings in the Radio Statuses pane.

To add a Radio Status profile, click the Add button, and in the dialog that opens,
specify the required statuses to be received from the radios (Receive tab) and sent
to the radios (Send tab).

6.4.14 Location Profile

The Location Profile feature allows configuring different profiles of location update
settings for built-in GPS receiver. Location Profile overrides default location trigger
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configuration in Server settings. For example, fire emergency service has a number
of departments in a city and needs to monitor current position of radio subscribers
(firemen). The administrator can create a number of separate location profiles with
different location tracking settings for each department.

Note: The Location Profile feature is available for MOTOTRBO Generation
Il radios, firmware version 2.4 or later.

¢ Go to Administration (1), Location Profile (2). You can see the default
Location Profile settings (3) in the Location Profile pane.

File View Msp Tools Help

Administration ocation Profile & [

L[] swift Commands Profles A

i % Teemelry p 1 Line fres [«][@] | P intercom [2][+][@] | P Maintenace [2][«[@]
Radio Statuses (vEE [][«][@] | P disp 15 [1][<:][@] |8 ¥ Group 10 [21][«][@]
Mobie Cl &t Profie ¥ Group 20 = (vEED [21][=][] ¥ Group 11 [2][«][@]
A Todls 2 ¥ Group 22 [][«][@] B[] Private cal [=2][=][2]

13) Disabled Radios
S niem e o e S Add [ Edit | Bk Delete

{11} Voice Dispatch
Profile type: MOTOTRBO

@ Location Tracking Manage trigger manually: Yes
Chanrel type: Non-scheduled (Reguiar GPS over Voics or Data Revert Channel)

w Job Ticketing Location priority: GPS
GPS data Latitude, Longtude, Direction, Speed, Precision

Route Management {Beacon data 1Beacon: Major, Minor
Fast GPS on Connect Plus systems No

[] TextMessages Periodic Trigger: Interval 30.0 sec

(R neports

Event Viewer

EE] Radio Allocation \ 5

@ Administration —

127001 £ & B, | § Administrator | [ Licensed to: demo Demo License | © active~

There is a default Location Profile that the administrator can use and edit.
The administrator can do the following:
1. Use default location profile.
2. Create a custom location profile: Add button.
3. Edit a profile: Edit button.
Note: In the default profile, the Name and Description cannot be
changed.
6.4.14.1 Adding a Location Profile
¢ In the Location Profile pane, click the Add button.

Location Profile X

Profile type: MCTOTRBO -

FS 5000
Extended device

Profile name:

Location Profile #4

Conce

= Profile type
Select the Profile type (MOTOTRBO, FS 500, or Extended device).

= Profile name
Enter the name of the profile.
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212

MName: [Location Profile #4|

¥ save GPs data to database

[ Manage trigger manualy

Channel type

Location priority: [Beacon

[Mon-scheduled (Regular GPS aver voice or Data Revert Channel)

¥ GPS data:

Leflel L] Le]

[ otitude, Longituce, Predsion, Direction, Speed

[~ Beacon data: ‘Majm Minor

1 =

[ Fast GPS on Connect Plus systems.
W Periodic trigger
Interval: 0.0 2] second

™ Distance trigger

[ Telemetry trigger

I Emergen
7 shos

Name
Specify a name for the location profile.

Description
Add a description for the location profile.

Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

Manage trigger manually
Select this option so that GPS triggering will be started manually by the
dispatcher.

Channel type
From the drop-down list, select a radio channel for sending location data to
TRBOnet Server:

= Non-scheduled
This is a channel with regular GPS (Enhanced GPS not supported).

= Scheduled
This channel is available when the Enhanced GPS feature is configured in
the radio system.

= Non-scheduled with CSBK data
This channel allows using CSBK (Control Signaling Block) while decoding.

= Scheduled with CSBK data
This is a channel with Enhanced GPS, which allows using CSBK (Control
Signaling Block) while decoding.

Location Priority

This option is used when beacons are placed on the maps. If the radio having a
GPS fix enters the range of a beacon placed on the map, its location tracking
will be performed according to the selected priority.

* Beacon
Location tracking will be performed based only on the GPS coordinates of
the beacons placed on the map.
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= GPS
Location tracking will be performed based only on the GPS coordinates
received from the radio.

e GPS data
Select this option to enable the user to select what GPS readings to send to
TRBOnet Server. In the drop-down list, select which GPS data to include in a
packet.

¢ iBeacon data
Select this option to enable sending iBeacon data to TRBOnet Server. In the
drop-down list, select which iBeacon data to include in a packet:

= Major, Minor (included by default and cannot be disabled)

= UUID
iBeacon's Universally Unique Identifier

= TX Power, RSSI
The strength of the beacon's signal as seen on the receiving device.

¢ Number of iBeacons
Specify the number of the most recently detected iBeacons whose data will be
included in the data packet sent to TRBOnet.

e Periodic trigger
Select this option to set a periodic location trigger on a radio. The trigger is a
request to the radio to send its GPS and/or iBeacon data at the specified time
interval.

* Interval
Specify the location update interval, in seconds.

o Distance trigger
Select this option to allow receiving location updates by a distance:

= Distance
A radio will send location updates if the travelled distance exceeds a
specified distance from the last GPS point, in meters.

= Min. interval
A radio will send location updates no more than once within this time
interval, in seconds.

e Telemetry trigger
Select this option so that a radio will send GPS and/or iBeacon data upon
sending a Telemetry command.

e Emergency Trigger
Select this option so that a radio will send GPS and/or iBeacon data upon
entering the emergency mode.

= Show emergency mode for Radio when Emergency GPS message is
received
Select this option if you want a Dispatch Console operator to see the
emergency status of a radio that transmitted location data.

¢ C(lick OK to save the location profile settings.
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To apply Location Profile to a radio:

e Go to Administration (1), Radios (2), select the radio in the table, and click
Edit (3):

File View Map Tools Help

Administration Registered radio groups and radios =
~
oo (RETE : [Jorou 2 5
i = Logical Groups [PARepester 21: Slot =1 [FArepester =1: Siot 22 [)][«][@] [ ] an cal
F) Radio Gr‘wy 2
B Radios v
" Reg Unregistered
A\l voice Dispatch Ak Add Group | =% Add MOTOTRBO Radio =) Add WAVE Radio = Add TRBOnet Mobile [Zb Edit
Callsign & Type Radio ID MDC / Sel-5... | SIP ID Radio Groups | Legical Goups | Description
@ GPS Positioning ® 125 MOTOTREQ... 125 0 2125 Firemen
@ 235 MOTOTRBO... 235 o 2235 Firemen
ﬁ‘ Job Ticketing
Route Management 3
QI RFID Tracker
[] Text Messages
ﬁ Voice Recording
A
Event Viewer
“5] Radio Allocation 1
5., Administration -
1|40 | ¢ | Record 1of2 b | m[m] ¢ »
[ 127001 & By B | 8 Administrator | [ Licensed to: demo Demo License @ Active-
Voice Dispatch 125 X
General | Logical Groups | Additional| TP Call| Cameras |
Calsign: [125 ]
Radio ID: 125 4| MDC ID: o
Rado Grovps: |l ~[+]
Home Group: |cieaners ~[+]
Use icon: |@ Fortable Radios vI+=]
Location Service
Location Seurce: Built-in GPS receiver v
Location Profie: [Defauit) [~]+]
\(Deiault)
| L ocation Profile #1
Telemetry Service
TLM Source: Built-n Telemetry ~
TLM Profie: (Default) e
Text Messages Service
1< Trna: Standard ~ 4
Hide Advanced Settings

= (Click the General tab, and from the Location Profile list select the location
profile to use for the radio.

= Select/clear the Location Enabled check box to enable/disable the location
trigger.

Note: The Location Profile is only applicable when the 'Built-in
GPS receiver' or 'Extended device' (if any) is selected in the
Location Source.

6.4.15 Mobile Client Profile

The Mobile Client Profile feature allows configuring different location profiles that
can be applied to the Mobile Client app running on a smartphone. For information
on how to register a TRBOnet Mobile app, see section 6.4.27.1, Adding TRBOnet
Mobile.

e Go to Administration, Mobile Client Profile.

You can see the default Mobile Client Profile settings in the Mobile Client
Profile pane.
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6.4.15.1 Adding a Mobile Client Profile
¢ In the Mobile Client Profile pane, click the Add button.

¢ In the Mobile Client Profile dialog box, specify the following parameters:

Maobile Client Profile X

Profile Name: [oefauit)

Client Type: [TRBanet Mobile -

Available Modes: |Vmce Calls, Text Messages, Location, Job Tickets j

Location |

Location priority:  [Beacon |
[1 Moniitor location from other stations
Use GPS location
Trigger interval: [ =] seconds
Emergency interval: [ =] seconds
Use Indoor location
Trigger interval: m seconds
Emergency interval: [ =] seconas
Number of iBeacons: 3
iBeacons fiter: | 28934426 -4fa2-4298-8024-be5b 71e5278F =]
Defaults Cancel

= Available Modes
In the drop-down list, select/unselect the features that will be available to
the associated Mobile Client.
= Monitor location from other stations
Select this option so that the Mobile Client will receive locations of other
radios (mobile clients).
= Use GPS location
Select this option to enable sending GPS data to TRBOnet Server.
e Trigger interval
Specify the time interval, in seconds, used to send GPS location data.
= Use Indoor location
Select this option to enable sending iBeacon data to TRBOnet Server.
e Trigger interval
Specify the time interval, in seconds, used to send iBeacon location data.
¢ Number of iBeacons
Specify the number of the most recently detected iBeacons whose data
will be included in the data packet sent to TRBOnet.
e iBeacons filter

Click the arrow on the right and enter (Add link) the UUID of the
beacons that will be used by the mobile client.

Note: If you don't specify the iBeacon UUID, the Mobile Client
app running on an iOS device won't detect any iBeacons.

6.4.16 Tools

On the Tools page, you can find some useful tools.
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6.4.16.1 Templates for Extended Messages

The Templates can be used for Extended Messages and Extended Notes.

The Extended Messages feature is a special function allowing users to send detailed
preconfigured templates containing necessary information to each other with the
help of the special TRBOnet Dispatch Console application.

This service has been created especially for clients who need to use more detailed
and structured messages in their work. If the standard messages are not enough to
contain all required information, you may use the Extended Messages service.

e Go to Administration (1), Tools > Templates (2) to create a new template:

File View Map Tools Help

Administration
(&) Swift Event Profiles ~
[ Telemetry

HEE
[Jancan [][«][e]

[y Radio Statuses
GPs Profile
] % Tooks 2
] Tempiates
43} Indoor 2D Map Converter
S\ Disabled Radios

[JPrivate Call

=l Add From File | = Add =} Edit []] Save ToFile | =k Delete
Preview Name

<

J)) Voice Dispatch
New Form

g Location Tracking

& sobTicketing
Route Management
@ RFID Tracker

[] Text Messages

'& Voice Recording
Event Viewer

e ]

/1

o) 4|+ |Record 10f 1 » [w[mm] «

Group 30 [-0][=]

127001 &9 By | & Administrator | [28 Licensed to: demo Demo License

@ Active -

e Click Add From File (3) to add a template from a file.

template to a custom directory.

e Click Add (4) to create a new template:

Note: Before adding a template from a file, save the created

Select the directory where you saved the template and click OK to add the file.
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Add/Edit Template - o X
i"i"‘b:"“: Template ID: | 754e575-d966-48c(-add 7-67%F1 091920 | []
e
labi Textbae New Fomn o]
[] CheckBox (3]
== ComboBox o
(DataBindings) ~
AccessibleDescrption
Drag selected AccessibleName
CaEa Accessbleole Defautt
AlowDrop False
Template size: [ Gea fucher ot
E i Appearance Nomal
U LS AutoChedk T
Heght: 500 1= AutoElipsis False
: 3 AtoSize True
BackColor [ ControlLightLight
B || Beckguundinage [ frone)
BackgoundimageLayout  Tie
CausesValidation Tue
CheckAign MiddeLeft
Checked False
CheckState Unchecked
ContextMenuStip (none)
Cursor Def:
Dock None
Enabled Tue
FlatAppearance
FatSvle Standard ¥
Checked
Indicates whether the component i in the checked state
oK Cancel
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= Name (1)
Specify a name for the template to display in the Dispatch Console (1).
= Elements (2)

Select elements to add to the template. Drag and drop the selected
element to the desired place on the mail template box.

= Template size (3)
Specify the template dimensions and background color.

= Click an element on the template. On the right side of the Template dialog
box, you can see the selected element properties.

For directions on how to send an extended message to a radio, see section 6.9.2.1,
Send Extended Text Message to a Radio.

6.4.16.2 Indoor 2D Map Converter

TRBOnet Dispatch Console provides the Map Converter to use custom images as
Indoor 2D Floor plans. The tool allows converting images to the BMAP format that is
supported in Indoor Positioning.

e Click Administration (1), Tools > Indoor 2D Map Converter (2).

File View Map Tools Help

Administration Indoor 2D Map Converter €]
A

3 intercom : Line free e (mEED [« [e]
o MGy Mcow 3 <l

[JPrivate call [2][«][@]

-1

P -

[ 127001 &8 B | § Administrator | [ Licensed to: demo Demo License @ Active -

¢ Name
Specify a name for the new Indoor 2D Map.

¢ Image
Click the ellipsis (...) button and locate the image file (PNG, JPG, TIFF, GIS) on
your computer.

e Directory
Click the ellipsis (...) button and locate the folder where to save the converted
Indoor 2D map on your computer.

e Click Start to convert the image.
To use the converted map

e Click Location Tracking (1). On the Map menu, click Open New Map in Tab
(2):
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@ Reports Date Radio System Sender Recpient Message Details
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e From the Map Type list box, select '‘Beacon 2D'.

e Click Add to and browse for the map you have converted.

e Click OK to open the Indoor map in the Map pane.
6.4.17 Schedulers

The dispatcher can create pre-defined schedules to be used as event sources in
Event/Alarm management, for database backup, and in job ticket templates.
¢ Go to Administration (1), Schedulers (2).

¢ In the Schedulers pane, click Add (3).
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File View Map Tools Help

Administration edule &)
a poer d ereee </l B Jintercom [ ]1%] IR B ventenace «lel
[y Teemetry [ Jsaes ooE (BT Do) (S Plelel
[ Radio Statuses = . o
Location Profile L] Lozt Ll S [-)][«][e]
Scheduler x
Mabie Cient Profie [Joroup 20 [][«][e]
& 4 smm‘m Cloet] o [Database backup | el
2 Disabled Radios—— 2 T Jreg [ Recrenceattem
= D\spaodver Groups & =
58 Copetchr |3 ade B 8 Days of Week o =]
=  Monthly [V Monday | Tuesday | Wednesday
ame
E‘Eﬁ e —— = o | ¢ oneTime ’|:rnursdav IV Friday I saturday | ruesday
~ Sunday
Periodically
@ Location Tracking
3
&% s0b Ticketing
Route Management
[ Recurrence Range
[ ] Text Messages Start: [0 200 A -]
Stop: <Maximum Date > hd
G Voice Recording
(5 Reports Carce
EEI Radio Allocation 1
@ Administration s —
0 0 0 o o D
[ Connected @3 B B B B | | Administrstor | [ Licensed to: demo Demo License | @ Active~

In the Scheduler dialog box, specify the following parameters:
= Name

Enter the name of the scheduler.
Recurrence Pattern

Choose one of the recurrence patterns for the scheduler:
= Days of Week
Specify the time and select the day(s) of the week.
= Monthly
Specify one of the following options:
¢ Specific Day
Specify the ordinal day of the month (in the range 1-31, or select Last).
¢ Day of Week

Specify the week number in a month (in the range 1-4, or Last) and
select the day of the week.

* One time
Specify the date and time.

= Periodically

Specify the time interval, the repetition period (in seconds/minutes/hours),
and select the day(s) of the week.

Recurrence Range

= Start

Specify the start date/time.
= Stop

Specify the stop date/time.

6.4.18 Disabled Radios

TRBOnet Dispatch Console provides the Disable function that allows disabling a
radio even when the radio is offline. The system will disable an offline radio as soon
as it gets available.
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Note: The dispatcher can disable a radio when they have relevant
Access Rights (for more details on adding and editing
dispatchers, see section 6.4.20, Dispatchers on page 224).

¢ Go to Administration (1), Disabled Radios (2) to disable/enable selected
radio:

File View Map Tools Help

Administration Disabled Radio 8 |

() Swift Event Profies "

) Telemetry M mtercom [] 3 L Line free [Jancal [+
LCf) Radio Statuses P crou 10 [2][«][@] ¥ P croup 20 [-0][][@] 88 ¥ Groun 30 [2][«][@]

5 &S Profile

K Tools [ JPrivate call [][«]
5) Disabled Radics a S :
2 Cupatcher Gm‘u:\ ) DisableRadio " Enable Radio | 1 KillRadio

&, Dispatchers 2 Radio | Disable date Reason
& 125 21-Nov-2016 12:30

5 235 21-Nov-2016 12:30

Email Groups

<

(1) Voice Dispatch

@Lmﬁmtradriu

@ Job Ticketing
Route Management
@ RFID Tracker

[ Text Messages

g Voice Recording
Event Viewer
[753] Radio Allocation / 1

04| 40| 4| Record 20F2 ¢ [m|mi| 4] »
127001 &3 B | @ Administrator | [ Licensed to: demo Demo License | © active~

@mm o

e C(lick Disable Radio (3) and in the dialog box that appears:

Disable Radio X
fé Disable Radio
Radio: |@ 235 (Basil) 235 |
Enable: INo auto-snabling j
Reason:
Tesﬂ
Canca

= Radio
From the drop-down list, select the radio to be disabled.

= Enable
Select the time period after which the radio will be enabled again.

= Reason
Enter the reason for disabling the radio.

= (Click OK to disable the radio.
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Message 1 of 3

235
Repester £1: Slot £1
Disabling

The command has been executed.

01-Nov-2016 17:48

Radio has been disabled

[] Do not show this message next time

Show on map
Request Location

Close

The Radio is added to the Disabled Radios list and is marked as Disabled in the
Voice Dispatch pane:

EBl=t & 7 03

=] & Online Dispatchers (1)
R Administrator
=] |_|J Firemen .

‘ﬁ_‘ 17% (Pete) 125
(£ 235 (Basil) 235
i 1, Palice

e C(lick Enable Radio (4) to enable selected radio.
e Select a radio from the drop-down list and specify the reason to enable.
e Click OK to enable the radio.

6.4.18.1 Kill Radio

The Kill Radio feature is available only when a Capacity Max system is used.

Note: This operation is not reversible. If you kill a radio unit, it will be
impossible to recover it.

6.4.19 Dispatcher Groups

The administrator can add, edit, and delete dispatcher groups in the system.

¢ Go to Administration (1), Dispatcher Groups (2) to work with dispatcher

File View Map Tools Help
Administration Reg ed Dispatche &)
-Gy Rado Statuses * |5 Titne free (<] I Bintercon oEE (VBT Fille]
3 i call [][«[@] B Ecroup 20 [[<][@] B ¥ Group 11 [«l[e]
|8, Dispatcher Groups Pcouwp 22 [[«[@] I Bdrrivate cal [[<][@] B F maintenace [«][e]
%Dwsuamr's\ ' (B Pl
A, vaice b (5% Add| ) Edit | =k Delete | = Grouping 7 Auto Filter (&> Default Settings
Name A[Rado D SPD Desaription
p S Maintenace 60400 60400
= Sales 50500 50500
W Job Ticketing
g ‘Route Management 3
0| RFID Tracker
[] Text Messages
E Voice Recording
| Event Viewer
] Radio Allocation 1
"
o i
4| 4] 4 |Record 10F2 ¥ | w|m[ 4] »
127001 &3 B | @ Administrotor | [ Licensed to: demo | @ active~
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e Click Add (3) to add a dispatcher group.

Dispatcher Group X

General  Call Group RequestTo Talk

MName: |Maintenace

Description: |

Cancel

On the General tab, specify general parameters for the new dispatcher group.

e Display Name
Specify a name for the dispatcher group to display in the Dispatch Console.

e Description
Add a description for the dispatcher group.

On the Call Group tab, specify the following parameters:

Dispatcher Group %
General Call Group  RequestTo Tak
Radio ID: 50400
Phone Call
SIP ID: [so<00 |
SIP Mame: |Maintenance |
Password: | ““““ il |
Cancel
e Radio ID
Specify the Radio ID of the dispatcher group.
Phone Call
e SIPID

Enter the SIP ID that will be used by the dispatcher group.
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e SIP Name
Enter the SIP user name that will be used by the dispatcher group.

e Password
Enter the password for the dispatcher group to be authenticated by the
telephone system.

On the Request to Talk tab, specify the parameters that will be used by radios to
request a call from the dispatcher group:

Dispatcher Group X
General Call Group RequestTo Talk

Automatically by receiving Text Message from a radio
Message: 60400 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: Any event -
Automatically by receiving DTMF command from a radio
Command:  |50400| #60400%

[ automatically by receiving Status from a radio

Cancel

¢ Automatically by receiving Text Message from a radio
Select this option to request a call from the dispatcher group when a radio
sends a predefined text message. If you select this option, specify a brief text
message in the Message box.

e Automatically by receiving Telemetry Command from a radio
Select this option to request a call from the dispatcher group when a radio
sends a predefined telemetry command. If you select this option, specify the
VIO contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

¢ Automatically by receiving DTMF command from a radio
Select this option to request a call from the dispatcher group when a radio
sends the specified DTMF tones. If you select this option, specify a DTMF
combination without the # characters in the Command box.

¢ Automatically by receiving Status from a radio
Select this option to request a call from the dispatcher group when a radio
sends the specified Status to TRBOnet Server, for instance, 1. If you select this
option, specify the Status.

Once you have added the dispatcher group to the system, the appropriate PTT box
will appear in the Radio Interface pane.
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6.4.20 Dispatchers

The administrator can add, edit, and delete dispatchers in the system.

e Go to Administration (1), Dispatchers (2) to work with dispatchers:

File View Map Tools Help

Administration Registered Dispatchers §]
18} Indoor 2D Map Convert a
© schedulers
[ JReguiar GGROUP
2 Dispat s
i
Email smuns‘\
= S Groups
is Roles
Logical Groups 5 Add|-| = Edit | X Delete | = Grouping " Auto Filter @ Defoult Settings
M

< 5 || username 2Role Display Name Radio D P Desaription

A Disp 1 Dispatcher Dispatcher 1 60100 50100
L) voice Dispatch T Disn2 Dispatcher Dispatcher 2 50200 50200

R wan Dispatcher ivan 25
Ig Location Tracking
4 30b Ticketing 3
Route Management
[] Text Messages
A
FRr———

1] | < |Record 10F3 ¥ [ w[wm] ¢ v
[ Connected &3 B B b T € | @ Administrator | [ Licensed to: demo Demo License | @ active-

e Click Add (3) to add a dispatcher.

Dispatcher X

General Dispatcher Rights Radio Systems Radio Groups  Dispatcher Grou| * | *

Authentication: TRECnet Authentication ~
User Name: |Dispau:her 1 |
Password : | ““““ |
Repeat password: | ““““ |
Display Name: |Dispau:her 1 |
Description:

Dispatcher Role: Dispatcher j

[ 1nvisible to all other users
[ 1nvisible to &l except the assigned aroups

[ Allow multiple simultaneous logons

Carcel

¢ On the General tab, specify general parameters for the new dispatcher.

= Authentication
Select the Authentication method from the drop-down list.
Select TRBOnet Authentication to log on as a user registered in TRBOnet
Dispatch Console users list.
Select Windows Authentication to log on using the PC name. The system
automatically shows the PC name as User Name.

Note: The password is not required when Windows
Authentication is used.
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Note: For more details on user access to Allocation Console,
section see section 6.4.23, Users (page 232).

= User Name
Specify a user name for the dispatcher registered in TRBOnet Dispatch
Software users list.

= Password
Specify a password for the dispatcher.

e Display Name
Specify a name for the dispatcher to display in the Dispatch Console.

e Description
Add a description for the dispatcher.

e Dispatcher Role
Form the drop-down list, select the role of the dispatcher in the system
(Administrator or Dispatcher).

Note: In addition to the Administrator and Dispatcher roles, you
can also create custom dispatcher roles. For this, in the
Dispatchers pane, click the Roles tab, and then click Add.

¢ Invisible to all other users
Select this option to make the dispatcher invisible to other users.

¢ Invisible to all except the assigned groups
Select this option to make the dispatcher invisible to other users except for
users belonging to the same group of dispatchers.

e Allow multiple simultaneous logons
Select this option to allow the dispatcher to use multiple instances of Dispatch
Console simultaneously.

On the Dispatcher Rights tab, select the available modules and specify the available
access rights for the dispatcher.

Dispatcher X

General Dispatcher Rights Radio Systems Radio Groups  Dispatcher Grou 4 | *

Available Modules: |(AII Modes) j &
Voice Dispatch Functionality
Use the Voice Dispatch module
Intercom calls
Telephone calls via the SIP 2.0 phone interconnect
Initialize Private calls
Play back the recorded voice communications
[ view all other voice calls in addition to assigned groups
Change control station channels
Configure audio
Tone and PTT
Allow to send audio records
Save and export recorded voice communications
View System Bridge/Patch
Enable/disable System Bridge/Patch
[] Enable/disable encryption
Allow Call Preemption Mode for: 30 = minutes
Application w

Cancel
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On the Radio Systems tab, specify the radio system(s) that will be available for the
dispatcher.

Dispatcher X
General Dispatcher Rights Radio Systems  Radio Groups  Logical Groups |4 | *

(O Al Radio Systems available
(® Only selected Radio Systems avallable

Radio System X
Bl Contral Station #1

[ |Repeater #1: Slot #1 v
¥ |Repeater #1: Slot #2 W

Chedk Al Uncheck Al

Cancel

¢ All Radio Systems are available
Choose this option to make all radio systems available for the dispatcher to
transmit and receive Voice and Data.

e Only selected Radio Systems are available
Choose this option and specify which radio systems will be available to the
dispatcher.

= Select the check box in the left column to add the corresponding radio
system to the Radio Interface for the dispatcher.

= Select the check box in the TX column to allow the dispatcher to make
Voice calls using the corresponding radio system. When the check box is
cleared in the TX column, the dispatcher cannot use the corresponding
radio system to transmit voice and data.

On the Radio Groups tab, specify the radio groups that will be available for the
dispatcher.

226 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SOftware

Dispatcher X
General Dispatcher Rights Radio Systems Radio Groups  ogical Groups |4 | *

() All groups are avalable
(® Only selected groups are avaiable

All call

Firemen

Weoie

Chedk Al Uncheck Al

Cancel

¢ All groups are available
Choose this option to make all groups in the system available for the
dispatcher.

e Only selected groups are available

Choose this option and specify which radio groups will be available to the
dispatcher.

= In the list, select the groups to make them available for the dispatcher.

On the Logical Groups tab, select the logical groups that will be available for the
dispatcher.

Dispatcher X
Radio Systems Radio Groups  Dispatcher Groups  Logical Groups  Dispatch| * | *

() All groups are avalable

(® Only selected groups are available

Name Desdription
=H E—ﬂ Cleaning
by EI] Cleaning 1 Cleaning in Department 1
L *ri,] Cleaning 2
= ﬂﬂ Security Groups for Security
|t ﬁﬂ Security 1
E o ‘ﬁl] Security 2

Select Al Deselect All

Carcel

On the Dispatcher Groups tab, select the dispatcher group(s) the dispatcher will
belong to:
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Dispatcher X

Dispatcher Rights Radio Systems Radio Groups Dispatcher Groups [ ogic| 4 | *

() All groups are avalable

(® Only selected groups are avaiable

Group 1B
Maintenace

v | Sales v

Chedk Al Uncheck Al

Cancel

On the Dispatch Call tab, specify Dispatch Call and SIP call settings for the
dispatcher:

Dispatcher X
Radio Groups  Logical Groups  Dispatch Call  Request to Talk  Reports

Radio ID: 60100 3:

Phone Number: | 123-4567 |

Email: |bi||y @gmail.com |
Phone Call
SIP ID: |s0100 |
SIP User: |s0100 |
Password: |oo|ooolooo |
SIP Profile: | v |

Cancel

e Radio ID
Specify the Radio ID of the dispatcher.

¢ Phone number
Specify the dispatcher's phone number (additional data).

e Email
Specify the dispatcher's Email (additional data).

Phone Call

e SIPID
Enter the SIP ID that will be used by the dispatcher.

e SIP Name
Enter the SIP user name that will be used by the dispatcher.
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e Password
Enter the password for the dispatcher to be authenticated by the telephone
system.

e SIP Profile
From the drop-down list, select the SIP profile to use.

On the Request to Talk tab, specify the parameters that will be used by radios to
request a call from the dispatcher:

Dispatcher X
Radio Groups  Logical Groups  Dispatch Call  Request to Talk  Reports i I

Automatically by receiving Text Message from a radio

Message: 60100 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command: High level -
Automatically by receiving DTMF command from a radio
Command: 60100 #60100%

[ automatically by receiving Status from a radio

Cancel

¢ Automatically by receiving Text Message from a radio
Select this option to request a call from the dispatcher when a radio sends a
predefined text message. If you select this option, specify a brief text message
in the Message box.

e Automatically by receiving Telemetry Command from a radio
Select this option to request a call from the dispatcher when a radio sends a
predefined telemetry command. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

¢ Automatically by receiving DTMF command from a radio
Select this option to request a call from the dispatcher when a radio sends the
specified DTMF tones. If you select this option, specify a DTMF combination
without the # characters in the Command box.

e Automatically by receiving Status from a radio
Select this option to request a call from the dispatcher when a radio sends the
specified Status to TRBOnet Server, for instance, 1. If you select this option,
specify the Status.

On the Reports tab, specify the reports that will be available to the dispatcher.
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Dispatcher
Radio Groups  Logical Groups  Dispatch Call Request to Talk Reports

() all reports are available
(® Only selected reports are avalable

4

X

3

g.. Queries

| B Lost Devices
E System reports

ED
] ‘D Unregistered Radios
-4 ) 6Ps status
-] D User Connection History
‘D System Bridging Activity
.7 [} Channel Change
E Common reports
. ] ) Messages for Period
] D State of Radios

|:| B User Messages and Motes
-] D Radio Allocation
-.[ ] ) Radio Disabling
] B Telemetry &7

Chedk Al Uncheck Al

¢ All reports are available

Choose this option so that all the reports will be available to the dispatcher.

e Only selected reports are available

6.4.21 Email Groups

Email Groups are used in Event/Alarm Management and Job Tickets configuration to

Choose this option and in the list below select/unselect the reports to
include/exclude.

send emails to dedicated recipient groups.

¢ Go to Administration (1), Email Groups (2) to add/edit/delete email groups
in the system:

File View Map Tools Help

Administration a oup
Telemetry ~
Raio Statuses [ mtercom [][«] & L: Line free [4] [Jancar
() epsprofile Mcow 10 [][«][@] ¥ M Group 20 [-0][«][@] 88 ¥ Group 30
b
¥ Tools
(&) Disabled Radios [ [prvste call [2][4]
2 ';::E:ﬁ:f”““ % Add ) Edit | ) Delete | = Grouping '/ AutoFikter € Defautt Sttings
/ A Desaription Email List
5 s Groups . quuerty @gmal.com, asdf@gmal.com
Region 1 Terminal 1 84@trbonet. com, 65@trbonet.com, 66@trbenet.com
A1, Voice Dispatch

%mermhu

@ Job Ticketing

Route Management

@ RFID Tracker

[] Text Messages

g Voice Recording

Event Viewer

1

P

e

|« | 4| Record 10F2 ¥ [m|mi[ <]

4l

127001 &3 B | @ Administrotor | [ Licensed to: demo Demo License

e Click Add (3) to create an email group.
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Add/Edit Email Groups *
Name: Terminal 1
Description: Region 1 Terminal 1]
Emai list: 64@trbonet.com

65@trbonet.com
66@trbonet.com

Add Remow

i
=]
o

Ok Cancel

* Name
Specify a name for the email group.

= Description
Add a description for the email group.

= Email list
Click Add to add an email address to the Email list.

6.4.22 SMS Groups

SMS Groups are used in Event/Alarm Management configuration to send SMS to
dedicated SMS recipient groups.

e Go to Administration (1), SMS Groups (2) to add/edit/delete SMS groups in
the system:

file View Map Tools Help

Administration aller Group CIER (<]

Pt ~ | FEginereom (3 [[] Jl & e fee OE) EEE ()
A Tools Fcowp 10 [][«][@] ¥ P Group 20 BaE (vErEl ]
é E::;:S.:.Esd:ips [Private call [«[@]
2::::5::: L Add ) Edit | k Delete | = Grouping ' Auto Fiter > Default Settings

415015 Groups) Group Nane 4/ Desaiption Phene Numbers

EEEaden

B wsers 2 + || Deparbyent 2. Regio 1 Depariment 2 79117384561, 79217894561
.| Departmeqt 3 Region 1Department 3 792112374567, 79111234567

(1)) Voice Dispatch

3

u:mﬁmrmdﬁug

@ Job Ticketing

an:z}‘lanagumvt

@ RFID Tracker

[] Text Messages

gv\ﬁzm

Ewmtvimu

[ Radio Allocation 1
/

| ] 4| Record 20F2_» [ w|mhi] < | >

Emm istratic e

127001 &3 B | @ Administrator | [8 Licensed to: demo Demo License | @ active~

e Click Add to create a new SMS group:
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Add/Edit SM5 Groups X
MName: Department 3
Description: Region 1 Department 3
Phone Numbers: 792112374567
79111234587
oK Cancel
* Name

Specify a name for the SMS group.

= Description
Add a description for the SMS group;

= Phone Numbers
Click Add to add a phone number to the SMS group.

6.4.23 Users

The administrator can add/edit/delete users in the system. In addition, the
dispatcher can export/import users (see section 6.3.4.3, Exporting/Importing

Objects).
e Go to Administration (1), Users (2) to add/edit/delete users in the system:

file View Map Tools Help

Administration e &)
;253 l‘j‘:‘;‘j"‘f‘“p ~ | IR mtereom [ol[sc/[2] WG 1: e free OE EEE el
&, Dispatehers o 10 [« B B croup 20 oEE (ErE EEE]
Email Groups
5 55 Groups [Private call [1[<]

2 = e
=% Add =) Edit | [ Delete | = Grouping W/ Auto Filter @» Default Settings
ups 2 Logn £ | Display Name SIPID | Desciption
@ Rados v [[Best Basl
Pete Pete 2401

Eﬁ Voice Dispatch

Location Tracking 3

@ Job Ticketing

Route Management

@ RFID Tracker

[] Text Messages

g Voice Recording

Event Viewer

EEI Radio Allocation 1

P -

|« | Record 10F2_» [ w|mhi| < | >
127001 &3 B | @ Administrator | [8 Licensed to: demo Demo License | @ active~

e Click Add (3) to add a new user to the system:

¢ On the General tab, set general parameters for the user:
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Add/Edit User X

General Radios Advanced User Call Logical Groups  Custom Fields

‘% Specify user information

Login: |BaS|I |
Password : | """" |
Repeat password: | ““““ |
Display Mame: |Basi| |
Max radios count: 1 =

Description:

Cancel

* Login
Specify the login for the user.

= Password
Type in the individual password for the user.

= Display Name
Specify a name for the user to display in the Dispatch Console.

= Max radios count
Select a number of radios that will be available for the user.

= Description
Add a description for the user.

¢ On the Radios tab, specify the radios that will be available to the user.

Add/Edit User X
General Radios  Advanced User Call Logical Groups  Custom Fields
Specify radios that the user can take
" Allow all radios
¥ Only selected radios
Callsign Group
! ® 111 Police, Firemen
v @ 125 Firemen
® 222 Police, Firemen
@ 235 Firemen
W4 | 4 | Record 2of4 b | M M| 4 »
Cancel

= Allow all radios
Choose this option to allow using all radios in the system.
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= Only selected radios
Choose this option and specify which radios will be available to the user.

e On the Advanced tab, specify settings related to taking/returning radios:

Add/Edit User X

General Radios Advanced User Call Logical Groups  Custom Fields

I¥ Disable radio on return
™ Allow DTMF management
1234

IV Allow Text Messages management

Take radio: Bsile
Return radio: Bsilexit

I allow Sign In / Sign Out management

[¥ Allow beacon management
Major 1D: 10 3:
Minor ID: 0 3:

I send notification to radio after it is taken/returned

Cancel

= Disable radio on return
Select this option so that a radio will be disabled after the users returns it.

= Allow DTMF management
Select this option to allow taking/returning radios by sending the specified
DTMF tones.

e Take radio
Specify DTMF tones to be sent by the user to take a radio.

¢ Return radio
Specify DTMF tones to be sent by the user to return a radio.

= Allow Text Messages management
Select this option to allow taking/returning radios by sending specified text
messages.

e Take radio
Specify the text of the message to be sent by the user to take a radio.

¢ Return radio
Specify the text of the message to be sent by the user to return a radio.

= Allow Sign In / Sign Out management
Select this option to allow taking radios when the user signs in to a radio.
e Sign-inID
Specify the password that the user enters to sign in when they take a
radio.
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= Allow beacon management
Select this option and enter Major ID and Minor ID of the beacon that will
be used for taking/returning radios. When a radio enters/leaves the range
of the specified beacon, this radio will be considered taken/returned by the
user.

Note: This functionality is available only if the radio is equipped
with an option board.

= Send notification to radio after it is taken/returned
Select this option so that a notification is sent to a radio every time the user
takes/returns it.

e On the User Call tab, specify SIP Call settings for the user:

Add/Edit User x

General Radios Advanced User Call Logical Groups  Custom Fields

Phone Number: 79211234567 |

Email: |24C|1@gma||.com |
SIP Call

SIPID: [2901

SIP Name: [2401

Password: |

SIP Profile: | bd

[ Block incoming calls
[ Block outgaing calls

Cancel

= Phone number
Specify the user's phone number (additional data).
* Email
Specify the user's email address (additional data).
SIP Call
= SIPID
Enter the SIP ID that will be used by the user.
= SIP Name
Enter the SIP user name that will be used by the user.

= Password
Enter the password for the user to be authenticated by the telephone
system

= SIP Profile
From the drop-down list, select the SIP profile to use.

= Block incoming calls
Select this option to block all incoming SIP calls for the user.
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= Block outgoing calls
Select this option to block all outgoing SIP calls for the user.

e On the Logical Groups tab, specify logical groups for the user:
= In the list of available groups, select desired group(s).
= For more information about logical groups, see section 6.4.24, Logical

Groups (page 236).
e On the Custom Fields tab, specify the desired values for the fields (see section
6.4.6, Custom Fields).

6.4.24 Logical Groups

TRBOnet Dispatch Console allows adding custom logical groups in addition to radio
groups. You can create groups and subgroups and then assign
radios/users/dispatchers to these groups.

e Go to Administration (1), Logical groups (2) to work with Logical Groups:

Cleaning in Department 1

Groups for Security

|~ 1
P -
[@ 127001 g8 B | @ Administrator | [ Licensed to: demo Demo License @ Acti

e Click Add (3) to add a logical group.
= Select Add as a Root to add a logical group as a root folder.
= Select Add as a Child to add a logical group as a child folder.
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Group properties X

Name: Cleaning 1

Description: Cleaning in Department 1

Cance

= Specify a Name and Description for the logical group.
= Click OK to add the logical group.

To display logical groups, enable the Logical Group view:

Voice Dispatch
B[R HT
®

Logical Groups
e 5{ Uﬂh\mpmvwr\';)
& administrator

0y

<

All created logical groups are displayed in the list of radios.
6.4.25 Radio Groups

e Go to Administration (1), Radio Group (2) to add/edit/delete Radio Groups in
the system.
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File View Map Tools Help

Administration Radio Group 8 |
:% E‘SD:‘;::WS ~ | I B wntercom 2] G 1: e fre e M @]
&, Dispatchers Fcrouw 10 [)][«][@] I P Groun 20 [][«][@] N ¥ Groun 30 B[]
Email Groups
= s Groups [ ]Private Call [2][«][@]

%, Users = = C @

12 Logied Groups (5% Add| =) Edit | =k Delete | = Grouping 7 AutoFilter @ Default Settings

% Name A Radio ID MDC f Sel-5 (Hex) Descriprion

8 Redos 2 + |[@eaners 30 5 Cleaning group
Firemen 20 o

Eﬁ Voice Dispatch Police 10 ]

Ig Location Tracking

& 1o icketing 3

Raute ranagement

@ RFID Tracker

[ Text Messages

g Voice Recording

= Event viewer

“ 3] Radio Allocation / 1

P -

04| 40| 4| Record 10F3 # [m|mi[ 4] »
127001 &3 & | @ Administrotor | [ Licensed to: demo Demo License | © active~

e Click Add (3) to add a radio group to the system:

238

Group Properties X
Name: Cleaners
Group ID: 30 3| MDCID: 5 z
Description: Cleaning group

Use custom Call Tone
| Load from file
) Play back message
[] use Broadcast mode for call (only for IPSC)
[[] use open Vaice Channel mode for call {only for TPSC)

Cancel

Name
Specify a name for the radio group in the system.

Group ID
Specify the Radio ID for the radio group used to identify messages to/from
the radio group.

MDC / Select-5 / Quick Call | / Quick Call I

Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios depending
on the call type. Or, select Quick Call I / Quick Call Il signaling system and
specify the appropriate parameters.

Description

Add a description for the radio group.
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= Use custom Call Tone
Select this option and browse for the audio file (WAV, MP3) that will be
used as a custom tone when a group call is started by clicking the Tone and
PTT button in the group's PTT box (see section 6.5.2, PTT Boxes).

= Use Broadcast mode for calls
Select this option so that a group call will be made in the Broadcast mode,
causing that the group call receivers won't be able to answer (talk back) to
this group call.

= Use Open Voice Channel mode for calls
Select this option so that a group call will be made in the Open Voice
Channel mode, causing that the group call will be received by all radios
staying on the channel (and capable of receiving OVCM calls) rather than
only by the group participants.

Note: To use the Broadcast and OVC modes for group calls, the
Use NAI Voice option must be enabled for the repeater
(see section 5.9.2, Adding a MOTOTRBO Repeater).

6.4.26 Device Lists

The Device Lists are used to dynamically group radios based on current needs.
6.4.26.1 Adding List Templates
¢ Go to Administration (1), Device Lists (2).
¢ In the Device Lists pane, select the List Templates tab, and click Add (3).

File View MpTI Help

List Templates

3
ENYTIE] £ S el
g Location Tracking Name: N
= Group
Radio 235
Job Ticketing = ®
ﬁ ob Tic Group 2 @ Rodio 210
3 (@) Radio 16500000

Cg Reports.
il Selected: 3
5] Event Viewer §
a|F Ndhd i

‘4] Radio Allocation
(2 ) =
= ——
% Administration 7

66| 9| « | Record 102 » | » || v
[ Connected &3 B B B B B | § Administrator | [ Licensed to: demo Demo License @ Active-

¢ In the List Properties dialog box, enter a name and description for the list.
¢ C(lick the Radios tab (4), and select the radios (5) to include in the list.

6.4.26.2 Dynamic Regrouping

Note: The Dynamic Regrouping feature is available only for Capacity
MAX systems.

To assign radios to dynamic groups:
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Go to Administration, Device Lists.
In the Device Lists pane, select the Active Lists tab, and click Create.

Or:

On the Tools menu, click Dynamic Regrouping.

Dynamic Regrouping - x

Action: [assign to dynamic graup =
Group: [Group 50 AES =
Radios
[Radio [ Active Group

W | @ Rradio 135 Group 20

W | @ radio 567 Group 50 AES
2 Radio 35521 Test 10

| Selected: 3

Execute

In the Dynamic Regrouping dialog box, enter the following parameters:

= Action
From the list, select the action (Assign to, or Exclude from dynamic group).

= Group
From the list, select the radio group to which to assign (or, from which to
exclude) radios.

= Group Alias
Enter an alias for the radio group.

= |n the list below, select the desired radios.

= (Click the Execute button.

6.4.27 Radios

240

The administrator can add/edit/delete radios in the system. In addition, the
dispatcher can export/import radios (see section 6.3.4.3, Exporting/Importing

Objects).

Go to Administration (1), Radios (2).
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File View Map Tools Help

Administration Radios
" Registered |_Ur tered
4 Add Group | 55 Add Digital Radie H =l Add WAVE Radio = Add TREOnet Mobile =) Add Range >’
v
< 5 Radio Namess | Type RadoD _|MDCD _|SPID Radio Gro... | Logical Gr.... | Description
C 125 MOTOTRBO Radio S o 125 11; Firemen  Cleaning, ...
L, voice Dispatch @ 13 MOTOTREO Radio 1 Al
@ 235 MOTOTRBO Radio 235 Firemen; P... Cleaning
g Location Tracking @|3333 TRBOnet Mobile 3333 2
(@ ss5 MOTOTRBO Radio Al
@ Job Ticketing (@ Radio 300 MOTOTREO Radio Al
Route Management
Q' RFID Tracker
[ Text Messages
ﬁ Voice Recording
/=] Event Viewer
+ 3] Radio Allocation 1
Fa— —
|« «|Record 10fs »|m|m <] »
[® 127001 &5 @ | 8 Administrator | [ Licensed to: demo | © Active-

e Click Add Digital Radio (3) to add a new radio.

On the General tab, specify general settings for the radio:

Voice Dispatch 125 X

General |Log|&3l Groups' addmonall SIP Calll Camerasl

Radio Name: 135 |
Radio ID: 125 | MpcID: o 5

Radio Groups: |AII v |
Home Group: |Cleaners | |
Use icon: |® Portable Radios ~E = |

Extended Device:  [None ~ Test | ~

Location Service

Location Source: |Eu\|t—in GPS receiver ~ ‘

Location Profie: |(Default) ars ‘

Location Enabled

Telemetry Service
TLM Source: |Euw|t—|n Telemetry - ‘
TLM Profile: |(Default) ok ‘

Text Messages Service

TME Tunar [2tandard vl
Hide Advanced Settings

Cancel

¢ Radio Name
Enter a descriptive name for the radio to display in the Dispatch Console.

e Radio ID
Enter a Radio ID for the radio. This ID is used by other calling radios when
addressing the radio, for instance, when making a private call or sending a text
message.

e MDC / Select-5 / Quick Call I / Quick Call 1l
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios depending on
the call type. Or, select Quick Call | / Quick Call Il signaling system and specify
the appropriate parameters.

¢ Radio Groups
In the drop-down list, select a radio group(s) to which to assign the radio.
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e Home Group
In the drop-down list, select a home group for the radio.

e Useicon
From the drop-down list, select an icon for the radio.

¢ Extended Device
From the drop-down list, select the option board type the radio is equipped
with.

Location Service

e Location Source

Built-in GPS receiver
Select if the radio has its own built-in GPS receiver to send GPS data.

Not equipped with GPS receiver
Select if the radio cannot send GPS data.

Extended device
Select if the radio is equipped with an option board.

¢ Location Profile
From the drop-down list, select the default or preconfigured Location Profile.
For more details on Location Profiles, see section 6.4.14, Location Profile
(page 210).

Location Enabled
Select/clear this check box to enable/disable the location trigger.

Telemetry Service
e TLM Source

Not equipped with Telemetry
Select if the radio cannot send Telemetry data.

Built-in Telemetry
Select if the radio has its own built-in Telemetry.

Extended device
Select if the radio is equipped with an option board.

e TLM Profile
From the drop-down list, select the default or preconfigured Telemetry Profile.
For more details on Telemetry Profiles, see section 6.4.11, Telemetry
(page 204).

Text Messages Service

e TMS Source

Not equipped with display
Select if the radio is not equipped with a display.

Built-in Text Messages
Select if the radio has its own built-in Telemetry.
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e TMS Profile
From the drop-down list, select the default or preconfigured Text Message
Profile. For more details on Text Message Profiles, see section 6.4.12, Text

Messages (page 208).
Job Tickets Service
o JTS Type

* None
Select if the radio is not equipped with a display.

= MSI Proprietary
Select if the radio is equipped with a display and supports the Enhanced
Job Ticket protocol.

= Text Messages
Select if the radio is equipped with a display and supports the legacy Job
Ticket protocol.

Radio Status Service

= RS Profile
From the drop-down list, select the default or preconfigured Radio Status
profile.

For more details on Radio Status profiles, see section 6.4.13, Radio Statuses
(page 208).

On the Logical Groups tab, specify logical groups for the radio:

Voice Dispatch 123 s
General Logical Groups ]Additional] SIP Call] Cameras]
Name Description
i bl Cleaning 1 Cleaning in Department 1
Lok .= Cleaning 2
= | Security Groups for Security
e[S Security 1
L7 Security 2
Cancel

¢ In the list of available groups, select desired group(s).

e For more information about logical groups, see section 6.4.24, Logical Groups
(page 236).

On the Additional tab, specify additional information about the radio subscriber:
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Voice Dispatch Radio 125 X

Generall Logical Groups  Additional ISIP Call] Cameras]

Max speed: &0

Route Color:

Load Image...

... Mame T Value

B nName

B Desciption

B car make Hyundai

B Plate number RAMBO 01

. Phone +7911 1234567
B3 Email tester @gmail.com

Cancel

e Max speed
Specify the maximum speed allowed for the vehicle, in kilometers per hour or
in miles per hour, depending on the measurement system specified in
TRBOnet server.

¢ Route Color
Specify a color to display the route passed by the radio on the map.

e Load Image
Click this button and browse for the photo or image to assign to the radio.

¢ In the table below, specify the desired values for the custom fields (see section
6.4.6, Custom Fields).

Note: To automatically create and assign job tickets to the radio
(see section 6.4.5.16, HotSOS (Email)), there must be
present at least one field with the 'Email’ type.

On the SIP Call tab, specify SIP Call settings for the radio:
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Voice Dispatch 125 X

General | Logical Groups} Additional SIP Call lcamerasl

SIP ID: 2125 |
SIP Name: 2125 |
Password: [seseersaee |
SIP Profile: s 1 ~]

[ Block incaming calls
[ Block outgaing calls

Cancel
e SIPID
Enter the SIP ID that will be used by the radio.
e SIP Name

Enter the SIP user name that will be used by the radio.

e Password
Enter the password for the authentication.

e SIP Profile
From the drop-down list, select the SIP profile to use for the radio.

¢ Block incoming calls
Select this option to block all incoming SIP calls for the radio.

¢ Block outgoing calls
Select this option to block all outgoing SIP calls for the radio.

On the Cameras tab, select the check box beside the camera that will be associated
with the radio:
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Voice Dispatch 125

MName

Camera 2

General] Logical Groups] Addmcnal] SIP Call Cameras l

Blcanea 1

Cancel

6.4.27.1 Adding TRBOnet Mobile
In addition to digital radios, you can create accounts for TRBOnet Mobile Clients that

246

can connect to your radio systems.
e Click Add TRBOnet Mobile.

Voice Dispatch 3333

General  Logical Groups  Additional Cameras

Radio Name: | 3333

Radio ID: 3333

Radio Groups: |F|remen

Home Group: |Firemen

Dispatcher Groups NJAll

Profile: }Mobile Client Profile #1
Use icon: |® Portable Radios
sIP I [3333

SIP User: [3333

Password: |----------

Password (repeat): | ssssssssss

[7] Block incoming phone calls

X
[
]
o0
o0
¥
Cancel

In addition to digital radio parameters, TRBOnet Mobile has two more parameters:

Dispatcher Groups and Profile.
¢ Dispatcher Groups

In the drop-down list, select a dispatcher group(s) which to assign to the

mobile client.

e Profile

In the drop-down list, select the profile for the mobile client.
Or, click the plus button on the right to create a profile.
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Note: For directions on how to create/edit a Mobile Client Profile,
see section 6.4.15.1, Adding a Mobile Client Profile.

6.4.27.2 Adding WAVE Radio

If the WAVE controller is connected, you can add WAVE radios to your radio
systems.

e Click Add WAVE Radio.

WAVE Radio X
General ILogicaI Groupsl Addiﬁanal] SIP Call] Cameras}

Radio Name: |Wave 145 |
(Radio I0: 145 2)(wave D:
By — Fireman =
Home Group: |Fireman | |
Use icon: |® Portable Radios ~ k= |
Extended Device:  |None Test | ~

Location Service
Location Source: |Bui|t-in GPS receiver i |
Location Profile: |(Default) ~ |

Location Enabled
Telemetry Service

| |
Text Messages Service

[ ] v
Hide Advanced Settings

Cance

In addition to Radio ID, the WAVE radio has the Wave ID parameter.

= Radio ID
Specify a Radio ID for the WAVE radio. This ID is used by other calling
radios when addressing the radio, for instance, when making a private call
or sending a text message.

= WAVEID
Enter the Wave ID that corresponds to the user registered in the WAVE
server's user database.

6.5 Voice Dispatch

When on the Voice Dispatch tab is selected, the dispatcher can make radio and
phone calls, send text messages to radios and phone numbers, monitor recent calls
and events, radio state, active tasks and routes and view selected map.

6.5.1 Radio List

6.5.1.1 View Options

The toolbar in the upper part of the Radio List pane provides buttons to change the
appearance of the list:
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oice Dispa
NN A=

Radio, Dispatchers, Dispatcher Group, Radio Group, ... =

=] 3; Online Dispatchers (1) =

8 naministrator
[:} Online, Indoor (0}

© () Online, GPS Fixed (1)
(€3] Radio 27

=] O Online, Na GPS (1)
@ Radio 235

@ () offine (3)
(&) 4444

(%) Radio 125 5

e Click to view radios by radio list.

e Click @ to view radios by their states.

Yellow
A radio is online and enters the beacon coverage zone; has Indoor
positioning lock.

Note: When GPS location is available and the radio enters the
beacon coverage zone, the state will turn yellow from
green.

Blue
A radio is online; GPS data is not available.

Green

A radio is online; GPS data is available. This state is shown if the Server has
received GPS data during the last 30 seconds (the time interval is set in
Location Profile > Periodic trigger interval).

Grey
A radio is offline.

e Click to view radios by radio groups.

e Click to view radios by logical groups.

e Click 4 , and select which radio list elements to display in the Radio List pane.

Voice Dispatch

B e Y R T T
Radio, Dispatchers, Dispatcher Group, Radio Group, T
Type: /

Radio

|C| Dispatchers 1

[T Dispatcher Group 2

Radio Group

[T Logical Group
State:

[T Online, Indoor

Online, GPS Fixed

ine, Mo GPS i 3
| oK | | Cancel |
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= (lick the arrow button (1).
= Select the object types and the radio states (2) to filter radios.

For example, you may select to display only radios and radio groups that
are online and have fixed GPS signal.

= Click OK (3) to apply filter settings.

e Click 3 , and from the drop-down list, select how to sort the radios in the
Radio List (Name, Radio ID, State).

e Click Fa to open the Settings dialog box to specify which quick buttons to
display in the Radio List pane.

Dispatcher Buttons
[ send Message I Request To Tak

Radio Buttons
[¥| Find on Map @] private Cal
[ Find on Google Earth 7] Send Message
[ Show Route ] Request To Tak
[ show Route on Google Earth ] Blocking On/off

[¥] Send Message

7] Request To Tak

Logical Group Buttons
(¥ Send Message

Additional Options
[ show checkboxes [F] Show Location trigger state

Freview:

& 2 onine Dipatehers
B somy

& [} Redio Group Sa
%) Rediot Zasew
@® redio2 moew

= Dispatcher Buttons
In this group, select the quick buttons to be displayed in the Radio List for
dispatchers.

= Radio Buttons
In this group, select the quick buttons to be displayed in the Radio List for
radios.

= Radio Groups Buttons
In this group, select the quick buttons to be displayed in the Radio List for
radio groups.

= Logical Group Buttons
In this group, select the quick buttons to be displayed in the Radio List for
logical groups.

Note: For the preview, see the lower part of the Settings dialog
box.

= Additional Options

e Show checkboxes
Select this option to display check boxes next to each radio and radio
group. Selecting/clearing a check box will display/hide the
corresponding radio/radio group on the map.
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e Show Location trigger state
Select this option to display the Location trigger state for a radio in the

Radio List pane.

=] |_U Firemen

v’ Grey
A radio is offline.

v" Blue + white dish

A radio sent ARS but didn't send GPS packets.

v" Blue + red dish

A radio sent ARS and GPS packets without GPS data, that is the radio

is out of GPS coverage.

v Green

A radio is fully online (has a GPS fix).

6.5.1.2 Quick Filter

Type in Radio ID or Radio name to filter the Radio List. Search results are displayed
in the Radio List pane:

Voice Dispatch

Sl VYK &
27|

{_} Online, Indoor (0)
© () Online, GPS Fixed (1)

» CET

(_) Online, No GPS (1)

() offiine (3)

6.5.1.3 Radio Pop-up Window

The dispatcher can see the last received radio data in the Radio pop-up window.
Select a radio in the Radio List and hover the mouse pointer over it:

250

125

i) On Duty

®
Capadty Plus #1 1
Online by ARS 2

% Battery: 60% 3

4

Lone Worker 5

12:44 PM
City Mall

12:45PM
6

Accepted #A09152 7
Accepted #A09155

GPS:
Speed:
Altitude:
Region:
Latitude:
Longitude:

199178

7 Liniya Vasil'yevskogo Ostrova,
36, Sankt-Peterburg, Russia,

7/12/2018 6:24:35 PM
1.9kmjh
Unknown 8

Mo
59°56'27.85" M
30°16'47.71"E
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The following information on the radio is displayed in this pop-up window:

1.
2.

The current channel/radio system the radio is on.

The note about the radio state (displayed only if the Show latest note in Unit
information details option is selected in the Advanced tab of the Options
dialog).

The current battery level, in percent (displayed only if the radio is equipped
with an option board).

The User Activity list the radio is assigned to, if a User Activity task is activated.

5. The Lone Worker policy's state, if a Lone Worker task is activated.

7.
8.
9.

The route assigned to the selected radio, if a Route Management task is
activated for the selected radio.

The associated job tickets.
The current GPS data and current location data.

The current location resolved to address.

While this pop-up window is open, the dispatcher can do the following:

Click B2! to request the presence of the radio in the radio network.
Click = to send a text message to the radio.
Click k=! to request the radio's location.

6.5.1.4 Radio Shortcut Menu

To open the radio's shortcut menu, right-click a radio in the Radio List pane:

This shortcut menu contains the following items:

Presence in Network
Choose this menu item to send a Check Radio command. If the radio is online
and is located in the coverage area, the dispatcher will see a message like this:

Message 1 of 1 X

125
Repeater £1: Slot £1
Checking Presence in Network
The command has been executed. 14-Nov-2016 17:49

Radio is present in the network
Agent: Radio Networks
Radio System: Repeater #1: Slot #1 [ Peer 1002

[] Do not show this message next time Show on map
Request Location

Close

Private Call
Choose this menu item to initiate a Private Call to the selected radio.

Request to Talk
Choose this menu item to send a talk request to the selected radio.

Request Location

Choose this menu item to request the location of the selected radio (for radios
with GPS module only).
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¢ Send Message
Choose this menu item to send a text message to the selected radio (for radios
with display only).

e Advanced > Remote Monitor (Open mic)
Choose this menu item to activate the radio microphone in hidden mode
(remote monitor duration — 30 sec.)

e Advanced > Reset Location Trigger
Choose this menu item to customize the Location Update settings. When you
reconnect to the Server or reassign a Location Profile to the radio, temporary
settings will be updated to the Location Profile settings.

Reset Location Trigger >
3, Reset Location Trigger
100
@ Reset location trigger
() Stop location trigger
() Start location trigger

[] change periodic interval

= Reset/Stop/Start location trigger
Choose which command to send to the radio.

= Change periodic interval
Select this option and specify the new location update interval.
e Advanced > Enable Radio
Choose this menu item to enable the selected radio.

e Advanced > Disable Radio
Choose this menu item to disable the selected radio.

e Advanced > Send Audio Record
Choose this menu item to send an audio record to the selected radio.

Record audio

Convert Text to Speech
|:_. Start ‘|i_| Cancel | | Load |‘|

= Click Start and start talking to the microphone.

Record audio

00:34

b ‘ ]\I'?""'"1’\“#"“""'—"""‘"'-"'-"-"—""-

Convert Text to Speech
Lu send \|L| Cancel | | Load |‘|

= Click Send to send the recorded message to the radio.
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= You can also load your message from file, or from Saved Audio Files. Just
click the Load button.

= Or, you can send a text message converted to speech. Just click the
Convert Text to Speech link.

Convert Text to Speech X

Text:

Pete, get back at work j
=
Listen Cancel

e Advanced > Send Coordinates To
Choose this menu item to send the coordinates of the selected radio to
selected recipients.

Send Text Message x
Target: |235{Baswl}‘ ‘
Templates: bl %
Tesd: 125 (Pete) Latitude: 59°56'25.69"N; Longitude:
I01E47.51"E
66
Mtachments: Il Add File
Select Radios and Groups
Filter: | 235
¥] 3 235 (Basi)

1188 Online Dispatchers

I send copy by Email
I Send copy by 5M3
I Send to offine radios

Hide Advanced Opticns SEND Cancel

= In the dialog box that appears, specify the radio/radio group/dispatcher to
send the coordinates to.

e Advanced > Send Email
Choose this menu item to send an Email message to the selected radio
mailbox.

e Advanced > Hot Key - Private Call
Choose this menu item to assign a hot key that will be used to make a private
call to the selected radio. When the prompt appears, press the desired key or
key combination.

Hot Key x

A r? Click for the combination to specify
A WS the Hot Key or Esc to reset

¢ Find on Google Earth
Choose this menu item to display the selected radio location on Google Earth.
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e Show Route on Google Earth

254

Choose this menu item to display a route traveled by the selected radio on
Google Earth for the specified time period.

Show Route X
Radio: 125 (Pete) "
From: | 15-Nov-2016 0:00 ~|
To: |<Last known location = ﬂ
Color: [ B 105, 105, 105 -]

Optimize Route (group all nearest points)

Cancel

Monitoring > Monitoring in New Window
Choose this menu item to open a new Map window for the selected radio.

Monitoring > Google Street View
Choose this menu item to open Google Street View with the latest location
and direction of the selected radio.

Monitoring > Yandex Street View
Choose this menu item to open Yandex Panorama with the latest location and
direction of the selected radio.

Set Location Profile
Click this menu item and select the location profile that will be associated with
the radio.

Specify State Colors
Choose this menu item to select to set individual parameters for the radio
icons.

State Colors X
State Color
viofine @ offine T
Online, Mo GPS @ Online, MNo GPS v ok -
Online, GPS Fixed @ online, GPS Fixed - o+ -
Online, Indoor (@) online, Indoor v o+ -
Alarm C Alarm -
Reset
Preview
Offline Online Online (GPS) Online (Beacon) Alarm
0K Cancel
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= In the State Colors dialog box, you can specify icons for the states of the
selected radio. Select icons from the drop-down list. To set a custom color
for the radio state icon, click the + button and select a color in the uniform
color palette. Click the — button to delete a custom color.

= In the lower part of the dialog box, you can see the preview of the icons.
= To set default icons for the selected radio, click the Reset button.

Set Radio Channel > Radio Active
Select/unselect this menu item to make the selected radio active/inactive.

Set Radio Channel > Channel
Select the radio channel over which to make calls to the selected radio.

Cameras >
Click this menu item and select a camera associated with the radio. As a result,
a new window with the camera view will open.

Set On Duty
Choose this menu item to assign the selected radio to the On Duty list.
See also section 6.4.5.6, User Activity (page 168).

6.5.2 PTT Boxes

The dispatcher can make voice calls from the Dispatch Console by using PTT boxes:

I'/_ Control Station #1 =

Channel 1
All call [~]

Session:

Free channel

Sender:

I

RX [TX

. /

The following options are available for the PTT box:

Click the button to make the channel the default PTT channel.
Click the [+2] (Tone and PTT) button to start transmitting after a tone sound.
Click the [« (Solo) button to mute all channels except this one.

Click the (Mute) button to mute this channel.

Right-click on the selected PTT box to display the shortcut menu which contains the
following commands:

Default PTT channel

Select this menu item to make the channel the default PTT channel.

Specify Hot Key

Choose this menu item to assign a hot key that will be used to transmit on this
radio channel. When the prompt appears, press the desired key.

Specify External PTT
Select the external PTT device that will be associated with this PTT box.
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Specify External Indicator
Select the external PTT indicator that will be associated with this PTT box.

Add to New Group

Choose this menu item to add the channel/group associated with the selected
PTT box to the Patch box. When two or more channels/groups are added to
the Patch box, the dispatcher can click the Create link to create a patch group
for the selected channels/groups.

Tone and PTT
Click this menu item to start transmitting after playing a tone sound.

Mute this channel
Click to mute the selected channel.

Mute all channels except this
Click to mute all channels except the selected one.

Volume
Move the slider to specify the speaker volume level on the selected
channel/group.

Microphone
Move the slider to specify the microphone volume level on the selected
channel/group.

Configure channel
Click this menu item and, in the dialog box that opens specify the recorder,
player, speaker, external PTT device, etc.

Slet 1

*

=
i
ol

=5
=3

Recorder: |Default j
Flayer: |Dafault j
Speaker: |Dafault j
Volume: = +
External FTT: |Footswind1 (Footswitch FTT) j
Indicator: |Footswitch (RTS) j
Theme: |Default j
Cancel

Private Call Mode
Select this mode to allow making private calls from the PTT box.

Select By Radio ID Mode
Select this mode to allow making calls by entering radio IDs from the PTT box.

Recipient
Select the call recipient for the PTT box.

Terminate Transmission
Click this menu item to terminate the current transmission.

Note: The incoming transmission can also be interrupted and
terminated by clicking the Interrupt button in the PTT box.
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’f Slot 1 [«] [3_\
All call ||

—
’?D Sf"ff"i\‘@

Security

Sender:
@ Rady 125

Reset
Click this menu item to reset connection to the selected channel/group.

Minimize/Restore
Click to minimize/restore the PTT box size.

6.5.3 Voice Calls

6.5.3.1

The dispatcher can make the following types of calls:

Private Call
This is an individual call from the Dispatch Console to a radio via the radio
channel.

All Call
This is a call from the Dispatch Console to all radio groups registered in the
system.

Group Call
This is a call from the Dispatch Console to a selected radio group registered in
the system.

Intercom Call
This is a call from the Dispatch Console to other dispatchers. There are three
types of Intercom Call:

= Intercom Call to all dispatchers
= Group Intercom Call to a group of dispatchers
= Private Intercom Call to a selected dispatcher

Phone Call
This is a call from the Dispatch Console to a selected phone number.

In addition, the dispatcher can send voice mails to offline radios.

Private calls

The dispatcher can make a call to any online radio registered in the system. To make
an individual call from the Dispatch Console to a selected radio via the radio,
channel do the following:

Or:

Select the radio in the Radio List.

Click the button on the right.

Right-click the radio in the Radio List.

On the drop-down menu, click Private Call.
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To terminate a private call, do the following:
e Click the PTT button on the PTT box.

Or:
£
e Click the button in the Radio list.

Note: You can also create a special PTT box for Private Calls. For more
details, see View > Configure PTT Boxes on page 98.

6.5.3.2 All calls
The dispatcher can make a call to all online radios registered in the system (for
example, in the case of alarm). To make a call from the Dispatch Console to all radios

registered in the system, do the following:
e From the drop-down list, select All Call.

(_D Repeater #1: Slot #2

All call E
All Call

Firemen

Police

Session:

Free channel

Sender:

L ]

RX [T =
5]

. J

e Click the PTT button.

6.5.3.3 Group calls
To make a call from the Dispatch Console to a selected radio group registered in the

system, do the following:
e From the drop-down list, select a group.

(_ 1P Site Connect: Slot #1 (=

All call E
All Call
Cleaners

RX JTX =

e Click the PTT button.

Note: You can also create a special PTT box for Group Calls. For more
details, see View > Configure PTT Boxes on page 98.

6.5.3.4 Intercom calls
The dispatcher can make calls to all dispatchers or to selected dispatchers in the
system. To make an Intercom Call to dispatchers, do the following:
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e On the Intercom PTT box, from the drop-down list, select either All Call, or a
group of dispatchers, or an individual dispatcher.

(B tercom

@ Offline: Dispatcher 2

O Sender:

RX JTX

" J

e Click the PTT button.
6.5.4 Predefined Voice Messages

The dispatcher can send predefined voice messages (recorded or voice messages, or
audio files) to a radio or a selected radio group:

File View Map Tools Help

Voice Dispatch Radio Interface
i % RT @g@

() Radio 204 mg e
(%) Radio 205

© | ) Firemen

[ Repeater #1: Slot #2 [ [« @

@ All call

ssssss

B Repeater #1: Slot #1 [ =@

Al cal
@@ 25@asi)  HR
(%) Radio 200 e YW sesson

QD Radio 201
Patch on Repeaters
% Location Tracking Esnary patch
System Bridge
W pablicketing Repeater #1: Slot #2 ==l
—— Recent Calls/Events ™ |
Playback (] Saver Reload Filter By Radio oupins Auto Filter € Default Settings || 7' Details )
5 Playback (s -8 | B y ping 7 G g z
| Gj] RFID Tracker Date | Recipient | Message | Details | Note. |
—_ o 15-Nov-2016 15:43:52  Repeater #1: Sl.. D\SDEMEY 1 125 Private Call: Dispatcher Dispat... Members: Dispatcher 1, 125
Text Messages S5 15-Nov-2016 13:28:52 235 Al Reset Geofencing Alarm
? 15-Nov-2016 13:28:48 235 Al The Geofendng - Monitor Area.
i s s—"— BB 15-Nov-2016 13:28:48 235 Al Radio left allowed region My ...
L= S 15ov-2016 13:28:48 235 Al Radio left allowed reaion 'Mv z. hd
— | «| | Record 1ofs78 > |wmi| <]
:F Event Viewer Recent CallyEvents | RecentCals | Request toTak | Radio state | Actve Tasis | acti | User actvity | Map | Cameras
E‘)mom@@@‘ﬁnpth 1| (28 Licensed to: demo Demo Lic | © Active-

¢ In the Queued Messages panel, click the Voice Message button.

¢ In the confirmation dialog box, click Yes.
6.5.5 Patches

6.5.5.1 Predefined Patch

The Patch function allows configuring the network to redirect calls. A predefined
Patch can be created by the administrator only and a dispatcher cannot configure it.
A predefined Patch is displayed in the Patch panel by default. The Patch feature is
intended to combine different radio channels in a single group to make voice calls
from a dispatcher to radios and from radios to a dispatcher (for example, to connect
a dispatcher with the firemen and police).
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(%) (® Rauio 203
(%) Radio 204
(%) (D Radio 205
© [ Firemen
HEm —
€210 125 Pete) = PTT PTT
®om
(#) ® 235 @asi)

[ Repeater #1: Slot #1 [ <@ A Repeater #1: Slot #2 [ €M@

Drag and Brop PTT Box here to create new group

Group Call Group Call Patch on Repeaters
] — Y CR— oo

T el
@ Dispatcher 1 @ Dispatcher 1 Firemen - Police ]

(@ repeater #1: Slot #2

Voice

=1
)

Police
RX/TX —————————— R/ ———————————— =
Fr—— 5 o) || e

v

Recent Calls/Events
Playback [ Save~ () Print | 11 Pause <# Clear = @i Reload | [ Filter By Radio | = Grouping ' AutoFilter @ Default Setting? |[E&F Details
B8 Playback = = prin | y ping g

Date | Radio System | Sender | Redipient | Message | Note. |
15Nov-2016 17:35:17  Repeater #1:Sl... 125 Firemen Radio'125' calls group Fir -
Text Messages 15N0v-2016 17:35:17  Repeater #1:S... 125 Police Radi 125" calls group ol
15Nov-2016 17:35:09  Repeater #1:Sl... 235 Police Radio'235' calls group Pol

15Nov-2016 17:35:08  Repeater #1: Sl... 235 Firemen Radio 235" calls group ‘Fireme...  Members: 235
15-Nov-2016 17:34:37

-
Repeater #1: 5. Al Call from '235' (00:01) Members: 235 hS

o — A :

= Rcent CalgEvents | Recent Calls | Request o Tak | Radiostate | ActeTasks | activeRoutes | User actuity | 1map | cameras |

(6127001 g3 By B | Dispatcher 1 | [ Licensed to: dema Demo License | @ Active-

z

6.5.5.2 Custom Patch

The dispatcher can create a custom Patch to connect selected PTT boxes (for
example, the Emergency and Firemen radio groups). In addition, you can connect
analogue and digital radios via a Patch.

1.

2.
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Radio Interface

Radio Interface| Recent Cals/Events

(%) (© Rauio 204 Hee

®Oramzn B oo HE m
© | Firemen To: Selected Channels

®e

B 222 - Voice Message

(®) @ 235 @asil)

(#) (D Radio 200 v

iremen
(#) (D Radio 201 X Cleaners 1
— Create Clear
e O (] [« (F2tch on Repeaters
- . chans chani [I8inary Patch

[] Firemen - Police X
nﬂfi[emr #1:Slot #2 PTT

Firemen Cleaners

Recent Calls/Events
Playback (gl Save~ (=) Print | 11 Pause <¥ Clear » ‘& Reload Filter By Radio | = Groupin Auto Filter © Default Settings Details
yl y ping 9

Date | Radio System | Sender | Recipient | Message | Details | Note.
15Nov-2016 18:03:01  Repeater #1:Sl... Dispatcher 1 Firemen Dispatcher ‘Dispatcher 1 calls .. Members: Dispatcher 1 ﬂ
1500v-2016 17:58:21  Repeater #1: ... Dispatcher 1 Firemen Dispatcher Dispatcher ' calls ... Members: Dispatcher 1
15Nov-2016 17:58:21  Repeater #1:S... Dispatcher 1 Cleaners Dispatcher Dispatcher 1 cals ... Members: Dispatcher 1
15Nov-2016 17:55:01  Repeater #1:Sl... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher 1'calls .. Members: Dispatcher 1

15-Noy-2016 17:55:01  Repeater #1: 5l... Dispatcher 1 Cleaners Disoatcher ‘Dispatcher 1' calls Members: Disoatcher 1 A
| «| «| Record 10f875 »ﬁ» wd »

Recent CalEvents | Recent alls | Reauest o Tak: [ Radiostate | Acte Tasks [ Actve Routes | User actwity [ 1ap [ cameras |
127001 83 B B | § Dispatcher1 | [ License

demo Demo License | @ Active-

In the Radio Interface pane, select the PTT boxes you want to combine in a
group. Drag and drop them to the empty Patch box (1).

Click the Create link (2) to create a custom Patch.

Note: Until you click the Create link, this patch will remain as a
temporary patch that will be deleted after you reconnect to
TRBOnet Server or restart TRBOnet Dispatch Console.

As a result, the new patch will be added to the Patch panel. Select the check
box to activate the patch.
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adio Interface

Radio Interface| Recent Cals/Events

(%) (® Rauio 203

(%) (© Rauio 204 oe e
(%) (© Rauio 205

© | Firemen Drag and Brop PTT Box here to create new group
HEm

® S . o Patch on Repeaters
@0 o [I8inary Patch
() ® 235 (Basil) N

(#) (D Radio 200 Group
(#) (D Radio 201 meQ Sépeilér #1:Slot #2

eeeeee

Repeater #1: Slot #1
Firemen

[ Firemen - police
Repeater #1: Slot #2 (e
Police

Repeater #1: Slot #1

Firemen

Recent Calls/Events
Playback [z Save = () Print | 11 Pause < Clear » '3 Reload | [ Filter By Radio | = Grouping ‘[ Auto Filter > Default Settings || 5 Details
yt y ping g

Date | Radio System | Sender | Recipient | Message | Details | Note. |
15Nov-2016 18:06:05  Repeater =1:Sl... Dispatcher L Firemen Dispatcher Dispatcher 1 calls... Members: Dispatcher 1 -
T —— 1500v-2016 18:06:05  Repeater #1: ... Dispatcher 1 Firemen Dispatcher Dispatcher ' calls ... Members: Dispatcher 1

15Nov-2016 18:03:06  Repeater #1: Sl... Dispatcher 1 Cleaners Dispatcher Dispatcher ' cals ... Members: Dispatcher 1

15-N0v-2016 19:03:01  Repester =1:Si... Dispatcher 1 Firemen Dispatcher Dispatcher 1'cals ... Members: Dispatcher 1
15Noy-2016 17:58:21  Repeater #1: 5. Disoatcher 1 Firemen Dispatcher ‘Disnatcher 1' calls Members: Dispatcher 1 hs
T ——| i AT :
= Recent CalsfEvents | Recent Cals | Request to Tak | Rado state | Acve Tasks | ActveRoutes | User Actwity | vap | cameras. |

(127001 g3 & € | § Dispatcher 1 | [ Licensed to: demo Demo License | @ Active-

6.5.6 Quick Commands

The dispatcher can create Quick Commands (Text Messages, Send Telemetry,
Request Location, Send Voice Message, and some other commands) and display the
Quick Commands panel in the Radio Interface pane. With these commands, the
dispatcher can quickly send Text Message, Telemetry, Location Request, Voice
Message, and some other commands to a radio by clicking the appropriate Quick
Command button.

To configure the Quick Commands panel, do the following:

¢ Make sure Show Quick Commands Panel (2) is selected under the View
menu.

¢ On the Quick Commands panel, click the Configure link (3).

Show Navigation
Show Modules

Cenfigure PTT Boxes.

Configure Active Calls Panel.
Customize Hot Keys...
Add Radio Interface Page...

Delete Raio Inteface Page — [LResrc ]l e P

To: Selected Channels

Show Channel Selector Box

Audio Message Library...
Extended PTT Boxes
Large PTT Boxes
Medium PTT Boxes
Small PTT Boxes

Custom PTT Bbxes r P Free channel

— Cleaners

Free channel

Voice M
Firemen olce Message

Drag and Drop PTT Box here to
create new group

Recent Calls/Events
) Playback [ Save~ (b Print | 11 Pause < Clear + 'S Reload | [ Filter By Radio | = Grouping '/ Auto Fitter

Date |Radio Syst... Sender  |Redpient | Message | Details | Note |
% 16-Nov-2016 10:22:05 Server all Connection to ‘Repeat. .. -
15Mov-2016 18:26:36  Repeater... Dispatcher 1 Firemen Dispatcher Dispatcher... Members: Dispatcher 1
15-Noy-2016 18:26:28  Repeater ... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher... Members: Dispatcher 1

Show Telephony Tab
Show Extended Messages Tab
Show Radios Tab

15-Nov-2016 18:26:21  Repeater ... Dispatcher 1 Firemen Dispatcher ‘Dispatcher... Members: Dispatcher 1
15-Nov-2016 18:06:12 Repeater ,..  Disoatcher 1 Cleaners Dispatcher 'Disoatcher... Members: Dispatcher 1 h
|4 4| Record 10767 »Ti w4| 3
Recent CallfEvents | Recent Cals | Requestto Tak: | Redio state | Actve Tasks | Actve Routes | User Actvity | Mep | Cameras |
B 127001 &3 B, B, | 8 Dispatcher 1 | [ Licensed to: dema Demo License | @ Active-

¢ In the Configure Quick Commands dialog box, click the Create link.

* Name
Specify a name for the quick command. This name will be displayed as the
button name in the Quick Commands panel.
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6.5.6.1 Send Text Message

Cuick Command X
Name: |Test
Command
Command: |Sand Text Message ﬂ
Message: |This is a test]

" Send to Radio Group
{+ Send to Radio

Recipient:

® 13 -
M@ 125
M@ 235

@ 555

® 3333

® +42

(#) 5555 =
Selected: 2

EllE EE

= Command
From the drop-down list, select Send Text Message.

= Message
Enter the text of the message.

= Send to Radio Group
Choose this option to send the text message to radio groups registered in
the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send a predefined text message to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.6.2 Send Telemetry

Cuick Command X

MName: |Test

Command

Command: |Send Telemetry j

VIO: VIO 1 | Command: High level -

" send to Radio Group
{* Send to Radio

Redipient:

® 13 -
M@ 125
W@ 235

@ 555

® 3333

@ 2442

(#) 5555 =
Selected: 2

=] LEEE

= Command
From the drop-down list, select Send Telemetry.
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= VIO

Specify a VIO to which to send a telemetry command.
= Command

From the drop-down list, select a telemetry command for the selected VIO.
= Send to Radio Group

Choose this option to send the telemetry command to radio groups
registered in the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the telemetry command to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.6.3 Request Location

Quick Command X

Mame: |Locaﬁon of 125 and 235

Command

Command: |Request Location ﬂ

Recipient

® 13
W@ 125
W@ 235

@ 555

@ 3333

® 2

@ 5555

® Rradio 300

(&) Radio 333

(® Radio 3862

Selected: 2

@ a 7|+ =(~

= Command
From the drop-down list, select Request Location.

= Recipient
Select radios to which to send a location request.
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6.5.6.4 Send Voice Message

264

Cuick Command X

MName: |We are on fire|

Command

Command: |Sand Voice Message ﬂ

|| Load from file
,}a Record message
) play back messane

Channel Call Target

5} Capacity Plus #1

Call Type

Group Call Firemen -

op Add ¥ Remove

|Norma| ﬂ

Priority:

Command
From the drop-down list, select Send Voice Message.

Load from file
Click this link and locate the audio file on your PC.

Record Message
Click this link to record a new voice message.

Play back message
Click this link to play back the voice message.

Specify Call Type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the phone
book, click the ellipsis (...) button in the Call Target column
and select a contact from the phone book.

Priority

From the drop-down list, select the priority with which the voice message
will be sent/queued. If this priority is higher than that of the current
transmission, which is, in turn, allowed to be interrupted, the current
transmission will be interrupted and the voice message will be sent instead.
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6.5.6.5 Send Signaling

CQuick Command X
Mame: ISlgnaI 1
Command
Command: ISend Signaling j
Radio System: ICaDacit\r Plus #1 j
Target: IFiremen j
Type: [custom |

Freq.1 (Hz) Freq.2 (Hz) Duration {ms) Pause (ms)

o Add ¢ Delete # MoveUp ¢ Move Down
Cancel

Command
From the drop-down list, select Send Signaling.

Radio System
From the drop-down list, select the radio system.

Target

From the drop-down list, select the target group to which the signal will be
sent.

Type

From the drop-down list, select the signaling system type (Quick Call |,
Quick Call Il, DTMF, or Custom).

If the Custom type is selected, specify the Frequency 1, Frequency 2,
Duration, and Pause for the signal to be sent.

6.5.6.6 Send Command to Control Station

Quick Command X

Name: ICummand to Control Station

Command

Command: ISend command to Control Station j

Control Station Command |

-

PINS SET OM
PING SET OFF
PING PULSE

o Add ¢ Delete

ancel
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= Command
From the drop-down list, select Send command to Control Station.

= Click Add

e Control Station
From the drop-down list, select the Swift Agent connected to
TRBOnet Server.

¢ Command
From the drop-down list, select the PIN number and its value.

6.5.6.7 Request To Talk

Cuick Command x

MName: |R'I'I' 1

Command

Command: ‘Request To Tak j

" send to Radio Group
¥ Send to Radio

Recipient:

® 13
W@ 125

® 235

@ 555

@ 3333

(®) 444

® 5555

@ Rradio 300

-G
Selected: 1

& |- |:=|-

= Command
From the drop-down list, select Request To Talk.

= Send to Radio Group
Choose this option to send the request to talk to radio groups registered in
the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the request to talk to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.6.8 Custom Event

= Command
From the drop-down list, select Custom Event.

= EventID
Specify the event ID.
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6.5.6.9 Send Swift Command

Cuick Command X
MName: |5'N|f't 1
Command
Command: ‘Send Swift Command j
Swift Command: ‘Swiﬁ: Command 1 j
0=
0=
¥ send to Radio Group
" Send to Radio
Recipient:
System Group
Capadity Plus #1 Firemen |
o Add % Delete
oK Cancel

= Command
From the drop-down list, select Send Swift Command.

= Swift Command
From the drop-down list, select the appropriate Swift command.

Enter the required parameters, if any.

= Send to Radio Group
Choose this option to send the Swift command to radio groups registered
in the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the Swift command to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.7 Queued Messages
This feature enables dispatchers to send audio messages even if the channel is
currently busy. The dispatcher records a message to be sent to a busy channel and

then TRBOnet automatically forwards this message as soon as the channel becomes
available:
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File View Map Teols Help

Voice Dispatch Radio Interface
Bil=t & % 7@

e & Online Dispatchers

D pispatcher 1
o R Gt = =T
d Ch, |

© ) Cleaners
(%) Radio 200
(%) (D Radio 201

5] Playback [l save~ () Print || 11 Pause ¥ Clear - 'S Reload | “\F Fitter By Radio | = Grouping |7 Auto Filter

Date | Radio Syst... | Sender |Recpient | Message | Detais. | Note |

15hov-2016 18:26:23  Repester... Dispatcher 1 Cleaners Dispatcher ‘Dispatcher... Members: Dispatcher 1

15Nov-2015 18:26:35  Repeater... Dispatcher 1 Firemen itcher... Members: Dispatcher 1

% 16-Nov-2016 10:22:05 Server Al ‘onne epe:

1| 4| 4| Record6790F 679 » [ 1|1 4| »
Recent Calls/Events | Recent Calls | RequesttoTak | Radio State | Active Tasks | Active Routes | User Activity | Map | Cameras

6127001 &3 B & | © Dispatcher 1 | (8 Licensed to: demo Dema License | @ Active~

To queue an audio message for delivery to the selected recipients, first record a
message by clicking the Record button. Alternatively, you can select an MP3 or WAV
audio file from any storage location, or select a prerecorded message from the
library.
6.5.7.1 Select Audio File
e Click File > Open Audio File and browse for the audio file on the local PC.

Open Audio File...
Audio Message Library

Voice Message

6.5.7.2 Audio Message Library
You can select an audio file from the Voice Message templates.

e Click File > Audio Message Library.

Saved Audio Files X

4k Add X Remove | 7 Filter | Hot Key

Filename Description Severity Hot Key Visibility
Alarm Tone Alarm

»  Bobby.mp3 Information
Daisy.mp3 Information

st _| cancsl_|

e Select an audio file in the list and click OK to use this file as a queued Voice
Message.
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6.5.7.3 Record Audio File
You can record a voice message that can be sent to selected radios.

e Click Record > Record audio to open the recording tool:

Record audio

Convert Text to Speech

= Click Start and start talking to the microphone.

Record audio

.-‘_‘lll....‘l_.-.-.-.‘l,ﬂ..iI\‘,1L.Jﬁ\ﬁhh'k'-‘1ilt.ll‘HL-. ‘i.t,,-_._._._.__..__.E

Convert Text to Speech

= Click Stop to stop recording the message.

Convert Text to Speech

|u Send Hu Cancel | |H Save |‘|

= Click Send to send the recorded message immediately.

= (Click Save > Save as file to save the recorded file as an audio file on the
PC.

Or:

= (Click Save > Save as Saved Audio File to add the recorded file to a list of
the Saved Audio Files.

6.5.8 Activity Monitor Panel

While in this panel, the dispatcher can perform a wide range of tasks, including:
¢ Monitoring and listening to recent calls and viewing system events
e Monitoring selected radio state
e Monitoring active tasks for selected radio
e Monitoring active routes for selected radio
e Enabling and disabling User Activity monitoring
¢ Displaying selected map in a compact view mode
e Monitoring cameras connected to Dispatch Console
6.5.8.1 Recent Calls/Events

In the Recent Calls/Events tab, the dispatcher can monitor recent Server events,
view and listen to recent calls.
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File View Mop Tools Help

Voice Dispatch

Radio Interface

& )

k& KT B & || Radio Interface| Recent CalsEvents
~ e -
[ Repeater #1: Slot #1 [ =@ ]
HEm EEN - frcechanne
(®) @ 125 (Pete) =eEW e Queued Messages  [X]
- o
£)(D 222 EENE
g fion] >
(& ® 235 (Basin) el Bdrepeater gr:siot 2 [1)] (€][@)]
£) (D Radio 200 Free channel
£) D Radio 201 () voice Message
“““““ Alcal Voice Message
(1Y voice Dispatch hd
«ecent Calls/Events »
[;!,L Location Tracking [ Playback (el Save~ () Print | 11 Pause <7 Clear - i Reload | “[f| Filter By Radio | = Grouping |7 Auto Filter >
Date Radio System Sender Recpient | Message Detzils Note
& 30b Ticketing -
([ 16ov-2016 15:22:16 Repeater #L:Slot =2  Administrator Al Al Call from dispat... Members: Administrator
[j Route Management [ 16+4ov-2015 15:22:116 Repeater #1: Slot 1 Administrator Al All Call from dispat... Members: Administrator
() 16-ov-2016 15:22:15 Interc iisrator Al rcor .. M tor
0] RFID Tracker 16-oy-2016 15:22:12 Repea Cl: M
16-oy-2016 15:22:12 Repea Administrator  Firemen = M
[] Text Messages (7 15-ov-2016 15:22:07 Repeater Administrator Al Al Call from dispat... Members: Administrator
(7] 16ov-2016 15:22:07 Repeater =1:Siot =2 Administrator Al Al Call from dispat... Members: Administrator
ﬁ Voice R i D 16-Nov-2016 15:22:06 Intercom Administrator Al Intercom Call: Disp... Members: Administrator
S5 15-Noy-2016 13:33:09 235 Al Reset Geofendng .., i
- | ««| < Recordsofsss »|m|mi ¢ »
Event Viewer Qe:gn(cal\sﬁvgnﬁ RecentCalls | Requestto Talk | Radio State | Active Tasks | Active Routes | User Activity | Map | Cameras /

[32127.00.1 &3 €Y B | @ Dispatcher 1| [ Licensed to: demo Demo License

Voice Recording
Play back selected call(s)
e Select the voice call recording you want to play back and click the E5) Playback
button on the left of the toolbar.
The Audio player box will appear.

8l Audic player

Duration:
Left:

Position

[T Pause m is| Player rs Open
All call from dispatcher "Administrator’ (00:03)
Clear

= Click the Play button to play back the recording.
Click the Pause button to make a pause.
Click the Stop button to finish playing back the recording.
Click the Open button to select a new audio file to play back.

Note: You can play back multiple recordings in a row. Use the CTRL
and/or SHIFT keys to select multiple recordings you want to play
back. Then click the =9 Playback| b ton

Save selected call(s)

e Select the voice call recording (or multiple recordings, with the help of
CTRL/SHIFT keys) you want to save as an audio file.
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¢ Click Save > Save Selection as Individual Files to save selected recordings in
separate files.
Or

¢ Click Save > Save Selection as Single File to save selected recordings in a
single file.

¢ In the Save As or Browse For Folder dialog box, browse for the folder where
you want to save the file(s).

Recent Calls/Events Toolbar

[ playback (el Save~ () Print | 11 Pause < ¥ Clear ~ 'S4 Reload | “[J Filter By Radio | = Grouping | \F Auto Filter © Default Settings | " Details | [ | Show Notes [ 2] Add Note Add Message
Click the Pause button to pause updating the Recent Calls/Events log.

Click the Clear button to clear the Recent Calls/Events log records.

Click the Reload button to reload all log records.

Click the Filter By Radio button to filter log records by a selected radio/radio group.
In the Radio List pane (the upper-left-pane of the main window), select a radio or

radio group. The Recent Calls and Events for a selected radio will only be displayed
in the Recent Calls/Events pane.

Click the Grouping button to group log records. Select the column you want to
group log records by. Drag and drop the selected column header to the Grouping
field.

Click the Auto Filter button to set a filter for the recent calls and events. You can
filter the Recent Calls/Events list by any parameter. For example, to filter the list by a
selected Sender, select the Sender column (1), and start typing the sender name (2).

) Playback [l Saver (&) Print | 11 Pause < Clear - ils | [ Show Notes.

Date Radio System

Dispatcher Dispatcher I calls group ...
Al Callfrom disptcher ‘Dispatcher 1"

16-Nov-2016 16:54:16 Repeater =

[ 16-40v-2016 16:5%03 Repester #1: Slot 22 Dispatcher 1

16-Nov-2016 16:53:57 Repe: ot £2 Dispatcher 1 oiice Dispatcher ‘Dispatcher 1" calls group "

16-Hov-2016 16:53:57 Repeater #1: Slot #1 Dispatcher 1 remen Dispatcher Dispatcher T calls group ...
[ 16+0v-2016 15:35:23 Repe: ot #1 Dispatcher 1 Al Call from dispatcher ‘Dispatcher ..,
(2] 16+0v-2016 15:35:15 Repe: ot #1 Dispatcher 1 Al Call from dispatcher ‘Dispatcher ..,

iremen Dptdv nptm1|\g

15Hov-2016 18:26:36 Repe:
B <chie nas 100878 Mo e clos 5 hd
4| 4| <] recordoofso » [ w4 »
B - Edit Fiter

Recent CallsEvents  RecentCalls  RequesttoTak  RadioState | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

Click the Default Settings button to apply default settings to all log records.

Click the Details button to see the talk session participants:

) playback [l Save- () Print | 11 Pause <7 Clear - i Reload | [ Fitter By Radio | = Grouping "\ Auto Filter || %7 Details | [ | Show Notes

Date Radio System Sender ¥ Recpient Message Detais
16-Nov-2016 16:54:16 Repe: Dispatcher 1 Firemen Dispatcher Dispat r ' ... JMembers: Dispatcher 1 -
[ 16-Hov-2016 16:54:05 Repe: Dispatcher 1 Al Al Call from dispatcher ‘Dis... [Members: Dispatcher 1
16-Nov-2016 16:53:57 Repe: Dispatcher 1 Police: Dispatcher Dispatcher I'c... [Members: Dispatcher 1
16-Nov-2016 16:53:57 Repeater Dispatcher 1 Firemen Dispatcher ‘Dispatcher 1 ... |Members: Dispatcher 1
D 16-Nov-2016 15:35:23 Repe: Dispatcher 1 Al All Call from dispatcher ‘Dis.... [Members: Dispatcher 1
[ 16-Hov-2015 15:35:15 Rep Dispatcher 1 Al Al Call from dispatcher ‘Dis... [Members: Dispatcher 1
15-Nov-2016 18:26:35 Repe Dispatcher 1 Firemen Dispatcher Dispatcher T'c... [Members: teher 1
15-Nov-2016 18:26:28 Repeater Dispatcher 1 Cleaners Dispatcher ‘Dispatcher 1 ... |Members: Dispatcher 1
¥ 15-Nov-2016 18:26:21 Repeater ¥1: slot #1 Dispatcher 1 Firemen Dispatcher Dispatcher I'c... mhers: Dispatcher 1 A
] 44 ord 0 El v
Bz - it Filter

Recent Calls/Events  RecentCalls | RequesttoTak | RadioState | Active Tasks | Active Routes | User Activity | Map | Cameras

Click the Show Notes button to enable the Note column. All notes added by the
administrator and dispatchers for the recent calls and events will be shown in the
Notes column. So, you can mark recent calls and events to later find them by notes.
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Click the Add Note button to add a note for the selected recording and/or event.
The notes will be displayed in the Recent Calls/Events log if the Show Notes mode

enabled:
Click the Add Message button to add a message for dispatchers to the Recent
Calls/Events log.

Add user message x
Recipient: | All ﬂ
Severity: (i) Information -

Message: Tes] -]
=

= Recipient
Select either All or an individual dispatcher if you want to see the message.

= Severity
Select the severity level to inform dispatchers about the level of importance.

= Message
Enter the message text.

= Click OK.
As a result, the message will be added an event to the Recent Calls/Events
pane.

6.5.8.2 Recent Calls
On the Recent Calls tab, the dispatcher can see and configure the latest Voice calls,
including Private, Group, and Intercom calls:

Types: ‘ Private | 4k Group OAII Call | <F Clear 57 Filter

Most Recent Call aller Call Number Actions
-1 27.04.2017 12:1" 1 3 5 12L& |||
P All call Group Call Private Call
L Llcams: 1 2 Calls: 3 Calls: 1
\';i/ 27.04.2017 12:19 27.04.2017 12:18 27.04.2017 12:18
A | A ;
1 D&

+| 27.04.2017 12:03 235

Recent Calls/Events | RecentCalls | RequestTo Talk | Radio State | Active Tasks | Active Routes | User Activity | Map = Cameras

e Click the Private button (1) to display the latest Private calls.

e Click the Group button (2) to display the latest Group calls.

o Click the All Call button (3) to display all call types, including Intercom calls.
In a Call Box, you can see the number of calls and the last call date and time:

3~ | Alcal
& & calls:1
S 2014-07-07 14:02:47

Click the I'S button to start a Private call to the Sender-Radio (Radio is displayed in
the Sender column).

Click the V] button to mark the calls as viewed.
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Click the [#| button to clear the recent call history.
6.5.8.3 Request to Talk
On the Request to Talk tab, the dispatcher can see Missed Calls and Requests to

Talk:
Request To Talk kd
Types: \“ Missed Call . Request To Talk | View: | [ Table B8 Cards | <J Clear S Filter _% Options
Most Recent Cal Caller Accepted/Queued Call Type Call Mumber Actions
18.04.2017 17:30 @ 125 Dispatcher 1 A Request ToT... 1 (88788
M| 4| 4 |Record 10f 1 k| b M| 4 4

Recent Calls/Events | RecentCalls = Request ToTalk  Radio State | Active Tasks | User Activity | Map | Cameras

e Click the Missed Call button to display Missed calls.

e Click the Request to Talk button to display Requests to talk.
e C(lick the Table button to display the calls in a table view.

e Click the Cards button to display the calls as a set of cards.

e Click the Clear button to clear all the records.

¢ Click the Filter button to set a filter for the records. You can filter the records
by any parameter. For example, to filter by the caller select the Caller column,
click in the empty row and start typing the caller name.

¢ Click the Options button to specify options related to Request to Talk:

Request To Talk H

Motifications

[¥ Enable Request To Talk workflow
I¥ show RTT notifications in a pop-up window
IV After dicking Accept, start a return call
Iv Play a sound when RTT notifications arrive
v Show notification in the Windows tray
v Synchronize with other dispatchers
v Automatically delete Request To Talk record after responding
¥ Wait for response from caller

¥ Enable Responses to a Radio Group

Talk Group: Home Radio Group j

Cancel

= Show RTT notifications in a pop-up window
Select this option so that incoming Request to Talk messages will pop up
over the application window.
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Request to Talk

J 125
. The Reguest to Talk has been received.
d) You must accept or reject it.

Reject Queue

o After clicking Accept, start a return call
Select this option so that a return call will start as soon as the Accept
button is clicked.

Play a sound when RTT notifications arrive
Select this option so that an alert tone will sound when a Request to Talk
arrives.

Display notification in the Windows tray
Select this option so that a notification will be displayed in the Windows
tray when a Request to Talk arrives.

Synchronize with other dispatchers
Select this option so that a Request to Talk sent to one dispatcher will
automatically be forwarded to all dispatchers.

Automatically delete Request to Talk record after responding
Select this option to automatically delete the corresponding record after
the Request to Talk call is responded.

Wait for response from caller
Select this option so that a Request to Talk will be considered responded
only if the radio has answered to the return call.

Enable Responses to a Radio Group
Select this option so that a response to a Request to Talk will be made to
the selected radio group.

e Talk Group
From the drop-down list, select the radio group.

Note: If the Home Radio Group is selected, and the Home Group
is not specified for the radio that initiated a Request to Talk,
then the response to this Request to Talk will be made as
an All Call.
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On the Notifications tab, specify the following parameters:

Request To Talk X

Dispatcher 1

¥ Send notifications to caller
¥ Autodetect notification type
" Send Text Message

" Send Audio Message
Notification texts:

Queued: |Ca|| queued

Rejected: |Ca|| rejected

Not Available: |Dispatcher is not available

Cancel

= Send notifications to caller
Select this check box to notify the radio when a request is rejected, queued,
or the dispatcher is unavailable.

e Choose one of the option buttons below to specify the way the radio is
notified.

v Autodetect notification type
Choose this option button so that the type of notification will be

selected automatically depending on whether or not the Text
Messages Service is enabled on the radio.

v Send Text Message

Choose this option button to send text notifications to the radio.
v" Send Audio Message

Choose this option button to send voice notifications to the radio.

¢ In the Notification texts boxes, enter the corresponding notification

texts. These texts will be used when sending text notifications to the
radio.

6.5.8.4 Radio State

On the Radio State tab, the dispatcher can see the log of radio states for the radio
selected in the Radio List pane (the upper-left-pane of the main window):

125 (Pete)

@=@

Show Notes Add Note Add Message

Date Dispatcher 4/smEte
5”;;'”;1 Set #2 17-Nov-2016 11:35:22 Reset Geofencing Alarm -
S 7oy IuTE s | T Mev2us 113515 Geofendng e: 17-Nov-2016 11:35:15; Latitude: 59°56'27. 78°N; Longitud...
spead:  D.4km 17-Nov-2016 11:35:15 Radio left oute 1
Atude:  Unknown 17-Nov-2016 11:35:15 Radio left allowed region Route 1'
Lofitude:  59°5627.78°N 16-4N0y-2016 10:34:20 Radio Online
Longitude:  30°16'47.08°N 15-Nov-2016 18:47:22 Radio Offine
15-Nov-2016 14:01:27 Radi Oniine
15-Nov-2016 14:00:25 Radio Online
15-Nov-2016 11:25:26 Radio Online

RecentCals/Events | RecentCalls | RequesttoTak | Radio State | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

In the Radio State pane, the dispatcher can do the following:
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6.5.8.5

6.5.8.6

276

Click the Show Notes button to enable the Note column. All notes added by the
administrator and dispatchers for the radio state records will be shown in the Notes
column. So, you can mark radio state records to later find them by notes.

Click the Add Note button to add a note for the selected radio state record. The
notes will be displayed in the Recent Calls/Events log if the Show Notes mode
enabled:

Click the Add Message button to add a message for dispatchers to the Radio State
log.

Active Tasks

On the Active Tasks tab, the dispatcher can monitor all active tasks for the selected
radio (for example, Lone Worker, Active Routes, and other tasks).

il Stop | = Grouping ' Auto Filter (» Default Settings

Task Radio State
Lone Worker 1 125 (Pete) R0 = 12:31
Timer 235 (Basi) 0.00:29:16 - Timer started.

id| 4] 4| Record 102 b [ wr[mi[ ¢

Recent Calls/Events | Recent Calls | RequesttoTalk | Radio State | Active Tasks  ActiveRoutes | User Activity | Map | Cameras

The dispatcher can manage active tasks as follows:
Click the Stop button to stop executing the selected task.

Click the Grouping button to group the tasks. Select the column you want to group
tasks by. Drag and drop the selected column header to the Grouping field.

Click the Auto Filter button to set a filter for the active tasks. You can filter the tasks

by any parameter. For example, to filter by selected radio select the Radio column,
and start typing the radio name.

Click the Default Settings button to apply default settings to all active tasks.
Active Routes

On the Active Routes tab, the dispatcher can monitor all active routes.

b start | 1l Pause Ml stop | =} Edit @) Export~| = Grouping '/ Auto Filter ©» Default Settings
Name Route
b Route 1 00:01 12:21 1231 10:00 10:40

(¢
17-Nov-2016 12:20 Pointi o

#|«| <« Record1of1 » | » M <
RecentCals/Events | RecentCalls | RequesttoTak | Radio State | Active Tasks | Active Routes | User Activity | Map | Cameras

The dispatcher can manually set statuses for route checkpoints. To do this, right-
click a route point and from the drop-down menu, select the desired status.

= Waiting
The checkpoint is waiting to be attended.
= Attended
The checkpoint has been attended on time.
= Unattended
The checkpoint hasn't been attended on time.
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= Alarm
The checkpoint is in Alarm mode.

= Note
Click this item to add a note to the selected checkpoint. The note will be
displayed in the pop-up window that appears when hovering the mouse
pointer over the checkpoint.

6.5.8.7 User Activity

e Click the User Activity tab to monitor the activity of radio users:

. Disable the User Activity monitoring | <> Configure.

Off Duty Al mime [ On Duty A Tme | User Activity #1 4| Time

% 111 B @ 235 13:15:01 @ 125 13:15:09
(&) Radio 200

(@ Rado 201

(@ Radio 202

(@ Radio 203 ==

Radio 204
@retom: =

RecentCals/Events | RecentCalls | RequesttoTalk | Radio State | Active Tasks | ActiveRoutes | User Activity | Map || Cameras.

e Click the Configure button to configure the User Activity list:

6.5.8.8 Map

On the Map tab of the Activity Monitor panel, you can monitor location of radios on
the map and simultaneously perform all available actions in the Radio Interface
pane (make voice calls, send messages, disable and enable selected radios, and
other actions):

) 0L iy | Fites @] @[ Q@] 17 | Show Beacons: 41 + | Ruler 4 FindonMop~ 4, & Drowing Panel (| Route» <& Geofencing ] Coverage Map | | Select Map i} Gongle Earth
o S
‘Lg)/
.
?’L
¥
‘0
N9
&
5 o
Walt %, o
235 (Basil) 3 % ;o)
5, Lathude: 58°56:27.56N: Longtude: 3071631 91°E

125 (Pete)
Recent Calls/Events  Recent Calls REG)ESttﬂTEk Radio State ~ Active Tasks ~ Active Routes ~ User Activity Map  Cameras

For more details on map options, see section 6.6, Location Tracking (page 280).

6.5.8.9 Cameras

On the Cameras tab of the Activity Monitor panel, you can monitor cameras
connected to Dispatch Console.

ff Add -

[camera 1 ~|

7-2017 YTB 15:22:02
3 —

1

Close Close

Recent Calls/Events | RecentCalls | RequestTo Talk | Radio State | Active Tasks | Active Routes  User Activity = Map = Cameras
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e Click the Add button and select a camera to be displayed on the tab.

Note: You can add up to four cameras to the Cameras tab view.

6.5.9 Phone Calls

The Telephony function allows making calls from telephones to radios and vice
versa.

The phone system must be previously configured by your TRBOnet administrator.

6.5.9.1 Phone Calls from/to Dispatch Console

To make a phone call from the Dispatch Console:

[@ Telephony E‘
/ 2

[irel: 2400 ¥ -
s Jpred] =
Jotinet || ez 4| Lnes

|
1/\ tine 4 | Line 5 4| Lnes
T

!

|

|

3
===
e 7 ) [
‘. = #

o|lew e |m

>,

¢ Inthe Telephony box, select the Line (1), enter the phone number (2) and click
the [ *™ (3) button.

Terminate a phone call

e In the Telephony box, click the |i| button.
Open a phone book

¢ Inthe Telephony box, click the ellipsis (...) button (2) or click Menu > Phone
Book (2):

@ Telephony 2 \ E‘
i |

b [ Menn || =
Hold Call

-Linel

| Forward Call...

IlJ] Phone Book |
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Answer an incoming call

@Telephunv E
[wair -]
S e

[Lune1 ]| ne2 | tnes |

j tine4 || tines 4| Lines |

=

\" E :j

¢ In the Telephony box, click the E (3) button.

Forwarding Phone Call to a Radio

¢ While in a call, click Menu > Forward Call.

@ Telephony

[Tel: 2400 - ]

Menu “I’ - 1|

-
E Hold Call
| Forward Call... |
pLine 4

u Phone Book
|

SR i | |

R

7 e s Ao

i |

/

Forward Call H
AH + Specify text to searh
i =

- 125 (Pete)

g Dispatcher é 235 (Basil)

Radio — 1

Radio Group 2
Q Phone
4 3

Conference Forward | Cancel

e Click the Radio tab (1), select the radio (2) and click Forward (3).
Add call participant(s)

e C(lick Conference (4).

Note: Only one radio or radio group can participate in a conference call.
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6.5.9.2 Making Telephone Calls from Radios

6.6

280

Make a DTMF call

Note: Only 1.07.02 and higher firmware version for all radios equipped
with dialing keyboard support DTMF.
To make a DTMF call, do the following:

=  Press the PTT button on a portable radio and hold it.

= While holding the PTT button, dial a phone number and press # (For example,
0079521112233#).

= Release the PTT button. The server will automatically initiate a phone call.

Call by sending Text Message
To make a phone call, send a text message with the text PrefixN where:
o Prefix — is a short text to define the special text message (for example, sip:);
¢ N - the phone number.
For example, to initiate a call to a phone subscriber "123 456 7890", the following
text message must be sent to TRBOnet Server: "sip:1234567890".
Terminate a call

To terminate the call, press the PTT button and then press # twice on the radio.
Location Tracking

In the Location Tracking tab, the dispatcher can monitor selected radio location on
supported maps, open different maps in separate tabs and toggle between map
tabs:

File View Map Tools Help

®DRado204 QBW

& [} Firemen o
BH@m

BING_ROAD'
0 1 | Fier| @[ @) [0 @] 17 | showBeacons: a1 ~ | & Ruler (4 FindonMap- 2| ¥ L Mep Opects
(=] % o 4 [ Abiding place
B D222 % 2 JE\ % 2 [ Fire dep
| () (S 235 (Basil) (©) . K %, ¥ [#] Hospital No2
- Hospital No2 %
o i 12 [ Police department ...
(&) Radio 200 » Fire dep Z i
= g © G54l [ Map Regions
% e < @ +7 vy zone
(1Y voice Dispatch & o -] [ Map Routes
?’0\\4“ [ g Route 1
% Location Tracking = e
s g :
5
% 100m 235 (Basil) ¥
P
;] Route Hanagement 5, & Latitude: 59°5623.96"N: Longituds: 3071634 85°E
@ Recent Calls/Events ™
RFID Tracker X — 5
I Playback [l Save~ (G Print | 10 Pause <3 Clear - i Reload | [ Filter By Radio | = Grouping 7 Auto Filter @ Default Settings
[~ it Hcssages Date Radio System | Sender Redpient. Message Detals Note
[ i8-Nov-2016 10:41:45  CapacityPLUS  Server 235 The Route 1 is finished ﬂ
17-Nov-2016 20:51:23  Cz PLUS 345 125 Private Call: Dispatcher '34. Membe 345, 125
g‘ ~ [1] ov- apadityf rivate Cal: Dispal Er‘ eeeee
o 17-Nov-2016 20:51:16  CapacityPLUS 125 345 Private Call: Subscriber '125... Members: 125
o 17-Nov-2016 20:50:44  CapacityPLUS 456 125 Private Call: Dispatcher *45... Members: 456, 125
F o 17-Nov-2016 20:50:32  CapadityPLUS 456 125 Private Call: Dispatcher *45... Members: 456, 125 -
6| 4] «| Record 10f392 b [ |m] 4 3
] Radio Allocation Recent CalsfEvents | RecentCals | RequesttoTak | Radio State | Active Tasks || Active Routes | User Activity | Beacons | Beacon Events | TagList
fE

127001 &3 B | § 35 | (8 Licensed to: demo Der

The main user interface elements are as follows:
1. Radio List pane

2. Voice panel
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6.6.1

6.6.1.1

3. Map panel

4. Objects panel

5. Activity Monitor panel

While in the Activity Monitor panel, the dispatcher can perform a wide range
of tasks, including:

Objects

Monitoring and listening to recent calls and viewing system events
Monitoring selected radio state

Monitoring active tasks for selected radio

Monitoring active routes for selected radio

Enabling and disabling User Activity monitoring

Monitor beacons and beacon events.

On the Objects panel, the dispatcher can view and enable/disable the following

objects:

e Beacons - all beacons connected to the system.

e Map Objects — all manually created map objects and predefined objects
created with the Map Drawing toolbar.

e Map Regions — all map regions created with the Map Drawing toolbar (use
the Add Polygon tool to create a map region).

e Map Routes — all map routes created with the Map Drawing toolbar (use the
Draw Route tool to create a map route).

In addition, the dispatcher can export and import these objects (see section 6.3.4.3,
Exporting/Importing Objects).

Beacons

TRBOnet Dispatch Software provides the Indoor Positioning feature to monitor the
location of radios inside a building where no GPS signal is available. This feature
requires additional hardware (the beacons spread around the building and the
option boards in radios). A radio user will be displayed on the indoor floor plan
when the radio enters the beacon coverage area. The beacon icon on the map
displays the amount of radios that are currently in the beacon coverage area.
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Eile View Map Teols Help

Location Tracking Map € ||| obsects |
g &V 4 NG RoAD X/ scheme X| g
are) Q [ig| Tea ~ | ShowBeacons: Al ~ | Show Info:
© [} Firemen
= s 8 M @ Beer
® @ 25 W 85 RO Coffee 2
Vh M - 1=.~. (0) I W@ Tes
......... ,, Beer ( ‘ 80 [F ap Objec
1 voice Di D-camera 1
(izl) Voice Dispatch / ~ N II : O @ rospta
\. Il O roice
@ EEEIrET (] (57 Map Regior
d \\ - [ Map Routes
& sob Ticketing - men 2% 111
T \ 7
Feeelil ) Q| ||
I I[Coffee 1 &
] RFID Tracker " @z}s \ T i I
| 7/ I
[ ] Text Messa — | = =
< Beacons " |
ﬁ ~ Show: | Al ~| | 7 AutoFilter @ Default Settings
Name Description Rados Previous Detection
(R nepor= @ 08.06.2017 14:53:58
O Coffes 235 05.06.2017 14:55: 18
Event Viewer i@ Beer Bear tap 08.06.2017 14:53:34
e« [wmi] e ,
Eﬁl Rakodioca RecentCals/Events | Recent Calls | RequestToTak | Radio State | Active Tasks | ActiveRoutes | User Activity | Beacons | Beacon Events | TagList

) 127.00.1 & Administrator | [ Licensed to: demo Activer
0]

Beacons are displayed on the building floor plan (1) and in the list of beacons (2) in
the Objects panel. When a radio comes into the range of a beacon, they both are
highlighted in yellow on the floor plan/map (3).

For more details on beacons, see section 6.13, Beacons (page 320)
6.6.1.2 Map Objects

The dispatcher can create custom and predefined map objects using the Drawing
Panel. The dispatcher can attach 2D or 3D floor plans for Indoor Positioning.

For more details on creating map objects, see section 6.6.2.7, Drawing Panel
(page 284).

6.6.1.3 Map Regions

The dispatcher can create map regions that can be used for Geofencing rules. The
map Regions can be created manually on the map (click any point on the map to
select it as a region border) or, the dispatcher can add map points by GPS
coordinates to create a region.

For more details on creating map regions, see section Draw a Map Region
(page 285).

6.6.1.4 Map Routes

The dispatcher can create routes on the map that can be used for Geofencing rules.

For more details on creating map routes, see section Draw a Route (page 287).
6.6.2 Map Tools

The Map toolbar is located in the upper part of the Map pane:

" BING_ROAD
CREE NN ] B EI 1 E [@ ] show Beacons: a1 ~ | & Ruler 4 Findon Map~ & | & Drawing Panel | JA Route - <6 Geofencing ] Coverage Map | | SelectMap &S Google Earth
& % 3
A 5 2
% % % % ¥
2 % e )
u o . 2
) & Police b %
" 3 S % ®
e % 3 ) 2
Pes % % o
) % 3
5, &
: 7
s e 8
& ®, e
.
. = o > {Teao)] o 3
o o L.‘ 9 Z 23
Ea Hospital ’% %'s
¢ L
b % e
100m 8 4o < o

o
o Lotitude: 59°5630.58" N: Longitude: 30°1650.72" E
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6.6.2.1 Zoom in/out
e Click to zoom in a map.
e Click to zoom out a map.
6.6.2.2 Bookmarks

e Click to put a bookmark on the map.
e Click Save as Bookmark to save the map region as a bookmark.

Save as Bookmark x

Name: Prince garden

==

e The atcher can create any number of the bookmarks. To open a bookmark,
click and select the bookmark in the list.

6.6.2.3 Default View

e Click and choose Save as Default View to save current map view as a
default view. The dispatcher can save only one default view.

To open the default view, click and choose Show Default View.
6.6.2.4 Filters
Select the filters to display radios on the map:
- radio is online, beacons are detected;
- radio is online, GPS data is received;
@I - radio is online, no GPS data is received;

- radio is off, no GPS data is received.
All filters are enabled by default. Click the selected icon to disable selected radios on

the map.

Click the button and select the visibility of the radios having On Duty and/or
Off Duty states.

Click the button and select which radios to hide according to the radio groups
and/or logical groups they belong to, and the map regions they are currently in.

Click the
6.6.2.5 Ruler

button to toggle showing object names on the map.

e C(lick to enable the tool to measure distances on the map.

o Left-click a point on the map to start measuring. Left-click intermediate points
and see the distance displayed at the mouse pointer.

6.6.2.6 Search by Address

The dispatcher can search map objects by their address.
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Note: For online maps, Internet access is required!

e Click |4 Find on Map - and choose Address to find an address on the map.

Search by Address (BING_ROAD) x

Broadway 18 “

18 Broadway, Tamytown, NY 10591, USA
18 Broad: Somervile, MA 02145, USA
18 Broadway. Denver, CO 80203, USA

18 Broadway, Denver, CO 80203, USA

e Click the address in the list to display it on the map.

File View Map Tools Help

Location Tracking Map
& 1: Line free
40 cal [ search by Address (My Map)
-] (5 Beer
¢ ey Vo oEm—
@ ® 235 My Map X[ Floor plan X/ V(@ Tea
8 Filts Show Beace Al [ Map Objects
8 I Police Seiiualm=[elelolelw/a] o 18 Erosdvay Samervls, A Q2145 US4 =] Camera 1
= 18 Eroadway, Tamtown, NY 10581, U
18 Broadway. Lawrence, MA 01840, USA -9 [#] Hospital
. 18 Boodey s Fidge W 7656 USA Flo
") sy, Taunt MAnzm, [y Map Regions
(¢ 2 . . 917 Region 1
s ) Z 18 Broadway. Bayonne. NJ 07002, USA B Mop Routes
0y, & ) 18 Broadway. Newport, RI 02840, USA
g Sr 18 Broadway. Denville, NJ 07834, USA oo 111
(1)
(128
0m (12) (140} ?
I
S
e £
Recent Calls/Events
B Playback [l Save~ & print | 11 Pause < Clear - & Reload | [ Fitter B Cose | [tails | [ Show Notes |
Date | Radio System | sender | Recpient [essage [Detals |
4% 09.06.2017 14:43:57 Server al Connection to 'Capacity Plus 1" has been. ﬂ
15 Event viewer 09.06.2017 12:43:30  Capacity Plus 1 Administrator 1 Dispateher ‘Administrator’ calls group '11... Members: Administrator, 125
. 09.06.3017 12:40:06  Capacity Flus 1 125 1 Radio '125'calls group "1 (00:08) Members: 125
@ 09.06.2017 12:38:55  Capacity Plus 1 Administrator 1 Dispatcher 'Administrator’ calls group '11... Members: Administrator
06,2017 12:38:34 Capadity Plus 1 Administrator Palice. Dispatcher ‘Administrator’ calls aroup Po... Members: Administrator hS
] Record 10305 b | [mi[ 4] »
E Recent CaliEvents | Recent Call | RequestToTak | Radio State | Actve Tasks | | User Activity | Beacons | | Taglist |
127001 &3 & | B Administrator | [ Licensed to: demo | @ Active-
i |
6.6.2.7 Drawing Pane
. ,ﬁ Drawing Panel . . .
. CI|ck| to display the Drawing toolbar:
7@ | Show Beacons: Al - ‘ < Ruler 4 Find on Map - 4 I|f Drawing Panel || A Route - >
29| Custom Object = |
= %
=} 5, ’
© %
2
- %
% % %
% < %
%, =
% % %
e Z %,
£ % %
Z s, o
‘u, Q A
% <&
% i
% o
e)
SEN
A <
s Vasil'yevskiy Island
B
‘%a Saint
Andrew's - m = n
', Catheden) ‘ Latitude: 59°56'31,82" N; Longitude: 30°16'46,55" E

284 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console SOftware

Draw a Map Region

Draw a region manually

e Click @ and choose Draw on the map.

e Left-click points on the map to create a new map region.

BING_ROAD XI[ Indoor plan_ X[|
(U)ol gl ‘ Fliter _ N7 |.‘ Show Beacons: Al - ‘ & Ruler ‘ & Drawing Panel | gf] Coverage Map =
7320 B4 G f G @ (=] 2 Custom Object -

Draw a polygonal region
Click on the map to mark corners of a polygonal region. If you make a mistake, right-click to delete the last placed corner point. The first and the last points
will be autoconnected to form a dosed polygon. When you are done, dick Save and spedfy additional properties of the region.

Abiding place

Save Cancel

al <
X

Vasileostrovskaya B

el
ol

Hospital No2
L

© O-
i
4 Qd Latitude: 59°56'35.54"N; Longitude: 30°16'53.23"E

e Click the Save link to add a new polygon region.

Object on Map X

General Region  Logical Groups

Mame: Zone 2

Description: Becrete area

Cance

* Name
Specify a name for the new map region.

= Description
Enter a description for the map region.
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Region tab

Object on Map X

General Region  Logical Groups

Color: 0, 0, 255 ﬂ

Fill region area

Transparency: |30 + %

Cancel

= Color

Select a color to display the region on the map.
= Fill region area

Select this check box to fill in the region area on the map.
= Transparency

Specify the transparency level (in percent) for the fill color.

Draw a region by coordinates

e C(lick @ and choose Specify coordinates.

Create Region by Coordinates X

Latitude Longitude @) &) | =

59,0000000  25,0000000 Tamnn - ——.__
58,5000000  27,0000000

53,0000000  25,0000000

Eesti

70 km

Latitude: 59,2827203; Longitude: 25,9437070 |

ik add [ShEdit X Delete: Selectmap

e Click the Add link to add a point.

286 TRBOnet Enterprise — User Manual



neocom
TRBOnet Dispatch Console sofFtware

Coordinates input - [m| X

Coordinate system: Decimal Degrees =
Coordinates

Lattude 59.9419768|"
Longtude: 302874584

0K Cancel

= Coordinate system
From the drop-down list, select the convenient format (for example,
Decimal Degrees) for the coordinates.

= Latitude/Longitude
Enter the coordinates of the point.

= Click OK to add the point.
e Click the Edit link to edit the selected point.
e Click the Delete link to delete the selected point.
e Click the Save button to add a region.

Draw a Route

e Click and then set route points one after another by clicking on the map.

BING_ROAD X|

<), G % fu-|Firer [B] @R[ B] 7 Show Beacons: Al ~ | 2 Ruler (4 Find onMap~ 4. |7 Drawing Panel| A Route - ] Coversge Map
2] OB A & & G @ [ 2 Custom Object-
Save Cancel
Click to place the route waypoints on the map. Right-click to delete the last waypoint. When you are done, cick Save and provide additional route properties.
[ When adding way points, follow the actusl road trsjectory and de not place the waypoints ferther then 5 km spart |
Zayachy Yo oo
fsland
MO Morskoy Ly
ty|  wd
Admiralteyskiy
MO Bortsoviy okrug
2 MO |
€235 (Basi)
Vasilyevskiy Isiand
e rolerer” )
=) T oy - o
a2 * Pelice devmmantNo 1 | 7., altude: SOETO560'N. Longtude: 301206 21'E

e Once you have finished drawing a route, click the Save link.

¢ |n the Object on Map dialog box, specify a name and description for the
route.

e C(lick the Route tab.
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Object on Map X

General Route  Logical Groups

Color:

[ 255; 0; 255 -

Fill region area

Transparency: |90 %

Tolerance zone (m):  |100

meters

Caeel

= Color
Select the color in which to display the route on the map.

= Fill region area
Select this check box to display a transparent edge around the route line.
The edge width is specified by the value of the Tolerance zone parameter.

e Transparency
Specify the transparency, in percent, for the line edge.

* Tolerance zone
Specify the corridor width, in meters. If a radio will pass out of this tolerance
zone, the dispatcher will receive an alarm signal.

Add a Beacon

e Click @I and choose Place on the map.
e Click on the map where you want to place a beacon.
e Click the Save link.

The Beacon properties dialog box will appear.

¢ On the General tab, specify the following parameters:
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Type:
Name:
Major 1D:

Minor 1D:

Beacon properties

Description:

General Logical Groups  Cameras

iBeacon -

|Coﬁea

1
1

Coffee shop at the comer

Cancel

= Type

Select the beacon type from the drop-down list.

= Name

Specify a name for the beacon.

= Major ID and Minor ID
Enter the beacon’s major and minor ID exactly as specified on the iBeacon

device.

= Description

Add a description for the beacon.

neocom
SOoftware

On the Logical Groups tab, select logical groups that will be associated with

the beacon.

On the Cameras tab, select the check box beside the camera that will be
associated with the beacon.

Note: You can also place a beacon by specifying its coordinates. To do
this, click @ and choose Specify coordinates.

Add a Point of Interest

e Click and choose Place on the map.

e Click on the map where you want to place a POI.

e Click the Save link.

The Object on Map dialog box will appear.
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Object on Map

Name:
ID:

Description:

Bind to PTT
System:

Group:

ral‘ Beacon Map  Logical Groups  Cameras

School dep

2 -

Look after

|Capacity Plus 1

|Firemen

=
K
Cancel

= Name

Specify a name for the new map region.

= Description

Enter a description for the map region.

= Bind to PTT

Select this option to connect the POI to a radio group in your radio system.
Clicking the object's icon on the map will start a call on the selected radio

group.
e System

From the drop-down list, select the radio system.

e Group

From the drop-down list, select the radio group.

On the Logical Groups tab, select logical groups that will be associated with

the object.

On the Cameras tab, select the check box beside the camera that will be

associated with the object.

Note: You can also place a POI by specifying its coordinates. To do this,
click and choose Specify coordinates.

Note: Similarly, you can place other objects with predefined icons, such
as Warning points, Police departments, Emergence departments,
Fire departments, Houses, and Cameras. To do this, click one of the

following icons on the toolbar: AR = RERT B .
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Create a Custom Object

In addition to objects with predefined icons, you can create your own objects to be
then placed on the map.

. CIick| 22| Custom Object+| 1§ choose Add Custom Object.

Custom Object on Map x
Name: Clown’s nook |
Select image
D:\Images"Popov2 jpg ‘ x
Preview

16x 16 24x24 32x32 -1-Ex-i-5_'
* = m %
Advanced mode Cancel

= Name
Specify a name for the object.

= Select image
Click the Browse button and locate the image file you want to use as an
icon for the object.

Note: You can also assign different images for different icon sizes.
Click the Advanced mode link and select images for
different sizes (16x16, 24x24, 32x32, 48x48).

After you create a custom object, the corresponding icon will appear along with
other predefined icons on the Drawing Panel.

e To delete a custom object, click| 22| Custom ije‘:t'| and choose
Delete Custom Object.

6.6.2.8 Route

Show Route
e C(Click and choose Show Route.

Show Reute X
@ [ LimeGreen E
V(@ 125 (Pete) B 105, 105, 105
@ 222 [ RoyalBlue
¥ (&) 235 (Basi) [ Aqua
I~ @ Radio 200 [ skyslue
I~ (®) Racio 201 [ DarkGray
[~ @ Radio 202 [ DeepskyBlue
[~(®) Radio 203 I DaricSlateBlue
[~ @ Racio 204 [LightGreen
I~ @ Radio 240 mobie: [ Lime: |

& =l
Route Type:  [Static |
43 3: H -

From |22:00v-2016 0:00 ~|
To: |<Last known location> ~|
Route Style. [Dots and lines with direction -

Optimize Route (group all nearest points)

[ Automatic emor comsction

Configure
Show Events telemetry. alams and etc)
[ Shaw Canlog Events
oK Cancel
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= In the list of radios, select a radio and the color with which to display the
route for the radio.

= Route Type
Select the route type, either Static or Dynamic.

= Show Route for Last
If the Dynamic route type is selected, specify the time period, in hours, for
which to show the route.

* From/To
If the Static route type is selected, specify the start and end dates of the
time period for which to show the route.

= Route Style
Select the style in which to display the route on the map.

= Optimize Route (group all nearest points)
Select this option to group all points in a 100-meter radius.

= Automatic error correction
Select this option to detect and correct invalid GPS data. Click the
Configure link and select the maximum possible speed for your vehicles.

= Show Events
Select this option to display TRBOnet Server events (telemetry, alarms, and
other events).

= Show CanlLog Events
Select this option to display events that occurred in a vehicle (door
opening, and other events).
Export Route

You can export the routes travelled by radio users in a GPX or KML files. To do this,

after you have performed a Show Route command, cIick and choose
Export Route > Export to GPX file/ Export to KML file.

Play Back Route
e Click and choose Play Back Route.

Playback Route X

Radio Date a GPS Data Speed | Events
125 22:-Nov-2016 10:17:17 Latitude: 59°56'25,88°N; Longitude: 30°1... 0.5km/h
125 22-Nov-2016 10:18:17 Latitude: 59°56'25,86'; Longitude: 30°1..,
125 22-Nov-2016 10:18:47 Latitude: 59°56'25, 16'N; Longitude:
125 22-Nov-2016 10:19:17 Latitude: 53°56'25. 38N; Long
125 23-Nov-2016 10:19:47 Latitude: 5°56'25.27°N; Long
125 22-Nov-2016 10:20:17 Latitude: 59°56'25,37°; Longitude: 30°1..,
125 2240v-2016 10:20:47 Latitude: 53°56'25.37™; Longitude: 30°L.., 0.8 km/h

eeceoeoos

Total: 660

Q @ @ Export [v Load
From: [22-ov-2015 0:00 =l

To: [ <tastknown location> |

L1 Gptimize Route (group all nearest points)
Adomatic eror comection

Configure
Show Events (telemetry, alarms and etc)

Show CanLog Events

Radio 4| Color

=]
3

111 [ LimeGreen

125 (Pete) [ 105, 105, 105

222 I RoyalBlue

235 (Basil) [ Aqua

Radio 200 0 SkyBiue

Radio 201 [ Darkray ~

Select Al Unselect Al

00008 a
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= In the list of radios, select the radio and the color with which to display the
route for the radio.

* From/To
Specify the start and end dates of the time period for which to show the
route.

= (lick the Load button.

= Once you have loaded the route points, click the Play button to play back
the route on the map.

v Iy ol PG =i fee

Msop pEE (VB
[ ] @
125
10G_ROAD || indoorpan_ | 125
.G fines |@)| @] Q| @) 7 | & OrawingPag 175
Expart 1o |
CRONONOM- - i
o [T o e frmentre 1
Too [mtioonn st 5
o 0] optmae Route Group s et )
2 Adomae emor comection
[
= 2 shon Events tkemetry, aarms and 1)
B : ) Show Cantop Events
Rado 2 Golor
] -
ause < F Clear ~ & B e -
105, 105, 105 —
Spr— | e |
T T = -
@ vorenecordng Rado 200 (=
ado 1 = oarcray
(B 2 R,
5] Erent Viewer Ompatcher 1 s rvate Cal: Devatcher Dpatcher .. Member: Depatcher 1, 235
(73] Radtio Atocation Cols | RequmstioTek | RadoState | AdveTasks | ActveRoutes | User Acity | Bescons | Bescon Events | Taglst
127001 & th | @ Dspatcher | (8 Lcensed o derno DernoLicense © Ace-

6.6.2.9 Geofencing

The Geofencing feature allows controlling the location and speed of radios relative
to manually defined regions on the map.

The Geofencing monitoring consists of the manually defined regions and the tasks.
The regions specify where to apply the rules, while the tasks specify how to apply
the rules for the regions and radios.

e On the Map toolbar, click ,

The administrator can add/disable/delete the rules for Geofencing as well as
edit the currently selected rules:

e For more details on configuring Geofencing rules, see section 6.4.5.2,
Geofencing.

e To enable Geofencing rules, go to Administration, Tasks, and in the Tasks
pane, select the check box next to Geofencing.

6.6.2.10 Coverage Map

The Coverage Map option allows to see RSSI levels on the map.

e On the Map toolbar, click M,
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pan_ |
ines|®)| @] Q| @)

W
el
i
G eriketng lm
i
Ty — S

Recent Calls/Events

2 prine | 1l Pause

235 (Basi)

Wait
125 (Pete)

7 [&] show seasons 1

Fuler | # DrawingPanel | af] Coverage Map| 2
Seect S5 data by pericd

G| smone

[Err=——|
22402015 000 =l

End D

'
W0 ¢ Record 108613

Rad Systern

Capsonpus
RO

Dewits [ showhiores 2|

AAAAA

RecentColsEvents | RecentCals | ReusstioTek | RadoState | ActveTads | ActveRoutes | User Acthily | Bescons | BesconEvents | Taglist

For more details on configuring the Coverage Maps, see section Coverage Map

(page 121).
6.6.2.11 Select Map

e On the Map toolbar, click _

Select Map...

Map Type:

Caption:

Available Maps

Orline maps

‘My Map|

Name

MAPNIK
crcLe
TRANSPORT
LANDSCAPE
BING_ROAD
BING_AREA
BING_HYBRID

Path

Add

Remove

= Enter the Caption of the map that will be displayed in the active tab.
= In the list of Available Maps, choose the map to be displayed.

Note: For more details on available map types, see section Map
Types (page 112).

6.6.2.12 Google Earth

To open the Google Earth application:

|
e On the Map toolbar, click | GeegleEarth|

Note: Google Earth must be previously installed on the PC. To
download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and click
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6.7

6.7.1

Job Ticketing

TRBOnet Dispatch Console provides the Job Ticketing feature — the integrated
ticketing system that allows dispatchers to create, assign, and track job tickets
through the radio network.

Note: Before using the feature, make sure that your TRBOnet
Dispatch Software license includes Job Ticketing.

e Click the Job Ticketing tab, and manage Job Tickets in the Job Ticketing

File View Map Tools Help
Job Ticketing Job Ticketing
Eil=s & 8 % -
rou X
© | Firemen S
®CETS]
®®2 ©B = 3
o [ Lpoice S Bdl| 3ob Ticketing | Statuses | Custom Fields | Templates
E‘EE! - (5 Add (F2) ~ 5] Edit (F4) - Assign (F5) | = Grouping 7 Auto Filter @ Default Settings
Status | ID Text ... | Specified End Time City

% Hion T - # New #AD0006 Check the pipe in ... v 07.06.2017 15:40:00 Mo...

2% New #AD0007 Medium, Check the. St.
& 30b Ticketing —
g Route Management

| 4| 4| Record 10f2 b | |mH[ 1] »
|0]| RFID Tracker Processing tasks:

Status D | e | oo Start Time End Time Specified|

[] Text Messages + Accepted #A0D008

= Assigned #A0D003
g Voice Recording
Ce Reports
F Event Viewer

| «| «|Record 20f2 »[ e |m] «] | »
127001 & B | § Administrator | [ Licensed to: demo | @ Adive-

Adding Statuses for Job Ticketing

¢ In the Job Ticketing pane, click the Statuses tab to see the statuses available
for job tickets.

Job Ticketing - Statuses | Custom Fields | Templates |
= Add |5 Eair D:i

Name Action Dedcription Status
New New T New

Cancelled Cancel X Cancelled

Assigned Assign = Assigned

Accepted Accept + Accepted

Rejected Reject — Rejected

Completed  Complete + Completed

InProgress  In Progress O InProgress

4| < |Record 40f7 »|m|m] 4] i

e Click the Add button to add a Job Ticket status.

Job Ticket Status X

Name |Accep1ed
Description Accept

Action (CPS): [Accept |

Status [+ Accepted s
+ Completed

& InProgress

— Rejected
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* Name

Specify a Job Ticket status name to display in the system.
= Description

Add a description for the job ticket status.
= Action (CPS)

Enter the action name as specified in MOTOTRBO CPS.

Note: The Action (CPS) value must match the value of the
corresponding Action/Response field configured for a radio
in MOTOTRBO CPS, Job Tickets.

= Status
From the drop-down list, select the Job Ticket status (Accepted, Completed,
In Progress, or Rejected).

6.7.2 Adding Custom Fields for Job Ticketing

In addition to the default fields (Priority, Deadline, etc.), you can add custom fields
with pre-defined values to be used in tickets/ticket templates.

¢ In the Job Ticketing pane, click the Custom Fields tab to see the list of
custom fields available for job tickets.

Job Ticketing Tsmmsev ‘Custom FleklsTTempIabes ]
=, Add| =) Edi
= = it :} Delete

Name Values

Town Kotka;Hamina;Loviisa
Quality High;Low;Middle
|| 4 |Record 10f2 ¥ |k M|+ r

e Click the Add button.

Job Ticket Customn Field s

Name: Town |

Values
Kotka
Hamina

Loviisa

Total: 3

4 Add X Delete

oK Cancel

In the Job Ticket Custom Field dialog box, specify the following:

= Name
Enter a name for the field.

= Values
Click the Add link and enter a pre-defined value for the field.
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6.7.3 Creating a Job Ticket

¢ In the Job Ticketing pane, click the Job Ticketing tab to see the list of
created job tickets.

Job Ticketing T Statuses r Custom Fields r Templates ]

%. Add (F2) |~ =% Edit (F4)

W 4| 4 | Record20f2 b |k |M| 4
Processing tasks:

Status D | e Start Time
+ Accepted FAODDOE o e e
= Assigned #A00009

4|4 | 4| Record 10f2 b | bk |M| 4

Text Pe... |Cr...
Medium, Chedk the pi... 07...
dium %eCity %6 o07...

=~ Assign (F3) = Grouping -'|_|7 Auto Filter :z

Specified End Time

.. | End Time

e Click the Add button to create a job ticket.

Default Settings

Created By
Administrator
Administrator

.. | Specified End Time

Status Colors

Note: To create a ticket from a template, click the arrow on the
right of the Add button to select from the available ticket
templates. For directions on how to create templates, see
section 6.7.4, Creating a Ticket Template.

Notfication List

lob Ticket x
Ticket D: [#AD000D |
Priority: Medium il
Deadine: |21.04.2017 11:54 -

45min  +10min  +30min  +1hour
Predefined Texts: | || +|-
Teadt: Check the pipe

111

Wariables: Priority Due Date Due Time

] Motify on status changes

] Motify if ticket is not accepted by

[21.04.2017 11:49 =l

Comment:

Hide Advanced Opticns

Cancel

In the Job Ticket dialog box, specify the following parameters:

Ticket ID

This value will be set automatically once the ticket has been created.

Priority

From the drop-down list, select the task priority.

Deadline

Select this option and in the box to the right, enter a due date and time for

the task.
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* Predefined Texts
From the drop-down list, select a predefined text for the Job Ticket.

e Click the B button to edit the predefined text.

Predifined Text Editing X

Text
Check the pipeling|
Check the toll fare

Total: 2

#_d ¥ Delete Prioity Due Date Due Time

0K Cancel

e Click the Add link and type the text in the line that appears.
In addition, you can also add to this text:
v" Priority
Click this link to add the ticket priority to the text.
v Due date
Click this link to add the ticket due date to the text.

v" Due time
Click this link to add the ticket due time to the text.

= Text
Enter the text message in this box.

= Notify on status changes
Select this option to send notifications to Dispatchers, Email and/or SMS
groups when a Job Ticket status changes.

= Notify if ticket is not accepted by
Select this option to send notifications to dispatchers, Email and/or SMS
groups if a radio does not accept the Job Ticket at the time specified in the
box below.

= Notification List
Click this link and choose the recipients of selected notifications.

Netification List x

Dispatchers || Email | 5MS || Radios || Radio Groups

Notify Dispatchers

Administrator
¥ Dispatcher 1

[] Dispatcher 2

OK Cancel
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You can notify dispatchers with the help of notifications in the Dispatch
Console (on the Dispatchers tab, check Notify Dispatchers, and select
dispatchers), Email groups by sending Emails to dedicated Email groups
(click the Email tab, check Notify by Email, and select Email groups) and
phone users by sending SMS to dedicated SMS groups (click the SMS tab,
check Notify by SMS, and select SMS groups).

= Comment
Add a comment for the ticket.

6.7.4 Creating a Ticket Template

You can create ticket templates in advance to then use them when creating tickets.

Job Ticketing TStab.lses T Custom Field;/YTemplates]
%Add _—} Edit -y Binding =" Default Template Delete | = Grouping 7 Auto Filter A Default Settings

MName Priarity Text Specified End Time Comment Bin...
Towns Medium %PRIORITY % in %City %o
Cleaning Medium Do deaning in %Town%

|| 4 | Record 1of2 k| WM 4 3

e Click the Templates tab to see the list of templates available for job tickets.
e Click the Add button to create a ticket template.
¢ Inthe Job Ticket Template dialog box, fill in the desired fields, and click OK.

Note: For information about the fields, see section 6.7.3, Creating
a Job Ticket.

In addition, you can enable automatic creation of the template-based tickets by
using a scheduler. For this, go to Create Automatically by Scheduler, click the
arrow down button and select the corresponding scheduler. Or, click the plus button
on the right, and create a new scheduler.

6.7.5 Selecting Ticket Status Color

You can also color tickets based on their statuses.
e Click the Job Ticketing tab, and on the toolbar, click the Status Colors

button.
Job Ticketing T Statuses T Custom Fields TTempIabes ]
=k Add (F2) - =} Edit (F4) . Assign (FS) | = Grouping "/ Auto Filter 2 Status Colors
Status jin] Text Al Spedfied End Time /|| . Town
1 New #A00010 Medium ¥eCity %o T T s Kotka
£ Mew #A00007 Medium, Chedk ... e e St.Peter.

In the Select Job Status Color dialog box that opens:
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Select Job Status Color X

Status Color
New [ vellowGreen |+
Cancelled Custom | Web | System
Assigned =1 Darkkhaki N
Accepted [ Beige
Rejected [ LightGoldenrodyellow
Completed = Olive
N 3 Yellow
rogress [ Lightvellow

B [ Ivory
Expiring Job Ticket B CliveDrab

Time to complete Job Ticket {minute) == YellowGreen

B DarkQliveGreen

3 GreenYellow

3 Chartreuse =

Default

Color:

0K Cancel

e Click the arrow on the right, and from the drop-down list, pick the color for the
selected status.

6.7.6 Assigning a Job Ticket

e Select a job ticket in the list, and click the Assign button.
Or, right-click the job ticket and choose Assign.

JolecketingTStamses r Custom Fields TTempIabes ]
=L Add (F2) = =L Edit (F4) - Assign (FS) | = Grouping "/ Auto Filter (7 Default Settings .= Status Colors >

Status | ID Text Pe... |Cr... | Spedified End Time Created By Prio... |C... | v | Qu...
$E New FA0000F Medii —

2% New #ADD010  Medil ]

Administrator  Medi...

_% Lt Administrator  Medi... ... High
Cancel
#|4|4|Record 10f2 ¥ |m -3‘ Archive v
Processing tasks: S Create Based on...
Resend . —
Statu D .. | End Tii — ¥ End Ti
= _% Change Status 2 e peche e
+ Accepted #A0DOOB 0 T |
=, Add
= Assigned #A0000 Sé Add 0
M| 4| 4 |Record 1of2 » |m M4 2
In the Assign Job Ticket dialog box that appears:
Assign Job Ticket X
\-\ Assign Job Ticket
-
Radio: \
M@ 125 .
@ 235
® 3333
V@ 4
@ 5555
(# Radio 25 -
Selected: 2
o |~ |i=|~
0K Cancel

e In the list, select a radio or multiple radios, radio group(s), or logical group(s)
to which to assign the job ticket. To switch between the Radio List, Radio

Groups, and Logical Groups, click the “= 17 button and select the desired list.
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e Click OK to assign the ticket to the selected radio(s)/radio group(s)/logical

group(s).

As a result, the selected radio(s)/radio group(s)/logical group(s) will receive the
job ticket.

Note: When you assign the job ticket to multiple radios and the first

radio accepts the ticket, the behavior of other radios depends on
the Job Ticketing Service type configured for these radios.

If the Text Messages type is configured for the radios, all other
radios will receive a corresponding text notification.

If the MSI Proprietary type is configured for the radios (or Mobile
Client is used as a radio), the ticket will be cancelled on all other
radios (Mobile Clients).

6.7.7 Viewing Job Ticketing Statistics

e On the main menu, select Tools, then click Job Ticketing Monitoring to see

the Job Ticketing statistic diagram:

“, “, “ % =, =, =, =, K = =,
% 4 % o v & - % i %

For more details on the statistics, see Job Ticketing Monitoring.

6.7.8 Viewing Job Ticketing Reports

To view a job ticketing report, go to Reports (1), and select
Usage Statistics Reports (2) — Job Ticketing (3).

On the Usage Statistics Reports pane, click the Report Settings tab, and
specify the appropriate parameters and then click Generate Report.

Click the Job Ticketing tab to see the generated report.
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File View Map Tools Help

% z‘:‘s::r"l‘ﬁé'::::“ ~ [ B wtercom [[<[@] Bl 1: Line free oE) (WL [«@] B F crow 10 mEEl
[T5] usage Statistics Reports Group 20 Group 30 [:)][«][@] B[ ]Private cal [][%]

) Messages
D Radio Actvity . Report Settings " Job Ticketing X|
T Radio Status oo <] |
[ Radio Status Summary o
() User Messages and Notes
[ Radio Allocation
) Disabled Radios
T Telemetry 2
T Lone Worker Activities
5 JobTicketing
B Jubﬂm(sm&\ )
%PRIORITY:% 07-Nov-2016 07-Nov-2016
5 5400000 N Administrator Med
@ Location Tracking j PRICRITV% e 140431 14:1%,00 ministrator Medium
07-Nov-2016 07-Nov-2016
. 4400001 %PRIORITY% Accepted Agdministrator Medium
& s0b Ticketing ¢ 1408:58 14:49:55
At 07-Nov-2016 07-Nov-2016
& HAID00D  %DATE% assigned | 0" Lisos Administrator Medium
07-Nov-2016 07-Nov-2015
I HADDODZ  BTIME% Accepted o o Administrator Medium
2] RFID Tracker 1425:25 15:00:35
#A00004  jkg assigneg 07 MOw-2018 07-Mov-2016 Administrator Medium
[ e 15:01:53 15:17:57
HANDODS  Abc e S U7-Hlov-2016 Administrator Medium
ﬂ Voice Recording 15:18:13 15:21:07
1 4400006 123 L25{Cleaning Completed WN?V'ZMS DH\J?V'ZD” Administrator Medium
@ i P 1) 1%:29:13 15:35:02
#ADODO7 456 New 2;’?;;;“6 Administrator Medium
1= Event Viewer §
07-Nov-2016 07-Nov-2016 D7-Mov-2016
HADDODE  Visit martre Completed o o o Administrator Medium
3 _ 1538:39  17S@ZL  1M58:49
Durationl: 02:19:41
[ Administraty Duration2: 00:00:28 >
Administration 7l D
3127001 g3 B | @ Administrotor | [ Licensed to: deme Demo License | @ Active-

6.8 Guard Tour / Route Management

The Guard Tour / Route Management feature allows the user to create routes and
assign them to selected radio subscribers or dispatchers.

File Viev Map Tools Help

Route Management Route Management

2 o | Ut ey i 1: Line free [«][@] | M ntercom M Group 10
Seron P (v B [=][<][e@] [ Group 11
31.05.2017 14:58 . == E D —
/! Monitoring
b start | (reate\é Edit =}, Copy @ Export - | [k Delete | = Grouping 7" Auto Filter > Default Settings
(41, Voice Dispatch Name Route
Route 1. 15:00 15:15 1530 1600
Temme
4., Location Tracking & 2 & 8
@ Job Ticketing
2
Route
1
@ 'RFID Tracker
[] Text Messages
4] 4] 4 | Record 10F 1 k|1 mi] 4| v
g 'Voice Recording Active Routes
b Start | 11 Pause Ml Stop | [5b Edit @ Export~ | = Grouping "/ Auto Filter @ Default Settings
(3 Revons Name Route
= b Route 1 00:00 1500 1545 1530 1
Event Viewer @ @ @ B
31.05.2017 14:58 Coffee Hospizal Tea Poic2
[ 1] Tetemetry
1] @] | Record tof 1 v | [mi] 4] "
(127001 g5 g | G Administrator | (A Licensed to: dema | © nctive-

e Click the Route Management tab (1).
6.8.1 Creating a Route

¢ In the Route Management pane on the right, select the Management tab,
then click the Create button (2) to create a new route.
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Route X

Name: [Route 1

Description: [restroute

Rule [l checkpoints, strict order, strict schedule |

StartjStop Kilks! | Route Points | Chedpoint Statuses | Notfications | Tags | Logical Groups

‘Start Route 2
Manually by dispatcher

Automatically by recelving Text Message from a radio
Message 2 |

[ Automatically by receiving Telemetry Command from a radio

1 E [ryevent =]
Automatically by recelving DTMF command from a radio

Command:  [123 #123%

[ Automatically hy eeeeeeee g Status from a radio

[ wait for confirmation from a radio

Pause Route

Resume Route

» %«

Finish Route

Manually by dispatcher
[ Automatically by receiving Text Message from 2 radio

[ Automatically by receiving Telemetry Command from a radie

L E Any event -

[ Automatically by receivin g DTMF command from a radio

o

[ Automatically by receiving Status from a racio

[ Automatically after al points have been attended

Name

Specify a name for the route to display in the route list.
Description

Add a description for the route.

Rule

Select the type of the rule from the drop-down-list:

All checkpoints, strict order, strict schedule
Checkpoints are to be attended in the specified order, each within a
specified time range.

All checkpoints, strict order, loose schedule
Checkpoints are to be attended in the specified order. The time for
attending each checkpoint is not limited.

All checkpoints, loose order, loose schedule
Checkpoints can be attended in any order, each at any time.

Click the Start/Stop Rules tab.

Start Route
Specify the rules to start the route.

Manually by dispatcher

This option is enabled by default and cannot be edited. This option enables
the dispatcher to start the route by clicking the Start button in the Route
Management tab or in the Active Routes pane.

Automatically by receiving Text Message from a radio

The route starts when the radio sends a specific text message to TRBOnet
Server. If you select this option, then specify the text message the radio will
send in the Message box.
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= Automatically by receiving Telemetry Command from a radio
The route starts when the user presses a preconfigured button on the radio
and TRBOnet Server receives a telemetry command from the user's radio. If
you select this option, specify the VIO contact, and from the Command
drop-down list, select the signal level at which the user's radio should send
the telemetry command.

= Automatically by receiving DTMF command from a radio
The route starts when the user sends a specific DTMF command to TRBOnet
Server, for instance, #11#. If you select this option, specify a DTMF
combination without the # characters in the Command box.

= Automatically by receiving Status from a radio
The route starts when the user sends a specific Status to TRBOnet Server,
for instance, 1. If you select this option, specify the Status.

= Wait for confirmation from a radio
Select this option to start the route after the TRBOnet Server receives a
confirmation from the radio. In this case, the route is assigned to the radio
or user and paused. The route will be resumed after a confirmation is
received.

Pause Route
Specify the rules to pause the route.

Resume Route
Specify the rules to resume the route.

Finish Route
Specify the rules to finish or stop the route.

= Automatically when all points have been attended
Select this option so that the route is finished automatically when all
checkpoints have been attended.

= Limit route processing time
Select this option, and specify the maximum allowed time in the Max. Time
box. If the time is exceeded, the route will stop automatically. All
unattended checkpoints automatically change their statuses from ‘Waiting'
to 'Not Attended'.

¢ In the Route dialog box, click the Route Points tab.

Route X
Name: [Route 1
Description: [restroute
Rule: a0 checkpoints, strict order, strict schedule =l
Start/Stop Rules Route Points | Chedpoint Statuses | Notifications | Tags | Logical Graups |
GOt Tine: [Specified tme of day -
yZ o _ [ Name [Tme
o o % [Point 1 9:00
% Paint 2 9:30
NN Z g Coffee 100
9:30 ‘a‘ Fire dep 10:40
©
Point 1 ¥
2:00 5
Fird dep
10:40
© %
00m | Latitude: 59°56'39.85"N; Longitude: 30°16'48.13"'E L
[Bepsponts (& seacons [ map obiects A creste Sbedt X pelete
12 3
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= Click the GPS Points link (1) to add points to the selected map:

Select Map... X
Map Type: Online maps >
Caption: |My Map]|
Available Maps

Name Path State
MAPNIK oK
CYCLE oK
TRANSPORT QK
LAMNDSCAPE QK
BING_ROAD 0K
BING_AREA QK
BING_HYERID QK
Add Remove Cancel

= Select the map. For more details on map types, see section Map Types
(page 112).

= Click the Create link or double-click a selected point on the map to create a
new route point:

Point properties X
Name: [Bank
Location [Fattude: 53°56'35.20; Longitude: 30°16'4.. ~|
Radius: 10 =] meters
I” Intermediate way point (ot served)
Time: 15:00 =
Time delta: 5 =] minutes

* Name
Specify a name for new point to display on the map.
= Location
This box displays the current GPS coordinates of new point.
= Radius
Specify the radius within which to consider the point as attended.
* Intermediate way point (not served)
Select this option to exclude the point from being used as a checkpoint.
= Time
Specify the time the point is to be attended at.

= Time delta
Specify the time accuracy to attend the point.

= Click OK to add the new point.
= Click the Beacons link (2) to add a beacon as a checkpoint.
Note: To enable the Indoor feature, make sure your license
includes Indoor Positioning (see section 5.1 License
Information on page 11) and Indoor Service is selected in

the list of available services (see section 5.9.1 Services on
page 29).
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Route

Name:
Description:

Rule:

[Route 1

[Test route

[a1 checipaints, strct order, strct schedule

Start/Stop Rules  Reute Points |Checkpo|n( Statuses | Notifications | Tags | Logical Groups |

i geer
g coffee
@Tea

Time: [speafied tme of day

Name Time |
Point 1 9:00

Point 2 EE]

Coffee 10:00

Fire dep 10:40

[@epspoints (@ seacons [ map obiects

A crezte Ehedc X pelete

Click the Create link and then click a beacon in the list.

Point properties
Name! [offee
Beacon: [@ coffee =l
Radius: 3: meters

I Intermediate way point (not served)

Time: 10:00 =
Time delta: 5 =] minutes

e

= Click the Map Objects link to add a map object as a checkpoint.

Route

Name:
Description:

Rule:

[Route 1

[rest route

IAH checkpaints, strict order, sirict schedule

Start/Stop Rules Route Points | checkpoint Statuses | Notifications | Tags | Logical Groups|

[Babiding place
(QlFire dep

[#]Hospital o2

[Ellice department o 1

Time: [specified tme of day

I

[E@eps points (@ Beacons [P Map Objects

Name Time |
Point 1 5:00

Paint 2 EE]

Coffes 10:00

Fire dep 0 |

o Create [EbEdit X Delete

= Click the Create link and then click an object in the list.

Name: [Fre dep
Map Object: [ Fire dep |
Radius: 10 3: meters

I” Intermediate way point (not served)
Time: 10:40

Time delta:

5 3: minutes

e

¢ In the Route dialog box, click the Checkpoint Statuses tab.
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Route

Name: [Route 1

Description:

[Test route

Rule: [AT checkmomnts, sirict order, strict schedui

@ By

Start/Stop Rules | Route Points Checkpeint Statuses

Set status to Attended:

condition nhen radio is
Automatically by r

€ When racio enters the pointarea

in the point area

ing Text Message from a radio

Notifications | Tags | Logical Groups

Message:  |Yer

Set status to Alarm:

1

Commane d: 5

O Automatically by r

[ Automatically by receivi
[ Automatically by receivi
Statuses that can be set by dispatcher:

[ Automatically by receivi

[ Automatically by receivi

Automatically by receivi

metry Command from a radio
ing DTMF command from a radio

ing Status from a radio

ing Text Message from = radio

ing Telemetry Command from a radio

ing Emergency from a radio

Waiting, Attended, U... =

Emg. Type:  [Emergency Alarm
[ Automaticaly by receivi

ing Status from a radio

Set status to Attended

neocom
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Select this option so that TRBOnet Server will change the checkpoint status to
‘Attended' based on the information from the radio.

= When the radio enters the point area
Choose this option so that the radio detects the closest beacon and sends
location data to TRBOnet Server. The respective checkpoint changes its
status to 'Attended ' automatically.

= By condition when the radio is in the point area
If this option is chosen, the radio sends a preconfigured command to

TRBOnet Server. The last detected checkpoint changes its status to

‘Attended ' by this command. Configure the preferred command(s):

¢ Automatically by receiving Text Message from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific text message from the radio. If
you select this option, then specify the text message the radio will send

in the Message box.

e Automatically by receiving Telemetry Command from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific telemetry command from the
radio. If you select this option, specify the VIO contact, and from the
Command drop-down list, select the signal level at which the user's
radio should send the telemetry command.

e Automatically by receiving DTMF command from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific DTMF command from the radio,
for instance, #11#. If you select this option, specify a DTMF combination
without the # characters in the Command box.
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¢ Automatically by receiving Status from a radio
Select this option so that the checkpoint is considered to be attended
after the dispatcher receives a specific Status from the radio. If you select
this option, specify the Status.

e Statuses that can be set by dispatcher
Select this option to allow the Dispatch Control operator to manually change
the status of checkpoints in the Active Routes panel.
In the drop-down list, select the checkpoint statuses to be available for the
operator: Waiting, Attended, Unattended, and Alarm.

e Set status to Alarm
Select this option to allow the radio to set an alarm on the attended
checkpoint. Configure the command(s) that can set the checkpoint status to
‘Alarm’.

Automatically by receiving Text Message from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific text message from the radio. If you select this option,
then specify the text message the radio will send in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific telemetry command from the radio. If you select this
option, specify the VIO contact, and from the Command drop-down list,
select the signal level at which the user's radio should send the telemetry
command.

Automatically by receiving DTMF command from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific DTMF command from the radio. If you select this option,
specify a DTMF combination without the # characters in the Command
box.

Automatically by receiving Emergency from a radio
Select this option to set the point to alarm mode after the dispatcher
receives an Emergency from the radio.

e Emg. Type
Select the Emergency type from the drop-down list.

Automatically by receiving Status from a radio

Select this option to set the point to alarm mode after the dispatcher
receives a specific Status from the radio. If you select this option, specify the
Status.

In the Route dialog box, click the Notifications tab to manage notifications to

a radio.
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Rule: [A checepoints, strct order, strict schedle =]

Start/Stop Rules| Route Points | Checkpoint Statuses NHHEaH57]| rags | Logical Groups |

Vou can use variables i text message:
RouteName}, {Pointhame}, (szme} NextPointhame), {NextPointTime}

[V Send a Text Message on route assign to radio

‘Text Message: [fassion {Routename)

[V Send a Text Message on

Text Message: {RouteName}

[V Send a Text Message on route suspend

Text Message: [he {Routename} is suspended

[ send a Text Message on route resume
Text Message; [he Routename} is resumed

[V send a Text Message on route finish
Text Message; [he {Routeniame} is frished

¥ Send a Text Messag
‘Time before attend:

ien approaching attendance tme

|5 =] minutes

Text Message: [serve (Pointiiame) at (PointTime}

¥ Send a Text Message after point s at
Text Message; [he 4
For the last point: [rhe 4

rved. Nextis {NextPointhame} at {NextPointTime,

[ Send a Text Message if point is not.
Text Message: ¢

[V Send a Text Message

Text Message:

Note: To enable an option, select the check box. The Text
Message boxes already include text. If necessary, replace
the text with your own text, using variables as placeholders
that will be substituted with actual data.

Send a Text Message on route assign

Select this option to inform a radio holder that the route is assigned to.

Send a Text Message on route start
Select this option to inform a radio holder that the route started.

Send a Text Message on route suspend
Select this option to inform a radio holder that the route is suspended.

Send a Text Message on route resume
Select this option to inform a radio holder that the route is resumed.

Send a Text Message on route finish
Select this option to inform a radio holder that the route is finished.

Send a Text Message when approaching attendance time
Select this option to inform a radio holder that the next checkpoint is

neocom
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expected in the time interval specified in the Time before attendance box.
This message is only available for routes with the specified attendance time.

Send a Text Message after point is attended
Select this option to confirm attending a checkpoint.

Send a Text Message if point is not attended

Select this option to notify a radio holder if the point was not attended.

Send a Text Message if point is in alarm mode
Select this option to notify radio holder if the point is in alarm mode.

In the Route dialog box, click the Logical Groups tab.
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[Route 1

[festronte

IAH checkpoints, strict order, strict schedule

Start/Stop Rules | Route Foints | Checkpoint Statuses | Notifications | Tags Logical Groups
Name | Desaription

=+ Cleaning

[ Cleaning 2
=S security
o

[y security 2

I Assign Logical Groups to a radio when the route starts

Cleaning in Department 1

Groups for Security

= Select a logical group(s) in the list of available groups.

= Assign Logical Groups to a radio when the route starts
Select this check box so that when the route is assigned to a radio, the
selected logical group(s) will automatically be assigned to the radio.

Note: For more information about logical groups, see section
6.4.24, Logical Groups (page 236).

e Click OK to save settings.

The new route is now added to the route list (1):
6.8.2 Starting a Route

File View Map Tools Help

Route Management Route Management

b start 0l Pause Wl Stop

BT

I Route 1 00:07

235
31.05.2017 14:58

VB Bllel
Wl crow 11 e

(1)) voice Dispatch Name

@Lﬂtﬂﬁmlmﬂﬁlﬂ

# Job Ticketing

Route Management 1
@ RFID Tracker

[] vext Messages

14| 44| 4| Record 1of 1 » [ 1[mi] ¢

Q Voice Recording Active Routes

b start| 1 Pause M stop | 5 Edit 49 Export~| = Grouping 7 Auto Filter @ Defautt Settings

@ Reports Name Route
~ / Route 1
Event Viewer
31052017 14:58
E Telemetry

i44] 44| 4 | Record 1of 1 » [ n[mi] <]

00:07 1500 1515 1530 16:00

Cofiee  Hospital  Tes  Poike

(127001 g3 & | § Administrator | [A Licensed to: demo

| @ active-

Click the Start button (2) to start the route:

Create Route

Start Route
Mame: IRoutE 1
Start Date: |]4—Ott—l[] 16 10:58
Route: IRoutE 1
Radio: |@ 125 (Pete) 125

Radio Owner: I

Dispatcher: [ail
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In the Start Route dialog box, specify the following parameters:

Name

Enter a name for the route to be started. This name will be displayed in the
Active Routes pane.

Start Date

Select a date to start the route on.

Route

From the drop-down list, select the route to start. Click the Create Route
button to create a new route based on the selected route. Click the Modify
button to modify selected route parameters.

Radio

From the drop-down list, select the radio to assign the route to.

Radio Owner

From the drop-down list, select the Users to assign the route to.

Note: Select only one of the two (Radio or Radio Owner) to
prevent an incorrect route.

Dispatcher
From the drop-down list, select the dispatcher to monitor the route.

Click OK to start the route.

The active route appears (1) in the Active Routes panel.

File View Map Tools Help

Route Management Route Management

» Start 1l Pause |l Stop

EIE[E]

b Route 1 00:37

31.05.2017 14:58

/ Monitoring

b start | S} Create = Edit =} Copy @ Export - | [k Delete | = Grouping
{2l voice Dispatch Name
Route 1 1500 1515 1530 16:00

== 8 & @ 0O

Coffes Hospial  Tes  Poice

7 Auto Filter € Default Settings

Route

g

& 30b Ticketing

unmmmgemmt

@ RFID Tracker

[] Text Messages

F—

@ Reports

e

e

] 4] «| Record 101 »
Active Routes
¥ Start
Name

p Route 1

Il Pays€ Wl Stop

31.05.2017 14:58

wet|«| «|Record 1of 1k [w[wm[ <

= Edit @ Export~ | = Grouping
Route
00:37 15:08  15:15 15330  16:00

Ys pial Tesp Poke
AN

7 Auto Filter

@ Default Settings

[®127.001 & B | § Administrator | (28 License

d to: demo

»
@ Active

If a route point is attended in time, it is displayed in green (2)

If a route point is not attended in time, it is displayed in red (3).

For more operations with checkpoints, see section 6.5.8.6, Active Routes

(page 276).

6.8.3 Tracing Active Route on Map

¢ In the Route Management pane, click the Monitoring tab (1).
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File View Mop Tools Help

Route Management Route Management | &)
 Start Il Pause il Stop lanagement M,
Q@7 Shew Beacons: Al + | Ruler X Findon Map~

- NN
b Route 2 2 00:28 v, e * ’* — L . &
125 O i .
05.06.2017 16:26 % 30
J Route 1 00:23 )
235 N1
05.06.2017 16:31 kS

1 No? e 3
i N\
(1Y voice Dispatch 3 B\ e \
SN

Location Tracking

3 *RY 3
(3 p - 3
= . \\ X & L]
43 30b Ticketing 3 =
S\ \ @ B
9 \
Route Management 22 ,a' \ Hespital )

= N\
0| RFID Tracker ik DR A
o5 Y o
7 125
[] TextMessages i = \\
.
i N \\ X "
Fy— 5 Lo\
2 o
2%
2 =
Ey— L s SN P
» = 2 A 22| Lettude: 59'5629.02" N: Longitude: 30°1642.45' E |
- s 0 \o© =
Event Viewer Il Pause Ml stop | 5 Edit @ Export-
Name Route
‘3] Radio Allocation b Route 1 00:23 1631 1651 16:00 17:00
235 @ @
@ Administration 05.06.2017 16:31 Hospieal  Tes Polce  Coffes
@ 127.00. @ Administrator | [ Licensed to: demo ctive~
3 127001 Admi [=# Licensed to: d A

¢ Inthe upper-left pane, select the route (2) to be traced on the map.
6.8.4 Stopping a Route

Depending on the route configuration settings, a route/guard tour can be stopped
automatically:

e by a command sent from the radio;
e when all checkpoints are attended;
e when the route time is elapsed.

To manually stop the route:

e Click the Stop button to stop the route. Once the route is stopped, it will
disappear from the Active Routes panel.

After the route is stopped, the checkpoint statuses cannot be modified neither
automatically, nor manually.

6.8.5 Generating Route Reports

The administrator can generate reports on the finished routes.

e Click the Reports (1) tab, and in the Reports pane select Common reports >
Completed Routes (2):
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File View Mop Tools Help

) Lone Worker Actvites A
g o 75 1: Line free [<]

) CAN Messages [Jssles [<]

b Ticke!
[ 20b Tidetng 2 [ Jemeraency Grour  [1][<][@] [ ]Regular GGROUR

-5 Job Status Change;
[Jarcal [<][e]

B J0b Ticket Assignyfents
[J6row 1

/" Report Settings.

[ Full Movement Details [Jrrivate call
T seaurity reports

[5) Management

T tndoor reports Completed Routes
) Movement Details v
. N SovedProfies:  [Notdefned— ]
) voice Dispatch Select data by period:
Start Date: 10/10/2016 12:00 AM =] |
@ e End Date <Maximum date> =] B
Filter:
&5 30b Ticketing

Radio: [Fotdefrea— =]
ot defined— -

Radio ID (e.0. 22,33,40-55,88):

Logical Group:

nmn::ﬂamgnmmt

[] Text Messages

User: it defined— -
ﬁ Voice Recording

Dispatcher: ot defined— hd
Ge Reports Route Name:

Rl [
Event Viewer \ I Show routes with exceptions only
\l' Frint detailed data

Radio Allocation 1

Generate Report Save Report Profile

@ - _

Delete Report Profile

[ Connected 43 B B | § Administrator | [ Licensed to: demo Demo License

Text Messages

| @ active -
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In the Text Messages tab, the dispatcher can review and send text messages to other
dispatchers, individual radio subscribers and radio groups:

File View Map Tools Help

Text Messages Text Messages

P irtercom [2][«][2] Bl & 1 Line free [«:][@] JAL ] an cal
VEXT <Ii@) i Mo 20 DEE, 4; Group 30

e & Online Dispatchers (1) B

& Dispatener 1 % Y fste e [<]e]
O Online, Indoor (0) " Simple [ Extended

& () Online, GPS Fired (2) ¥ Clear (£ Reload |[% inbox | sent
[EYC] 125 pere) [5]<] The Point 1is not served ~
@@ 235 (Basil) 3 18-Nov-2015 14:05:10 Sent from Server to 125
The Paint 2 s not served
21-H0v-2016 11:08:18 Sent from Server to 125
U} Voice Dispatch The Paint 1is served
21-0v-2016 11:08:18 Sent from Server to 125
4 Location Tracking The Paint 215 served
[21-Hov-2016 12:30:04 Sent from Server to 125
S8} 30b Ticketing The Route 1is finshed e
22-40v-2016 17:20:44 Sent from Server to 125
Route M Call 5678: Cannot detect channel to execute this operation
[22-N0v-2016 17:21:03 Sent from Server to 125
. Call 5678: Camnot detect channe! to exeaute this operation
22-00v-2016 17:21:15 Sent from Server to 125
Call 5678: Cannot detect channel to execUte this operation
Text Messages
[22-N0v-2016 17:21:30 Sent from Server to 125
ﬂ‘ il 5678 Canrot datert channel in ever e fhis anerafion o
Voice Recording
Recipient: | 125 (Pete) | 3 Send | I Attach File
pete, youre |
Ge Reports
Event Viewer
113
3127001 £3 B | G Dispatcher 1 | [ Licensed to: demo Demo License | @ active~

1. Radio List

displays dispatchers and radio subscribers available for text communication.

Note: Radios must be equipped with a display to receive Text

Messages.

2. Text Messages panel

displays the latest messages transmitted via a radio channel.

3. New Message panel
provides you with text sending options.

4. Calls Panel in compact mode
allows making voice calls.
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6.9.1

Sending Text Messages

The dispatcher can send a text message to:

Selected Radio
Selected Radio Group
Selected Logical Group
Selected Dispatcher

All Online Dispatchers or a group of dispatchers

The dispatcher can send a text message to selected subscribers from:

New Message panel
Radio List

6.9.1.1 New Message panel

314

In the New Message panel, click the ellipsis (...) button.

File View Map Tools Help

Text Messages Text Messages €]

Eh & KV @
© [ Firemen
() ® 235 (Basil)
B @ 51
(O Radio 200 13 [ onine Dpatchers -
(1l voice Dispatch 1 §G”’“D1
1 *= Cleaners
T —
@ Location Tracking 219 |#2, poice
1 2m
4F 30b Ticketing 214 |3 125 Pete)
1 "J 22
Route Management oy (3 235 Bast)
€ |2 Rado 200
- ony |® Radio 201
22N a
@ RFID Tracker ¢ |2 Rado 202
oy |2 Redo203
[ Text Hessages ¢ |12 Radio 204 El
22-N|
g Voice Recording /| Cancs|
v
() Repens Recipient; 7% |Fremen | 3 send | ] Attach File
P [Shack # Ton fre
Event Viewer
E Telemetry
106
(127001 £y By | @ Dispatcher 1 | [ Licensed to: dema Demo License | © Active-

In the Select Recipient dialog box, select the radio, radio group or dispatcher
and click OK.

Type the text message you want to send.
Note: The size of a text message is restricted to 125 characters.

Click the Attach File button if you want to attach a file to the message being
sent.

Click the Send button.

The text message will be displayed in the Text Messages panel.

The message details highlighted in red indicates that the message recipient is offline
and the message will be delivered as soon as the recipient gets back online again.

The message details in grey indicates that the message has been delivered.
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6.9.1.2 Radio List

e On the Radio List, right-click the radio/radio group/dispatcher you want to
send a text message to, and choose Send Message.

SR Firemen

- Send Message...
)21 i 3
= Advanced 3
%4 1 T E—
\'/l@ Specify Status Colors...
&2 —
— VIO1: High level
\g‘/]@ 2 VIND: Hink lewel

¢ In the Send Text Message dialog box that appears, specify the following
parameters:

Send Text Message X

Target: Firemen; Police; Online Dispatchers; ‘

Templates: ~| B

Tent: Shack # 1is onfire

Attachments: @ Add File
Select Radios and Groups

Fitter: | |

¥ #5 Firemen -
1% Mobile Client
W %% Police =]
&l ,7211 Online Dispatchers
=2 [F EU Cleaning
=

™ send copy by Email
™ Send copy by SMS
I Send to offine radios
™ Confirmed Group Text

Hide Advanced Opticns SEND Cancel

= Target
This box displays the target for the message.
= In the Text box, type the message text. You can also insert a template text

from the Templates list box. Note that the size of a text message is
restricted to 125 characters.

= In the Target list, add recipients by selecting radios/radio groups/logical
groups/dispatchers.

= Store and attempt to deliver if the user is offline
Select this option to store the message on the server if a radio is offline,
and to send it as soon as the radio becomes online.

Note: The storage time is set in TRBOnet Server's Advanced
Settings > Text Message Passive Timeout (Unlimited, by
default).

= (Click Send.
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6.9.2 Extended Messages

The Extended Messages service is a special function allowing users to send/receive
detailed preconfigured templates containing necessary information.

This service was created especially for clients who need to use more detailed and
structured messages in their work. If the standard messages are not enough to
contain all the information you need to send, you may use the Extended Messages
service. Also note that an extended message can only be viewed on a Dispatch

Console.

6.9.2.1 Send Extended Text Message to a Radio

ile [View | Map  Tools Help

Show Navigation

B Show Medules

Show Voice Panel

Text Messages

[e [0l

23 1: Line free

[<](@]

Large PTT Boxes
PTT Boxes

[Jarcal [1][<]
Group 20 Group 30 []

[»][«][e]

o Show Extended Messages Tab
Bonn
- 125 M
E‘Eﬁ Voice Dispatch p Send to Radio |
orm
~
@ Location Tracking
New Form
@ Job Ticketing 5
Route Management 3
- v
Ql RFID Tracker G 53
1 =) ] -
[ Textm | — ) Playback el Save- () Print Pause «f Clear
Date e | Mes. Details | N...
,& jice R di 4 [ 21Nov-2016 11:13:21  C... 235 Al AlC... Mem... B
D 21Nov-2016 11:13:12 C... 125 Al AlC... Mem...
B / (2 2N0v-2016 11:13:08  C... 125 Al AIC... Mem...
4 " o 210v-2016 11:08:18  C... 5. 125 The
Inbox (0} o 2100v-2016 11:08:18 ... 5. 125 The
t‘ %] Radio Allocation = 5 21-Nov-2016 10:56:55 235 Al Rese
‘-)k‘ 21-Nov-2016 10:56:42 235 Al The
Al N O s i P hd
@ New Message... i #]4| Record1af6i7 v |« »
[% 127001 &5 B | § Administrator | [ Licensed to: demo Demo License @ Active~

e Click the Text Messages tab (1).

e Click the View menu, and select Show Extended Messages Tab (2).

¢ In the Text Messages pane, click the Extended tab (3), and New message (4).

New Message...

New Form

N

1

| SendtoRado

et [ ] \

[ Growp 1

< >

Inbox (0)

Outbox (0)

e Select the template in the list (1).

[ Playback I Save- () Print | 11 Pause <# Clear -

Date .o | Ext. Note
01-ov-2016 13:48:37 Dis... Me... -
01-Nov-2016 13:48:37
[ 01-Nov-2016 13:48:34
(2 01-vov-2016 13:48:27
(7 01-Nov-2016 13:48:23
[ 01-Nov-2016 13:48:13
[ 01-Nov-2016 13:48:16

Al Al Me..

WY e am e os PP
| ] 4| Record 1ofg k[ w|m| < v

For instructions on how to create templates,

see section 6.4.16.1, Templates for Extended Messages.

e From the drop-down list (2), select the radio to which to send the extended

message.

¢ Click Send to Radio (3) to send the extended message to the selected radio.
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neocom
sofFtware

On the Voice Recording tab, the dispatcher can display the list of calls according to
certain criteria, listen to the calls and save them to file.

File View Map Tools Help

Voice Recording [ Playback (el Save~ () Print rouping '/ Auto Filter > Default Settings || & Details ||[] Show Notes
e Ra Date RadoSy.. Sender | Reoplent | Message Detais Note
ime Range: O 17Nov-: Capacity... Administr... 235 Private Call: Dispat... Members: Adminis. -
From: 16-Nov-2016 0:00 Tf Ll || €@ 17Nov-2018N8:47:41  Capadity... Tel: 2409 125 Private Cal: Dispat... Members: Tel: 24...
To: 247002016000 v] | e || € 17-Nov2016 1959:%  Capocity... Achninstr.. Radio 2. Private Cal: Dipat... Members: Admins.
© 17-0v-2016 13:5%;, Capadty... Administr.. Radio24... Private Cal: Dispat.., Members: Adminis...
Filter: © 171002016 23038 Capagty... 345 125 Private Calls Dispat.... Members: 345, 125
Call Type: Frivate Call ] [ 1702016 20:30:42  Copacity... 256 25 Private Cal: Dispat... Members: 456, 235
RedoSystem: Al <] || @ vovais a0z capecty.. 125 345 Private Call: Subsar... Members: 125
i © 170/-2016 20:32%6  Capadty... 456 235 Private Cal: Dispat... Members; 456, 235
s Al T || @ 17nov-2016 20:32:54  copecity... 235 256 Private Cal: Subscr.. Members: 235
Radio Group: Selecteditems: 1 <] || @ 17vov2016 203305 copecity... 395 25 Private Cal: Dispat... Members: 345, 235
gcdGom [ <1 || @ 7oy 203318 capacy... 395 15 Private Cal: Dispat... Members: 345, 235
© 1740/-2016 203455 Capaaty... 456 35 Private Cal: Dispat... Members: 456, 235
Racio 1D (e.g. 22,33,40-55,88): © 1702016 2053700 Capadty.. 35 235 Private Cal: Dispat... Members: 345, 235
© 171i0v-2016 2037112 Capadty... 345 235 Private Cal: Dispat... Members: 345, 235
Find Text: © 170,216 20:33:23  Capacity... 456 235 Private Cal: Dispat... Members: 456, 235
| @ 1740v-2016 20:40: 16 Capadty... 235 456 Private Cal: Subscr... Members: 235
™ Hide z2ro session audio message © 1710/-2016 204050 Capadty... 235 456 Private Call Subscr... Members: 235
2 @ 17N0v-2016 20:42:05  Capacty... 345 125 Private Call: Dispat... Members: 345, 125
Load Data © 17N0v-2016 20:42 1L Capacity... 456 235 Private Cal: Dispat... Members: 456, 235
© 17110/-2016 20:4400  Capaaty... 125 35 Private Call: Subsar... Members: 125
(i) voice Dispatch © 17002016 20:44:16  Capadity... 125 456 Private Call: Subscr.... Members: 125
© 17002016 444 Capadty... 125 256 Private Cal: Subscr.. Members: 125
% Location Tracking @ 17-0v-2016 20:45:07  Capadty... 125 456 Private Call: Subscr... Members: 125
© 71002016 204814 Capaaty... 125 456 Private Call: Subser... Members: 125
0 308 ket © 1740,-2016 4505 Capaaty... 125 345 Private Call: Subsar... Members: 125
© 170,216 204914 Capadty... 125 345 Private Call Subsar... Members: 125
© 174002016 204930 Capadty... 125 345 Private Cal: Subscr.. Members: 125
o ) 17N0u-201620:45:45  Capadity... 125 456 Private Call: Subscr... Members: 125 =
- et o] Recordofas » [ m ¢ »
5] RFID Tracker
u Sender Admiistrator Date: 17-110v-2016 19:59:56
[] Text Messages. Reciient: Radio 240 mobile EBlplavbock [ save
) Private Cal: Dispatcher Adminitrator” calis the radio ‘Radio 240 mable’ (00: 10)
Q Voice Recording | | Units: Adminisirator, Radio 240 mobie
@ s

[127001 &3 B, | ¥ Dispatcher 1 | [8 Licensed to: demo Demo License

e Click the Voice Recording tab (1).

@ Active-

¢ In the Voice Recording panel, specify the criteria according to which you want
to display call records, and click Load Data (2).

e In the right pane, you will see the list of calls according to the criteria you have

specified.

e To play back a record, select it in the list and click Playback (3).

Note: For more actions available in the Voice Recording panel, see

section 6.5.8.1, Recent Calls/Events, Voice Recording.

6.11 Reports

The Reports tool provides you with various printing forms with monitored radio

network activity data.
e Click the Reports tab.

File View Map Tools Help

Usage Statistics Reports

T3 General Information
TS Registered Radios

¢ |l

B Curent Reparts B

& 1:Line free. [«](@] N B mntercom [BEe) (=] [«@
5 [private cal =) ([~ (][ (2] I B Firemen Pl@
T Lastknown Systems and Rados
7 presence and s staus (VEEX] DEE) ((EEE B[]

) Inactive Radios |, Report settings |
T Unregistered Radios =
) System Reports
% :s“;‘“:‘”:‘s‘“" Usage Statistics Reports
ystem Bridges
. D Channel Changes These the radio systems during a specified time range.
) Usage Statists Reports pro—
M Plsanes
B D e acy
T Radio Statue ) Radio status
7 Radio Status Summary ) Radio Status Summary
) User Messages andNotes T User Messages and Notes
- Radio Alocation %) Radio Alocation
T Disabled Radios TS Disabled Radios
1 Telemetry ¥ || B relemety
T Lone Worker Activities
Ul voioe Dispatch B smsens
T 2ob Tiket tatuses
% jlectioaacidon) 7 Job Ticket Assionments
) Completed Routes
[ Route Hanagement ™ cancharss
T Catbessaces
[] Text Messages.
() Reports -~
4., Administration @
< >
[ Connected &3 B &, | & Administrator | [B Licensed to: demo Demo License @ Active~
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6.11.1 Report Types

TRBOnet Dispatch Console supports the following report types:

General Information
These reports contain general information on the radio systems registered in
TRBOnet.

Current Reports
These reports contain current information on the radio systems registered in
TRBOnet.

System Reports
These reports contain system information on the radio systems registered in
TRBOnet.

Usage Statistics Reports

These reports provide information on various activities that occurred in the
radio systems during a specified time range. The reported information may
include information about Messages, Radio States, User Messages and Notes,
Allocated Radios, Disabled Radios, Job Ticketing, Completed Routes etc.

Location History
These reports contain movement details for GPS and Indoor Positioning, for a
selected time period.

Security Reports
These reports contain information related to security issues that may affect the
radio systems connected to TRBOnet.

Data Export
This report contains information on extended notes in the messages. The
report can be generated in XLS or XML format.

6.11.2 Main Report Parameters

To generate a report, go to Reports section and select a report type you want to
generate.

When generating a report, you might need to specify the parameters listed below:

Time Range

From
The date from which to start reporting.

To
The date on which to finish reporting.

Filter Content

318

Message Type
Select available message types from the drop-down list (All Messages, Talk
Sessions, Text Messages, and other message types).

Radio System
In the drop-down list, select the system(s) to include in a report.
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6.12

e Radio
In the drop-down list, select the radio(s) to include in a report.

e Radio Group
In the drop-down list, select the radio group(s) to include in a report.

¢ Logical Group
In the drop-down list, select the logical group(s) to include in a report.

e Dispatcher
In the drop-down list, select the dispatcher(s) to include in a report.

e RadioID
Enter the Radio ID or multiple Radio IDs.

e Find Text
Enter the text to filter by.

Radio Allocation

The radio can be assigned to a selected employee registered in the system.

All available radios are disabled and an employee will need to type in a username
and password to take and enable the selected radio. When an employee returns the
allocated radio, it gets disabled again.

e Click the Radio Allocation tab (1) to assign radios to users:

File View Map Tools Help
Radio Allocation

Radio Allocation &

= a o
FEEEIERIEEY | crms Rlo) BEE) (A Ll=le)
2 Group 10 = " “) P crou 30 (@]
SIS 125 Pete) | E ES: ] LLe
-+
®222 =
(#)® 235 (Basi) || L Take/Retumn Radio | =, Add Missed Data ~ | = Grouping '/ Auto Filter & Default Settings
Callsign £ Taken by User Group Vehide Make Plate Number Drivers
{1l voice Dispatch ® 111 Firemen, Folce
@ 125 Firemen
@ Location Tracking @® 222 Firemen, Palice
@® 235 Firemen
@ Job Ticketing @ radio 200 Al
® Racio 201 Al
Route Management @ Radio 202 Al
- (@ Rado 203 Al
@ RFID Tracker (@ Radio 204 Al
[] Text Messages
@ Voice Recording
==
Event Viewer
EE! Radio Allocation ~—— 1
IE Administration
W« 4 Record2of9 b B w4 »
@ 127001 &3 B | & Administrator | [ Licensed to: demo Demo License @ Active~

e Select the radio in the list and click the Take/Return Radio button (2):

Take Radie X
Radio: [125
User: |Pete ﬂ
Password: | “““ |
| Take Radio Cancel

= Radio
This box displays the selected radio.
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= User
From the drop-down list, select the user to allocate the radio to.

= Password
Enter the password for the selected user.

Note: For more details on user access to Allocation Console, see
section 6.4.23 Users (page 232).
e Click the Take Radio button to assign the radio to the selected user.
The administrator can generate reports on the allocated radios.

e Click the Reports (1) tab, and in the Reports pane, select
Usage Statistics Reports > Radio Allocation (2):

File View Map Tools Help

) system Bridges ~

) Chennel Changes
[T Usage Statistics Reports
) Messages

) Radio Activity PApsc 1 slot =1

) Radio Status M crow 20

~
Radio Allocation Saved Profies: |~Notdefined— <
T Lone Worker Actvities 2 This report contains information on the allocated radios (radio, user, tme the radie was taken returned) within the specified time range.
T 3ob Ticketing v
Time Range:
(] Voice Dispatch
From: 23-Sep-19 12:00 AM 2
@ _- o <Maximum date> <] [
Filter:
ﬁr Job Ticketing Radio: ot defined — -
Logical Group: ot defined — -
Route Management
Radio ID (e.g. 22,33,40-55,88 ):
[] Text Messages
User: ot defined— 2
Reports .
(g srouping:
LN ping:
Group by: By radios i
15| Event Viewer N 1
"5) Radio Allocation
Generate Report save Report Profie Delete Report Profile
E Administration
< >
[ Connected &5 B B B% B | § Administrator | [ Licensed to: demo Demo License @ Active

6.13 Beacons

TRBOnet Dispatch Console provides the Indoor Positioning feature to monitor the
location of radios inside a building where GPS signals are not present. The feature
requires additional hardware (beacons located around the building and Bluetooth
modules/option boards installed in radios). A radio unit will be displayed on the
indoor floor plan at the beacon location as soon as the radio enters the beacon's
coverage area. A beacon icon on the map will provide a count of the number of
radios that are currently in this beacon's coverage area (for example, Room 1(3) -
there are 3 radios in Room 1).

Note: To enable the Indoor Location Tracking feature, your license
must include Indoor Positioning (see section 5.1, License
Information) and Indoor Service is selected in the list of available
services (see section 5.9.1, Services).

To enable the Indoor Location Tracking feature, your license must include Indoor
Positioning (see License information page) and Indoor Service is selected in the list
of available services (see Services).
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6.13.1 Adding a Floorplan
Click the Location Tracking tab (1), then click Map (2) and choose Open New Map

in Tab:
Y TREOnet Enterprise 5.2 / Dispatch Console - o X
File View Map Tools Help
Locatior. Tracking
&3 [ Map Objects
P 7] [8] Camera 1
Cucust ®V|F||Iel: ®[@]O]@] 7 [&)] show Beacons: | # Drawing Panel » 9 ) Hospital
& Select Map.. X Dgﬂp"“ﬁ
-+, Location Tracking | Map Regions
= 1 MapType: |Beaconan <2 g g:u Rautes
A\ it
G 200 Tckeung oo | ]
& Avaiable Maps
‘Route Management
Name Path State
RFID Tracker
3
[ ] Text Messages b
g Voice Recording. P‘?D'"#c
% 4 5
C@ Reports. Recent Calls/Events %
- [ Playback (e Save / \ uto Filter 5
{5] event viewer Date Details
2 AV
09.06.2017 10:39: _ T = TR Concel | [Members: 235 B
(3] Radio Allocation 09.06.2017 10:38; L] : == I | et | embers: 125 -
W[ 4| 4| Record10f 289 ¥ [ 4] r
E et Recent Cals/E... | RecentCals | RequestToTak | Radio State | ActiveTasks | | User Actvity | Bescons | | Taglist
127001 83 B | 8 Administrator | [28 Licensed to: demo | @ Active~
= Map Type

From the drop-down list, select '‘Beacon 2D' to enable 2D floor plan, or
'‘Beacon 3D' to enable 3D floor plan (3).

= Click Add (4), and browse for the required map on your PC.
= Click OK (5) to add the map.
6.13.1.1 Floor Plan Toolbar

The Floor Plan pane's toolbar is located in the upper part of the Floor Plan pane:

)‘ Show Info: { Mame, Radios j| Images:{ Default - MMO\MNEW (| Select Map
_‘

SN e oo
2 ‘ 5
Zone E -
Training Room ’
| | ' Tl \ﬂ N
0 0 G == |_ '
‘* - ]

1. Zoom in/out
Click the Zoom buttons to zoom in/out the floor plan.

| amam

| .
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Default View

Click the arrow beside and choose Save as Default View to save current
floor plan as a default view. The dispatcher can save only one default view.

To open the default view, click the arrow beside and choose Show
Default View.

Set Location
Click the Set Location button to manually set a beacon on the floor plan.

Available beacons drop-down list

Select a beacon from the list and click the Set Location button to put the
selected beacon on the floor plan. If you are going to add a new beacon,
select 'New Beacon' from the drop-down list and click the Set Location button
to add a new beacon to the floor plan.

Show Beacons
The dispatcher can select which beacon types to display on the floor plan.

= All - all beacons are displayed on the map.

= With Radios — beacons with attached radios are displayed on the map.
= Without Radios — beacons without radios are displayed on the map.

= In Alarm - beacons in Alarm mode are displayed on the map.

= No - all beacons are hidden on the map.

Show Info
From the drop-down list, select which information to display for beacons.

Images
From the drop-down list, select an image size for beacon icons.

Route

= Click Route > Show Route to display a route traveled by the radio for the
selected time period.

Show Route

X

Radio: 125 (Pete) it

From: [15410v-2015 0:00

To: |<Last known location >

Lef Lo Lo

Color: [ 105, 105, 105

Optimize Route (group all nearest points)

Cancel

e Radio
Select the radio to display the route for.

e From/To
Specify the time period to show the route for.

e Color
Select a color to display the route with.
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e Click OK to show the route for the selected radio.

= Click Route > Play Back Route.
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Playback Route

Radio Beacon Date
Radio 240 mobile 21-Nov-2016 15:16:48
Radio 240 mobile Tea 21-Mov-2016 15:16:54
Radio 240 mobile Coffee 21-Mov-2016 15:16:54
Radio 240 mobile Tea 21-Mov-2016 15:16:58
Radio 240 mobile Beer 21-Mov-2016 15:17:03

Detected

State

Detected

Lost
Lost

Detected

From:  [21Nov-2015 0:00

To: |<Last known location>

[ Radio 201
|| Radio 202
|| Radio 203
| Radio 204
[| Radio 240 mobile
] walt

Select Al Unselect Al

Led Led

Load

X

|l ettt

e Select the time period to request data for.

e Select the radio(s) to request data for. Click Select All to display history
for all radios registered in the system. Click Clear All to cancel radio

selection.
e Click Load to load the history.

9. Overview
Click this button to view the entire floor plan.

10. Select Map

Click this button to change the map in the current tab.

6.13.2 Adding a Beacon to the Floor Plan

e Click the Set Location button (1) and then click on the map to point the

location of a physical beacon on the floor.

¢ In the dialog box that appears (2), specify the beacon properties.
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© [} Firemen

B®1s

P Grow 10

3 Group 20 [][«][@!

n Area ,
-

Recent Calls/Events
[ Playback |l Save - i P

Date Radio 5|
09.06.2017 10:33:00  Capacit|
09.06.2017 10:38:54  Capacit|

|« 4| Recordiof2s »

Objects.
li=| &
[<](0) I B ntzrcom &
[][«][@] N P i cal -] [ Beacons
(Wcen Lol 7 (@) Beer
Beacon properties o) (3 Coffee
6@ Tea
General Logical Groups Cameras 2 ¥ [ Map Objects
[ [&) Camera 1
Type: Beacon -~ - ) [4] Hospital
Name: [coffes ] @ [ eoice
Il [ Map Regions
Major ID: 1 ¥ [ Map Routes
Minor 1D 1 e
Description: Coffee shop (2nd floor)
rint Filter ’j‘
Jers: 235 3
T T
[ by 3
Recent Cals/E... | ReentCalls | RequestToTalk | RadioStste | ActveTasks | ActveRoutes | User Actty | Beacons | BeaconEvents | Taglist

127001 &5 B | @ Administiator | (8 Licensed to: demo

Type

| @ Active-

Select the beacon type from the drop-down list (K-Term or iBeacon).

Name

Specify a name for the beacon.

Major ID and Minor ID
Enter the beacon’s major and minor ID exactly as specified on the iBeacon

device.

Or, if a K-Term beacon is being added:

Beacon ID

Enter the beacon’s ID exactly as specified on the K-Term device.

Description

Add a description for the beacon.

6.13.3 Editing Beacon Parameters

e Select a beacon in the Objects panel and double-click to edit its parameters.

File View Map Tools Help

& () oniin

e, GPS Fixed (2) b

(1) 125 Pete) BESNE
(®® 235 (Basil) Qe v

© (1) Online, No GPS (1) -

eeeee

Indoor plan X|

&+ [ Map Objects
¥ [ Abiding place

A1, Voice Dispatch

New Beacon...

v Show Beacons: Al

o [ Fire dep

unmﬁmrmdsiug

~

] [#] Hospital No2

¥ [E police department Na 1
£12 [ Map Regions
W=7 My zone
&+ [ Map Routes

3 210

&L 3ob Ticketing ‘/
[¥] 3 Route 1
Route Management i
- Conemon foom N
@ RFID Tracker q 0 o ViR
r y '—m—} s [
1 [ \
Beer(0)
[t h W N
Recent Calls/Events 7|
g ke Reconkan [ Playback (el Save~ () Print | 11 Pause - Clear + 'S Reload | “[{ Filter By Radio | = Grouping ’_"
= Date RadioSy... Sender  Recpient | Message Dt Note
[ 21Nov-2016 11:13:21  Capacity... 235 Al Al Call from '235' (... Mer

V2016 11:13:12  Capadty... 125

L1v]

Al AllCall from '125' (... Mer

127001 85 B | & Administrator | [ Licensed to: demo Demo License

5] Radio Allocation [ 21Nov-2016 11:13:08  Capadity... 125 Al Al Call from "125' (... Members: 125 -
it 4| | Record 10f617 k| |m[ 4 »
[ -
= RecentC.., |Recent... | Request... | RadiSt.. | ActiveT... | ActiveR... | User Ac... | Beacons | Beacon . | Taglist
| @ Active~

¢ In the Beacon properties dialog box that appears, edit the desired properties.
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Note: For more details on K-Term beacons, see the following
article at https://trbonet.com/kb/how-to-find-out-a-

beacon-id/.

6.13.4 Unregistered Beacons

If the radio detects an unregistered beacon, this beacon will appear in the
Unregistered Beacons folder at the top of the Objects pane.

: 2227
Configure geofencing
Show all objects on the map
Hide all chjects on map
Add Beacon

¥ Delete object
#f Properties

[
To add an unregistered beacon to the Dispatch Console, right-click it and choose
Add Beacon on the shortcut menu.
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7.1
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TRBOnet Web Console

TRBOnet Web Console is a special online application. It is an extension for TRBOnet
Dispatch Software which allows dispatchers to get access to the system via a Web
browser. The Web Console is the best solution for carriers, operators and systems
with a huge number of users.

This application allows you to monitor your system without any special software
installed on your computer.

Installing Web Console

e Click Start>Control Panel>Programs and Features.

e Click the Turn Windows features on or off link.

« B 5 Control Panel » All Control Panel Items > Programs and Features ~ || | SearchPrograms and Features 0

Uninstall or change a program

tall o program,

ect it from the list and then click Uninstall, Change, or Repair.

Organize *  Uninstall/Change =~ @
Install a program from the o
network Name Publisher Installed On  Size
4/ TRBOnet Enterprise 5.1 Neocom Software 21-0ct-2016 51
(D TRBORetWatch 2.3 Neocom Software 02-Sep-2016 1
€] Unity Web Player Unity Technologies ApS 25-Aug-20. 124
2 Unlocker 1.9.2 Cedrick Collomb 00-Dec-2015
[E5)Visual Studio 2010 Prerequisites - English Microsoft Corporation 23-Nov-20.. 7.
& Windows Driver Package - Google, Inc. (WinUSB) An...  Google, Inc 22-Dec-2015
erPa . Motorola Solutions, Inc. 18-Nov-20.
.. Motorola Solutions, Inc. 18-Nov-20..
. Nokia 25-Aug-20..
Riverbed Technology, Inc 12-Sep-2016
The Wireshark developer comm... 15-Sep-2016 17
Gougelet Pierre-e 07-Sep-2015 16
a Mail Ru 12-Sep-2016
il lenrp rypoii (Micros. i (Mic... 25-Nov-20. 37
5! Aaeikoeoit naket Microsoft Visual Studio 2010 Tools g Micrasoft Corporation 03-Nov-20., My
< >

%ﬂ Motorola Solutions, Inc. Preduct version:  12/16/2013 03.06.00.00

=Y

¢ In the Windows Features dialog box, expand Internet Information Services:

= Expand Web Management Tools and make sure that
IIS Management Console is selected.

= Go to World Wide Web Services>Application Development Features
and make sure all of them are selected.

= In addition, expand Common HTTP Features and make sure that
Static Content is selected.

[ Windows Features - o be

Turn Windows features on or off e

To tum a feature on, select its check box. To turn a feature off, clear its
check box. Afilled box means that only part of the feature is tumed on.
= @] Internet Information Services ~
[ FTP Server
= @ | Web Management Tools
[ | 1S 6 Management Compatibility
1S Mansgement Console
O | 1S Management Scripts and Teols
[ 1sManagement Service
= [®] | World Wide Web Services

= [ Application Development Features
NET Extensibility 3.5
WNET Extensibility 4.7
Application Ini
Asp
ASPNET 3.5
ASP.NET 4.7
c6l
ISAPI Extensions
ISAPI Filters
Server-Side Includes
WebSocket Protocol
& [E] T Common FTTP Feat
Default Documen it
[ Directory Browsing
[] | HTTP Erers
O  wrTe Red\re(tmn/
Static Content
]| WebDAV Publishing v
Concel
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e Restart your PC.
e Click Start>All Programs>Accessories>Command Prompt.

e For 32-bit systems:
Go to This PC>Local Disk (C: )> Windows > Microsoft. NET > Framework >
v4.0.30319/aspnet_regiis.
For 64-bit systems:
Go to This PC>Local Disk (C: )> Windows > Microsoft.NET >
Framework64 > v4.0.30319/aspnet_regiis.

e Drag the aspnet_regiis file into the Command Prompt then press the space
bar and add the -i key. Then press the Enter key:

e Go to Control Panel > Administrative Tools.

e Double-click the Internet Information Services (1IS) Manager shortcut and
double-click ISAPI and CGI Restrictions.
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3 intermet Information Services (15} Manages o x
o » SOM2 » @
Fle vVew Help
Connections Actions

@) 50142 Home
e Filter: v % Go (- Show All | Groupby: Area =N Manage Server

FoTT 2 nes

L @m e 9 B B M

net NET NETEmer  NET  MNETTmst Apphcation Connection
Authorizs.. Compistion  Pages  Giobalzatien  Levels  Seti Stings
- o =
4 s 95 ]
MachineKey Pagesand  Providers  Session State SMTP E-mail
Conlrols °
5 ]
&=

tory  EmorPages  FascCGl

et
H o=

SaPI PR MMETRe Modues  Ouput
Crcmg

e |n the Restriction column, set Allowed in all lines.
.
Qe “ﬂ' ISAPI and CGI Restrictions Actben
— ;

e Copy the Web Site archive WebConsole to Computer > Local Disc (C:)
>inetpub to create a folder for the Web Console.

e Go to Application Pools (1). Double-click DefaultAppPool (2) and check the
.Net CLR Version (3):

[=

- 3+ S0 » Asplction Pooks EERe-
e

Connections Actions

- U‘;l Application Pools

P

v @ shes
@ Detaut b 52
| sspndy cient

o
NET CLR Versi

Mansged pipeline mode:

Integratect v

) St appiction poolimmedintely

e Click Sites (1), right-click Default Web Site (2) and choose View Applications
3):
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3 intermet Information Services (15} Manages o x
@ @, so b sies - w e
“‘J! Sites
Filter: - ¥ Go - G ShowAll | Group by: No Grouping
C Cr T — ey v
e 0
s
i’ .
M
e
;
:
e
<t
L]
Ready &
lick the Add lication link
e Click the Add Application link.
L]
© @+ 0142 b Stes b DefautWebSte » (CRNC - 1
Connections. P~ Actions
-~ 0 Applications =

A is page i A s
2 Application Pools This page ~
A Fiter: - wGo - Gshowan |Groupby: NoGrowping =
v aspnt clent Virtual Path Physical Path ste ‘Agplication Pt

T Features View I3 Content View

e Specify the Alias and Physical path for the application:

Add Application ? X

Site name:  Default Web Site

Path: /
Alias: Application pook:
[TRBOnet o | [pefauitappPoot ] Select..

Bample: sales

Physical path:
[cinetpub\WebConsole: | E\
Pass-through authentication

Connect as... Test Settings...

[ Enable Preload

oK Cancel

e Browse for the folder with unarchived Web Console.
e Click OK.

o Select Application Pools (1) and click the Set Application Pool Defaults link
(2):
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= 31 S+ Applcatanbools YR

AppicationPosildentity
2

Terminate
Troe
Maxs 1

3wt
WebClent Setup
@ Webconsole

- Respone Type

win10 loadBal setto Hitplevel and is
“topped, HTTP.sys will return an HTTP 503 arrcs. I set o TepLevel, HTTP.

ok Cancel

e Set Enable 32-Bit Applications to True (3).

The Web Console will be added as an application to under the Default Web
Site:

Wy intemnet Information Senaces (I5) Manager 0 x
(/7 3 » S0142 » Stes » DefaukWebSie » TREONS » Bah @
Fle View Help
Conmections. Axtions.
r &) /TRBOnet Home
gsn‘uz(Ns\vluhm:hM ~| firer « % Go - (FShowall | Groupby: Ases
5 s e =
~ @ Dela E d L =
S A& > =
NET WNET ANET Errer NET WNET Profile  NET Roles T
Authonizat.. Compilation  Page Globahzation Browse Application
s = ﬁ = s
P2 B DT S
NET Trust  NETUsers  Application  Connecti e
e ol emie @
-
3 !
Providers  Session Sate SMITP E-mil
Festures View | (.3 Content View
Rendy b |

Note: Make sure your account has sysadmin privileges (for more
details, see

Appendix B: Configuring SQL Server 2012 for Local System
Account on page 340, and Appendix C: Granting Sysadmin
Role to Local System in SQL Server 2012 on page 343) and
the database connection is successful (see section 5.2,
TRBOnet Server Database on page 13).

To open Web Console, right-click your application, choose Manage Application >
Browse.

G et nformatin Semaces 15) Mansger o x
(/7 3 » S0142 » Stes » DefaukWebSie » TREONS » Bah @

File View Help

Connections Actions.
- &) /TRBOnet Home
J3 S0142 (45w kufricher) |- e o A
ASPNET r
4 4 & [
NET ANET Errer NET WNET Profile  NET Roles s
— Page  Globslation

Browse Appiication

ﬂ&;v irve Key F‘ Mu\lul @
Manage Application
K Remove v

TRBOnet Web Console is now ready for operation.
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7.2  Configuring Web Console

e If TRBOnet Server is not installed on your PC, select the application and click
Application Settings:

Gy iternet eformation Senaces 15) Manager 0 x

b Stes » Defaur WebSite » TREOnet + [CRSR -

~ Actions.
& /TRBONEt Home
Fier: = % 6o« Eshowil | Group by: Aren -@- Bl el
Manage Application
Browse Application
@

Festures View .3 Content View

<
Ready.

e Specify the IP address and Port of the PC with installed TRBOnet Server:

' lnternet Information Services (15) Manager 0 x
@ 0 5 142 s St » DefaubWebSite » TREON® » [CRE -
fle View elp
Connections. - o Actions.
- & application Settings
o3 soraz pswaamiche || - .
o o ‘
. X &
. Geoup by No Grouping
Hame o oty e olllhda
Faie Loaal
Local
Local
Goagy Local
) Lol
e To10T009 )
MoSpecdOnRoue 120 Local
Lot
Locel
Locat o

[ Festore Vi

Configuration: Default Vieh Sae/ TREGnet’ weh.config

e Right click TRBOnet Web Console and choose Edit Permissions.

N IotemetInformation Senaces 15) Manager 0 ox
@77 5 r 12 » stes s DefaumWebSte r TREONE b W @
e view Hep
Comrctions . Aetions
2 S /TREONet Home e
o 2| Fker « % 6o~ EShowAll | Groupby: Aren il
ASPINET A A - - 2
T e \ ST
MNETEmer  NET  NETProfile NETRoles s =
o Globek  Browse Applcation
T
Key Pages and
Cortroh @

te SMTP E-mail

I3 Swildhto Content View  fntent View

Ready

e Click the Security tab and then click the Edit button to edit permissions:
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WebConsole Properties X

General Sharng Securty Previous Versions  Customize
Object name:  C:\WebClgsale

GFDLIP ar User names:

B2 Authenticated Users N

S8 5YSTEM

SR Administrators (S0142\Administrators)
B2 Users (S0142\Users)

To change permissions, click Edit. W
Pemissions for Authenticated

Users Allow Deny

Full cortrol N
Maodify

Read & execute

List folder contents

Read

Wite ]

For special permissions or advanced settings, Advanced
click Advanced.

QK Cancel Apphy

e Select User in the Users list. In the Allow column, select Write:

Permissions for WebConsole X
Security
Object name:  C:\WebConsale

GFDLID Or USer names:

SR Autherticated Users

BR.5YSTEM

S8 Administrators (S0142\Administrators)
BR Users (50142\Users]

Add... Remaove

Pemissions for MNonesosatent Allow

Read & execute

Deny
O
List folder contents O
O
O

Read \

Witte
Special pemissions w

Cancel Aoly

e Click Apply.
e Click OK.
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7.3 Using Web Console
7.3.1 Connecting to TRBOnet Server

e Launch the browser.
e In the browser's address bar, enter the IP address of the PC with the installed
TRBOnet Web Console, and the path (for example, 70.70.100.99/TRBOnet).

Note: For the path, see section 7.1, Installing Web Console,
IIS Manager>Add Application>Alias

As a result, the TRBOnet Login page will open:

B3 TRBOnet WebConsole X — [m] X
< = 0O ‘ 10.10.100.99/TRBOnet,/Account/Login aspx?ReturnUrl=92fTRBonet%:2f f{‘ = 4 g
TRBOnet
Build £.4.0.2187
o =S
Web Interface o

Login Password

Connect

¢ Login
Enter the User Name registered in the TRBOnet Dispatch Console Users list.

e Password
Enter the user password.

e (Click Connect.

Once you have connected to TRBOnet Server, you will see a window like this.

B TREOnet WebConsole X+ — [m] X

&< = 0O ‘IO.1D.1UO.§§,”1E:nét ﬂ" = ¥ O

TH B 0n et o Web Console

Map

Reports Messages Job Ticketing

-a -
a \

Radios
Bloom
~| ) Online, Indoor
B v @ Online, GPS fixed
« @ Radio 25
E v @ Online, No GPS

v @125
v @25
< @ Radio 27
=« @ Offline
v ®13
v @®3333
v @ aada
< @555
(®) 5555
(& Radio 300
< (@ Radio 333
< @ Radio 3662

Radio 333
Radio 27

Radio 25
3333

27
Radio 3662

&
by

Text Messages -
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7.3.2 Radio List

The Radio List pane is located on the left and contains the list of radios. From this
pane, you can perform the following tasks.

Click the “* button to see the selected radio in the center of the map.

Click the #* button to button to display a route traveled by the selected radio on
the map.

Show Route: ®

- @125

From: 24-Nov-2016 0:00

To: 24-Nov-2016 18:41

[ Optimize Route (group all nearest
points)

Load | Cancel

Specify the From and To date and time. Select the Optimize Route option to group
all points in a 100-meter radius.

Click the “~ button to request a location of the selected radio.

4
0 125

Message 1 of 1

Close

Click the o button to display the selected radio properties.

Callsign: 123
Talk Group: Firemen
Radio ID: 125
MDC ID: 0
Equipped with Display: V]

Equipped with GPS Module: /]
Cancel

7.3.2.1 Disabling a radio
To disable a radio:
e Right-click the desired radio in the Radio List pane.
¢ In the shortcut menu that opens, click Disable.
e Enter the Reason and click OK.

Note: The dispatcher can disable a radio when they have relevant Access
Rights.
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7.3.3 Map

7.3.3.1 Map Layers
e Click the small plus button on the right of the Map pane.
e Choose the map layer to display in the Map pane.

¢ In the Overlays list, select whether to display Regions, Map Objects and Radios
on the map. Just select/clear the corresponding check box.

5 TRBONet WebConsale X+

& =00 ‘mmmugg RBonet ‘,“(‘ =4 Q& -

TB B an e t ! Web Console

Map Reports Messages Job Ticketing

Radios

(O Online, Indoor
[ @ Online, GPS fixed
| @ Radio 25 Q| A s LF
[l @ Online, No GPS =
< @ 125 Q|| A s | L3

v @ 235 Q| A s G
| @ Radio 27 Q|| A |ces| L[]
@ ofine H

. Radio 27
26 \ ~ Radio 25
B Bloom| 235

B

e vl L e

7.3.3.2 Zoom In/Out
e Click the large plus button on the left of the Map pane to zoom in the map.
e Click the large minus button on the left of the Map pane to zoom out the map.
Or:

e Use the mouse wheel to zoom in/out the map.

7.3.3.3 Radio Coordinates and Address
¢ In the Map pane, click the radio you want to inspect.

As a result, a window will appear displaying the coordinates and address of the
inspected radio.

) TRBOnet WebConsole X =+ x

- o
& 5 O | e | = M4 8 -

TRBOnet " web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout

Region: EZNNNR] 7=

Radios [sHEY| E 18, Broadway Q +80
> £ 3 - 2 #
2 2 :
< (D Online, Indoor J ; =
= () Online, GPS fixed \ 0
32
@125 Q A ors L} —
. 5 School number 21
v @23 QA s L a Spices & Joy Wikona No21 &
1=« @ Online, No GPS e 3 235
@Radio2d0m... Q A ors ¥ A Date: 25-Nov-2016 13:40:12 / I:L”Jiﬁ
£ v @ Offine Latitude: 59°56'26.40°N Z
9 Longitude: 30716'47.89°E |
@ 111 Q A ors L3 Altitude: Unknown ‘
@222 Q A o £ : ‘, T-ya liniya, 34, Sankt-Peterburg, Russia, 199034 :‘U%': o
(® Radio 200 Q| & lers| £ 1_’ pans
® Radio 201 Q| A ers| 3 A snsileostrousk
L 2
. Text -
@Rao22 A A& Google I e R )
A onn = -l
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7.3.3.4 Filter Radios

You can filter the display of radios on the map. To do this, use the colored car
buttons at the top of the Map pane.

e Click to remove radios that are online and have a detected beacon
position from the map view. Click this button again to bring them back to be
displayed.

e Click H to remove radios that are online and have a detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click E to remove radios that are online and have no detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click to remove radios that are offline and have no detected GPS position
from the map view. Click this button again to bring them back to be displayed.

e Click and select the visibility of the radios having On Duty and/or Off Duty
states.

7.3.3.5 Search by address
¢ In the Find Address box, enter the address you want to locate on the map.
e Click the lens button on the right.

¢ In the Found addresses window, click the address to locate it on the map.

TRBOnet " web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout

- =]
R o [B) ¥ +a0
v o Online, Indoor . 18 Broadway, Tarrytown, NY 10591, USA fon Caf
lon Cafe
B~ @ Online, GPS fixed il 18 Broadway, Somerville, MA 02145, USA i
v @125 Q A ors L} — 18 Broadway, Denver, CO 80209, USA
r 18 Broadway, Denver, CO 80203, USA nited
v @235 s
GV Q& L 18 Broadway, Bayonne, NJ 07002, USA
£ @ Oniline, No GPS I 18 Broadway, Brooklyn, NY 11249, USA ige
@Radio2dom... O A ors L}
= v @ Offline
@ 111 Q A s O3
& 222 Q A o L
® Radio 200 Q R es £
® Radio 201 Q R ars £
(® Radio 202 QA o ‘ Goog 0] W
A e All= -

7.3.4 Text Messages

With TRBOnet Web Console, you can send text messages to radios/radio
groups/dispatchers.

e Click the Messages tab at the top of the window.
e Click the Send Text button.
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R - o x

E = @ | o w| = BB -

TRBOnet ™ web consote <] send Text

Map Reports Messages  Job Ticketing © Dispatcher 1 Logout
235 All Send Text Message 25-Nov-2016
& 13:40

Y Text
18-Nov-2016
ikzas-w\“ See you 13:53
Y - 3 15
18-Nov-2016
gs-w\n (] 2 222 13:47
151 = | e
LG . 2 Radio 200 i =
[] 2 Radio 201
(] 2 Radio 202
- a ndieman
Send to Offline
Send Cancel

In the Send Text Message window that appears:
= Enter the text of the message.
= Select the radios/radio groups/dispatchers to send the message to.

= Select the Send to Offline option to send the message to offline radios.
7.3.5 Job Ticketing

With TRBOnet Web Console, you can create, assign, and track job tickets through
the radio network.

e Click the Job Ticketing tab at the top of the window.

) TREOnet WebConsole X |+ - o x
S x| == H -
TRBOnet "~
Inet” web console <] send Text
Map Reports Messages Job Ticketing  Dispatcher 1 Logout
[Brdd |[Sede || o fosan || Serche | |
L] Status D T Text Performer Creation Time Start Time End Time Spe
Q a a Q a a a a
4 New #A00017 Get out of there 25-Nov-2016 14:10:25
ErEES %) Assign || g Resend |[ Bk archive || @ cancel l
Status D T Text Performer Creation Time Start Time End Time Spe
Q a a Q a a a a
Assigned #A00007 456 07-Nov-2016 15:38:32
Assigned #A00010 Stop smoking 07-Nov-2016 15:42:27
Rejected #A00014 To be done on %DATE% 07-Nov-2016 16:36:00 07-Nov-2016 16:36:33

In the upper pane, you see the list of created job tickets. In the lower pane, there are
assigned job tickets.

7.3.5.1 Add a Job Ticket
e Click the Add button.
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Text: V Check the pipe
Enable Deadline
End Time: 25-Nov-2016 14 [
Priority: Medium u
e Ticket ID
This value will be set automatically once the ticket has been created.
o Text

Enter the text message in this box.

¢ Enable Deadline
Select this option and in the End Time box, specify a due date and time for
the task.

e Priority
From the drop-down list, select the task priority level.

¢ Comment
Enter a comment for the ticket.

e Click OK.

Once you have added a ticket, it will appear in the list of tickets in the upper pane.

7.3.5.2 Assign a Job Ticket
Select the job ticket in the upper pane, and click the Assign button.

[ Cleaners
I\ Firemen
. Police
@ m
< @125
@ 222
@235
@ Radio 200
® Radio 201
(® Radio 202
(® Radio 203
(@ Radio 204
@ Radio 240 mobile

@ walt

<

OK Cancel

¢ In the list, select a radio(s), radio or logical group to which to assign the job
ticket.

e Click OK to assign the task to selected radio(s).

As a result, the selected radio will receive the job ticket. The assigned job ticket

will appear in the upper pane.
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7.3.6 Reports
e Click the Reports tab at the top of the window.

[ TRBOnet WebConsole X+ - O x

& 5 0 10m0i00smHOnesaowebnconsoie +

i
w
&

TRBOn et " web console <] send Text

Map Reports Messages Job Ticketing © Di her 1 Logout

T GPS Reports Location for period

T3 Location for Period

T3 Drive Activity Detailed Select data by period:

T Staying in a region Start Date: | 18-Nov-2016 11:21 B

T 1dle time detailed End Date: | 25-Nov-2016 11:21 |2 |
) Commen Reports Fiver:

T%) Messages for Period Radio: | pm

GPS Export
B P Min.Interval: | 0 7 Seconds n

T Location for Period O
Show street names
T Drive Activity Detailed

T Staying in a region

¢ In the right pane, select report parameters and click Generate Report.

Once the report is generated, you will see it in a separate tab of your Web

browser.
[ TReOnet WebConscle B Lecation for pencd x4+ - o x
& 3 O | eroacoseeon - howsreemames-fasesunt-1ssanoate- 1 2 nzieencene [ fr | = 4 O

Location for period
from 18-Nov-2016 11:21 to 25-Nov-2016 11:21

Radio: 125 (Cleaning 1)

Altitude | Accuracy
B e o e e e ey
37 0.0 0 on map

18-Nov-2016 Latitude: 59°56'25.95"N

11:21:29 Longitude: 30°16'47.06"  Unknown

18-Nov-2016  Latitude: 59°56'25.96"N

11:22:29 Longitude: 30°16'47.01"  Unknown 35 210 g on m,
18-Nov-2016  Latitude: 50°56'25.96"N

11:22:59 Longitude: 30°16'47.90°  Uknown 46 0.2 0 on map
18-Nov-2016  Latitude: 59°56'25.96"N

11:23:29 Longitude: 30°16'47.90"  Unknown 37 12 o S
18-Nov-2016  Latitude: 59°56'25.96"N Uk 37 02 0

11:23:50 Longitude: 30°16'47.89"E nknown - on map
18-Nov-2016  Latitude: 50°56'25.96"N

11:24:20 Longitude: 30°1647.89%  Uknown 37 3 2 L
18-Nov-2016  Latitude: 59°56'25.96"N Unkrown 37 0> o on
11:25:01 Longitude: 30°16'47.89"E - anmap
18-Nov-2016  Latitude: 59°56'25.96"N

11:25:29 Longitude: 30°16'47.80°  Unknown 37 o2 2 on may
18-Nov-2016  Latitude: 59°56'26.23"N . - .. .

You can print the report, save it as a file, and so forth.
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Appendix A: SQL Server Edition Considerations

How to select SQL Server ‘

0 - 200 subscriber units 200 + subscriber units
Windows 7, Windows Server 2008 MS SQL 2008 Express MS SQL 2008 Standard
Windows 8, Windows Server 2012 MS SQL 2012 Express MS SQL 2012 Standard
Windows 10, Windows Server 2016 MS SQL 2016 Express MS SQL 2016 Standard

Appendix B: Configuring SQL Server 2012 for Local System
Account

During installation of MS SQL Server 2012, you can grant the required role to
Windows Local System account in advance. On the configuration setup, click
Database Engine Configuration:

%2 5QU Server 2012 Setup [E=% =R~
Database Engine Configuration
Speciiy Database F_r\gif\e authents. security mode, inis and data di
Setup Support Rules [ server Configuration lnm Directories lU;u]nmru F[I_E‘.TRE.&M‘

Feature Selection

Tnaliotion fules Specify the authentication mode and administrators for the Database Engine.

Instance Configuration Authentication Mode

LR ERSAE LS @ Windows authentication mode
Server Configuration

| Database Engine Configuration |
Errcr Reporting Specify the password for the SQL Server system administrator (s3) account

Mixed Mode (SQL Server authenticaticn and Windows authentication)

Installation Configuration Rules
Installation Progress

Enter password:

. Confirm password:

Specify SQL Server administrators
VM WINT 002\admin (admin SOL Servar adeninictrators

have unrestricted access
to the Database Engine.

<back || mea> ][ concel |[ Hew

Windows Authentication mode
e Click Add to add an additional account to MS SQL Server administrators.

¢ In the Select Users or Groups dialog box, click the Advanced button in the
Enter the object names to select box to find a required user name.
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Select Users or Groups
Select this object type:
Users, Groups, or Builtin security principals Object Types...
From this location:
Enter the object names to select (examplas):

| Check Names

e Click the Find button and select SYSTEM account. Click OK to add the user
and close the window.

Select Users or Groups ﬂil

Select this object type:

IUsers. Groups, or Builtin security principals Object Types... |

From this location:
fmrrva Locations...

Common Queries |

Hame: IStarts with x| I Calumns.. |

Descriptian: IStarts with j I find Now

I | Disatied acoounts Slop |

I | Nom expiring password

=
[ays since last logom: I 'l 2.—_)7

St e =]
|

Mame (RDN} | In Folder -
82 15_1USRS MITYA

B2 INTERACTIVE
@3 11 1em

P ]
% NETWORK SERVICE

B OWNER RIGHTS

4% REMOTE INTERACTIVE LOGON

2, restore MITYA
HE sERVICE

%SQLSEWErZﬂ’DErSOLBersErUsErSMITYﬂ MITYA

L

e Select NT AUTHORITY\LOCAL SERVICE (LOCAL SERVICE):
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Mixed Authentication mode

342

% SQL Server 2012 Setup B ol =
Database Engine Configuration
Specify Database Engine authentication security mode, administrators and data directories.
Setup Suppert Rules Server Configuiation | Data Directones | Uses Instances | FLESTREAM
Feature Selection : e e :
Installation Rules Specify the authentication mode and administrators for the Database Engine.
Instance Configuration Authentication Mode
Disk Space Requirements ® Windows authentication mode
Server Configuration _
) Mixed Mode (SQL Server authentication and Windows authentication)
Database Engine Configuration
Error Reporting Specify the password for the SQL Server system administrator (sa) account.
Installation Configuration Rules Enter password:
Installation Progress
Tz Confirm password:
Specify SQL Server administrators
VIM_WINT_002\admin (admin) SQL Server administrators
INT AUTHORITY\LOCAL SERVICE (LOCAL SERVIC have unrestricted access
to the Database Engine.
Add Current User | | Add... ] [ Remave | /
< Back L MNext > Cancel l Help

¢ Click Next and follow the prompts to finish the installation.

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules
Setup Role

Feature Selection
Installation Rules
Tnstance Configuration
Disk Space Reguirements
Server Configuration

Database Engine Configuration

Error Reporting

Installstion Configuration Rules

Ready to Install
Installation Progress
Complete

Server Configuration FILESTREAM

Specify the authentication mode and administratars for the Database Engine.

Authentication Mode
=) Windows authentication mode

( @ Mixed Mode (SQL Server authentication and Windows authenticati nni’

Specity the password for the SQL Server system administrator (sa) account.

Enter password:

Confitm password: sews:

Specify SQL Server administrators

TRBOnet-PC\Adminuser S0L Server administrators
have unrestricted access

to the Database Engine.

[ Agdcumentuser | | agd.. | [ Remove |

7
/

| < Back Il Mext = ” Cancel | Help |

Click Mixed Mode (SQL Server authentication and Windows authentication).

Enter and confirm the password for SA SQL user in the Enter password and
Confirm password boxes.

Click the Add Current User button (unless it is already there).
Note: Once you have added the SA account, you'll be able to use this SA

account to connect to SQL Server with administrator privileges as
an alternative to a Windows user account.
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Appendix C: Granting Sysadmin Role to Local System in SQL

Server 2012

If you have already installed MS SQL 2012, you need to grant sysadmin role to

Local System account in MS SQL Server 2012.

e From the Start menu, run SQL Server Management Studio.

e Connect to your database instance where TRBOnet database is created.

¢ Go to Security node and select Logins.

5 (2 Replication
5 23 Menegement

B MT SERVICE G Wiriter
5 M1 SERVICE Wihengent
e
& VMWINT D0Z\sdenin
71 [ Server Roles
& [ Credentials
5 [ Server Objects

e Right-click NT AUTHORITY\SYSTEM login and choose Properties.

¢ In the Login Properties window, select Server Roles and select the sysadmin

check box.
] Login Properties - NT AUTHORITY\SYSTEM [=a ==
Selecta page ~ I3
4 General S - 1
4 Server Fidkes
4 User Server roie: 5 used b grant server-wide secunty prvileges to a user
& Securables
B Status
T Server mies:
bubcadmin
choreator
[ dakadmin
processadmin
¥ public
securtyadmin
[ serveradmin
selupadmin
Bomoin ]
Connecson
Sanvar
VM_WIN7_D02\SQLEXPRESS
Connection:
VM_WIN7_D02\ackmin
#{ View connection properties
Progress
Ready
y [0 ] [ caed ]

¢ Click OK to add sysadmin privileges to the selected user.
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Appendix D: Backing up and Restoring Database and Audio
Recordings

Configure Backup

TRBOnet Dispatch Software has an automatic mechanism for database and audio

recordings backup. Initially, it defaults to two paths to store database and audio
recordings.

For TRBOnet Enterprise:

%ProgrambData%\Neocom Software\TRBOnet.Enterprise\Backups and
%ProgramData%\Neocom Software\TRBOnet.Enterprise\Audio.

For TRBOnet Plus:

%ProgramData%\Neocom Software\TRBOnet.Plus\Backups and
%ProgramData%\Neocom Software\TRBOnet.Plus\Audio.

For your convenience, the default paths can be changed:

e Open TRBOnet Server and stop the TRBOnet Server service.

Configuration Service Version: 5.4.0.2210
o A
0 Network The TRBOnet Server service is installed
@ Redundancy
Database Status: (D service started

[ Reports Stop service
£F Service Management 4\
)’_ Advanced Settings + Save changes and restart service
A Geocoding Servers

! Radio Systems Uninstall Service

- LF Services

-pl) TPSC 1

)’_ Advanced Settings
-1 Privacy

-~ Slot #1

LI Slot #2

-LC13 Local Slots

ol CP1

/ Advanced Settings
Privacy
L} DDMS service
,f_ Advanced Settings

P MMTS Aats carvies

< s E\liev.‘ Log Entries Export Configuration Import Configuration

Apply oK Cancel

e To customize these backup folders, on the Configuration pane, select
Database, then select the Specify the path for database archives and Use
custom folder for audio files options. Next, enter the new (custom) folder for
the backup database (for example, C:\TRBOnet\Backup\DB) and custom
folder for the audio files (for example, C:\TRBOnet\Backup\Audio). The
database and audio backups will be stored in the selected directories.
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Configuration
§ Service
G Network

# Redundancy
= Database
f_@ Reports

£F Service Management
X Advanced Settings

neocom
software

Database Version: 5.4.0.2210
~
S0L Server: (local) \SQLEXPRESS -
Database: TREOnet1 -
Authentication: Windows -

A, Geocoding Servers

! Radio Systems
{} Services

ol TPSC 1

X Advanced Settings

w2 Privacy

M Specify the path for database archives

Fath: C:\TRECnet\Backup'\DB

E Use custom folder for audio files

= Path: :C:\TREOnet\Backuphaudio e
LI Slot #2 [ Use custom folder to store file attachments /
L7 Local Slots Paths

ol CPL o

X Advanced Settings

gy Privacy Test Connection
{:} DDMS service

X Advanced Settings SE Ee efiide -
T MNIS dats corvice Create Database <

Set Defaults

e Save your changes

>

Apply

and restart the service.

Back up Database and Audio Recordings

Cancel

To back up the database and audio recordings, do the following:

¢ In the Dispatch Console go to Administration (1), and select Database (2) in
the Navigation tree.

e Click the Backup (3) button:

File View Map Tools Help

Administration Database

&)

g server ~

8 Ucense 7 1: Line free [+ A intercom [2][<d[e] Al Cal [2][«][e]

[(Jostabce| Moo 0 ooE B ooE R D]

i} Radio Systems.

57 System Bridging 2 [erivate call [

? Tespreny o || 5 Backup | s Schedule
L) voics Dispaten u Database Information
i Server name: (local) \SQLEXPRESS
o lucation e Dotabase name: TREOnEt

3 Backup date: 25-0ct-2016 16:28:26
& sob micketing Database version: Mosoftsal Server 014 (°2) (B171021) - 12.0.5000.0 069
Jun 172015 19:1
Copyright (c) Mmsm Corporation
Route Management Express Edition (64-bit) on \Windows NT 6.3 <X64> (Build 10586 )
@ RFID Tracker Data size: 17.23M8
Audio size: 2277MB
[] Text Messages
Q Voice Recording.
() Reports
Event Viewer
[7%] Radio Allocation 1
e
127001 & @ | § Administrator | (4 Licensed to: demo Demo License | @ Active~

e Specify the backup

details:

Database maintenance

|\h Remove old data and shrink database

Path:
C:\ProgramData'\Meocom Software\TREOnet. Enterprise\Backups

Backup data

Backup audio

Remove
Remove all data older than date:
Audio files
Data

IlO-JuI-ZO].G - I

Cancel
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= Backup audio
Select to back up audio recordings.

= Remove

Select to remove audio files and data from the database.
= Remove all data older than date

Specify the date to remove data older than that specified date.
= Audio Files

Select to remove audio files.

= Data
Select to remove data.

= Click OK to run the backup procedure.
The Backup progress bar will be displayed in the lower-right corner.
1. In a while, a ZIP archive will be created in two possible directories:
For TRBOnet Enterprise:

e The default directory is %ProgramData%\Neocom
Software\TRBOnet.Enterprise\Audio for Audio files and
%ProgramData%\Neocom Software\TRBOnet.Enterprise\Backups
for backup files.

e The custom directory is specified in TRBOnet Server settings.
For TRBOnet Plus:
e The default directory is %ProgramData%\Neocom
Software\TRBOnet.Plus\Audio for Audio files and

%ProgramData%\Neocom Software\TRBOnet.Plus\Backups for
backup files.

e The custom directory is specified in TRBOnet Server settings.

2. The archive includes the database backup file and audio recordings files. The
archive name contains the date of backup. New backup files will be placed in
the same directory.

» Comguter » Local Disk &) » ProgamData » Meocom Software » TESOret Enterprise »

eganize = Include in kbeary ¥ Share with = Mew folde - I

Ml Deskicg B TREOnet Enterprise 21,

i Network
ER Control Panel
& Recycle Bin

o5 8040
| G-

Impartant docs
Pies

SA5Plenet_1 2080
[PR—

|
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For TRBOnet.Plus:

GO

———— . —

. » Computer » Local Disk (C:) » ProgramData » Meocom Software » TRBOnet Plus » Backups »

=) Recent Places

B Desktop
4 Libraries
@ Documents
Jﬁ Music
[ Pictures
BE Videos
A A Roman Lapin
M Computer
€ Network
I [E3 Control Panel
]

b

Recycle Bin

2 100 level 2D map
J 585 roman

| Config_Pics

. CP5.8.0.410

| Dispatcher Actior
. Elastix

. Elastix 2.2.0 x86 (t
. Floor

| Impertant docs
. Jenkins

| Licences

MNAT -

1item

Organize = Include in library « Share with + New folder

P Name ’ Date modified Type Size
Bl Desktop | 4) TREOnet Plus_20140528.zip 5/28/2014 7:36 PM Compressed (zipp... 208 KB
& Downloads
%23 Dropbox

Restore Database

To restore the database

e Open TRBOnet Server and stop the TRBOnet Server service.

Configuration

o B

& Network

# Redundancy

= Database

f.? Reports

£F Service Management
X Advanced Settings

/A Geocoding Servers

IR Radio Systems

{} Services

-pfl PSC 1

X Advanced Settings
13 privacy

[ Slot #1

...[0 Slot #2

L7 Local Slots

3 CP1

X Advanced Settings
i Privacy
{:} DDMS service

T TS Amb= carica

Service Version: 5.4.0.2210
The TRBOnet Server service is installed

Status: ° Service started

Stop service
+ Save changes ;:rtiservix

Uninstall Service

X Advanced Settings

Viaw Log Entries Export Confiquration Import Configuration

Apply oK Cancel

e Unzip the backup archive and open the folder:

neocom
software
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Favortes
M Desinep

& Downicads

& Recent Places

B Desinop

Audio
Infetot
TREDe Entefarise bk

LT (pn——

fied: 113 109PM

e Run SQL Server Management Studio Express with sufficient rights to

manage databases.

Geoghe Caroma
Googhe fath
HTMIL Help Wodcshop
Hytern ROR

KT

Frte Codee Pack:

Corfgaration Tools
Mactarola
Wil Formes
s Sattwan
Hoiia PC Suite
POF Edits
Pl sty Pro
Sosom Recarder

4 S0L Server la ruggemesi Studis Exp

o a
inwe whare prevn

Sl

L

e Select Database in the navigation tree (for example, TRBOnet):

Ble [ Yo Dong Tech Bnfow Hep

58

ol | ] ey (5 15 S| 4 S

¢ Right-click the selected database, and go to Tasks/Restore/Database:
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-----

mmmmmm

Comnection

e el
O AN 007 s

imw comnaction gropanin
Progen

Raady
Mty Backup Med

Canesl Help

Select Database backup properties:

¢ In the Destination group, type in or select Database name to back up to from
the drop-down list (for example, TRBOnet).

¢ In the Source group, click Device.

e Click the ellipsis (...) button to select the directory with database backup:

e Click Add and select the directory to which you unarchived the database
backup (for example, C:\TRBOnet\Backup\DB).

3 Select backup devices = ==

N

([ox J[ coce |[ nee |

Speciy the backup media and &3 location for your restare aperation

Backup media type: Fie -
Backup media

Note: Select the *.bak file type.

e Click OK to add the directory.
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4z Restore Dutatiase - TRBnEt S[EI=
D b backupsst sedected to b restared
Selecta page. e
2 Genal
# e e
& Dptiors
Dotsbase
& Dipice: (-
Dutiuse -
Destinatian
Cutagaee TREOEL .
Besre s
S — = |
A ————
o i
Usdam reds s L X
[—
Cpragramateencsn Zaftvare| R Onet Enterpse Back ]
[
Conmaction [ ot ]
B VNUWINT 007 SQLEPRESS
[T 07 i)
‘e comestian peapeties /
L G |[ Corcel || e
Reacy . .
¥ Cancal Hap

e Click OK.
The database is added to the list of restored databases.
0 Fuaty
’_:";:::IW Ssoe - | [Dymep
.y . = _
[——
)" Duatabane Ful  SOOUSOUENPRESS  TREOnet 1 '?M?w
v o _!nluhhnﬂnii-l:
e Select the check box and click OK to restore the database.

¢ In the Configuration pane, select Database.

e From the Database drop-down list, select the restored database.
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Configuration Database Version: 5.4.0.2210
@ Service ~
G Metwork SQL Server: (local)\SQLEXPRESS -
@ Redundancy Database: rRECnet ] T
Database
I Authentication: TREOnet -
(P Reports TREONEt.
{:} Service Management TRBOnet_VR
x Advanced Settings TRE0net1
: " TREOnet2
i, Geocoding Servers
)’\ N TRBOnetWatch
T Radio Systems /] Specify the path fo| TREOnetWatch1 v

i LF Services
3 Repeater #1
: x Advanced Settings
=] Privacy
L0 Slot #1
I Slot #2
.17 Local Slots
I PTT over Cellular
X Advanced Settings
l TRBOnet.Mabile gatew

Path:

C:\TRBOnet\Backup\DB

M Use custom folder for audio files

Path: C:\TRBOnet'\BackupAudio

[] Use custom folder to store file attachments

Test Connection
E Remote Agents
[ Friendly servers Upgrade Database -
v
Y Telamhnm Create Database -
< >
Set Defaults

Apply

Cancel
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e Click Test Connection to check the connection to the database.

e Click Upgrade Database to upgrade the database if the current database was
restored from the database version lower than current.

e Click the Save changes and restart service link.

S Service Version: 5.4.0,2210
# B A
0 Network. The TREOnet Server service is installed

@ Redundancy

Database Status: o Service started

(@ Reports Stop service

L} Service Management )
)’_ Advanced Settings o Save changes and restart service

)\ Geocoding Servers
BB Radio Systems Uninstall Service
: Services
Repeater #1

- Advanced Settings
Privacy
Slot #1
Slot #2
= Local Slots

! PTT aver Cellular

: / Advanced Settings

B TREOnet.Mobile gateway #1
35 Remote Agents
[ Friendly Servers

B Telarmhans A
<

& E:Viev.' Log Entries Export Configuration Import Configuration

Apply oK Cancel

Restore Audio Recordings

To restore the audio file:

e Launch TRBOnet Server and stop the TRBOnet Server service.

Configuration Service Version: 5.4.0.2210
U Service ~
& Network The TRBOnet Server service is installed
& Redundancy
Database Status: o Service started

(2 Reports Stop service
£F Service Management
/1 Advanced Settings + Save changes and restart service

----- A Geocoding Servers
l Radio Systems Uninstall Service
L3 Services
o IPsC 1
}' Advanced Settings
2 Privacy
I Slot #1
I Slot #2

L17 Local Slots
o8 cr1
/ Advanced Settings
Privacy
DDMS service
)’, Advanced Settings

FL MNTE Azta carvica
£ >

II'—T_IiiViev.' Log Entries Export Configuration Import Configuration

Apply Ok Cancel

¢ Go to Database section in the navigation tree and specify custom directory for
audio files (for example, for TRBOnet Enterprise
C:\TRBOnet.Enterprise\Backup\Audio; for TRBOnet Plus:
C:\TRBOnet.Plus\Backup\Audio).
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Configuration Database Version: 5.4.0.2210
@ Service
G MNetwork SQL Server: (local)\SQLEXPRESS v
@ Redundancy Database: TRECnetL -
= e
Authentication: Windows M
@ Reports
ﬂ Service Management Login:
x Advanced Settings Brzzmamt

A( Geocoding Servers
B Radio Systems
5§ PTT over Cellular
E Remote Agents
E Friendly Servers

E Specify the path for database archives

Path: C:\TRECnet\Backup'\DB

E Use custom folder for audio files

Telephon
8 phony Path: C:\TRECnetBackupAudio
1-* Data Sources
24 Email [ Use custom folder to store file attachments /
B0 sMs
Path:

5 License d

| Test Connection |

| Upgrade Database - |

| Create Database - |

| Set Defaults |

Rl

| | Cancel ‘

e Go to the directory you specified to store backup audio files.

e Unzip the backup archive:

|. ® Computer b Lozl Disk (C) » ProgramDits + Neccom Softwars + TRECrst Enterprive b Backups » - | e

Organie » g Open

Hame
4 Favoribes o

M Devetcp

Include in limary =

Share with =

P fisleler
Diste modified Type Sire

Hile folder

Test Document 1kB
BAK File

WinRAR ZIF srchive

| Budin
| Wbobit {i
| TRBOnet Entejarise ek

TR TRBOnet Entefprive 21 3050.0p

B Devmloads
U Receni Places

[ Desktop
S Librasies
%] Documents
o Muie
W Picturss =
B vide
B Roman Lspn
1B Comguter
S Heteork
8 Control Panel
& Recyeln Bin
| CPSEO410
Elastix

. Important docs
. Pics
b SASPlines_1 2080
TR TP o
| Audic  Datemodfed 8972013109 PM
I

EEEEE

e Copy unarchived audio files to the folder specified in TRBOnet Server settings
(for example, C:\ProgramData\TRBOnet Dispatch Software \Audio):

w | b [ Sazrn fuaie 0

|+ Comguar o Leeal Dk pC:) b Frogeembsts 5 Moo iokwan + TRBOrst Ertrpem 5. dudn »

Orgamice = Hew e = -
B Dsanisah " ame Date modiie Type Sie

lnchriinby »  Shcwih =

EL Arcent Places

M Db
G Libraries
% Docusments

T ELE R
§ mnzm 38
L HET
bz ez 1o
bz ez 18
bz ez s
bz o m
b 2002 92 0217
b 2002 02 0615
b 20020 06 15
b 2002 0 06 18
4 33 92 0 15
4 B3 05 8 15
\ B3 o 0T
4 B3 o g i
L a2 peon 13
bl eeor s

e Click the Save changes and restart service link.
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Configuration
& =
& network
& Redundancy
= Database
@ Reports
L} Service Management
X Advanced Settings

Service

neocom
software

Version: 5.4.0.2210

The TREONet Server service is installed

Status:

° Service started

Stop service

+ Save changes and restart service

)f\ Geocoding Servers
I8 Radio Systems

L. 43 services

3 Repeater #1
X Advanced Settings
Privacy
- Slot #1
.. Slot #2

.17 Local Slots

B PTT over Cellular

X Advanced Settings

l TREOnet Mobile gateway #1
52 Remote Agents

% Friendly Servers
P Talarbnr
<

Uninstall Service

View Log Entries Export Configuration Import Configuration

Set Defaults

Apply oK Cancel

Thus, the audio files will be restored.
Schedule Backups

To set a scheduled backup for the database and audio recordings, do the following:

¢ In the Dispatch Console, go to Administration section and select Database in
the Navigation tree:

Click the Schedule button:

File View Map Tools Help
Administration Database [F1ER
g e * | W5 e e B e M Ercar [l

-0 (B e (R o) (B Blele)

il Radio Systems

s Crea CER

% Teesteny o || Backup | S Schedule |
Elé'h Voice Dispatch u Database Iiformation
E Server name: {ocal) \SQLEXPRESS
Leatics Bacdes Database name: TREONE

Backup date: 25-0ct-2016 16:28:26
W Job Ticketing Datebase verson: ~ Microsoft SQL Server 2014 (SP2) (kB3171021) - 12.0.5000.0 (X64)
Jun 17 2016 19:14:0¢
Copyright () Muus ion
Ej Route Management Express Edition (64-bi ows T 6.3 64> (Buid 10535 )
@ RFID Tracker Data size: 17,2348
Audio size: 22.77ME
[] Text Messages
ﬁ Voice Recording
@ Reports
Event Viewer
—
® 12700.1 Administrator | [28 Licensed to: demo Demo License Active -
E ]

¢ In the dialog box that appears, specify the Backup details:
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Schedule Database Backup X
I é Configure the database backup scheduler
Iv Enable scheduler
Scheduler: |Database Backup AR
[m] (select Al
Backup data [ acf
; [ ahs
[ Backup audio Dty
|:| Remove |:| qwa
§ ] awerty
B = 0-o=cecacon
oK Cancel

e Enable scheduler
Check to enable the database backup scheduler.

e Scheduler
Click the arrow button on the right, and on the drop-down list select the
required scheduler(s). Or, click the plus button on the right, and create a new
scheduler.
For directions on how to create schedulers, see section 6.4.17, Schedulers.

e Backup data
Check to back up data.

e Backup audio
Check to back up audio recording.

¢ Remove
Check to remove audio files and data from the database.

= Remove all data older than [X] days
Select the number of days to remove all data.

= Audio Files
Check to remove audio files.

= Data
Check to remove data.

e Click OK to run the backup procedure.
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Appendix E: SIP Setup for Motorola Phone System

The native MOTOTRBO phone system is supported in the case of a direct IP

connection to the repeater. MOTOTRBO Phone system is recommended for IP Site
Connect mode.

Note: No extra license per repeater is required for Digital Phone Patch
from Motorola.

TRBOnet Software and Repeaters

TRBOnet Server requires a specific setup for a repeater in the IP Site Connect mode
as well as for SIP in order to make the phone system work properly.

Note: MOTOTRBO Phone System is available for repeaters in IP Site
Connect mode. For a system based on the control stations, use
TRBOnet Phone System.

Launch MOTOTRBO CPS and go to Repeater's General Settings page:

[ MOTOTRBO Customer Programming Software - [Sample_DR3000.cth - o
Fle Edt View Device Features Remote Window Help - x
=~ | ¥4 mBom QA k2 MM 192168111 E
RM | Open Save | Reports | Delste | Cut Copy Faste | Search | Resd Wite Clone & Biuetooth
- DR 3000 .
= General Settings
9 Aceessones Top CWID Voing  Microphone
@ Securty
= Network Radio Neme  [Motorota
=
g Link Estabishment
= Radio D [y
Llnstes
<& Talkgroups SIT (ms) 6000 =+
B~ @& Channels
Zenet Group Call Hang Time (ms) 3\:5\:3,
Private Call Hang Time (ms)  [a000 E|:
Emergency Call Har e (ms)  [4000 E|:
CallHang Time (sec) [3 E|;
Repeat Gain (98) [gg E|;
Antenna Relay Delay Timer (ms)  [1pp =

General Settings Expert View NUM

The Radio ID of actual repeaters in CPS must differ from the TRBOnet Peer ID.
TRBOnet Dispatch Console acts as another virtual peer repeater with Peer ID (for
example, IPSC network consists of 1 master and 3 peers. The repeaters' IDs (Radio
IDs in CPS codeplugs for repeaters) in this case would be 1, 2, 3, 4. The TRBOnet
Peer ID must differ from all the repeaters (the master and all peers, otherwise a

conflict will happen in the network as peers have the same ID). The TRBOnet Radio
ID is 64250.

e Open TRBOnet Dispatch Console. Go to Administration (1), Telephony (2),
Radio calls configuration (3) — Configure (4) and set DTMF Access and
DTMF Deaccess codes (5) to 0 and #, respectively:
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File View Maop Tools Help

il Radio Systems

(J Databace A Repeater #1: Slot 22

&P Telephony e
@ Tesks

Wirtual Modbus Devices
Event/Alarm Management

Do P

DTMF Deaccess code:

@ Administration | Configure

i System Bridging ‘Configure Calls | Extensions [ RedirectCalls [ Aliases [ Profiles

2 Radio calls configuration <——— 3

Alow subseribers to make outgoing cals: Yes

Allow to use DTMF: Yes
Allow to use Text Messages: Yes, Prefix: 'sip:*
[ ke T A e Radio calls configuration X
Initalize cal to radio:
s, GPS Positioning Initialize call timeaut: . X
Exeaute Check Radio before cd ¥ Alow subscribers to meke outgoing cally
& 30b Ticketing SendTextMessage ffeamnotel ¥ Allow to use DTME
Play tone when PTT changed: [¥ Allow to use Text Messages
Route Management DTMF Access code:

Prefix sip:

P
AR ST 4 Incoming calls configuratio|  [italze cal bmeout: Urlimited 3] seconds
5 [ Execute Check Radio before call
i‘ ) Call to Dispatch Center:
Cal to external number: [V Send Text Message if cannot establish cal
@ Reports Extension numbers (VOIC&| [ by tone when PTT changed o) !
Start call automaticaly:
DTMF Access code: o
= Maximum number length:
/5| Event Viewer 5
Number DTMF Deaccess code: *
0
& | s Lo | co |

Play the incoming cal tone on the radio: [After the called party answ... 7
Initsize call to radic Send ing tone -

127001 55 B Bl | § Administrator | (8 Licensed to:

Programming Radios

A special setup is required for radios

demo Demo License

in MOTOTRBO CPS.

e Read a subscriber's radio in CPS and go to Phone > System (1):

Bl MOTOTREO Customer Programming Seftware - [Untitled1]

[ Fie Ed® View Device Features Remote  Window

@ & H| @ | ¥ bR Q

El- @8 Signaing Systems A
P User Defined 5 To.

£l @ 5Tone

: ) syst

A
v

Help

b2 B M 192.168.11.1 5
RM | Open Ssve Reports | Deiele | Cut Copy Paste  Search | Read Wrte Clone | Bluetoolh

Ton DIME
Gateway 1D lﬂ‘_\
fccessCose o 2
3 <]mccess Code |

Preme me) [so =]

X Tone Duration (ms) [r20 =]
TXTone nterval (ms) [0 5]
Pause Duration (<) [s000 =

[Expert view |

[ [wum|

e Make sure that Gateway ID (2) is equal to TRBOnet Peer ID in the Repeater

settings of TRBOnet Server.

e Set Access Code to 0 and Deaccess Code to #, respectively (3).

¢ Go to Channels > Zone> Channel (1) and select the Phone System you have

previously specified (2):

Bl MOTOTRBO Customer Programming Software - [Sample_DP4301e.ctb]

Fie Edt View Device Festres Remote Window Help

@ & b 3 K ¥ moB| Q|

RM | Open Save | Repots | Delete | Cut Copy Paste | Search | Read

Bl @8 Flexibie RX List

AN
T

I EX IX

8B Listt

-

48 st
~
B @ cremes voos smocanertrie [T -
E- @ Zonet 1
% [Channal] 4=—T"" Dusl Capacity Direct Mode [~
{181 cromez Timing Loader Preference [gigom =
) Cranne Poat
El-@ Scan ScanRoemList [yans <
2 L Auto Scan [T
Bl @8 Roam
(@ Listt color Code [ = 5
Capacity P
e . RepeaterTmeSiot [1 )
- @ Voice
WB e Phone System
B @ Data
W Listt v #RS [Disabied = .
< - S| < N
Chomer [Epertview | o]
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Appendix F: NAI VOICE & DATA Support

TRBOnet Dispatch Software supports MOTOTRBO Network Application Interface
(NAI) VOICE and DATA.

NAI protocol allows operating with MOTOTRBO Capacity Plus and MOTOTRBO
Linked Capacity Plus repeaters over IP (Wireline Dispatch Console).

Voice Repeaters must have NAI VOICE and NAI DATA license activated. Data Revert
repeaters must have NAI DATA license activated. A repeater must have 32 Mb
memory.

Software Requirements

Server Computer ‘ Dispatch Computer ‘

TRBOnet Server installed

MOTOTRBO Network Interface Service (MNIS)

MOTOTRBO Device Discovery and Mobility Service TRBOnet Dispatch Console installed
(DDMS)

MS SQL Server 2008 R2 or higher
(can be installed on remote server)

Hardware Requirements

Server Computer Dispatch Computer
CPU Intel Core i7 or higher Intel Core i5 or higher
Memory 3GB 3GB
Multi-channel Sound Card required.
Recommended:
Sound Card — 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Windows 7/8.x/10

Windows Server 2008/2012/2016 Windows 7/8.x/10

Supported OS

Additional devices | — Microphone and speaker (headset)

Note: Itis possible to use a virtual machine as a Server computer.
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Voice and Data Flow 1

TRBOnet Voice and Data flow for NAl is represented on the following scheme:

TRBOnet @

Server

Dispatcher

MNIS
(Data

DDMS Geteway)

(Presence
Notifier)

Voice and Data Flow 2
MNIS is responsible for sending/receiving Data Packages and forwarding them to
TRBOnet Server.

DDMS (aka Presence Notifier) is responsible for ARS and notifies TRBOnet Server
when a radio is turned on/off. For more details, see NAI_RM_Training_v02.pdf.

All the repeaters in all sites should be available for TRBOnet Server, which normally
requires Port Forwarding rules on routers. For more details, see MOTOTRBO Linked
Capacity Plus (LCP) - HP MSR 20-20 Router Configuration Guide.

Single PC Installation

TRBOnet Server and Dispatch Console can be installed on the same computer.

LCP/Cap+ System

LTSN

Client and Server
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Client-Server Installation

For the systems with 2 and more dispatch positions, it is recommended to have a
dedicated server computer (could be a virtual machine).

Dispatcher 1

LCP/Cap+ System

TRBOnet
Server

Dispatcher N

TRBOnet Server and all the LCP sites must be in different networks, behind their
corresponding routers:

Site 1, Network 1

E Site 2, Network 2

sasmmmuRww
V71T S S
—

TRBOnet
Server
Network 0

Site 3, Network 3

Use the recommended Routers only.
Notes:

e One TRBOnet Server computer is for one LCP System.
e |tis possible to connect two or more LCP systems (System Bridging).
e TRBOnet System Bridging supports Group and Individual Calls.
e |tis possible to use a Virtual machine as a Server.
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LCP/Cap+ System 1

Y I

TRBOnet
Server
for System 1

LSS

Dispatcher

LCP/Cap+ System 2

Swift.Agent
for System 2

Limitations
e Logging of Radio-to-Radio TEXT is NOT SUPPORTED.

e Phone Interconnect is available with some limitations.

e Local Talk Group IDs must be unique per system.
Radio Subscriber Configuration

Network Settings

= @ DPasnt -
F

@ Accessories Top RadioNetwork Services Control Station  |P Site C
EHE Buftons
i Bluetooth  Bluetooth Serial PortProfile Data Routing ~ USBHIC
o Bl Text Messages
o=
- ARSRadolD [eas0 =
et ARSIP 13.0.250.250
[~ @ Signaing Syster
L i) Uger De ARSUDPPort [ag05 =]
E-@ sToe || TMSRadolD [pas0 =
=& mDC TMSIP 130250250
H L. [TJ Sys”
I:II Qukcar TMS UDP Port |4ou7 =+
i i) sys User Defined UDP Fort 1 [Disabied =
= @8 Digital Eme
i sys User Defined UDP Port 2 |D.,,M 3
= @8 Capactyt
7 n User Defined UDP Port 3 ID'“M 3,
i it sys
’:J- Phone Control Station
[T
[ @8 Encoder ony [
(D swtus
= @ Sequence (ARSMMWMQID | 3 )
209 Slﬂ
= ARS Monitorina IP~ 0.0.0.0

360 TRBOnet Enterprise — User Manual



Appendix F: NAI VOICE & DATA Support

neocom
software

/®

Personality Settings - 1

H-C!MPIIS

i) voloe_Rep_t
£ 1) Dats_Rep Sot_
1 Data_Rep_Siot_
Z| & scan

o
i

L =

& ustt

Personality Settings - 2

A Personality_1

Top RX IX
\ioice Announcement File |,.J,;,“e :l
(ms |on systemsite Crangs | )
Privacy [
Privacy Alias Im
RAS Mias | None -
Option Board [
Lone Worker [
Messaging Delay (ms) [go =]
@umpressed UDP Data Header [V _)
futo Roam [
Stte List [Listt -

I T

(oo )
(Emwwﬂvsm |syst =l )
vox [©
oo [
ToT e [0

TOT Rekey Delay (sec) |D H.

AiowIntzrruption [~
TX Intesruptible Frequencies [

(Mﬂm |cotor Code Fres

In Cal Crteris. {Fotow At Critzria |

RSS! Threshold (dBm) |.124 3;

Private Call Confirned [~

Data Call Confirmed [~
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MNIS and DDMS Settings
General Settings

MOTOTRBO Network Interface Service Configuration Utility — MNIS Restart Required =3 N [= | 1]
Configuration  View  Edit

NrLHOCO®

( System Operation Mode | Linked Capacity Plus '! )
( MNIS Application ID  [54250 3: "

@N\S IP Address  [192 168.10.76 )

Tunnel IP Address  152.168.10.77

Subnet Mask  255.255.255.0

Talk Group Settings

Configuration  View Edit Service Help

NLH OO

Grvwba'ﬁ'pe ICapadtyH.lstCF 'I>
C Al Groups vV )

e B

=} & Linked Capacy Plus
£ [ Stes [ | First Call ID | Last Cal ID
[ @ Advanced
2 Network
[ Forwarding Rules
- Application Ovemc
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Master Repeater Settings

MOTOTRBO Network Interface Service Configuration Utility - MNIS Restart Reg

Configuration  View Edit Senice Help

D)L HOCO®

Master IP Address [10.10355
Master UDP Pat [50017 =

MNIS LE Pot | % Automatically Assigned

' Manualy Assigned [None =

Authentication Key

Privacy Setting INW—H

LCP Sites Settings

MOTOTRBO Network Interface Service Configuration Utility -- MNIS Restart Require 2' = |I:I|1|

Configuration  View Edit Service Help

NrHOCO O

@ LCP_Test
- B General
- @ Seaunty ad | peee |
= @ Group List \‘
T b s [ stew Group List Outbound Data Limt

1 List1 i H

2 List1 =z

N |

] <@ Linked Capacty Plus
| <cEH
£} @ Advanced
- o Network
|- B Forwarding Fuies
Application Overic

Advanced Settings

MOTOTREO Network Interface Service Configuration Utility -- MNIS Restart Reguire :)_l - |EI|1|
Configuration View Edit Service Help

N)rLHEHO0O0

O LCP_Test
ISt Data Cal Cerfimed [
490 Lt émm”d UDP Data Headsr W )
= & Conventional
| % Doman 1 Battery Saver Preamble ¥
3‘ Capactty Plus Indvidual Data to Registersd Ste [~
= <@ Linked Capacity Plus
RYree T Preamble Durtion fne) [0 =]
= o [
-l Network Conventional Channel Access [T B
- [ Forwarding Rules
. Application Cvermic
MNISLEID | & \icc uNiS 1D
' Manually Assigned -
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Network Settings

% MOTOTRBO Network Interface Service Canfiguration Utility * - a x

Configuration  View  Edit Service Help

D LbkHd OO @

= @ Untitled
. General
@ Securty CAlNetwork [12 [£
£ ) Group List
- B Listi CAl Group MNetwork (225 |2

B @ Convertional

& Domain 1

-G8 Copacty Pl ARSUDPPot [4005 1=
[ ;4@ Linked Capacity Plus
B & Advanced TMSUDP Pt [a007 |2
"
- [ Forwanding Rulss Telemetry UDP Port 4008

Appliestion Oven Location Server UDP Port 4001

D

Battery Managemert UDP Port 4012 =
User Defined UDP Port 1 Disabled |5
User Defined UDP Port 2 Disabled |5
User Defined UDP Port 3 Disabled |3

XCMP Enable [
XCMP Server UDP Port  |4004 5

ARS Moritor [

ARS Monitor ID [Nene =

({_Server Address ) |127.0.0.1
o

DDMS Settings

The DeviceRefreshTime parameter defines how often radios should send ARS to
TRBOnet Dispatch Software. The value depends on the number of radios and
channels.

of i

Fle Acoon Hep
OYEIE HE %
Senvice 'El ARS Sedtings
B l_'rlerfams
‘21 ARS Setings
5| Walcher Settings
£ Loggng
DeviceRefreshTime
Devics Regisiration durafion in minutes, rounded up to the nearest 30
| minute interval Range: 1~ 6460 (D<forever)
Setings for ARS/SU interface
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ARS TRBOnet Settings

Configuration Service Management
ﬁ Service
G Network Presence service
* Redundancy Auto request presence timeout: 5 : minutes
Datab:
,a Ra .;se ARS refresh interval: 1440 5 | minutes
‘. epor
a Ignore unregistered Radios
X Advanced Settings — .
i\ Geocoding Servers ocation senvice
l Radio Systems GPS restart by inactivity timeout: | 10 : minutes
5§ PTT over Cellular Dispatch Console update interval: | 5 % seconds

E Remote Agents

W] Automatic error correction

E Friendly Servers
Configure

@& Telephony Aoy " P :
1 Data Sources Send the latest GPS data to dispatchers on alert
4 Email For the last:
[ 5MS GPS points:
[ License
Indoor service
i/ Remove offiine radio from beacon
Ignore beacon position on alarm if GPS is fixed {only K-TERM)
Set Defaults Apply oK Cancel

¢ Auto request presence timeout
Set this parameter to the value of the DeviceRefreshTime parameter in
MOTOTRBO DDMS.

¢ ARS refresh interval
Set this parameter to the value of the PersistenceTO parameter in
MOTOTRBO DDMS.

LCP Repeater Settings

Configuration CP1 Version: 5.4.0.2210
‘f Service -~
G Network System Name: Repeater #1
# Redundancy TREONet Peer ID: 100 =
Database TREOnet Radio ID: =
L% Service Management TREOnet Local Port: 50001 by
X Advanced Settings Master Repeater Connection Info:
A\ Geocodng Servers Master IP Address: 10.10.188.35 -
l Radio Systems <
£ Services Master UDP Port: 50000 - Test
..o Repeater #1 Authentication Key: 123456
X Advanced Settings System Type: iLinked Capadty Plus -
2| Privacy
'ﬂ' DOMS service System Identifier:
X Advanced Settings 7] Use NAI Voice
L3 MIS cata service /] Use NAI Data (MNIS and DDMS)
: X Advanced Settings I,
.01 Audio Paths
! PTT aver Cellular
X Advanced Settings
i [l TREOnetMabile gateway -.—1
El Damnta Anante
£ >
Set Defaults Apply oK Cancel

Special settings:
e TRBOnet Peer ID — any unique value.
e TRBOnet Radio ID - the default TRBOnet ID.
e TRBOnet Local Port — any free port on the PC.
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Audio Paths

Configuration
@ Service
9 Network
& Redundancy
Database
(2 Reports
{:} Service Management
X Advanced Settings
Ll Geocoding Servers
l Radio Systems
{} Services
3 Repeater #1
X Advanced Settings
11 privacy
-4} DDMS service
L. ndvanced Sett
¥ MNIS data service
X Advanced Sett
~m
5 PTT over Cellular
E Remote Agents

52 Friendly servers
R Talanhan
<

Set Defaults

Special settings

Audio Paths

Load Groups Map

Version: 5.4.0.2177

Cal Type Group ID Site ID
E Group Call 10 Wide
Group Call 20 Wide
W] Private call
|l cal
Add Delete Configure
Apply OK Cancel

e Load Groups from Master Repeater;

e Add Local Groups manually.
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Appendix G: Redundant Server

The TRBOnet Server supports a backup configuration which allows seamless
switching from the primary to redundant server in the case of failure of the primary
server. The Dispatch Console operation will not be interrupted.

Redundant configuration overview

\
TRBOnet Dispatcher I

=‘/N Heartbeat connection D]vﬂ—
— LN —
MS SQL TRBOnet TRBOnet MS SQL
Database 1 Primary Server Redundant Server Database 2

e Primary and Redundant Servers are configured identically.

e Redundant Server is operating in PASSIVE mode.

e Redundant Server is monitoring Primary Server status.

e Dispatch Console is connected to Primary Server.

¢ In case of Primary Server failure:
= Dispatch Console connects to Redundant Server automatically.
= Redundant Server becomes ACTIVE.

e Once failed Primary Server is back online, Dispatch Console automatically
reconnects to Primary Server.

e Primary and Redundant Servers do not exchange any data.
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&

TRBOnet Redundant Server Configuration

¢ In the Configuration pane, select Redundancy.

Configuration
& Service
0 Network
¢
Database
_b‘ Reports

Redundancy

Redundancy Mode:

Main servers:

L} Service Management IP Address

/’_ Advanced Settings
A Geocoding Servers

B Radio Systems

5§ PTT over Cellular

5=l Remote Agents

il Friendly Servers

ﬁ Telephany
I Data Sources

=4 Email

[ 5M3

[ License

Add Edit

Set Defaults

1 M 10.10.234.162

W Redundant server mode

Version: 5.4.0.2178

Passive -

Delete Test

Apply OK Cancel

In the Redundancy pane, select Redundant server mode.

Redundancy Mode

Select the mode for a redundant server from the drop-down list.

To add a primary server, click Add.

Server Properties

IP Address: | 10.10.234.153|

Fort: 4021

oK Cancel

-
-

Test

IP Address

Type the IP address of the primary server.

Port

Enter the same port number as specified for the Command port.

Passive Mode

In the Passive mode, the Dispatch Console is connected to the primary server. In
case the primary server crashes, the redundant server gets connected to the radio
system and then starts recording to the database (Database 2). The Dispatch
Console automatically connects to the redundant server. After the primary server is
recovered, the Dispatch Console will disconnect from the redundant server and
reconnect to the primary server.

Active Mode

Alternatively, in the Active mode, the redundant server is always connected to the
radio system and records to its database, thus duplicating the primary server's

datab
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The Active mode has some limitations that are outlined in another section (see
section Restrictions for Active Reserve Mode on page 369).

Restrictions for Active Reserve Mode

e Go to repeater settings and make sure that TRBOnet Peer ID of the
redundant server differs from the one set for the primary server. Each TRBOnet
Server must have a unique peer ID in the radio system:

Configuration
ﬁ Service ~
& Network

@ Redundancy
Database
a Reports
LF Service Management
X Advanced Settings
)\ Geocoding Servers
I8 Radio Systems
{:} Services

.. Privacy
- Slot #1
[ Slot #2
.11 Local Slots

I PTT over Celular

X Advanced Settings

i... | TRBONet.Mabie gateway #1
E Remote Agents

E Friendly Servers
P Talanknmg
<

Set Defaults

Dispatch Console Configuration

CP1

System Name: Repeater #1

TRECnet Peer ID: 100
TRBOnet Radio ID

i - 54250
TRBOnet Local Port: 50001

Master Repeater Connection Info:

Master IP Address: 10.10.188.35
Master UDP Port: 50000
Authentication Key: 123456

System Type: IP Site Connect
System Identifier:

Use MAI Yoice
Use MAI Data (MMIS and DDMS)

Apply

Version: 5.4.0.2210

AF AF 4r

Test

4r A

oK Cancel

To add a server to the list of servers:

e Launch TRBOnet Dispatch Console to open the Connect to TRBOnet Server

dialog box, or on the File menu, click Connect to TRBOnet Server.

Connect to TREOnet Server x
Connect to:
Address: 127.0.0.1 ]
Port: 4021 = Configure
Authentication:
Method: TRBCnet Authentication ~
User Name: |admin ‘
Password: | “““““ ‘
|:| Connect on startup
Cancel

e Click Configure to register the new primary server:
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Sk Add =) Edit | = Delete

Server Label Server Address Port

Servel 10.10.164.45 4021

Server Register TRBOnet Server x
Label: |Server 3
Address:  [127.0.0.1
Port: 4021 S

Redundant servers:
| | Address Port

Add Delete av]
J Cancel

= (Click Add to add a new TRBOnet Server:

Label — enter a name for the new primary server.
Address — enter the primary server's IP Address.
Port — specify the command port of the primary server.

Add - click and specify the IP address and port of the redundant
(backup) server for the primary server being registered.

Click OK to save settings and close the dialog box.

Console Connection to Primary and Redundant Servers

370

¢ Go to File > Connect to TRBOnet Server, and from the drop-down list select
the primary server you created:

Connect to TRECnet Server X
Connect to:
Address: |m |u
Serverl
iz Server2
Authentication:
Method: TRBOnet Authentication ~

User Name: |admin |

Password: | ========== |

[] connect on startup

e Click OK to connect to the primary server.

Now you are connected to the primary server. In case of a lost connection to
the primary server, the Console will try to restore the connection within 30
seconds. After 30 seconds have passed, the console will change connection to
the redundant server automatically. When the primary server is restored, the
Dispatch Console will reconnect to the primary server automatically.
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